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Volume 2
IMPRINT Pro User Guide

The Improved Performance Research Integration Tool (IMPRINT) was 
developed for the Army Research Laboratory (ARL) Human Research and 
Engineering Directorate (HRED). This manual describes the professional 
version of IMPRINT, named IMPRINT Pro. IMPRINT Pro is government-
owned and consists of a set of automated aids to assist analysts in 
conducting human performance analyses. IMPRINT Pro provides the 
means for estimating manpower, personnel, and training (MPT) 
requirements and constraints for new weapon systems very early in the 
acquisition process.

Chapter 1: Basic Procedures
Basic IMPRINT Pro procedures include creating, opening, and saving, 
cutting, copying, pasting, closing, deleting and exporting analyses. They 
also include adding and deleting the folders which contain them.

Before working with any new analyses, however, it is recommended that 
you first check your settings for your local server where your analyses will 
be saved. You may also optionally set your system up to work with a 
remote server in order to access files from a networked computer running 
the same version of IMPRINT Pro.

Elements of an Analysis 

An IMPRINT analysis contains the following elements:

Warfighters. The Warfighters in your analysis are the different 
types of people that are required by your Operational Mission 
models or Maintenance models. Warfighters are broken down 
into Operators, Maintainers and Supply and Support Personnel.
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Missions. The Missions in your analysis are models which 
represent processes you are attempting to simulate. Each model 
is comprised of a series of tasks, functions and goals which are 
connected as a network. When you run a mission model, the 
model calculates task performance times, implements 
appropriate workload strategies during operator overload, 
evaluates accuracy to determine task failure, implements failure 
consequences, and collects results of task, function and mission 
performance times.

Equipment. The Equipment node contains all scenarios, 
segments, subsystems, components and repair tasks required 
by a maintenance model. In turn, this maintenance model 
simulates the flow of systems into mission segments and the 
performance of maintenance actions to estimate maintenance 
manhours for your system.

User Stressors. The User Stressors node contains all user 
stressors designed for the analysis. Each user stressor, when 
implemented, is designed to impact task time and/or accuracy 
when the model runs.

Forces. The Forces node contains all Force Units included in 
your analysis. Each Force Unit is comprised of a set of activities 
(planned and unplanned) and jobs. This information, when 
modeled, helps predict the manpower needed to perform the 
routine and unplanned work done by a force unit.

By default, all analyses in your tree contain these same five levels of 
information. You must, however, provide the data in each of the areas as 
required by your model.

When you save, cut, copy, paste, delete, import and export an analysis, all 
areas listed above for the analysis you have selected are included.

Understanding the Analysis Environment

The highest level nodes in the Analysis Tree are the Local Server node and 
the Remote Server node. These nodes represent the local server directory 
and the remote server directory where you may access and store your 
analyses.

When starting up IMPRINT Pro, the server nodes immediately appear in 
the Analysis Tree.
2
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Viewing Analyses in the Local and Remote 
Servers
Analyses may be added to and stored in folders you create in the Local 
Server folder and Remote Server folder. For more information on setting up 
the remote server environment, see IMPRINT Pro User Guide Volume 2: 
Basic Procedures, Appendix D.

To view analyses in the local and remote server environments:

1. Click the plus “+” sign next to the Local Server node.

A list of folders containing your analyses appears.

Note:
By default, IMPRINT Pro includes a folder called “Analyses.” For creating 
additional folders in the tree see “Adding Folders to the Analysis Tree” on 
page 20.

2. Click the plus “+” sign next to a folder.

A list of analyses within the folder appears.
3
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Locking and Unlocking Analyses
When using the remote server option in IMPRINT Pro, access to analyses 
is shared between two or more users. This provides the benefit of allowing 
several users access to the same analysis without having to export and 
import the analysis from machine to machine.

To prevent two or more users from accessing the same analysis at the 
same time and potentially overwriting each other’s changes, you may first 
lock the analysis. The lock option allows you to open, modify, run and save 
the analysis as you choose while allowing other users limited privileges of 
viewing a copy of the analysis in its last saved state. When you have 
completed and saved your changes to the analysis, you may then unlock 
the analysis for other users to be able to access and modify your updated 
file as required.

To lock an analysis:

1. Right-click the desired analysis in the Analysis Tree.

From the shortcut menu which appears, select the Lock Analysis 
option.
4
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2. The blue lock symbol appears next to the analysis name in the tree.

To unlock an analysis:

Right-click the desired locked analysis in the Analysis Tree.

From the shortcut menu which appears, select the Unlock Analysis 
option.
5
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The blue lock symbol disappears from the analysis name in the tree, 
and the analysis is once again fully accessible by all other remote 
users.

Note:
Prior to unlocking the model, you will be prompted to save your analysis if your 
model has any changes which have not been saved.

The following conditions should also be considered when locking and 
unlocking analyses:

If another user has a lock on the model, a message appears both 
before the model run and before attempting to run reports that 
reports are unavailable. This is because you do not have the lock 
thus you cannot save model run data to the database for the 
reports to be able to utilize. 

If you have the lock and choose to unlock the analysis, every 
time you run the model the analysis will be re-locked. This is 
because IMPRINT Pro needs to ensure that data from the model 
run can be saved to the database, which requires a lock. 

Closing the analysis (using the actual Close Analysis shortcut 
option to do this) will result in the lock being released. 
6
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Collapsing the analysis in the tree does not result in the lock 
being released.

Adding New Analyses

To add an analysis:

1. In the Analysis Tree, right-click the Analyses folder (or other folder) 
and select New Analysis from the shortcut menu that displays.

OR

From the File menu, select the New Analysis option. In the submenu 
to the right, select the folder in which the new analysis should appear. If 
no folders appear, you must first create a new folder in the tree and 
then retry this option.

The new analysis displays under the selected folder in the Analysis 
Tree and is selected automatically. The Properties window updates to 
display properties of this analysis.

2. In the Properties window, type in a new name and version in the 
Analysis Name and Analysis Version fields, if desired.

3. Click outside the Properties window.

The name and/or version of your analysis updates in the tree.

Note:
A new analysis is not saved to your database until you use the Save or Save 
As command, or until you run the model. For more information see “Saving 
Analyses” on page 13.
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Adding Analyses from the Library

IMPRINT Pro contains libraries of data on numerous currently fielded Army 
systems. The purpose of these data is to provide you with a starting point 
for conducting your analysis. For example, if you want to conduct an 
analysis in support of a new tank, you could load the mission models for 
the M1 tank for reference, and then modify these existing missions to 
reflect the missions of your new tank.

To add an analysis from the library:

1. In the Analysis Tree, right-click the Analyses folder (or other folder) 
and select Library Analysis from the shortcut menu that displays. 

OR

From the File menu, select the Library Analysis option. In the 
submenu to the right, select the folder in which the new library analysis 
should appear. If no folders appear, you must first create a new folder in 
the tree and then retry this option.

A list of all the weapon systems for which IMPRINT Pro contains data 
displays.

2. Select the system that is closest to your new system, and then click OK.

This will cause the library data for the selected system to be copied into 
your analysis database. The mission, Warfighters, and equipment data 
associated with that library system will be available to you in 
subsequent dialog boxes.

The library systems available in IMPRINT Pro include those in the 
following table.
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Mission Area System Type System Name

Air Defense Air Defense Mobile Gun M163VULC

Air Defense HIMAD Patriot FP

Air Defense Man-portable Air Defense 
System STINGER

Aviation Attack Helicopter AH-64A

Aviation Cargo Helicopter CH 47D

Aviation Scout Helicopter OH 58D

Aviation Utility Helicopter UH-60A

Close Combat Heavy Cavalry Fighting Vehicle M3 BRADLEY

Close Combat Heavy Tank M1 ABRAMS

Close Combat Light Anti-Tank Vehicle M901 ITV

Close Combat Light Automatic Weapon M249 SAW

Close Combat Light Grenade Launcher M203

Close Combat Light Infantry Fighting Vehicle M2 Bradley

Close Combat Light Man-portable Anti-Tank 
Weapon DRAGON

Close Combat Light Man-portable Indirect Fire 
Weapon M252 81MM

Close Combat Light Rifle M16A1

Combat Service 
Support Heavy Truck M977 HEMTT

Combat Service 
Support Light Truck M998 HMMWV

Fire Support Medium Range Missile 
Artillery LANCE

Fire Support Rocket Field Artillery 
System MLRS
9
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Importing IMPRINT Analyses

IMPRINT Pro is compatible with analyses created in previous versions, 
such as IMPRINT 7 and IMPRINT Standard 8. Users of version 5 or 6 must 
upgrade to version 7, import these 5/6 analyses into IMPRINT 7 and then 
export them from IMPRINT 7 to a Pro-compatible format (.7xp). IMPRINT 
Standard 8 users must export their analyses from IMPRINT Standard 8 to 
the Pro-compatible format (.8xp). While these analyses are being imported 
into IMPRINT Pro, they will automatically be converted to the new Pro 
format (.pro) and will display in the IMPRINT Pro window. The conversion 
may take a few minutes depending on the complexity of the analysis.

Note:
Once converted, IMPRINT 7 and IMPRINT Standard 8 files may not be 
converted back to their previous format. Therefore backups of these analyses 
in their original format should first be made before any importing/converting 
occurs if opening these analyses in previous versions is still required. 

An IMPRINT Pro analysis and all of its data can be imported into your list of 
existing analyses from another folder or drive on your computer, or from 
another computer on a network. 

To import an analysis:

1. In the Analysis Tree, right-click the Analyses folder (or other folder), 
and then select Import Analysis... from the shortcut menu that 
displays.

OR

From the File menu, select the Import Analysis... option. In the 
submenu to the right, select the folder in which the imported analysis 
should appear. If no folders appear, you must first create a new folder in 
the tree and then retry this option.

The Import IMPRINT Analysis dialog box displays.

Fire Support Self-propelled Howitzer M109A2 HOW

Fire Support Towed Howitzer M102 HOW

Mission Area System Type System Name
10
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2. Click the drop-down arrow to the right of the Files of Type box.

3. Select one of the following:
• IMPRINT Pro files
• IMPRINT Standard files
• IMPRINT 7 imports
• All IMPRINT files

4. Locate and select the desired analysis to import.

5. Click Open.

The newly added analysis appears in the tree, highlighted to indicate it is 
the currently selected analysis.

Generic Conversion Variable for IMPRINT 7 
imports in IMPRINT Pro
C# (the language used for code in IMPRINT PRO) is a strongly-typed 
language. All variables and returned values must be of a declared type (int, 
bool, string, float). When importing code from IMPRINT 7, it is not always 
possible to determine which type a code expression is meant to have. In 
those cases, in order to create legal C# code, the expression is assigned to 
GlobalConversionVariable, a special internal variable that can be 
converted to the actual type of the expression.

For example, the following code from IMPRINT 7:

1;

Could be imported into IMPRINT Pro as either:

return 1;          (an integer)

or:

return true; (a boolean value)

It is not clear which meaning was intended by the IMPRINT 7 modeler, so 
the import process would generate the following code:

GlobalConversionVariable = 1;

return GlobalConversionVariable;
11
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If (at run-time) the code were in a context that expected to have a true/false 
value, GlobalConversionVariable would return true; if an integer were 
required, it would return 1.

Note:
Removing and/or altering the GenericConversionVariable expression(s) 
added to your model by IMPRINT Pro may result in model runtime errors.

Opening Analyses

When you open an analysis, you are opening the data tables in your 
database which correspond to your analysis. This will allow you to modify 
and/or run the models in your analysis in IMPRINT Pro. All analyses 
immediately available for opening display in the folders in the Analysis 
Tree. Any analysis you wish to open which does not appear in the tree 
must first be imported. You can open any existing analysis in a few simple 
steps.

To open an analysis:

1. In the Analysis Tree, click the +  adjacent to the node of the folder 
containing the analysis you wish to open.

The folder expands, and a list of analyses display below, sorted by 
name.

2. Click once on any analysis to select and open it.

The analysis is now selected, and the contents of the analysis are 
loaded from the database. The name of the analysis displays in the 
main window and the Properties window. Its listing is highlighted in the 
tree.

3. To see the contents of the opened analysis, click the +  adjacent to the 
analysis name node.

A list of nodes containing analysis data appear below. Nodes include 
Warfighters, Missions, Equipment, User Stressors and Forces.
12
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Displaying Analysis Information

To display analysis information:

In the Analysis Tree, double-click the analysis name.
The analysis information tab appears in the main window.

This same information appears in the Properties window.

Saving Analyses

As you work on an analysis, save frequently—do not wait until you finish 
working. By saving the analysis frequently, you reduce the amount of work 
lost in the event of a power failure or other unforeseen problem.

To save an analysis:

Do one of the following:
• From the File menu, select Save. 
13
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• On the tool bar, click the Save button.
• Press the shortcut keys Ctrl+S.

IMPRINT Pro saves the model to the database, overwriting any existing 
model with the same name.

Closing Analyses

Having more than one analysis open at a time can be convenient when 
copying and pasting data from one analysis to another. As a consequence, 
however, having more than one analysis open at a time can use large 
amounts of memory, leading to a lag in system performance while running 
a model. To improve system performance, close any unnecessary 
analyses in the tree that you are no longer using to free up system 
memory. Closing is not necessary prior to saving or exporting analyses, 
nor is it necessary prior to closing the IMPRINT Pro application.

To close an analysis:

1. In the Analysis Tree, right-click the analysis you wish to close folder, 
and then select Close Analysis... from the shortcut menu that displays.

OR

Click the desired analysis in the tree once to select it. From the File 
menu, select the Close Current Analysis... option.

2. You may be prompted to save changes to your analysis prior to closing. 
At the prompt, choose Yes to save changes and close or No to discard 
changes and close. Cancelling out of this option cancels the process of 
closing your analysis.

The desired analysis closes.
14
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Closing All Analyses in a Folder

Similar to the Close Analysis option, the Close All Analyses in Folder 
option helps to close unnecessary analyses that you are no longer using 
which can lead to improved system performance when running models. 
When selecting this option, however, it should be noted that all currently 
open analyses in the folder you select are closed. You may be prompted to 
save each analysis before it closes. Closing is not necessary prior to 
saving or exporting analyses, nor is it necessary prior to closing the 
IMPRINT Pro application.

To close all analyses in a select folder:

1. In the Analysis Tree, right-click the folder whose entire contents you 
wish to close, and then select Close All Analyses in Folder option 
from the shortcut menu that displays.

2. You may be prompted to save changes to your analysis prior to closing. 
At the prompt, choose Yes to save changes and close or No to discard 
changes and close. Cancelling out of this option cancels the process of 
closing your analysis.

The desired folder and all the analyses it contains close.

Closing All Except Current Analysis

Similar to the Close Analysis option, the Close All Except Current 
Analysis option helps to close unnecessary analyses that you are no 
longer using which can lead to improved system performance when 
running models. When selecting this option, however, it should be noted 
that all currently open analyses in all folders of the analysis tree, with the 
exception of the currently-selected analysis in the tree, are closed. You 
may be prompted to save each analysis before it closes. Closing is not 
necessary prior to saving or exporting analyses, nor is it necessary prior to 
closing the IMPRINT Pro application.

To close all analyses except the current analysis:

1. In the Analysis Tree, select the analysis you wish to keep open by 
clicking it.
15
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2. From the File menu, select the Close All Except Current Analysis 
option.

3. You may be prompted to save changes to your analysis prior to closing. 
At the prompt, choose Yes to save changes and close or No to discard 
changes and close. Cancelling out of this option cancels the process of 
closing your analysis.

All analyses other than the currently-selected analysis close.

Copying Analyses

You can copy an analysis from one folder to another in the Analysis Tree.

To copy an analysis:

1. In the Analysis Tree, right-click the analysis you want to copy and select 
Copy Analysis.

2. Right-click the folder to which the analysis should be copied and select 
Paste Analysis from the menu that displays.

The analysis is copied to the folder with the same name and version 
number, incremented by one. For more information on folders see 
“Adding Folders to the Analysis Tree” on page 20.

Pasting Analyses

You can copy and paste an analysis from an existing folder to the new 
folder. 

To paste an analysis:

1. Select the analysis you want to paste in to another folder.

2. Right-click the analysis and select Copy Analysis or Cut Analysis 
from the menu that displays.

3. Right-click the folder to which you want to paste the analysis.
16
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4. From the shortcut menu that displays, select Paste Analysis.

The analysis is copied from the existing folder and pasted into the new 
folder. 

Deleting Analyses

The delete command will remove the analysis and all its associated data 
from the Analysis Tree, and consequently from the database. Once you 
have removed the analysis, you cannot undo it.

To delete an analysis:

1. Right-click the analysis you want to delete.

2. Select Delete Analysis from the menu that displays.

Cutting Analyses

When you cut an analysis, you remove the analysis from the folder it was in 
but not from the IMPRINT Pro database. It can then be added to another 
folder using the Paste command.

To cut an analysis:

1. Select the analysis to cut.

2. Right-click the analysis and select Cut Analysis from the menu that 
displays.

3. Right-click the folder to which the analysis should be pasted.

4. Select Paste Analysis.

The analysis is cut from the existing folder and pasted into the new 
folder. When you perform the Cut command on an analysis, the 
analysis will display in red until you paste it to a new location.
17
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Exporting Analyses

The process of exporting an analysis allows you to combine all data from 
that analysis (stored as numerous tables in a database on your system) 
and save it to a single file which may then be distributed to other systems 
running a compatible version of IMPRINT Pro. These systems must then 
import this file to add the analysis to their databases.

Exported analyses are also a convenient way to back up your data - in the 
event you must reinstall IMPRINT Pro, any analysis you saved as an 
export can immediately be brought back into your database by using the 
Import Analysis option.

To export an IMPRINT Pro analysis:

1. Right-click the analysis to export and select Export Analysis from the 
menu that displays.

The Export IMPRINT Pro Analysis dialog box displays.

2. At the top of the window, click the drop-down arrow to the right of the 
Save in box, and select the location where you want to export the 
analysis.
18
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3. The File Name box automatically lists the name of the analysis you 
have selected to export. By default the exported file will take on the 
same name as the analysis, making it easy to recognize your analysis 
for import later on. You may, however, modify the name as desired by 
typing in the new name in the File Name field. 

4. Click Save.

The analysis is saved as a single file to the specified location with the 
extension .pro.

Export All Analyses in a Folder

Similar to the Export Analysis option, the Export All Analyses in Folder 
option helps to export analyses from your database so that they may be 
shared with other systems having a compatible version of IMPRINT Pro. 
When selecting this option, however, it should be noted that all analyses in 
the folder you select are automatically exported to the location you specify, 
and you will not have the option to modify the names of your exported file 
as you do with the Export Analysis option.

To export all analyses in a select folder:

1. In the Analysis Tree, right-click the folder whose entire contents you 
wish to close, and then select Export All Analyses in Folder option 
from the shortcut menu that displays.

The Browse for Folder dialog appears.

2. Locate and select the folder to which you wish to save your exported 
analyses.

3. Click OK.

All analyses in the selected folder export as unique .pro files in the location 
specified.
19
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Adding Folders to the Analysis Tree

You can organize analyses much like you organize files into folders on your 
computer by adding folders to the Analysis Tree. By default, IMPRINT Pro 
includes a directory in the Analysis Tree under the Local Server folder 
called Analyses, under which you may save your analyses. You may, 
however, create new folders in the tree as desired. 

To add a folder to the Analysis Tree:

Do one of the following:
• From the File menu, select Add Analysis Folder.
• Right-click anywhere in the Analysis Tree, and select Add Analysis 

Folder.

A new folder is added to the Analysis Tree and automatically selected.

Renaming Folders in the Analysis Tree

To rename a folder in the Analysis Tree: 

1. Select the folder to rename in the Analysis Tree.

Information for this folder displays in the Properties window.

2. In the Folder Name box, enter the new folder name.

3. Click the mouse outside the folder name field.

The folder updates to the new name.
20
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Deleting Folders in the Analysis Tree

The Delete command removes the folder and all its contents from the 
Analysis Tree and the database. 

To delete a folder:

Do one of the following: 
• Right-click the folder you want to delete, and select Delete Folder 

from the menu that displays.
• Select the folder you want to delete, and click the Delete button on 

the keyboard. 

A dialog box displays, asking you to confirm deletion of this folder and 
all its contents. To confirm Delete, click the Ok button.

The folder is deleted from the Analysis Tree. All analyses previously 
contained by the folder are also deleted from the Analysis Tree and the 
database.
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IMPRINT Pro Window

IMPRINT Pro uses a modified form of the MDI (Multiple Document 
Interface) made available by Microsoft .NET Framework. MDI provides a 
parent container window that contains several other different window 
panes. This configuration allows you to reposition windows into logical 
working groups and to temporarily hide windows that you are not using. 
The IMPRINT Pro window is highly configurable, and changes to the 
configuration are saved when you save an analysis.

IMPRINT Pro Window Overview

The default configuration for the IMPRINT Pro window consists of a 
container window with a title bar, menu bar, tool bar, and status bar. Within 
this container, the following elements exist as separate window panes: 
Analysis Tree, Network Diagram, Properties, Palette, Windows, Variable 
Watches, Event Queue, Search, and Output.

You can move, resize, hide, and dock all of the windows. You may want to 
use different configurations during different stages of analysis 
development. You may save up to three customized layouts at any one 
time that you may switch at the click of a button. Customized layouts 
always save in their last-modified state until they are once again modified 
or reset to the default IMPRINT Pro configurations. 

The following illustration shows the components of the IMPRINT Pro 
window. Each of these components are described in greater detail in the 
remaining sections of this chapter.
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IMPRINT Pro Window Components

This section describes the window components in the main IMPRINT Pro 
window. For details on resizing, moving, hiding, and docking the windows, 
see “Manipulating Windows” on page 45.

Title Bar
The title bar displays at the very top of the IMPRINT Pro window. It 
contains the name and version of the currently open mission or scenario 
and the analysis to which it belongs.
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Menu Bar
The menu bar displays below the title bar at the top of the IMPRINT Pro 
window and contains the File, Edit, View, Reports, Tools, Utilities, and 
Help menus. After opening your mission, the expanded menu will display 
the additional options of Moderators and Execution.

File. The File menu includes basic commands such as Add 
Analysis Folder, Save Analysis, Save As, Print Diagram and 
Exit.

Edit. The Edit menu includes basic edit commands such as 
Copy, Copy Diagram as Image, Cut, Paste, Clear Output and 
Preferences.

View. The View menu contains commands to zoom the display, 
display different windows, and reset the screen layout.

Moderators. The Moderators menu includes commands for 
mapping workload or maintenance to taxons, setting 
performance moderators and reviewing the affects of those 
moderators on task times and accuracies.

Execution. The Execution menu includes commands for 
controlling execution, such as Begin, Step, and Halt and Abort 
Simulation. It also includes Check for Errors, an option to run a 
syntax check on your model, and several options for adjusting 
model execution settings (execution speed, number of runs, 
simulation speed and more).

Reports. The Reports menu includes many types of detailed 
reports that can be generated to display the results of your 
model.

Tools. The Tools menu includes commands to display the 
Accuracy Calculator, Micromodels, Syntax Helper, and Unit 
Conversions windows.

Utilities. The Utilities menu includes commands for enabling 
Display Trace, Network Animation and Update Comment 
Variables. Commands for controlling the network nodes in the 
diagram (Alignment, Snap to Grid) also appear in this menu. You 
may also view the entire model in an html format using the View 
Model as HTML option.

Help. The Help menu contains the commands About to display 
version information and Help to open online help.
25



IMPRINT Pro Basic Procedures
Tool Bar
The IMPRINT Pro Tool Bar displays below the menu bar and provides 
access to commonly used commands. When you move the pointer over 
each button, a tooltip displays the command and the associated shortcut 
key if available.

By default the Tool Bar is divided into four sections, split by small notches 
in the bottom of the Tool Bar:

The File System section includes buttons to open, save, and 
cut, copy and paste.

The Execution section includes buttons to use in mission 
simulation, such as checking for errors, starting, pausing, 
stepping, and halting mission execution, and controlling 
simulation speed in real time mode.

The Layout section includes buttons for Custom Layout 1, 
Custom Layout 2, and Custom Layout 3.

The Tools section contains the Accuracy Calculator and Unit 
Conversions tool. It also contains the Micromodels tool for 
accessing human performance models and Syntax Helper for 
accessing sample code formats which may be used in effects, 
macros and other code windows. 

Accuracy Calculator
The Accuracy Calculator dialog box lets you enter three of the four data 
elements that are needed to specify task accuracy (accuracy standard, 
accuracy mean, accuracy standard deviation, and probability of success), 
so that it can calculate and display the fourth data item. In addition, it will 
draw the normal distribution and show the area under the curve that is 
used to calculate the probability of success.

File System Execution Layout  Tools
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In IMPRINT Pro, the likelihood that a task will be performed accurately is 
determined by an estimated mean and standard deviation that work 
together with the accuracy measure (for example, “percent steps correct”). 
When the model runs, IMPRINT Pro pulls a number from a normal 
distribution created with the mean and standard deviation you enter. This is 
compared to the accuracy standard to determine whether the task 
succeeded or failed its accuracy on each occurrence. If the number pulled 
is higher than the accuracy standard and the accuracy measure 
determines that higher equates with more accurate (e.g., percent steps 
correct), then the task is considered a success.

For example, you might say that on the average when performing this task 
the operators get 90 percent of the steps correct, or for another tasks they 
are within 10 mils of the correct azimuth. Under the first option, you will also 
specify the standard deviation, which is a measure of the worst and best 
the task is likely to be performed. An easy rule of thumb for specifying the 
standard deviation is to compute the difference between the worst and best 
performance and divide it by 6. For example, if the worst performance is 
40% steps correct and the best is 100%, then an estimate for the standard 
deviation would be 10% (((100 - 40)/6) = 10).

We realize that it is often difficult for users to think of accuracy in these 
terms, and that it is often easier to think of it in terms of the probability of 
success. To accommodate this fact, we have provided a calculator that you 
can use to calculate the probability of success from the information you 
have entered. When you select the Accuracy Calculator, IMPRINT Pro 
uses your accuracy mean and accuracy standard deviation, as well as the 
accuracy standard to calculate the probability of success. This is actually 
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calculated using standard statistical procedures that compute the area 
under a Normal statistical curve. IMPRINT Pro is also careful to evaluate 
your accuracy measure to determine whether “bigger values” are better (for 
example, percent steps correct), or “smaller values” are better (for 
example, mils from desired). For more information, please refer to a 
statistics textbook.

We have also provided access the Accuracy Calculator dialog box that lets 
you enter three of the four data elements that are needed to specify 
accuracy (that is, accuracy standard, accuracy mean, accuracy standard 
deviation, and probability of success), and it will calculate and display the 
fourth data item. In addition, it will draw the normal distribution and show 
the area under the curve that is used to calculate the probability of 
success.

To use the Accuracy Calculator:

1. In the Network Diagram or the Analysis tree, select a task for which 
accuracy will be calculated.

Note:
By choosing a task first before opening the Accuracy Calculator window, the 
Accuracy Calculator window, once opened, will then automatically provide an 
option for applying your calculated value to this selected task.

2. From the Tools menu click Accuracy Calculator.

The Accuracy Calculator window appears.

3. Choose a description of measure from the Measure drop-down list 
which best describes accuracy for your task.

4. Click the radio button of the value you wish to calculate. Values include 
Accuracy Requirement, Probability of Success, Mean Accuracy and 
Standard Deviation.

5. Enter values in the remaining three fields.

6. Click the Calculate button next to the choice you selected.

Your calculated value appears in the adjacent field.

7. Click the Apply to Selected Task button if you wish to replace your 
task’s existing value with the newly calculated value.
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Micromodels
The Micromodels tool is included in IMPRINT Pro to help you access a set 
of micromodels of human performance that have been gathered from 
psychological research literature. Detailed Micromodels help construct an 
overall task time. These micromodels provide time estimates for 
performing basic activities, such as visual scanning, moving a hand from 
one position to another, or pushing a button. By stringing together basic 
activities, an overall task time (or mean task time) can be estimated.

Many of these micromodels are just constant values, for example the Eye 
Movement Time (target is in the field) micromodel which has an algorithm 
value of 0.1. Other micromodels include prompts for you to enter pertinent 
data, for example the Hand Movement micromodel, which requires 
entering a distance to target and target size. In either case the 
Micromodels window then calculates an adjustment to the existing mean 
task time which you can then choose to apply to your task.

When you choose a micromodel you will be prompted to enter any 
parameter information that is needed. The reference for each micromodel 
is included in the dialog box, so that you can refer to the literature if you 
have specific questions about the assumptions behind each micromodel. A 
list of all the micromodels and their references is provided in Appendix A of 
this User Guide.

To apply a Micromodel:

1. From the Tools menu click Micromodels.

The Micromodels window appears.

2. In the Micromodel Name field click the drop-down arrow to display a list 
of available micromodels. Click the desired micromodel to select it.

The micromodel name displays in the Micromodel Name field, and its 
algorithm and reference display in the fields below.

3. Enter the necessary parameters in the P1 - P4 fields if required by the 
selected micromodel.

4. Click the Calculate button.

The adjustment appears in the Calculated Adjustment box in the Task 
section of the dialog.
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5. Select the manner in which the adjustment should be applied to your 
current mean task time by clicking the radio button next to your choice. 
The Calculated Adjustment may be added to, subtracted from or 
replace the current mean task time. By default, the option None is 
selected. 

By clicking the radio button of your selection, the modified mean task 
time (as it would be if you applied this adjustment) appears in the 
Adjusted Mean Time field.

6. Click the Apply to Task button.
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Syntax Helper
The Syntax helper is an interactive tool that helps you see the acceptable 
syntax for any expressions you might enter in IMPRINT Pro. Use the 
syntax help if you are uncertain of the format of any expression. You can 
copy and paste the sample code from the helper into your beginning 
effects, ending effects or advanced mean time expressions and then 
modify the generic expressions to suit the needs of your model. Use the 
sample code for more guidance.
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A detailed description of syntax is available in IMPRINT Pro Syntax 
Reference Manual, Vol.3 of IMPRINT Pro User’s Guide.

To use the Syntax Helper:

1. From the Tools menu click Syntax Helper.

The Syntax Helper window appears.

2. In the list on the left, click the desired code example under the Loops 
section or the Conditional Statements section. For example, click the 
“Do” listing to see sample code for a do-while expression.

Sample code appears in the window on the right. You may copy and 
paste code from this window into any code window in IMPRINT Pro.

3. Replace all parts of your pasted code containing “<expression>” with 
code that achieves your goal.

Unit Conversions Calculator
The Unit Conversions tool is a calculator which converts a value in a 
particular unit of measure to its equivalent value in a different unit of 
measure.
32



Chapter 2: Understanding the IMPRINT Pro Window
To use the Unit Conversion tool:

1. From the Tools menu click Unit Conversions.

The Unit Conversions window appears.

2. Click the Time tab or Distance tab, depending on the type of units you 
wish to convert.

3. Enter the value to be converted in the Original Value field.

4. Select the desired “from” and “to” units by clicking the drop-down 
arrows in each field and selecting the desired units from the lists 
provided.

The Result field automatically updates with the converted value.

Windows
Select Windows from the View menu to display the windows described 
below.

Analysis Tree Window
The Analysis Tree View window displays a hierarchical list of the analyses, 
automatically sorted by name. Listed under each individual analysis are 
Warfighters, Missions, Equipment, and User Stressors. The last item in the 
tree is the Plugins node which lists all user-defined plugins that are 
currently recognized by IMPRINT Pro.

To expand a component in the Analysis Tree, click the + adjacent to the 
item. To collapse a component, click the  - adjacent to the item.
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Animator
The Animator window displays a two dimensional graphical depiction of the 
model as it executes. For an operational mission, the Animator window 
displays bar charts of workload by operator which continually update as the 
model runs. Information displayed includes Maximum Workload, Number 
of Active Tasks and Active Workload Strategy. For a maintenance model, 
the Animator window displays Queue Data, Combat Data, Shift Manning, 
Maintenance Summary, Reliability and Availability, Clock, and Day data. At 
the bottom of the animation a graphic of a tank shows the progress of the 
model along a Percent of Time Elapsed bar. 

Each time you begin a simulation, data from the previous run will clear and 
the simulation will begin to display new information. If you halt the model, a 
dialog will display that tells you no reports will be available. 

To view animation during a model run:

1. Display the Animator window by clicking the Animator icon in the 
Windows pane on the left-hand side of your IMPRINT Pro application. 

Alternatively, you can display this window or by choosing Animator 
from the Windows option under the View menu.

2. From the Execution menu, select the Settings option. In the dialog 
which appears, check the Animation On box.

3. From the Utilities menu, enable the Display Trace option. By choosing 
to display the full trace of the model execution in the Output window, 
the Animator window updates more frequently during the course of the 
model run. 
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4. Run the model.

The Animator window updates as the model runs.
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Animator Window for an Operational Mission
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To set simulation speed:

You can set the simulation speed one of the following ways:
• Click the Simulation Speed option under the Execution menu, and 

then check 25, 50, 100, 200, 400, or 800%.
• Click the clock icon on the toolbar, and then check 25, 50, 100, 200, 

400, or 800%.

To zoom the animation:

Zoom in or out one of the following ways:
• Select Diagram Zoom from the View menu, and then check a 

magnification level of 25, 50, 100, 200, 400, or 800%.
• Hold down the Ctrl key and move the wheel on the mouse.

Animator Window for a Maintenance Scenario
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To pan the animation:

Pan the animation one of the following ways:
• Hold the space bar down, and then move the mouse in the direction 

you want to pan. 
• Click the wheel on your mouse, and then move the mouse in the 

direction you want to pan.

Note:
Running the model with Animator on will slow down the model execution.

Event Queue Window
The Event Queue window displays the list of events as they occur during 
model execution. These include the execution of tasks and scheduled 
events. You create the scheduled events for the simulation. Scheduled 
events can be one-time events or they can repeat at regular intervals. The 
group, ID, tag, and time, and type of event displays.

Beginning effects are highlighted in navy, ending effects are in green, 
suspended beginning effects are in blue, and suspended ending effects 
are in lime. Evaluate queue is in fuchsia, leaving queue is in purple, and 
waiting without queue is in red. And finally, external events are in yellow 
and snapshots are in maroon.
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Network Diagram Window
The network diagram window displays the graphical depiction of the task 
network developed in a Mission model. Use this window to construct the 
network diagram and view the mission execution.

Output Window 
The Output window displays the trace of the execution which consists of 
any actions as they finish in the course of the model run. The clock times 
for beginning effects, ending effects, and scenario events are listed. 
Application errors, plugin loading errors, and the start and end of a 
simulation are also included. Any syntax errors are indicated and you can 
use them for debugging purposes. You can save the information in the 
Output window to a file or to the Windows clipboard and clear the 
information in the window before running a new simulation.
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Palette Window
The Palette displays the tools you use to 
construct the network diagram. These 
include tools for adding functions, 
scheduled functions, comments, groups, 
tasks, and goals. To add one of these items 
to the network diagram, click the item and 
drag it onto the network. You can then enter 
its defining parameters in the Properties 
window.

Windows Pane
The Windows pane contains a list of the windows 
that you can display in IMPRINT Pro and is 
intended to be a shortcut to quickly open a 
window. Windows include the Analysis Tree, 
Animator, Event Queue, Network Diagram, Output, 
Palette, Properties, Search, and Variable Watches.

In the default configuration, the Windows pane 
displays as a pane docked on the left side of the 
IMPRINT Pro window. 
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Properties Window
The Properties window displays the properties of the item selected in the 
network diagram, such as function, task, or goal. It also displays the 
properties of items that you select in the Analysis Tree such as variables, 
macros, external events, external model calls, snapshots and cultural 
events. The properties that display in the Properties window also display in 
the dialog box for the associated item.

The Properties window functions like any folder list. To expand an item, 
click the adjacent + sign. To collapse an item, click the adjacent - sign.

Some of the fields in the Properties window have an associated drop-down 
list box. To display the list box, click in the text box and a drop-down arrow 
displays. Click the arrow and a selection list appears. A detailed description 
of any selected item automatically displays at the bottom of the Properties 
window.

Variable Watches Window
The Variable Watches window displays the values of variables during 
mission execution. You select the variables that you want to display by 
creating a watch for the variable. The variable name, value, and type are 
displayed.
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Status Bar
The status bar displays at the bottom of the IMPRINT Pro window. Any 
execution-related messages, such as the clock time and the run number, 
display on the right side of the status bar. 

Window Configurations

IMPRINT Pro provides three customizable window configurations or views, 
Custom Layout 1, Custom Layout 2, and Custom Layout 3. These views 
default to the layouts described below.
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Custom Layout 1 displays the default configuration of the 
Windows, Analysis Tree, Network Diagram, Properties, and 
Output windows. Tabs at the bottom of the windows display 
including Palette, Variable Watches, Event Queue, and Search.

Custom Layout 2 displays the default configuration of the 
Network Diagram, Analysis Tree, and the Output window. Tabs 
at the bottom of the windows display including Palette, 
Properties, Variable Watches, Event Queue, and Search. The 
Analysis Tree displays to the right.
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Custom Layout 3 displays the Network Diagram, Analysis Tree, 
and Properties with tabs Output and Search. The Analysis Tree 
displays to the left.

The reset screen layout capability on the view menu enables you to return 
to these defaults at any time. For more information on how to move 
windows around, see “Manipulating Windows” on page 45.

To change the layout configuration from the View menu:

From the View menu, click Layout, and then select Custom Layout 1, 
Custom Layout 2, or Custom Layout 3 from the menu that displays.

A check mark displays adjacent to the Layout command you have 
selected. The windows reconfigure to the selected layout.

To change the layout configuration from the tool bar:

From the Toolbar, click the Custom Layout 1 button, Custom Layout 
2 button, or the Custom Layout 3 button.

The windows rearrange to the selected layout.
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Manipulating Windows

Any window in IMPRINT Pro that has a title bar is considered a Tool 
window, for example the Analysis Tree window. A tool window can be 
floating, docked, hidden, displayed in a vertical or horizontal tabbed format, 
and have an auto-hide property.

Floating Windows
When a window is floating, you can move it around as a separate window 
that floats on top of the other windows. You can move a floating window 
outside of the main IMPRINT Pro window. 

To float a window:

1. Click the arrow in the right corner of title of the window, such as 
Analysis Tree or Properties.

2. Click Floating on the menu so that a check mark appears adjacent to 
the Floating item.

The window appears as a separate window at the upper left corner of 
the screen.

Making Windows Dockable
When a window is dockable, you can move it with the mouse so that it 
snaps to the closest side of the IMPRINT Pro window. 

To make a window dockable:

1. Click the arrow in the right corner of title of the window, such as 
Analysis Tree or Properties.

2. Click Dockable on the menu so that a check mark displays adjacent to 
the dockable item.

Docking Windows
Once you set a window to be dockable, you can dock it to any of the sides 
of the main IMPRINT Pro window. 
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To dock a window:

1. Drag the window toward an edge of the IMPRINT Pro window until you 
see a superimposed outline in the location you want.

As you drag the outline of the dockable window, four orientation 
docking symbols appear, each at the outer edge of the IMPRINT Pro 
application window. By dragging the outlined window over one of these 
symbols, the window is docked along that edge of the application 
window.

A separate docking orientation key is also within the window over which 
the window outline is currently hovering. If you want to set your window 
down in any part of this location, simply drag your mouse to the edge of 
the symbol corresponding to the edge of the window where you want 
your window docked. Release the mouse button.

2. Release the mouse button.

When you dock a window over an existing window, both windows now 
exist in the same space, but you can only view one at a time. You can 
choose what window to view by clicking that window’s corresponding 
tab (located at the bottom of the window region.)
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Displaying Tab Groups
You can display tabbed windows adjacent to each other so that they can 
be viewed at the same time. 

To display a tab group:

1. Right-click the title of any of the tabs in the main window.

2. Do one of the following:
• To display the tab in a horizontal format, click New Horizontal Tab 

Group.
• To display the tab in a vertical format, click New Vertical Tab 

Group.

The windows rearrange to the selected format.
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3. Repeat the previous step for any of the other windows.

Hiding Windows
Hiding a window completely removes the window from the display and 
frees up more working space. Hiding a window is the same as closing the 
window.

To hide a window:

Click the arrow in the right corner of title of the window, such as 
Analysis Tree or Properties, and do one of the following:
• Right-click the title bar of the window and select Hide from the 

shortcut menu that appears. 
• Click the  in the upper right corner of the window.

The window is removed from the display. 

Redisplaying Hidden Windows
Once a window is hidden, you can redisplay it using the View menu.

To redisplay a hidden window:

1. From the View menu, select Windows.
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2. Click the window you want to redisplay.

The window redisplays in the last position it occupied. You can also 
redisplay a window using the Windows tab. For details, see “Windows” 
on page 33.

Auto-Hiding Windows
Auto-hide minimizes a window and places a tab with the window name on 
the closest edge of the IMPRINT Pro window. 

To enable Auto-Hide:

Do one of the following:
• Click the arrow in the right corner of title of the window, such as 

Analysis Tree or Properties and select Auto-Hide on the menu that 
displays.

• You can alternatively click the push pin icon on the title bar of the 
window. The icon points to the left when auto hide is enabled.

When you move the mouse and focus to another window, the window in 
auto-hide mode minimizes and a tab with its name displays on the edge 
of the IMPRINT Pro window. 
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Displaying Windows in Auto-Hide Mode
Windows in auto-hide mode display as a tab along the edge of the 
IMPRINT Pro main window with the name of the window.

To display a window in Auto-Hide mode:

Move the pointer over the window tab.

The window slides back into view and is ready for use. When you click 
the mouse off the window, the window loses focus and automatically 
slides back to the tab on the edge of the main window.

Disabling Auto-Hide Mode
Disabling auto-hide mode returns the window to its previous position.

To disable Auto-Hide mode:

1. Move the pointer over the tab for the window so that the window 
redisplays.

2. Right-mouse click the title bar of the window.
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3. Select any option on the menu other than Auto-Hide, for example 
Dockable.

The window now becomes a docked window, and the Auto-Hide 
property is disabled.

Alternatively you may click the push pin icon on the title bar of the 
window. The icon points in a downward direction when auto-hide is 
disabled.

Moving Windows
Any docked or floating window may be moved to a new location in the 
IMPRINT Pro container window.

To move any window:

1. Click and drag the title bar of the window to the new location while 
holding down the left mouse button.

2. Release the mouse button when the window is in the new location.

Resizing Windows
To resize any window:

1. Rest the pointer over the border of a window until the pointer changes 
to .

2. Then, drag the border by pressing the left mouse button, and move the 
border to the new location.

Changing the Active Window 
To make a window active, click anywhere in the window.

If the window is not currently displayed, do the following:

1. From the View menu, select the Windows. 

2. From the submenu that appears select the window you want to make 
active. You can alternatively select the window from the Windows pane.
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Closing Windows
To close a window:

Click the  in the upper right corner of the window or tab. You can 
alternatively right-click the title of the window and select Hide from the 
menu that displays.
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This chapter describes the elements of an IMPRINT Pro analysis, including 
Warfighters, Missions, Equipment, Custom Performance Moderators, 
Forces and Plugins.

Warfighters Module

The Warfighters module helps you estimate the type and number of people 
that will be required to operate and maintain the system for the manpower, 
personnel, and training (MPT) analysis.

In Warfighters, you can select Specialties that are required, probably from 
a predecessor system, to operate and maintain the new system. It then 
permits you to see a profile of these specialties for the current year with 
estimates on their personnel characteristics.

For details on defining Warfighters, see “Warfighter Data” on page 67.

Questions that can be Answered in 
Warfighter Module

What types of Warfighters (in terms of personnel characteristics 
such as mental aptitude, reading grade level, etc.) may be 
available to operate, maintain, and support a system?

What types of people are currently in a Specialty?

What percentage of the Warfighters in this Specialty are Test 
Score Category IV?

What is the expected reading grade level of the crew?

Are there major differences in the types of people in these 
Specialties?

What percentage of this Specialty are high school graduates?
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Elements of the Warfighters Module
The only element of the Warfighters module is the Warfighter. A warfighter 
is any person or automated device that operates, maintains, supplies or 
supports military equipment thus Warfighters are broken down into three 
categories: Operators, Maintainers and Supply and Support Personnel.

Mission Module

IMPRINT Pro allows you to analyze a new weapon system by helping you 
build models of each mission that the weapon system will be capable of 
accomplishing. Since it is typically easier to describe the mission by 
breaking it into smaller sub functions than trying to describe the mission as 
a whole, you build these models by breaking down the mission into a 
network of functions. Each of the functions is then further broken down into 
a network consisting of other functions and tasks.

Then, by executing the mission model simulation, you can study the range 
of results that occur in the mission. A description of the variability of each 
element can be obtained for further analysis.

The execution of a mission model begins at the level of individual tasks. 
Each task is assigned an estimated task time, either though a value or an 
expression. In addition, with each task, you estimate accuracy levels and 
assign workload values that reflect the amount of effort the Warfighter will 
have to expend to perform the task. During the simulation, IMPRINT Pro 
predicts task performance and calculates how much workload each 
Warfighter was experiencing throughout the mission. In this way, you 
determine whether the Warfighters were overloaded, and if so, how 
changes can be made to reduce the workload to an acceptable level.

At the completion of the simulation run, IMPRINT Pro compares the 
minimum acceptable mission performance time and accuracy to the 
predicted performance. This determines whether the mission met its 
performance requirements.

For details on defining a mission, see “Mission Analysis” on page 85.
54



Chapter 3: Overview of Analyses
Questions that can be Answered in the 
Mission Module

How many people do I need in order to perform a set of tasks 
within my time constraints?

How much visual, auditory, cognitive, motor and speech effort is 
involved in performing this process?

What is the amount of workload a Warfighter will experience 
throughout the mission?

Are any Warfighters overloaded?

Is the current task allocation strategy balanced?

How many people do I need in order to perform this process 
within my time constraints?

What impact will workload have on mission performance time 
and accuracy?

What impact will automation have on mission performance time 
and accuracy?

Was the minimum performance time and accuracy of the mission 
completed as predicted?

Were the performance requirements of the mission met?

Elements of the Mission Module
The central element of Missions module is the task network. The task 
network encompasses the following elements:

Warfighters who represent the operators performing the tasks in 
your model.

Tasks which represent the steps in the process or “mission” you 
are attempting to model.

Task Attributes that specify the parameters associated with each 
task, including warfighter assignment, time, accuracy, and 
workload.

Functions which contain sub-networks of tasks.
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Paths which connect the functions and tasks in your model so as 
to direct the flow of entities running through your model when it is 
executed.

Goals which represent events external to the network modeled 
but which can have an impact on your mission when they fire.

RI Pairs, or resources and interfaces used by each operator in 
the mission.

Macros that return values or perform procedures when they are 
called in tasks.

Variables you define to represent changeable system states or 
characteristics, with values that change as tasks begin and end 
or scenario events occur.

Snapshots that collect the values of particular variables when 
triggered by conditions that you specify.

External Events that you schedule to occur at specific clock 
times to change the values of variables.

Charts that display the values of selected variables at run-time.

Cultural Templates that allows for the creation of a template to 
define the cultural and country differences that might cause 
people to react differently in a situation.

Plugins that communicate with other applications.

These elements and their interrelationships are shown in the following 
diagram. The diagram does not show a logical flow of model execution, but 
illustrates the general relationships between the aspects of a model.
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Warfighters
Warfighters define a crew for your model. In an operational mission, 
Warfighters comprise Operators in your analysis who perform the tasks in 
your operations model. For each Warfighter you add, you can choose a 
specialty appropriate to the task the Warfighter will be assigned.

For each operator in the mission, you may additionally set a “default” flag to 
indicate that Warfighter’s role in the system as well as a workload threshold 
and workload management strategy to help model realistic operator 
actions under conditions of work overload. Lastly, you may designate the 
operator as an automated device if the task is to be performed by a 
machine.

Tasks
A task represents the most basic building block in the mission you are 
modeling.
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Task Attributes
Every task you add to your network can be defined by the following seven 
attributes:

Time and Accuracy - the length of time this task usually takes 
and the likelihood this task will fail.

Effects - the circumstances which must occur before, during and 
after the firing of this task. 

Failure - the consequences as a result of this task failing.

Crew - the operators who will be performing the task.

Taxons - the categorization used to describe the workload 
composition of your task in a way that can be understood by 
performance moderators.

Paths - the decision logic describing the conditions under which 
each of the individual paths leaving a task are taken.

Workload Demand - value(s) indicating the relative demand on 
an operator performing a task.

The execution time for each task varies within the parameters you supply 
(usually distribution type, mean time, and standard deviation). Additionally, 
as each task executes it can alter the state of the system with expressions 
called “effects.” Effects are executed either at the beginning or at the end of 
a task. For example, the beginning effect of a machine task might decrease 
the number of available machines by one while the ending effect would 
increase the number by one.

Each task can also check the state of the system before it executes and 
delay execution until a certain condition, called a release condition, is met. 
For example, assume you define a variable named Workers that tracks 
the number of available operators. If you have a task that requires an 
operator to perform it, the condition Workers > 0 must be true for the 
task to execute.

Functions
Functions are the primary organizing items of the mission network and 
represent groups (or networks) of tasks. Functions do not have 
performance estimates of their own. Rather, they only encapsulate tasks.
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Paths
After adding the functions and tasks to your network to describe the 
different steps in your model, you must add the paths between them to 
direct the flow of your model. When you execute a model, an entity starts at 
the task you designate as the starting point. The entity then travels along 
the paths(s), executing each task it encounters. When more than one path 
leaves a task, the decision on which path to take will be determined by the 
value set in the task’s decision node. Decision nodes are automatically 
added to a task by IMPRINT Pro and display in the network diagram as a 
diamond-shape on the end of a task node. Each contains a letter inside of 
it (S, T, P, or M) indicating the branching logic the entity should follow. 

IMPRINT Pro uses four different branching logic decision types: Single, 
Tactical, Probabilistic, or Multiple. Tasks with Single nodes indicate the 
entity flowing through has only a single path it can follow at that point in the 
network. Tasks with Multiple nodes cause an entity to split up into multiple 
entities so that all paths out of the task are followed; these entities must 
later rejoin. The paths that the entity follows can vary, however, if you 
include probabilistic or tactical routing decisions. In a probabilistic decision, 
you specify the probability of each following task, and IMPRINT Pro selects 
the path to follow randomly within these probabilities. In a tactical decision, 
you specify the system conditions under which each following path can be 
selected. You can define these conditions and probabilities using 
expressions, operators, and variables that represent the state of the 
system.

Goals
IMPRINT Pro allows you to model human performance in a goal-driven 
context. This capability allows you to specify individual goals, the tasks 
associated with these goals, the triggering conditions, and the interaction of 
goals with each other and with workload.

RI Pairs
IMPRINT Pro provides capabilities for you to predict and assess the 
workload involved in performing tasks. This capability is consistent with 
well-known and documented theories of workload prediction, including the 
Wickens Multiple Resource Theory (MRT). 1 

1. Wickens, C.D., Yeh, Y-Y, 1986, A Multiple Resource Model of Workload Prediction
and Assessment. In Proceedings of the IEEE Conference on Systems, Man, and Cy-
bernetics (Atlanta, Georgia).
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Seven default human resources are provided within IMPRINT Pro. They 
include Auditory, Cognitive, Fine Motor, Gross Motor, Speech, Tactile and 
Visual. You can add more resources to the list if you desire. Additionally, 
you can identify specific interface elements (that is, controls and displays) 
that the warfighters will interact with. If your system design is not yet 
mature enough for that level of detail, then you can accept the default 
interface named “Crewstation.”

Macros
IMPRINT Pro uses two types of macros: built-in macros, which are 
available to all missions, and custom macros, which you define for use 
within a particular mission. Both macro types work in a similar manner. You 
can include the macro’s name or call the macro in any expression. When 
IMPRINT Pro encounters the macro, it executes the algebraic and logical 
expressions in the macro and returns a value that can be used in the 
expression.

Built-in macros include the following categories:

Modeling macros, which perform actions such as starting or 
stopping tasks, and pausing or stopping model executions.

Mathematical macros, which perform mathematical operations, 
such as calculating the minimum, maximum, and trigonometric 
functions.

Distribution macros, which generate random numbers for task 
execution according to a certain distribution.

Custom macros are particularly useful for calculations or procedures 
that you want to execute at more than one place in a model.

Example: You might create a macro to calculate machine utilization 
and use it to calculate utilization for various machines.

When macros are called in IMPRINT Pro, they are followed by 
parentheses, for example CalculateTime( ). To return a value from a 
macro, the macro itself must be declared with a return value (for example, 
an integer).
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Variables
Variables are an important element in any mission because they keep track 
of the state of the system. Three system variables are automatically 
created for each IMPRINT Pro mission, and you can additionally define 
variables specific to each mission.

The variables you define can keep track of whatever is appropriate for the 
mission—how many items are processed, what the current temperature is, 
or whether a machine is On or Off. Variables give different tasks, queues, 
and scenario events a way to interact with each other because they can 
evaluate and modify variable values.

Default system variables include the following:

Clock records elapsed time (in simulation time units) since the 
beginning of model execution.

Distributions allow access to all the model distributions. 
Distributions are used to determine task execution times.

Entity includes all the entity variables.

Model is used to control model actions, such as halt and pause.

Task includes all property attached to each task in the network 
model.

Snapshots
Snapshots provide a way to collect values of variables at specified times 
during model execution. You can specify snapshots to be gathered at 
specific clock times (one-time or repeating), when a task begins or ends, 
when an entity enters or leaves a queue, or when a model run ends.

External Events
External events provide a way for you to cause events to occur at specific 
times during mission execution. These can be one-time events, or events 
that repeat at regular intervals. External events are often used to change 
variable values, thereby changing the state of the mission. For example, 
you might have a variable called temperature that would increase at 15-
minute intervals during the day and decrease during the night. You could 
then make the times required for tasks such as warming up an engine be 
contingent upon the current temperature.
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Charts
The Chart option allows you to display a plot of one mission variable 
against another. Since the value of your model’s variables is determined at 
run-time, the points representing these variables’ values are plotted on the 
chart at run time as the animation progresses.

Cultural Templates
In IMPRINT Pro, cultural modeling is defined as the application of cultural 
or country based influences on human behavior or performance within a 
human performance model. Given a situation with the same physical 
conditions and the same resources, people from different cultures or 
countries may react to the situation and apply their resources differently. A 
cultural difference exists when the average reaction of a population from 
one culture differs from that of another.

IMPRINT Pro allows users to create and save profiles, or templates, which 
define the relevant cultural parameters for each culture modeled and the 
values derived from cultural data that are assigned to those parameters. 
One or more templates can be defined by the user. At execution time, the 
user selects the template that is to be used.

The user selects the cultural parameters that are affected by a selected 
culture and assigns the appropriate values for those parameters based on 
the cultural data. IMPRINT Pro also allows the user to specify default 
values for each cultural parameter. The default value is used when cultural 
data for a parameter is not available.

Equipment Module

The Equipment module helps you estimate the maintenance manhours 
required to attain acceptable system availability.

This module lets you enter properties that control such items as the 
maintenance manpower pools, the spare availability, and the combat 
damage potential. These properties, coupled with a mission schedule and 
the data describing the maintenance actions that your system may need 
are combined in a stochastic maintenance simulation. 

For details on defining an Equipment analysis, see “Equipment Analysis” 
on page 343.
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Questions that can be answered in the 
Equipment Module

How many people of each specialty do I need in order to meet 
the system availability requirement?

Which pieces of equipment (such as subsystems) are the high 
drivers for maintenance?

How should each organizational level be staffed?

How sensitive is my maintenance manpower requirement to the 
failure rates of individual components?

Elements of the Equipment Module
Equipment elements include Subsystems and Scenarios.

Subsystem. You will break your equipment analysis down into 
subsystems. A major subsystem is typically something like an 
engine, landing gear, or main gun. Next, you decompose your 
subsystem into components. Components are the individual 
pieces of equipment that have repair tasks attached. You can 
enter or edit maintenance data for all repair tasks associated 
with the components.

Scenarios. A scenario is a configuration defining the set of 
conditions under which the components will be used. You can 
develop many scenario data sets for each system. For example, 
you might want to create one scenario for a thirty day run and 
another scenario that contains input parameters for a ten day 
run. When you have selected a scenario, you can add mission 
segment data for that scenario. You can add, duplicate, and 
delete scenarios.
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Custom Performance Moderators

IMPRINT Pro allows you to create custom performance equations that can 
be used to affect task time or accuracy. These moderators can be either 
custom stressors or custom training moderators. This is done by identifying 
the moderator and then entering algorithms that link levels of the 
moderator to performance impacts by taxon. This is a way to embed your 
own experimental findings into an IMPRINT Pro model. To create a custom 
moderator, simply expand the Custom Moderators node in the Analysis 
Tree, add or select a custom stressor or custom performance moderator, 
add the desired moderator level(s), and then create corresponding 
algorithms for those moderator levels.

For details on defining custom moderators, see “Custom Performance 
Moderators” on page 427.

Force Module

The objective of the Force Analysis module is to help predict the manpower 
needed to perform the routine and unplanned work done by a force unit. 
Similar to the Define Equipment module in IMPRINT Pro, the Force 
Analysis module operates using a stochastic model which relies on various 
inputs you provide. 

Questions answered by the Force Module
What is the elapsed time for my planned and unplanned 
activities?

What is the cumulative amount of time an activity was performed 
over the course of the entire model run?

What was the status of an unplanned activity during the model 
run?

How many unplanned activities failed because the minimum number of 
Leaders, Sub-Leaders and Members required for this unplanned activity 
could not be met?
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Elements of the Force Module
Force Analysis Data consists of the following items:

Force Units. A Force Unit is a group of individuals who perform 
activities according to a schedule.

Schedule. A Schedule is a pre-defined sequence of activities, 
planned and unplanned, over a specific amount of time.

Planned Activity. A planned activity is a routine task. Examples 
may include guard duty, hygiene, eating and sleeping.

Unplanned Activity. An unplanned activity is an activity which 
interrupts a normal schedule. Examples may include fire and 
emergency.

Activities Trump Matrix. The Activity Trump Matrix is used to 
set task priority within a schedule for when any two activities 
overlap.

Jobs. Jobs are general tasks, or occupations, which makes up a 
force unit. A job is defined by a name, specialty, rank and role. 
Examples may include Driver, Navigator and Analyst.

Plugins

IMPRINT Pro contains a powerful plugin interface that allows developers to 
extend the runtime functionality of the simulator. This API provides 
extensibility and flexibility that far exceed the External Model Call 
functionality of IMPRINT 7, yet is much easier to create, debug and use.

For details on creating a plugin, see “Using Plugins” on page 497.

Using plugins in a model is simply a matter of calling a method defined on a 
plugin object, passing to it those values desired, and using the result (if 
any). This can be done from any code window in the program: Effects, 
Release Conditions, or Expressions. Any public method defined in the 
plugin class will be available to all analyses in Imprint Pro. Any use of a 
plugin method will be checked for type compatibility by the Syntax 
Checker, so that modelers will know immediately if there are problems with 
their code.
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Use the Warfighters node to select and define a crew for your model. 
Warfighters comprise the Operators, Maintainers and the Supply and 
Support Personnel in your analysis. Operators perform the tasks in your 
operations model while maintainers and supply and support personnel 
maintain and supply/support the systems in your maintenance model. For 
each Warfighter you add, you can choose a specialty appropriate to the 
task the Warfighter will be assigned.

For each operator (operators only), you may additionally set a “default” flag 
to indicate that Warfighter’s role in the system as well as a workload 
threshold and workload management strategy to help model realistic 
operator actions under conditions of work overload. Lastly, you may 
designate the operator as an automated device if the task is to be 
performed by a machine.

Displaying Warfighters

To display warfighters in the Analysis Tree:

In the Analysis Tree, click the +  adjacent to Warfighters node.

The following items display in a list below the Warfighters node: 
• Operators. Only the Warfighters which are designated as Operators 

can perform tasks in the Mission model. On the Crew tab of the Task 
Information dialog box, operators can be designated as either 
Primary Operators or Contingency Operators. Only one Primary 
Operator is allowed per task. Operators are the only Warfighter type 
that may be assigned a name, workload strategy and an overload 
threshold.

• Maintainers. Warfighters which are designated as Maintainers can 
perform Repair Tasks. Whereas Operator Warfighters have a 
specific name independent of their Specialty, Maintainer Warfighters 
list in the tree only as the Specialty they represent (for example, 
27X).

• Supply and Support Personnel. Warfighters designated as Supply 
and Support personnel appear in the Specialty combo boxes located 
in the Fuel Supply and Ammo Supply tabs under a Scenario and are 
listed in the tree by the specialty they represent (for example, 27X).
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When you begin a new analysis, IMPRINT Pro provides you with one 
operator, one maintainer, and one supply and support personnel by 
default. 

Adding Warfighters

Click the + beside the Warfighter node to view the Operators, Maintainers 
and Supply & Support Personnel nodes.

To add a warfighter:

1. Do one of the following:
• Right-click the Operators node in the Analysis Tree.
• Right-click the Maintainers node in the Analysis Tree.
• Right-click the Supply and Support Personnel node in the Analysis 

Tree.

2. Then, do one of the following:
• Select New Operator from the menu that displays.
• Select New Maintainer from the menu that displays.
• Select New Supply & Support Personnel from the menu that 

displays.

A dialog box displays a list of specialties along with their corresponding 
description, status and the military branch to which they belong. By 
default, all active specialties are listed at the top while all inactive 
specialties (obsolete) are at the bottom. Within those two groups, 
specialties are then ordered by the three-character designation under 
the Specialty field. 

To sort the list of available specialties:

1. Click the column header to sort by.

The list of specialties reorders according to the column header 
category.

To reverse the sort order, click the same column header a second time. 
An up/down indicator displays on the column used for sorting and 
indicates the direction of the sort order. 
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2. In the name field at the top (Operators only), type in a name for the new 
Warfighter.

3. Click the Specialty and Description that most closely fits the attributes 
needed for the system.

4. Click OK.

The Operator, Maintainer or Supply and Support Personnel selected 
displays in the list below the corresponding node in the tree.

Note:
In the Add dialog, a column on the right-hand side of the window called 
“Obsolete” displays. All specialties in the Warfighter selection lists are flagged 
as obsolete (True) or not obsolete (False). An obsolete specialty is one which 
no longer exists in the Army. All obsolete specialties appear, by default, at the 
bottom of the list.
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Displaying Operators

To display a list of operators:

Do one of the following:
• Click the +  to the left of the Operators node to display a list of 

Operators under the node.
• In the Analysis Tree, double-click the Operators node to display a list 

Operators in the main window.

Operators list in alphabetical order. The properties of each operator list 
in the columns to the right. For more information on these properties 
see “Displaying Operator Properties” on page 71.

Note:
IMPRINT Pro requires that one operator in the list be designated as the 
default operator. This operator automatically appears in your list of operators 
any time you create a new mission; it automatically appears with “(default)” 
next to its name. If this operator is deleted, the next operator to have been 
created after the deleted one becomes the new default operator. 
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Displaying Operator Properties

Use the Operator properties window to change an operator’s name and/or 
specialty, to set its automation flag, to set its workload management 
strategy, and to indicate whether or not the operator can be designated as 
a crewmaintainer for the system.

Note:
Only Warfighters of type Operator have properties in addition to specialty and 
specialty description.

To display Operator properties:

Double-click the operator below the Operator node.

The properties for that operator display in the main window and the 
Properties window.

Warfighter properties for Operators include:
• Operator name. The name of the operator displays in this box. Click 

in this field to edit the operator’s name.
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• Automated. Click in the box and choose Yes to indicate if the 
operator is an automated device. Automated devices to not incur 
workload and therefore do not require Workload Strategy or 
Workload Threshold assignments. More and more functions are 
required to be automated - this does not necessarily make the path 
easier but is likely to change the nature of the path, the crew size, the 
task allocation, and the skills and abilities needed to follow the path. 

• Specialty. Click the drop-down arrow in this box to view a list of all 
available specialty types to choose from for the selected operator. If 
an operator’s Automated field is set to True, the specialty field is 
disabled.

• Default Strategy. Click the arrow in the Default Strategy box, and 
then select one of the six possible management strategies (A-F) from 
the list that drops down. Selections A, E, and F require that you enter 
a Time Penalty and Accuracy Penalty. See “Operator Workload 
Management Strategies” on page 74 for more information on 
Workload Management. 

• Time Penalty and Accuracy Penalty. IMPRINT Pro allows you to 
specify any time and accuracy penalties related to employing certain 
workload management strategies. You will be able to make entries 
for time and accuracy degradations to be applied to tasks that are 
reallocated during model execution. You will also be able to enter a 
time and accuracy degradation percentage to be applied when the 
operator attempts to perform all tasks regardless of the overload 
situation. The window displays any previously defined percentage of 
time and accuracy degradations for the appropriate workload 
management strategy. Position the mouse pointer in the field you 
want to edit and enter a value between 0 and 100 using the arrow, 
Delete, Backspace, and numeric keys.

• Threshold. Click in the Thresholds box and use numeric, arrow, 
backspace, and delete keys to enter/edit the threshold value. The 
workload threshold for each operator must be a number between 0 
and 100. It is assumed that beyond the threshold, the operator is 
overloaded. The overall threshold is defined in terms of the total 
momentary workload index or score. When workload rises above the 
threshold during the simulation, IMPRINT Pro selects and applies a 
workload management strategy. 

Note:
An operator whose total workload exceeds his/her workload threshold is not 
considered to be in overload if that operator is currently performing only one 
task.

Note:
Automation devices do not have workload thresholds.
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• Crew Maintainer. Check this box to indicate that this operator is 
allowed to perform maintenance actions himself/herself instead of 
waiting for the system to be taken to a shop. This option is only 
available in circumstances where the required maintenance action, 
or repair task, is a Remove and Replace task, and spares are set to 
100% available. This concept is basically identical to “crew chief” in 
IMPRINT 7 with the following exception: in IMPRINT Pro this 
specialty performing the task does not always have to be the crew 
chief but can instead be someone else on the team. When two or 
more operators are flagged as crew maintainers, the existing mean 
time to repair (MTTR) for a repair task can be reduced since more 
bodies are available to help perform the task. The new MTTR in this 
case is calculated as follows:

where the Existing MTTR is the amount of time in hours that the repair 
task normally requires, and where Specialty1 and Specialty2 are the 
specialties required to perform this repair task.

For example, a Remove and Replace repair task normally requiring 2 
hours time from a single 35R Avionic System Repairer flagged as a 
crew maintainer would be reduced to only one hour if an additional crew 
maintainer were available:

• Default (Operators List and Analysis Tree only).  The default 
operator is the operator to which all tasks are initially assigned until 
they are manually reassigned to other operators.  The word “default” 
appears next to the Operator in the Analysis Tree who acts as the 
default operator for that analysis.

Changing Operator Specialties

You can change specialties of your Warfighters in the Warfighter 
Properties dialog box.

MTTR Existing MTTR #Specialty1 #Specialty2+( )
Number of available Crew Maintainers( )

--------------------------------------------------------------------------------------------------×=

MTTR 2 hours 1 0+( )
2( )

-----------------× 1 hour==
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To change specialties for an operator:

1. Click the drop-down arrow next to the Specialty field.

The Specialty Directory, listing all Specialty types, opens.

2. Select a Specialty for the Warfighter that most closely fits the type of 
attributes needed for your system.

The Specialty list closes, and the new specialty appears in the Specialty 
box.

Operator Workload Management Strategies

Workload management strategies help you model realistic operator actions 
under conditions of work overload. Each operator must be assigned one 
default strategy to describe his or her actions under overload conditions.

During mission execution, if adding a new task causes the operator to 
surpass his workload threshold, the management strategies will be 
evaluated.
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Entering a Default Management Strategy
To enter a default strategy:

Click the drop-down arrow in the Default Strategy box, and then select 
one of the six possible management strategies (A-F). Management 
strategies include:

A. No effect, all tasks are performed regardless of overload.

B. Does not begin the new task. New task is not started by 
another operator.

C. Task are performed sequentially, beginning with the ongoing 
task and then the new task.

D. Ongoing task is interrupted, new task is started. Ongoing task 
is started in “windows of opportunity.” 

In the event the operator is already performing more than one 
task at the time that he or she is taking on a new task, IMPRINT 
Pro must determine which among the former tasks must be 
suspended in order that the new task may be taken on. To help 
determine which task in the group must be suspended, choose 
an option from the Criteron field. Criterion options include:

Highest Priority. The task with the highest priority is 
postponed. The priority value for a task is set in the Effects tab 
for that task. A task with a Priority setting of 1 has a higher 
priority than a task with a priority setting of 2.

Lowest Priority. The task with the lowest priority is postponed. 
The priority value for a task is set in the Effects tab for that task. 
A task with a Priority setting of 2 has a lower priority than a task 
with a priority setting of 1.

Highest Task Difficulty. A task involving a high amount of 
workload is defined as a difficult task thus the task with the 
highest total workload is determined to be the most difficult task 
and is therefore suspended. This total workload is determined 
by summing up all single task demand values assigned to this 
task across all channels and is exclusive of any conflict values. 
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Lowest Task Difficulty. A task involving a low amount of 
workload is defined as an easy task thus the task with the 
lowest total workload is determined to be the least difficult task 
and is therefore suspended. This total workload is determined 
by summing up all single task demand values assigned to this 
task across all channels and is exclusive of any conflict values. 

Most Recent. The task which starts most recently before the 
new task is introduced is the most recent task; it is this task 
which is suspended whenever the operator reaches an overload 
condition as a result of having taken on additional newer tasks. 
In the case of a multiple decision node where several tasks 
along various branches start at the same time, the most recent 
tasks is determined by the order in which the paths from the 
decision node were drawn - the task along the path last drawn is 
the most recent task.

Least Recent. The task which starts least recently before the 
new task is introduced is the least recent task; it is this task 
which is suspended whenever the operator reaches an overload 
condition as a result of having taken on additional newer tasks. 
In the case of a multiple decision node where several tasks 
along various branches start at the same time, the least recent 
tasks is determined by the order in which the paths from the 
decision node were drawn - the task along the path last drawn is 
the least recent task. This task is also known as the “Top of the 
List” task because the path leading to it from the decision node 
displays at the top of the paths list of that decision node.

The task which is suspended by the criterion set in the 
operator’s window will once again be resumed by that operator 
provided that doing so allows the operator to continue in a non-
overload situation.

E. Reallocate a task to the contingency operator.

In the event the operator is already performing more than one 
task at the time that he or she is taking on a new task, IMPRINT 
Pro must determine which among the group of tasks, including 
the former tasks and the new task, must be given to a 
contingency operator in order that the original operator can 
avoid an overload situation. To help determine which task in the 
group must be reallocated to the contingency operator, choose 
an option from the Criteron field. Criterion options include:

New Task. The most recent task presented to the operator is 
reallocated to the contingency operator.
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Highest Priority. The task with the highest priority is reallocated 
to the contingency operator. The priority value for a task is set in 
the Effects tab for that task. A task with a Priority setting of 1 
has a higher priority than a task with a priority setting of 2.

Lowest Priority. The task with the lowest priority is reallocated 
to the contingency operator. The priority value for a task is set in 
the Effects tab for that task. A task with a Priority setting of 2 
has a lower priority than a task with a priority setting of 1.

Highest Task Difficulty. A task involving a high amount of 
workload is defined as a difficult task thus the task with the 
highest total workload is determined to be the most difficult task 
and is therefore reallocated to the contingency operator. This 
total workload is determined by summing up all single task 
demand values assigned to this task across all channels and is 
exclusive of any conflict values. 

Lowest Task Difficulty. A task involving a low amount of 
workload is defined as an easy task thus the task with the 
lowest total workload is determined to be the least difficult task 
and is therefore reallocated to the contingency operator. This 
total workload is determined by summing up all single task 
demand values assigned to this task across all channels and is 
exclusive of any conflict values. 

Most Recently Added. The task which starts most recently 
before the new task is introduced is the most recent task; it is 
this task which is suspended whenever the operator reaches an 
overload condition as a result of having taken on additional 
newer tasks. In the case of a multiple decision node where 
several tasks along various branches start at the same time, the 
most recent tasks is determined by the order in which the paths 
from the decision node were drawn - the task along the path last 
drawn is the most recent task.

Least Recently Added. The task which starts least recently 
before the new task is introduced is the least recent task; it is 
this task which is suspended whenever the operator reaches an 
overload condition as a result of having taken on additional 
newer tasks. In the case of a multiple decision node where 
several tasks along various branches start at the same time, the 
least recent tasks is determined by the order in which the paths 
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from the decision node were drawn - the task along the path last 
drawn is the least recent task. This task is also known as the 
“Top of the List” task because the path leading to it from the 
decision node displays at the top of the paths list of that 
decision node.

Selections A and E require that you enter a Time Penalty and/or 
Accuracy Penalty. 

Note:
In the event an operator is assigned workload management strategy E but no 
contingency operator has been assigned, this operator’s strategy will 
automatically default to strategy C.

Displaying Maintainers

To display a list of maintainers:

Do one of the following:
• Click the +  adjacent to Maintainers node to display a list of 

maintainers below the node.
• Double-click the maintainer node to display Maintainer specialty.

A list of Maintainers for the analysis appears.

To display properties of an individual maintainer:

Double-click the desired specialty in the Analysis Tree below the 
Maintainer node.

The tabbed window corresponding to that Specialty appears. 
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In this window the three-character designation and description for that 
maintainer displays, for example, 00A M1 ABRAMS Tank Turret 
Mechanic. The Properties window also updates to display this same 
information.

Changing Maintainer Specialties

To change specialties for a maintainer:

1. Delete the current maintainer from the list.

2. Add a new maintainer to the list. Upon adding the new maintainer you 
may choose the new specialty from the list provided.

Displaying Supply and Support Personnel

To display a list of supply & support personnel: 

Do one of the following:
• Click the + adjacent to Supply and Support Personnel node to 

display a list of supply and support specialties below the node.
• Double-click the supply and Support node to display a list of supply 

and support specialties in the main window.Specialties display in the 
main window and in the Properties window.

A list of Supply & Support personnel for the analysis appears.
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To display properties of individual supply & support personnel:

Double-click the desired specialty in the Analysis Tree below the Supply 
& Support Personnel node.

The tabbed window corresponding to that Specialty appears.

In this window the three-character designation and description for that 
specialty displays, for example, 92Y Unit Supply Specialist. The 
Properties window also updates to display this same information.

Changing Supply and Support Personnel 
Specialties

To change specialties for supply and support personnel:

1. Delete the current supply and support Warfighter from the list.

2. Add a new Warfighter to the list. Upon adding the new Warfighter you 
may choose the new specialty from the list provided.

Deleting Warfighters

To delete a warfighter:

1. In the Analysis Tree, right-click the warfighter below the Operator, 
Maintainers, or Supply and Support Personnel node.

2. Do one of the following:
• Select Delete Operator from the menu that displays.
• Select Delete Maintainer from the menu that displays.
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• Select Delete Supply and Support Personnel from the menu that 
displays.

The Warfighter is deleted along with all associated data for that 
warfighter.

Cutting Warfighters

The Cut command allows you to move a Warfighter from one analysis to 
another. However, IMPRINT Pro allows you to cut Operators only. You 
cannot cut a Maintainer or any of the Supply and Support Personnel.

To cut an operator:

1. In the Analysis Tree, right-click, the operator (for example, Gunner) 
below the Operator node.

2. Select Cut Operator from the menu which displays.

The cut operator highlights in red and is copied to the Windows 
clipboard along with all its associated data. Once an operator is cut, you 
can paste the operator to a new analysis using the Paste command.

Copying Warfighters

The Copy command allows you to copy a Warfighter from one analysis to 
another. However, IMPRINT Pro allows you to copy Operators only. You 
cannot copy a Maintainer or any of the Supply and Support Personnel.

To copy an Operator:

1. In the Analysis Tree, right-click the desired operator (for example, 
Loader) below the Operator node.

2. Select Copy Operator from the menu which displays.

The operator copies to the Windows clipboard and may be pasted into 
other analyses.
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Pasting Warfighters

The Paste command allows you to paste a Warfighter from one analysis 
into another. However, IMPRINT Pro allows you to paste Operators only. 
You cannot paste a Maintainer or any of the Supply and Support 
Personnel.

To paste an operator:

1. Cut or Copy an Operator.

2. In the Analysis Tree, click the + beside the Warfighters node in another 
analysis. Then right-click the Operator node.

3. Select Paste Operator from the menu which displays.

The Operator pastes to the analysis along with all associated data for 
that Operator.
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IMPRINT Pro allows you to analyze a new weapon system by helping you 
build models of each mission that the weapon system will be capable of 
accomplishing. Since it is easier to describe the mission by breaking it into 
smaller sub functions than trying to describe the mission as a whole, you 
build these models by breaking down the mission into a network of 
functions. Each of the functions is then further broken down into a network 
consisting of other functions and tasks. Then, by executing the mission 
simulation, you can study the range of results that occur in the mission. A 
description of the variability of each element can be obtained for further 
analysis.

Mission Analysis is divided into subchapters describing:

How to create a network diagram

Properties for mission components 

Creating missions using an external template

Settings that control mission execution 

Methods used to report the mission data

Subchapter 5.1 Mission Network Diagram

The graphical display of an IMPRINT Pro mission shows the functions, 
tasks, goals, comments, decision nodes, and paths connecting these 
items. Once you have analyzed the modeling process, drawing the network 
diagram in IMPRINT Pro is relatively easy. Using the tools on the Palette, 
you can place the functions, tasks, goals and comments onto the network 
diagram and then draw the paths to connect them. You can then define the 
properties for each task, goal and function individually. Once you have 
finished setting up your network diagram, you can run your model and 
watch the nodes representing your tasks in the network diagram highlight 
as the tasks fire.
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Creating a Network Diagram
To create a network diagram:

1. If the network diagram window does not currently display, click Window 
from the View menu, and then click Network Diagram.

Alternatively you can click the Network Diagram icon in the Windows 
pane.

The network diagram displays. If the network diagram corresponds to a 
new mission you have just created, the network will contain only a Start 
node and an End node by default.

2. Display the Palette by clicking the Palette tab.

3. Add the network objects to your diagram by dragging the objects from 
the palette over to the network diagram. Network objects include 
functions, tasks, goals, and comments.
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4. Draw the paths connecting the objects.

For details, see “Adding Network Objects” on page 88 and “Drawing 
Paths” on page 94.

5. Open the network object to display the description dialog box and 
Properties window.
• Open task or comment. To open task or comment dialogs, double-

click the task or comment object on the Network Diagram or Analysis 
Tree. An informational tab corresponding to the task or comment 
appears in the main window.

• Open functions or goals. To open a function or goal description 
dialog, double-click the function or goal node in the Analysis Tree. 
Double-clicking the function or goal object on the network diagram 
will open a subnetwork.

6. In the fields provided, enter the defining properties.

Properties are described in “Mission Components” on page 115.

Working with Network Objects
Network objects include the functions, scheduled functions, tasks, goals, 
comments and workload monitors available on the tool palette. For detailed 
descriptions of these objects, see “Mission Components” on page 115.
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Adding Network Objects
You can add objects to the network through the Palette or directly through 
the Network Diagram.

To add a network object using the Palette:

1. Open the Palette window.

2. Select the object you want to add.

When you select an object, a green box displays around the object.

3. Drag the object to the Network Diagram.

The object displays on the Network Diagram. The Analysis Tree also 
updates to display these new objects.

Note:
The Palette is unavailable for adding new network objects if a mission is not 
selected or if the Function Scheduler window is displayed.

To add a network object directly in the network diagram:

1. Right-click the network diagram.

2. From the shortcut menu which appears, select the Add Node... option.

3. Select one of the following options from the submenu which displays:
• Add Function
• Add Scheduled Function
• Add Task
• Add Goal
• Add Comment
• Add Workload Monitor
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The object displays on the network diagram.

Opening a Network Object
Open the object to enter defining properties.
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To open a network object from the Analysis Tree:

Double-click a node in the tree.

A new tabbed window appears for that node, displaying several fields 
where you can enter data for that item. Also, the Properties window 
updates to display these same fields for this item where this same 
information may be edited as desired. 

To open a network object from the network diagram:

Double-click a node in the network diagram.

A new tabbed window will appear for that task or comment, displaying 
several fields where you can enter data. Also, the Properties window 
updates to display these same fields for this node where this 
information may be edited as desired. 

Unlike tasks or comments, however, double-clicking on a function or 
goal node in the network diagram does not open up a tabbed window 
with fields; instead it opens up a new tab displaying the subnetwork of 
nodes this function or goal represents. The properties for this function 
or goal, however, continue to display in the Properties window and can 
be edited as desired.

Double-clicking a scheduled function opens the Function Scheduler 
window. This window displays all nodes contained by the scheduled 
function as bars along a Gantt Chart. Start times, end times and 
durations may be adjusted directly in the Function Scheduler display. 
Alternatively, These same properties also display in the Properties 
window where they can be edited as desired.

Network Object Identification
All tasks added to the network diagram are tagged with a unique ID to 
distinguish them from other objects in the network. This ID appears just 
before the task names in the nodes on the network diagram and also in the 
ID field in the Properties window when an object is selected. In the case 
where the ID appears as multiple numbers separated by underscores, the 
first number represents the node at the highest level of the network which 
contains the object. Each subsequent number represents the nth element 
(function) in the next level down in the network whose subnetwork further 
contains the object. The final number in the series before the task name 
shows the object as being the nth element added to the final level down in 
the network.
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In the first example below, a total of four nodes have been added to the 
network in the following order: 1 Function, 2Function1, 3Task and 
4Function2. The first number in each node reflects this order. Because 
there is only one number before the task name, it is understood that these 
nodes belong to the root level of the network diagram.

By double-clicking on 4Function2, we enter the second level of the network 
diagram.This is evident by the fact that all node IDs in this level contain two 
numbers in series.

By default, a Start and End node appear in the subnetwork, each prefixed 
in this case with a “4” to indicate they are contained by the function in the 
level above having an nth element ID of “4”.

In this level we add four more nodes:
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All new nodes begin with the number “4” to indicate they are also part of 
the sub-network owned by the fourth element (function) in the level above. 
In addition, each node also has a second number separated by an 
underscore to indicate it is at the second level in the network diagram, and 
even more specifically the nth element added to the subnetwork. In the 
example above, the highlighted node is the third element added into the 
subnetwork of the fourth element (function) in the level above.

By double-clicking this function we dive down one level deeper into the 
network diagram. Adding a function to this level results in the function’s ID 
being 4_3_1. This indicates it is the first element in the subnetwork of the 
third element (function) in the level above, which in turn belongs to the 
fourth element (function) at the root level of the network diagram.

The final number appearing after the task name indicates the nth node 
added to the mission as a whole. This number increments by 1 each time a 
new object (function, task or goal) is added anywhere in the mission. Any 
time an object is deleted and a new one is added to replace it, the nth 
element number of the new object will still be unique.

By deleting the original function above and adding a new one, we see that 
the new function’s final number, in this case “7” is one greater than the 
previous function’s number. The ID numbers belonging to deleted objects 
are not reused for newly added objects.
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Deleting Network Objects
You can delete any of the network objects. If you delete a function or a 
task, the associated paths are automatically deleted.

To delete a network object:

1. Click the object you want to delete.

A green box displays around the object.

2. Do one of the following:
• Press the Delete key on the keyboard.
• Right-click the mouse, and then click Delete from the menu that 

displays.

Moving Network Objects
You can move any of the network objects on the network diagram. Any 
associated paths automatically move and adjust to the new location.

To move a network object:

1. Click the object once with the left mouse button.

A box displays around the object to show it is selected.

2. Click the object again, and while pressing the left mouse button, move 
the object to the new location.
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Drawing Paths
Paths connect functions and tasks on the network diagram. Paths control 
the flow of execution during the simulation.

To draw a path:

1. Do one of the following:
• For a function, move the pointer over the right-most edge of the 

network object that is the start point for the path. The pointer 
changes to a hand.

• For a task, move the pointer over the decision icon for the task that is 
the start point for the path. The decision icon is shaped like a 
diamond and displays on the right side of the task icon.

2. Left-click the mouse, and while pressing the mouse button, draw the 
path to the destination task or function.

3. Release the mouse button.

The path displays, highlighted in green and marked with an arrow at the 
endpoint to show the path direction.

Displaying Path Logic
You can display the dialog box that describes the logic or code for a path. 
Path logic is contained in a task’s Paths Tab. For additional details, see 
“Task Information Dialog Box – Paths Tab” on page 157.

To display path logic:

1. Double-click the task node to display the Task Information screen.

2. Click the Paths tab.

The Paths Description dialog box for the path opens and displays the 
path logic in a code window. For each additional path leaving the task, 
an additional code window displays below. Code windows appear in the 
order in which their respective paths were created. 
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Removing Paths
To remove a path:

1. Click the path with the left mouse button.

Small green squares and diamonds display on the path. Squares 
outline each path segment, and diamonds display at the beginning and 
end of the path.

2. Press the Delete key on the keyboard.

The path is removed.

Alternatively, click the path using your right-mouse button, and then 
choose Delete Network Path from the menu that displays.

Zooming the Network Diagram
Using the zoom feature of IMPRINT Pro, you can view a specific part of the 
diagram in detail or broaden the diagram view.

To zoom the network diagram:

From the View menu, click Diagram Zoom, and then select the 
magnification level. Magnification levels vary from 25% to 800%.

The network diagram redisplays at the magnification level you selected.

Alternatively, if your mouse has a wheel, the network diagram may be 
zoomed by rolling the mouse up or down while holding down the Ctrl 
key at the same time.

Panning the Network Diagram
You can pan the network diagram to display areas that are not currently in 
view. When panning, you can move the mouse in all directions.

To pan the network diagram:

1. Press the space bar.

The pointer changes to this shape: 
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2. Move the mouse in the desired direction.

3. When you reach the section of the network diagram you want to view, 
release the space bar.

Alternative options for panning:
• Pan the display by dragging the blue view box in the bottom pane of 

the Palette window over the desired region of the network diagram. 
• Pan the display by using the scroll bars in the Network Diagram 

window.
• If your mouse has a wheel, the network diagram may be panned also 

by rolling the mouse up or down while holding down the Shift key at 
the same time.

Changing Network Levels
To move down a network level:

On the Network diagram, double-click a function.

A new task network window opens displaying the network of tasks. 

If you choose to instead move down a network level in a scheduled 
function, the Function Scheduler window appears instead of a task 
network. The Function Scheduler window displays all subnodes (tasks, 
functions and scheduled functions) as bars along a Gantt chart. In the 
Function Scheduler window, you can continue moving down 
subsequent network levels within that particular scheduled function by 
double-clicking a bar which corresponds to the desired node whose 
network detail you wish to view - a new Function Scheduler window for 
that node displays.

To move up a network level:

At the top of the Network Diagram window, click the tab corresponding 
to the desired function level.

The network corresponding to this function level displays.

Note:
If the tab for the desired function level does not appear at the top of the 
Network Diagram window, go back to the main Network Diagram window, 
navigate through the network until the desired function is reached, and then 
double-click the function; the network corresponding to this function level 
displays 
96



Chapter 5: Mission Analysis
Editing Text and Objects
With IMPRINT Pro tools you can select text or a network diagram object, 
such as a function, task, path, or comment. Once selected, you can copy, 
cut, delete, and paste text and objects.

Selecting Text or Objects
Before you can edit text or objects, you must first select them. The 
selection of an item depends on whether the item is a text string or an 
object on the network diagram.

To select a text string:

1. Open the Description dialog box or Properties window for the network 
diagram object containing the text string to be selected. 

2. Do one of the following:
• To select a string of text, click with the mouse and drag the mouse 

through the text.
• To select a word, double-click the word.

To select an object in the network diagram:

Click the item once with the left mouse button.

A box displays around the object to show it is selected. Paths leading 
out of the object are highlighted in red, and paths leading into the object 
are highlighted in blue. When you select a path, small triangles display 
at the beginning and endpoints of the paths; small squares display 
outlining each path segment.

To select multiple items on the network diagram, do one of the 
following:

• Click and drag the mouse to create a box around the items. 
• Press the Shift or Ctrl key while clicking the items with the mouse.

Upon releasing the mouse button, selected items appear highlighted in 
the network diagram.

Note:
Items selected with the box method (first method listed above) appear 
selected only if the entire object is contained within that box.
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Copying Text and Objects
The Copy command copies the selected text or object to the Windows 
clipboard. Copying an object copies all of the object’s properties. Once the 
text or object is on the clipboard, you can use the Paste command to insert 
it elsewhere in the model or into another application see “Pasting Text and 
Objects” on page 99.

To copy text: 

Select the text to copy, then do one of the following:
• Right-click the selected text, and then click Copy from the menu that 

displays. 
• From the Edit menu, click Copy.
• On the tool bar, click the Copy button.

The text is copied to the clipboard.

To copy an object:

Select the object to copy, and do one of the following:
• Right-click the selected object(s) and select Copy from the menu 

that displays.
• From the Edit menu, select Copy. 
• On the tool bar, click the Copy button.

The object(s) are copied to the clipboard.

Cutting Text and Objects
You can cut text and objects using the Cut command. Cutting places the 
text or object on the clipboard where it may then be pasted elsewhere in 
the analysis or in another application. Once the item is pasted, it is 
removed from its original location.

To cut text or an object:

Select the text or object to cut, and then do one of the following:
• Right-click the selected text or object, and then select Cut from the 

menu that displays. 
• From the Edit menu, select Cut. 
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• On the tool bar, click the Cut button.

The cut item is copied to the clipboard. You can now paste this item 
elsewhere in IMPRINT Pro or in another application.

Deleting Text and Objects
You can delete selected text and objects without placing them on the 
clipboard by using the Delete function. This method is especially useful for 
deleting something that you do not plan to reuse, especially if the clipboard 
currently contains an item that you do not want to lose.

To delete text or an object:

Select the text or object you want to delete, and then do one of the 
following:
• Press the Delete key on the keyboard. 
• Right-click the node and select Delete from the menu that displays.

The text or object is deleted.

Pasting Text and Objects
Items cut or copied to the clipboard can be pasted elsewhere in 
IMPRINT Pro using the Paste command. If the clipboard is empty, or if the 
current clipboard item is not in a format appropriate for the current location, 
the Paste command appears grayed out so that you cannot select it. You 
cannot use the Paste command to replace a network that is currently 
displayed or any network above it.

To paste text or an object:

1. After copying the text or object you want to paste, do one of the 
following:
• Right-click to paste text or objects. 

Text. Right-click in the area you want to paste the text to, and then 
select Paste from the menu that displays. 

Objects. Right-click anywhere in the network diagram, and then 
select Paste node(s) from the menu that displays. The pasted text 
or object displays. 

• From the Edit menu, click Paste. 
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• On the tool bar, click the Paste button. 

For objects on the network diagram, the pasted object is on top of the 
copied object. IMPRINT Pro automatically assigns a new ID to the item. 
The name is similar to the copied item, but is incremented. For 
example, you could have My Task as the original task, and then My 
Task 1 as the pasted copy.

2. For objects on the network diagram, select the pasted object and use 
the mouse to move it to the new location.

Pasting Objects to Mission Model or Analysis
IMPRINT Pro provides a Task Data Mapping Wizard to help you copy a 
task from one mission (or analysis) to another. By default, every task in the 
network is associated with at least one Warfighter. During the copy and 
paste process, however, you may be attempting to copy or move a task 
using Warfighter X to a different mission (or analysis) where the only 
available Warfighters are Warfighter Y and Warfighter Z. The Task Data 
Mapping Wizard leads you through a few steps to transition the copied task 
into the new environment, prompting you to reassign your task to one of 
these alternate Warfighters or specifically to the default Warfighter for your 
destination analysis.

Also, if the task you choose to paste also has Workload Demand values 
attached to it, you will be prompted to map these demand values in the 
destination analysis, as well.

To paste a network object to another mission or analysis:

1. Right-click the network object you want to copy, and then select Copy 
from the menu that displays.

2. Right-click the mission or analysis to which you want to paste the 
network object to, and then select Paste node(s) from the menu that 
displays.

The Task Data Mapping Wizard will open.

Note:
MPRINT Pro does not use the Task Data Mapping Wizard to paste 
Comments.
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Mapping Warfighters

When the Task Data Mapping Wizard opens, you are given two options:

Set Primary Warfighter to Default. Select this option to force 
the copied task to accept, as its Primary Warfighter, the default 
Warfighter of the analysis or mission to which it is being copied. 
By default the Primary Warfighter for any analysis or mission is 
the initial Warfighter that IMPRINT Pro automatically adds 
whenever a new analysis is created. If this default Warfighter is 
deleted, IMPRINT Pro will assume a new default Warfighter from 
your list of available Warfighters.

Copy Primary and any Contingency Warfighters. Select this 
option to allow IMPRINT Pro to map the Primary and 
Contingency Warfighters of your copied task to specific 
Warfighters available in the destination analysis or mission. If 
you choose this option, follow these steps:

1.Choose a Warfighter from the Source Warfighters list.

2.In the field to the right under Mapped Warfighters, click the 
field to reveal the drop-down arrow.

3.Click the arrow to display a list of Warfighters available in the 
destination analysis.
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4.Select a new Warfighter.

The Next button is enabled.

5.Lastly, you will be reminded that you should check all mean 
times, effects, release conditions,.etc. for the task you have 
just copied to verify they are still valid. Some values may 
have been reset to the default values during the copy 
process.

Mapping Workload Demand Values

In the event the task you choose to paste also has a Workload Demand 
attached to one or more of the resource-interface pairs from the source 
analysis, a second page in the Task Data Mapping Wizard displays, 
helping you to map these demand values to new RI pairs in your 
destination analysis. In your source analysis, these demand values were 
originally set through the Workload Demand tab in the main Task 
Information screen. 

The wizard displays the following two options:

Do not copy Workload Demand values. Choosing this option 
drops the Workload Demand values associated with the pasted 
task.
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Copy Workload Demand Values using the following 
mapping for RI Pairs. Choosing this option carries the 
Workload Demand values set in the source analysis to the 
destination analysis, prompting you to first remap the resource-
interface pairs with which they should be associated.

This page displays all resource-interface pairs in both the source and 
destination analyses.

Copying the Network Diagram as an Image
You can copy the viewable portion of the network diagram, as an image, to 
the Windows clipboard. This image may then be pasted into an image 
editing application. Only the graphical depiction of the network is copied. 
You cannot paste the diagram into IMPRINT Pro.

To copy a network diagram:

1. Open the mission to copy.

2. Right-click in the network diagram. and select Copy Diagram as Image 
from the menu that displays. Alternatively, you may select Copy 
Diagram as Image from the Edit menu.

An image of the viewable portion of the network diagram is copied to 
the clipboard. You can now paste the contents into an image editing 
application.

Printing the Network Diagram
The Network Diagram and portions of it may be printed by using the Print 
Diagram option. Before printing the network diagram, IMPRINT Pro 
displays a preview of how the network diagram will appear when printed. 
From this window, you control the zoom factor, the number of pages that 
are viewed, and can add header information.

To print the network diagram:

1. Select the mission whose network diagram you wish to print.

2. Do one of the following:
• Right-click inside the network diagram window, and select Print... 

from the menu which appears.
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• From the File menu select Print...

The Network Print dialog box appears.

3. Select the desired print option. The Print Diagram option allows you to 
print the network diagram in three different ways:
• Entire Network. Print the entire network diagram (this may require 

several printed pages depending on the size of the selected 
network.)

• Selected. Print only the currently-selected nodes and paths from the 
network diagram.

• Visible. Print only the portion of the network diagram currently visible 
in the Network Diagram window.

The Print Preview window displays.

4. Do any of the following:
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• To zoom the view, click the down arrow adjacent to the magnifying 
glass icon and select the zoom level.

• To view more than one page at a time when the network diagram 
extends over more than one page, click of the buttons to the right of 
the Magnifying glass: one, two, three, four, or six pages.

• To add a header to the network diagram, click the Page Setup 
button and type the header information. The header information 
prints on each page.

• To change the size that the diagram is printed, click the Page Setup 
button, and then select the size from the Zoom list box.

• To close the Print Preview window, click the Close button.

5. When you are ready to print the network diagram, click the Print button 
on the Print Preview window.

Users with Adobe Acrobat installed on their systems may print to PDF 
using the instructions below, provided this option displays in the list of 
available printers (see the Printers option under the Page Setup window.)

Printing the Network Diagram to a PDF File
To print the Network Diagram to a PDF file:

1. Select the network diagram you wish to print.

2. Do one of the following:
• Right-click inside the network diagram window, and select Print 

Network Diagram from the menu that appears.
• From the File menu select Print Diagram.

3. Select the desired print option: Print Network, Print Selected or Print 
Visible.

The Print Preview window appears.

4. Click the Page Setup button.

5. In the lower right-hand corder of the Page Setup window, click the 
Printer button.

A second Page Setup window appears, listing your default printer.

6. Click the drop-down arrow next to your default printer to access the list 
of available printer options.
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7. From the list select Adobe PDF.

8. Click the Properties button to access formatting options for the PDF file 
to be generated.

It is recommended the “Prompt for Adobe PDF Filename” option be 
checked before clicking Ok to this window.

9. Click Ok to all remaining Page Setup windows.

10. In the Print Preview window, click the Print button.

The Save PDF File As dialog box appears.

11.Click the drop-down arrow next to the Save in field to navigate to and 
select a new folder in which to save the file, if desired.

12.Enter a name in the File name field.

13.Click the Save button.

The PDF file generates and saves to the directory specified.

Subchapter 5.2 Working With Missions

IMPRINT Pro allows you to analyze the performance (such as time, 
accuracy, and workload) of a new weapon system by helping you build 
models of each mission that the weapon system will be capable of 
accomplishing. Models are built by breaking down the mission into a 
network of functions. Each of the functions is then further broken down into 
a network consisting of other functions and tasks.

When you execute the mission model simulation, you can study the range 
of results that occur in the mission. A description of the variability of each 
element can be obtained for further analysis.
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IMPRINT Pro performs the simulation model based on how long you tell it 
to perform each task in the mission. In addition, with each task, you 
estimate accuracy levels and assign workload values that reflect the 
amount of effort the Warfighters will have to expend to perform the task. 
During the simulation, IMPRINT Pro predicts task performance and 
calculates how much workload each Warfighter experienced throughout 
the mission. In this way, you determine whether the Warfighter were 
overloaded, and if so, how changes can be made to reduce the workload to 
an acceptable level.

At the completion of the simulation, IMPRINT Pro can compare the 
minimum acceptable mission performance time and accuracy to the 
predicted performance. This will determine whether the mission met its 
performance requirements.

Displaying Missions
In IMPRINT Pro, a single analysis can contain numerous missions. Each 
mission has its own list of elements below it which include RI Pairs, 
Macros, Variables, Snapshots, External Events and Cultural Templates.

To display mission names:

In the Analysis Tree, double-click the Missions node below the desired 
analysis.

For the selected analysis, IMPRINT Pro displays a list of missions in the 
main window under the Missions tab. Each mission listed is 
accompanied by its assigned mission Time Requirement. For more 
information on Time Requirement, see “Editing Mission Properties” on 
page 112.
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Alternatively, you may access the list of missions for your analysis by 
clicking the + adjacent to it to expand the list. 

The list of missions appears below the Missions node.

If there are no missions listed, you will need to add a mission. For 
details, see “Adding Missions” on page 109.

Once you have selected a mission, the mission name will also appear in 
the Properties window. By default, this window appears on the right 
side of your screen when you choose Custom Layout 1. If the 
Properties window is hidden, it can be brought back at any time by 
selecting it from the Windows option under the View menu. The name 
of your mission appears in the top of the window, and all other 
properties of the mission display below. 
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Adding Missions
This option allows you to add a new operational mission to this analysis. 
Initially the new mission will have a name only and no associated data 
(such as functions and tasks). 

To add a mission:

1. In the Analysis Tree, right-click Missions.

2. Click Add Mission from the menu that displays.

A mission will be added below the Mission node in the Analysis Tree 
and to the list of missions in the main window.

Note:
By default, the first mission added in IMPRINT Pro is initially named Mission. 
Every subsequent mission added is also named Mission, but is appended with 
a number that increments by one, for example “Mission2, Mission3,...etc.” You 
can edit the name of the Mission in the Mission Properties window name box 
or in the name box on the Mission information dialog box.
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Selecting Missions
To select a mission:

In the Analysis Tree, below the Mission node single-click a Mission 
name (for example, Mission1).

A network diagram displays along with the mission data in the 
Properties window. You will use the network diagram to add functions, 
tasks, goals, and comments to the mission.

For detailed information on adding Functions and Tasks to the Network 
Diagram, see “Mission Components” on page 115.

Displaying the Mission Properties
To display the Mission dialog box:

Double-click an existing mission below the Missions node in the 
Analysis Tree.

A new tab appears in the main window, displaying properties of this 
mission. This same data also displays in the Properties window. If not 
previously selected, this new mission now becomes the currently-
selected mission.
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Mission Properties
Mission properties includes:

Mission Name. At the top of the dialog box is the Mission Name. 

Mission Description. In the Description box you can add a 
textual description of the mission.

Time Requirement. The Time Requirement is the maximum 
acceptable time by which the mission must be performed in 
order to be considered a success.

Time Criterion. The Time Criterion is the percentage of mission 
runs that must be performed within the mission time requirement 
in order to be considered a success. Since the elements of the 
mission are variable, the predicted mission performance will also 
vary. The criterion allows you to account for this, and gives you 
an opportunity to specify a realistic percentage of runs that must 
meet the standards.

Accuracy Criterion. At the task level, an accuracy failure can 
lead to mission abort. Mission Accuracy Criterion lets you specify 
the percentage of time in which the mission must complete 
without an abort in order to be considered a success.
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Mission Criterion. The Mission Criterion is a percentage that 
represents how often the mission must meet both its time and 
accuracy requirements at the same time in order to be 
considered a success. Occasionally, your mission may be able 
to miss either the Time or Accuracy Requirement, but here you 
define how often it must meet both.

Later, you can execute a simulation model of your mission. The results of 
that mission analysis will be compared to the requirement and criteria you 
enter here.

Editing Mission Properties
To edit the values in the Mission Properties window:

1. Position the pointer in the box you want to change. 

2. Click once to set the insertion point in the box.

3. Type in the new value.

Note:
By default, the format for the Mission Time Requirement value and other time 
values in IMPRINT Pro is HH:MM:SS.mm, and the colons are required. You 
may change the current time format to a different format through the Time tab 
in the Preferences dialog, located under the Edit menu.

Deleting Missions
To delete a mission:

1. In the Analysis Tree, click the Mission you want to delete and do one of 
the following:
• Right-click the mission, and then select Delete Mission from the 

menu that displays.
• Press the Delete key on the keyboard. 

2. At the delete confirmation prompt, click OK.
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3. The mission is deleted from the tree along with all its associated data.

Note:
Although deleting a mission causes it to disappear from the analysis in the 
tree, the mission is not deleted from the database until the analysis containing 
it is re-saved afterwards.

Cutting Missions
You can move a mission from one analysis to another using the Cut 
command.

To cut a mission:

Do one of the following:
• Right-click the mission you want to move, and select Cut Mission 

from the menu that displays.
• Select the mission in the tree, and then select Cut from the Edit 

menu.
• Select the mission in the tree, and then click the Cut button.

The cut mission is highlighted in red. To paste the mission, see “Pasting 
Missions” on page 114.

Copying Missions
To copy a mission:

Do one of the following:
• Right-click the mission you want to move, and select Copy Mission 

from the menu that displays.
• Select the mission in the tree, and then select Copy from the Edit 

menu.
• Select the mission in the tree, and then click the Copy button.

The mission and all its associated data are copied to the Windows 
clipboard. To paste the mission, see “Pasting Missions” on page 114.
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Pasting Missions
To paste a mission:

1. After you cut or copy a mission, select the Missions node to which you 
want to paste your copied mission.

2. Do one of the following:
• Right-click the destination Missions node, and select Paste Mission 

from the menu that displays.
• Select the destination Missions node in the tree, and then select 

Paste from the Edit menu.
• Select the destination Missions node in the tree, and then click the 

Paste button in the tool bar.

The cut or copied mission will be added below the destination Missions 
node.

Note:
If you are pasting the mission to a mission node in a different analysis, the 
Task Data Mapping Wizard will display. For more information on how to use 
the Task Data Mapping Wizard, see “Pasting Objects to Mission Model or 
Analysis” on page 100.

Scheduled Missions
As an alternative to a conventional mission whose Start node fires 
immediately as the “Run Model” button is activated, Scheduled Missions 
allow you to create a mission which starts at a specific clock time instead.  
This is because scheduled missions are comprised entirely of scheduled 
tasks and functions, all of which have their own specifically scheduled 
start and end times. These times may be set in the Properties window of 
any task or function selected within this type of mission.  It is the first task in 
the root level of the network (or in the first function’s lowest level) whose 
start time determines the start of the mission.

To add a scheduled mission:

1. Right-mouse click the Missions node in an analysis.
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2. From the shortcut menu that appears, select New Scheduled Mission.

The new scheduled mission appears in the Analysis Tree under the 
Missions node.

Scheduled Missions are simply a mission-level representation of 
Scheduled Functions; the method for adding and setting the nodes in 
each remains identical.  For more  information see “Scheduled 
Functions” on page 122.

Mission Components
The network diagram of an IMPRINT Pro mission shows the functions, 
tasks, decision nodes and paths connecting these items. You can also add 
other text to the network diagram and display values of variables on the 
network diagram as the mission runs. 

In addition to the graphical network diagram, IMPRINT Pro uses RI pairs, 
variables, macros, snapshots, external events, and cultural templates in 
the mission simulation. All of these items are defined in description dialog 
boxes or in the associated Properties window.

Functions
IMPRINT Pro helps you break a mission down into its functions. Examples 
of functions are:

Acquire Target

Engage Target

Communicate

In addition, IMPRINT Pro helps you identify maximum acceptable 
performance times for each function. IMPRINT Pro helps you link the 
functions together in a network that makes up the mission. 

Note:
A function can contain other networks within it.

A list of functions associated with the mission displays in the Analysis Tree 
below the Network node. You can add, edit, and delete functions, and 
display function descriptions.
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Adding Functions

To add a function to the network diagram:

Do one of the following:
• From the Palette, drag the Function object to the correct place on the 

network diagram.
• Right-click the Network node in the Analysis Tree, and select Add 

Function for the menu that displays.
• Right-click the network diagram, and then select Add Function from 

the menu that displays.

Note:
IMPRINT Pro will name your new function Function. If you continue to add 
functions, each following function will be named FunctionX where X is the 
next integer. You can edit the name of the function in the Function Properties 
Window name box.

Displaying Function Properties

To display the Function properties: 

Double-click the function below the Network node in the Analysis Tree.

The Function Information tab appears in the main window, showing 
properties of this function. The Properties Window also updates to 
display this same information.

For more information on Layout, see “Window Configurations” on page 42.

Function Properties
The name of the mission to which this function belongs displays at the top 
of the Function Information tab. This tab contains three data elements:

Function Name. This is a short description of the function and is 
the label that is written into the node when the network diagram 
is displayed.

Time Requirement. This value is the maximum acceptable 
performance time for this function.

Criterion. This value is the percentage of times that this function 
must meet its time standard to be considered successful.
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Editing Function Information

To change function information:

1. Position the pointer in the box you want to change.

2. Click once to set the insertion point in the box.

3. Type in the new value.

The format for the time value is HH:MM:SS.mm, and the colons are 
required. 

Function Properties Window
The Properties Window contains additional information about your function 
that is not included in the Function Information tab, for example the 
Function ID and the Tree Parent Object.

The Function ID is an identification number which is generated when the 
function is created. At the root level of the network, all IDs are an integer 
representing the place that function lies in the sequence of functions 
created at that level. For example, a function with an ID of 2 means that 
this was the second function created at this level. Adding a function at the 
next level (within an existing function’s network) adds one level of 
complexity to the Function ID: it is prefixed with “X_” where X is the ID of 
the parent function. For example, 3_2 represents the second function 
created in the task network belonging to function 3, and function 3 sits at 
the root level of the network.

ID's do not affect sequence and are merely task label information. 
Sequence is solely determined by which paths you draw between nodes.
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The Tree Parent Object is the function containing your selected node, i.e. 
the Parent Function. In many cases this function may be the top level of the 
network in which case the Tree Parent Object is labeled as 
“Untitled(Root)”.

Deleting Functions
A function and all its associated data can be deleted from the Analysis Tree 
and network diagram. This command can not be undone.

To delete a function:

On the network diagram, select the function and do one of the following:
• Press the Delete key on the keyboard.
• Right-click the function on the network diagram, and select Delete 

Function from the menu that displays.
• Right-click the function in the Analysis Tree, and select Delete 

Function from the menu that displays.

The function is removed. All associated tasks are also deleted.

Copying Functions
A function and all its associated data can be copied and pasted into 
another network. 

To copy a function:

Do one of the following:
• Right-click the function you want to copy, and then select Copy from 

the menu that displays.
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• Right-click the function node below the Network node in the Analysis 
Tree, and then select Copy Function from the menu that displays.

• Select the function on the network diagram, and then click the Copy 
button on the tool bar.

Cutting Functions

To cut a function:

Do one of the following:
• Right-click the function node in the Network Diagram and then 

select Cut Function from the menu that displays.
• Right-click the function node below the Network node in the Analysis 

Tree, and then select Cut Function from the menu that displays.
• Select the function on the network diagram, and then select Cut from 

the Edit menu.
• Select the function on the network diagram, and then click the Cut 

button on the tool bar.

The function is highlighted in red. When you paste the function into 
another mission network, IMPRINT Pro will remove the function from its 
current location to the new location.

Pasting Functions

To paste a function:

Copy or cut the function, and do one of the following:
• Right-click the network diagram, and then select Paste Node(s) from 

the menu that displays.
• Right-click the destination Network node in the Analysis Tree, and 

then select Paste Node(s) from the menu that displays.
• Click the Network Diagram to which you want to paste the function, 

and then select Paste on the Edit menu.
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• Click the Network Diagram to which you want to paste the function, 
and then click the Paste button on the tool bar.

The function appears in the Network Diagram. If you used the Cut 
command, the cut function will be removed from its previous location

Note:
If you are pasting the function to a network node in a different analysis, the 
Task Data Mapping dialog box will display. For more information on how to 
use the Task Data Mapping dialog, see “Pasting Objects to Mission Model or 
Analysis” on page 100.

Changing the Appearance of Functions
Functions are represented by a rectangular shape on the network diagram. 
You can change the colors and shapes of a function. 

To change the appearance of a function:

1. In the Edit menu, click Preferences.

2. Choose the Shapes and Colors tab.

3. From the Select Node Type drop-down box, select Function.

4. Choose the desired shapes and colors for the network nodes using the 
drop-down lists provided.

5. Click Ok.

Nodes in the Network diagram update to the new preference settings.

Subnetworks of Functions
When a function in the network is very complex, you may want to simplify it 
by dividing it into more specific tasks. You can do this by defining the 
function as a subnetwork. A subnetwork can contain all the same elements 
as the main network—functions, tasks, paths, decisions, queues, and 
subnetworks at a lower level—and is defined by its own network diagram. 
In addition, a subnetwork can have a release condition similar to a task, 
and it can be preceded by a queue. Subnetworks are represented by the 
default green rectangular shape on the network diagram while tasks are 
represented by a rounded rectangular shape with a diamond attached. 
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To display the subnetwork diagram:

Double-click a function in the Network Diagram.

A lower level diagram will display. You can place functions and tasks on 
this diagram by using the Palette or by right-clicking on the diagram and 
selecting Add Function or Add Task from the menu that displays. 

Adding Functions to Subnetworks

To add a function to a subnetwork:

Do one of the following:
• Right-click the function representing the subnetwork to which the 

new function should be added. From the menu that displays, click 
Add Function.

• From the Palate, select the Function object, and then drag it to the 
subnetwork diagram.

• Right-click the Function node in the Analysis Tree, and then select 
Add Function from the menu that displays.

• Open the subnetwork by double-clicking the function node on the 
network diagram, right-click the subnetwork diagram, and select Add 
Function from the menu that displays.

A function will be added below the Function node in the Analysis Tree 
and to the subnetwork diagram. 

Adding Tasks to Subnetworks

To add a task to a subnetwork:

Do one of the following:
• Right-click the function representing the subnetwork to which the 

new task should be added, and then select Add Task from the menu 
that displays.

• Right-click the function in the Analysis Tree you want to add a task 
to, and select Add Task from the menu that displays.

• From the Palette, select the Task object and drag to the subnetwork 
diagram.

• Open the subnetwork by double-clicking the function node on the 
network diagram, right-click the subnetwork diagram, and select Add 
Task from the menu that displays.

A task will be added below the function in the Analysis Tree and to the 
subnetwork diagram. 
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Adding Comments to Subnetworks
Comments can be used to add headers for clarification, add other text to 
the diagram, and to display values of variables for display on the network 
diagram during the model run.

To add a comment to a subnetwork:

Do one of the following:
• Right-click the function representing the subnetwork to which the 

new comment should be added, and then select Add Comment 
from the menu that displays.

• Right-click the function in the Analysis Tree you want to add a 
comment to, and select Add Comment from the menu that displays.

• From the Palette, select the Comment object and drag to the 
subnetwork diagram.

• Open the subnetwork by double-clicking the function on the network 
diagram, right-click the subnetwork diagram, and select Add 
Comment from the menu that displays.

A comment will be added to the function subnetwork diagram. 

Scheduled Functions
Similar to regular functions, Scheduled Functions help you break a 
mission down into its functions. Different from regular functions, however, 
scheduled functions determine the start and end times of the tasks they 
contain using optional scheduled start and end times rather than by the 
progression of a network flow. By using a scheduled function, a task can 
start at a specific clock time within the context of the scheduled function 
rather than waiting for a node before it in the same subnetwork to finish.

A scheduled function is itself a subnetwork of nodes which contains one or 
more tasks, functions and/or other scheduled functions. Each node is 
triggered by the scheduled start and end times you specify (path logic in 
these subnetworks does not exist.) For each scheduled function added, a 
minimum of one subtask must exist in its subnetwork; the last task in a 
scheduled function’s subnetwork cannot be deleted unless the scheduled 
function contains a separate scheduled function in its network which does 
contain a task. The lowest level of any scheduled function must contain at 
least one task.
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A list of scheduled functions associated with the mission displays in the 
Analysis Tree below the Network node. You can add, edit, and delete 
scheduled functions either through the tree, through the network or through 
the Function Scheduler window available by double-clicking any 
scheduled function node in the network diagram. Scheduled function 
descriptions and properties may be displayed through the Properties 
Window.

Each scheduled function has optional performance properties to set which 
help identify its maximum acceptable performance times. The performance 
of each scheduled function is determined by the performance of the nodes 
it contains. 

Adding Scheduled Functions

To add a scheduled function to the network diagram:

Do one of the following:
• From the Palette, drag the Scheduled Function object to the correct 

place on the network diagram.
• Right-click the Network node in the Analysis Tree, and select the 

Add... option from the shortcut menu. From the submenu which 
displays, select Add Scheduled Function.

• Right-click the network diagram, and then select Add Scheduled 
Function from the menu which displays.

Note:
IMPRINT Pro names your new scheduled function ScheduledFunction. If 
you continue to add scheduled functions, each following function will be 
named ScheduledFunctionX where X is the next integer. You can edit the 
name of the scheduled function in the Scheduled Function Properties Window 
name box.
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Displaying Scheduled Function Properties

To display the Scheduled Function properties: 

Double-click the scheduled function below the Network node in the 
Analysis Tree.

The Scheduled Function Information tab appears in the main window, 
showing properties of this function. The Properties Window also 
updates to display this same information.

For more information on Layout, see “Window Configurations” on page 42.

Scheduled Function Information Tab
The name of the mission to which this scheduled function belongs displays 
at the top of the Scheduled Function Information tab. This tab contains the 
following data elements:

Scheduled Function Name. This is a short description of the 
function and is the label that is written into the node when the 
network diagram is displayed.

Time Requirement. This value is the maximum acceptable 
performance time for this function.

Criterion. This value is the percentage of times that this function 
must meet its time standard to be considered successful.

Schedule (for nodes within a scheduled function only). The 
Schedule parameters include a Start time and a Stop time to 
specify the exact times in your model when your scheduled 
function should begin and end within the context of the parent 
function’s timeline.
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Scheduled Function Properties Window
The Properties Window contains additional information about your 
scheduled function that is not included in the Function Information tab, for 
example the Function ID and the Parent Object ID.

The Function ID is an identification number which is generated when the 
function is created. At the root level of the network, all IDs are an integer 
representing the place that function lies in the sequence of functions 
created at that level. For example, a function with an ID of 2 means that 
this was the second function created at this level. Adding a function at the 
next level (within an existing function’s network) adds one level of 
complexity to the Function ID: it is prefixed with “X_” where X is the ID of 
the parent function. The Parent Object is the function containing your 
selected node, i.e. the Parent Function. In many cases this function may be 
the top level of the network in which case the Parent Object is labeled as 
“Untitled(Root)”. For example, 3_2 represents the second function created 
in the task network belonging to function 3 (this task’s parent function), and 
function 3 sits at the root level of the network.

ID's do not affect sequence and are merely task label information. 
Sequence is solely determined by which paths you draw between nodes.

The Scheduled Function Properties window also includes a Description 
field at the bottom of the window. As you select items in the Properties 
window to edit, the Description field updates to display the definition of the 
item you are editing.
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Editing Scheduled Function Information

To change scheduled function information:

1. Position the pointer in the box you want to change.

2. Click once to set the insertion point in the box.

3. Type in the new value.

The default format for the time value is HH:MM:SS.mm, and the colons 
are required. For more information on changing the time format see the 
IMPRINT Pro User Guide Volume 1 Chapter 5: IMPRINT Pro Menu 
Structure, Edit Menu, Preferences.

Deleting Scheduled Functions
A scheduled function and all its associated data can be deleted from the 
Analysis Tree and network diagram. This command can not be undone.

To delete a scheduled function:

On the network diagram, select the scheduled function and do one of 
the following:
• Press the Delete key on the keyboard.
• Right-click the scheduled function on the network diagram, and 

select Delete Scheduled Function from the menu that displays.
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• Right-click the function in the Analysis Tree, and select Delete 
Scheduled Function from the menu which displays.

The scheduled function is removed. All associated tasks are also 
deleted.

Copying Scheduled Functions
A scheduled function and all its associated data can be copied and pasted 
into another network. 

To copy a scheduled function:

Do one of the following:
• Right-click the scheduled function you want to copy, and then select 

Copy Scheduled Function from the menu that displays.
• Right-click the function node below the Network node in the Analysis 

Tree, and then select Copy Scheduled Function from the menu 
that displays.

• Select the function on the network diagram, and then click the Copy 
Scheduled Function button on the tool bar.

Cutting Scheduled Functions

To cut a scheduled function:

Do one of the following:
• Right-click the function node in the Network Diagram and then 

select Cut Scheduled Function from the menu that displays.
• Right-click the function node below the Network node in the Analysis 

Tree, and then select Cut Scheduled Function from the menu that 
displays.

• Select the function on the network diagram, and then select Cut from 
the Edit menu.

• Select the function on the network diagram, and then click the Cut 
button on the tool bar.

The cut scheduled function highlights in red. When you paste the 
scheduled function into another mission network, IMPRINT Pro will 
remove the scheduled function from its current location to the new 
location.
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Pasting Scheduled Functions

To paste a scheduled function:

Copy or cut the scheduled function, and do one of the following:
• Right-click the network diagram, and then select Paste Node(s) from 

the menu that displays.
• Right-click the destination Network node in the Analysis Tree, and 

then select Paste Node(s) from the menu that displays.
• Click the Network Diagram to which you want to paste the scheduled 

function, and then select Paste on the Edit menu.
• Click the Network Diagram to which you want to paste the scheduled 

function, and then click the Paste button on the tool bar.

The function appears in the Network Diagram. If you used the Cut 
command just prior to the Paste command, the cut scheduled function 
is removed from its previous location.

Note:
If you are pasting the scheduled function to a network node in a different 
analysis, the Task Data Mapping dialog box will display. For more information 
on how to use the Task Data Mapping dialog, see “Pasting Objects to Mission 
Model or Analysis” on page 100.

Changing the Appearance of Scheduled Functions
Scheduled Functions are represented by a rectangular shape on the 
network diagram. You can change the colors and shapes of a function. 

To change the appearance of a scheduled function:

1. In the Edit menu, click Preferences.

2. Choose the Shapes and Colors tab.

3. From the Select Node Type drop-down box, select Scheduled 
Function.

4. Choose the desired shapes and colors for the network nodes using the 
drop-down lists provided.
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5. Click Ok.

Nodes in the Network diagram update to the new preference settings.

Subnetworks of Scheduled Functions
Similar to regular functions, a scheduled function is designed to help divide 
a portion of your network into more specific tasks and functions and/or 
subfunctions. You can do this by defining the scheduled function as a 
subnetwork. 

A subnetwork contains all the same elements as the main network—
functions, additional scheduled functions and tasks at a lower level. Unlike 
regular functions, however, which are defined by a series of elements 
connected together in a network, the subnetwork of a scheduled function is 
defined by similar elements which are positioned along a timeline or “Gantt 
chart”, sequenced instead by the Start Times and Stop Times set for each. 
These start and stop times are set within the context of the parent object 
timeline. This charting and scheduling method of subtasks and 
subfunctions is done using the Function Scheduler. 

Displaying Subnetworks of Scheduled Functions using 
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the Function Scheduler

To display a scheduled function using the Function Scheduler:

Double-click a scheduled function in the Network Diagram.

The Function Scheduler window appears. 

This window displays the content of the selected scheduled function in 
the form of a Gantt chart.

Name. The name of the selected scheduled function

Parent. The name of the parent object of the scheduled function 

In the Function Scheduler all tasks contained by the scheduled function 
display as purple bars while all scheduled functions contained by the 
scheduled function display as blue bars. The corresponding task or 
function name and ID display to the left of the bar. The start of each bar 
is positioned relative to the timeline displayed at the top of the Function 
Scheduler window according to the task’s or function’s set start time, 
and the end of each bar corresponds to the Stop time. The length of bar 
bar represents the duration of the task, function or scheduled function 
selected.

Modifying the Function Scheduler Display
The Function Scheduler allows you to control the range of time displayed in 
your scheduled function. Scheduled tasks and functions within the display 
scale and translate accordingly.
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To modify the Function Scheduler display:

1. Locate the timeline at the top of the display. Note that the display 
defaults to displaying one hour of time within each segment.

2. Click the left-pointing arrow as needed to expand a smaller section of 
the timeline.

3. Click the right-pointing arrow as needed to advance to a point along the 
timeline further from the start.

Alternatively, click and drag on the timeline itself to shift the display 
window.

Adding Nodes to the Subnetwork of a Scheduled 
Function
Tasks, functions and/or additional scheduled functions may be added to 
the subnetwork of any selected scheduled function.
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To add a node to a subnetwork of a scheduled function:

Do one of the following:
• In the Analysis Tree, right-click the Scheduled Function node 

representing the subnetwork to which the new function should be 
added, and then select the Add Node... option. From the submenu 
which displays, select the option corresponding to the node you wish 
to add. Options include Add Task, Add Scheduled Function and 
Add Function.

• In the Function Scheduler window, right-click in the space 
underneath the listed subtasks and subfunctions, and then select the 
Add Node... option. From the submenu which displays, select the 
option corresponding to the node you wish to add. Options include 
Add Task, Add Scheduled Function and Add Function.
132



Chapter 5: Mission Analysis
For root-level scheduled functions only:
• On the root-level network diagram, right-click the scheduled function 

representing the subnetwork to which the new function should be 
added, and then select the Add Node... option. From the submenu 
which displays, select the option corresponding to the node you wish 
to add. Options include Add Task, Add Scheduled Function and 
Add Function.

A new function displays below the selected scheduled function node in 
the Analysis Tree; the same new function also displays in the Function 
Scheduler window. 

Modifying Nodes of a Subnetwork in the Function 
Scheduler
The start time, stop time and duration of any node inside the Function 
Scheduler window can be altered using the bars on the Function Scheduler 
display. 
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To modify a node in the Function Scheduler:

1. Position the cursor at the edge of the bar of the node you wish to 
modify.

The cursor changes to a double arrow.

2. Select the direction in which to drag the cursor.

3. Drag the cursor in the intended direction until the bar represents the 
desired length of the task.

4. Release the mouse.

The new time displays.

Tasks
IMPRINT Pro helps you break a mission down into its basic tasks.
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Examples of tasks are:

Tune Radio

Push Button

Clear Cannon

IMPRINT Pro helps you enter the relevant data elements for each task, 
such as timing information, execution constraints, effects of the task on the 
system, and routing information. Finally, it allows you link the tasks 
together in a network that makes up the mission.

A list of tasks associated with each function displays in the Analysis Tree 
below their respective parent functions under the Network node. You can 
display task descriptions, and add, edit, and delete tasks. 

Adding Tasks
You can add a task to your network diagram or subnetwork one of four 
ways.

To add a task:

Do one of the following:
• Right-click the Function node in the Analysis Tree, and then select 

Add Task from the menu that displays.
• Right-click in the network diagram or subnetwork, and then select 

Add Task from the menu that displays.
• From the Palette, select and drag the Task object to the correct place 

on the network diagram or subnetwork.
• Right-click the Function node on network or subnetwork diagram, 

and select Add Task from the menu that displays.

Note:
IMPRINT Pro will name your new task Task. If you continue to add tasks, each 
following task will be named TaskX where X is the next integer. 
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Displaying Task Information

To display the Task Information:

On the network diagram in the Analysis Tree, double-click the task.

The Task Information tab displays in the main window. The associated 
Properties window for the task also displays.

Task Information Dialog Box Overview
Above the tabs on the task information dialog box, you will see the Mission 
name, the Task ID, the Function name, and the Task name. The Task 
name is a short description of the task and is the label written in the node 
when the Network Diagram is displayed.
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The Task Information dialog box contains many data elements and is 
grouped into areas that contain related information. The tabs include the 
following:

Timing & Accuracy data

Effects data

Failure data

Crew assignment data

Taxon assignments

Path decision type data

Workload Demand data

When you first enter this dialog box, you will see either the last data sheet 
you were in for this task or the default Time and Accuracy data sheet. To 
view data related to one of the other topics mentioned above, click its 
corresponding tab at the top of the screen. 

Task Information Dialog Box – Time and Accuracy Tab
Click the first tab on the Task Data dialog box to show the Time and 
Accuracy dialog box. 

The dialog box has the following information:

Time and Accuracy Requirements
Beginning at the top of the dialog box below the task name, the first group 
of data displayed includes the performance standards for this task. These 
values define how well the task needs to be performed to be considered 
successful. Values include:

Time Requirement. The Time Requirement is the maximum 
acceptable performance time for this task.

Accuracy Requirement. The Accuracy Requirement is the 
minimum acceptable accuracy for this task in order for it to be 
considered a success. 

Accuracy Measure. Accuracy Measure is a unit corresponding 
to the nature of how your task’s accuracy is measured. This unit 
helps IMPRINT Pro to determine whether your task is more or 
less accurate when the number pulled from the accuracy 
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distribution is greater or less than the requirement you set. For 
example, assume that your Accuracy Measure is set to Percent 
Steps Correct and your Accuracy Requirement is set to 80. If the 
number pulled from the Accuracy distribution is 85, then 
IMPRINT Pro will consider this accuracy value to be a success 
since 85% is better than 80% in the context of Percentage of 
Steps Correct. If, however, you intend choose the unit of 
Measure Feet from Desired, IMPRINT Pro will consider this 
accuracy value of 85 to be a failure since 85 is less accurate that 
80 in the context of Feet from Desired.

Criterion. This value is the percentage of time that this task 
must meet both the time requirement and the accuracy 
requirement simultaneously to be considered successful.

When IMPRINT Pro executes your mission, the Distribution and 
its parameters are used to choose a specific task time for each 
occurrence of each task. These times are then accumulated 
throughout the model run and compared to the time requirement 
in order to report the percentage of successes for each task. 
Similarly, the Probability of Success (calculated based on the 
Accuracy Mean, Accuracy Standard Deviation, and Accuracy 
Requirement) is used to determine whether the task has 
succeeded or failed each time it occurs. These successes and 
failures are then accumulated throughout the model run in order 
to report the percentage of accuracy successes for each task.

Estimated Task Time
The second group of data elements on this dialog box describe the 
estimated task time. The Estimated Task Time is the amount of time a task 
will take to execute as calculated by IMPRINT Pro. Estimated Task Time 
may be specified either by using a distribution or by entering an expression 
for time. Depending on the values you enter for the distribution or the 
expression you use, the task times could vary each time the task is 
executed.

Distributions
To calculate a task time using a distribution, you must first choose a 
distribution type. In the Estimated Task Time Distribution list, 22 different 
distributions are available for choosing. Depending on the distribution type 
you choose, you must then enter between one and three parameters 
(Parameter 1, Parameter 2 and Parameter 3) to define the limits of this 
distribution. 
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Once you have selected your distribution type and entered the values to 
define it, IMPRINT Pro determines a distribution, or range, of possible 
values it can assign to your task’s time. When IMPRINT Pro runs your 
model, a random number generator is used to pull a number from this 
distribution of values. The number pulled becomes the new Estimated 
Task Time for that occurrence of the task. 

Note:
Of the available 20 distribution types, IMPRINT Pro uses, by default, the 
Normal distribution which uses Mean and Standard Deviation to predict a task 
performance time. Depending on the distribution type you choose to use, 
different and/or additional properties such as Shape, Probability of Success, 
Maximum, Minimum and Scale, might also be required. 

Distribution. The distribution describes the statistical 
distribution properties from which the actual occurrence time will 
be drawn. (If you are unfamiliar with statistical distributions, we 
recommend that you consult a statistics textbook or someone 
more knowledgeable in this field.) By default, IMPRINT Pro uses 
a Normal distribution for several of its parameters. 

Parameter 1, Parameter 2 and Parameter 3. The values 
required by the selected distribution type to determine a range of 
values for your task’s time. 

In the example of the Normal distribution which IMPRINT Pro 
uses quite frequently, the fields for Parameter 1 and Parameter 
2 represent the Mean and Standard Deviation of the 
distribution. The Mean represents the average amount of time 
the task will most likely take any time it is performed. Standard 
Deviation is a measure that tells you how closely all the various 
task times calculated by IMPRINT Pro are clustered around the 
mean task time. In general, one standard deviation away from 
the task mean time in either direction (greater than or less than 
the mean) accounts for somewhere around 68 percent of all 
computed task times. Two standard deviations away from the 
mean account for roughly 95 percent of the computed task 
times. And three standard deviations account for about 99 
percent of the computed task times. By specifying the Standard 
Deviation for your task, you are helping IMPRINT Pro to 
determine how widely varied (or unvaried) the distribution of all 
your different calculated task times will be.

If you choose to change the distribution type, for example a 
Triangular distribution type, Parameters 1, 2 and 3 now 
represent the Mode, Minimum and Maximum values which this 
distribution type requires in order to define a range of values for 
your task’s time.
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Information on the 19 other distribution types can be found in 
Chapter 4 Probability Distributions, IMPRINT Pro Syntax 
Reference Manual, Vol.3 of IMPRINT Pro User Guide.

Expressions
In place of a distribution, you may use an expression to set the estimated 
time for a task. To use this feature, click the Use Expression radio button 
in the Estimated Task Time window, and then enter an expression in the 
code box provided.

Expressions can be as simple as designating a set time for your task 
(00:00:30;) which will be used every time the task fires, or they can 
instead be much more complicated expressions involving operators or 
statements, for example (if clock<=30 then 10 else 15;). Each 
expression you include should be delimited by a semicolon. In building the 
expressions, you can use any of the algebraic or logical operators, 
including the following: (&&, ||, >, <, =,==, +, -,*, and /). You can also use if-
then-else statements. The assignment operator is =. The equivalence 
operator is ==.

For more information on writing expressions in IMPRINT Pro, see Chapter 
4 Expressions, IMPRINT Pro Syntax Reference Manual, Vol.3 of 
IMPRINT Pro User Guide.

Estimated Task Accuracy
As a compliment to the Estimated Task Time in which you compute a 
distribution of times for your task, the Estimated Task Accuracy is used to 
compute a distribution of successes (and failures) for the same task. 
Essentially, you are specifying the part of the task that will make it 
randomly succeed or fail, causing your model to exercise the various 
failure consequences throughout your model run. The items necessary for 
specifying task accuracy include:

Mean Accuracy. The Mean Accuracy is your estimate of the 
most likely, or average, Accuracy value for this task.

Accuracy Standard Deviation. The value specifying how tightly 
all the various values in the distribution are clustered around the 
Mean Accuracy value.
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Probability of Success. The Probability of Success is the 
likelihood that a task will succeed each time it is executed. This 
number can either be manually entered or can be calculated as a 
result of entering values for the remaining three fields upon 
which it is dependent, namely the Mean Accuracy, Accuracy 
Standard Deviation and the Accuracy Requirement.

To calculate these values, you must first think of the task’s performance in 
terms of Accuracy. IMPRINT Pro pulls a random accuracy value from a 
distribution of values, and then assigns it to your task. If this value meets a 
requirement you set, your task can then be considered a success. If this 
value falls short of your requirement, your task is then considered a failure. 
To generate these random task accuracies you must first set up a 
distribution in the Estimated Task Accuracy section of the Task window. 
The distribution type used by IMPRINT Pro for the accuracies is always a 
Normal distribution for which you must enter a Mean Accuracy, Standard 
Deviation, Accuracy Requirement and the Probability of Success.

The first step in this process is to set a Mean Accuracy. This value is the 
average value (or center) in the distribution. Most of the values in the data 
set will be close to this average while relatively few tend to one extreme or 
the other.

Next, you must specify the Accuracy Standard Deviation. By specifying the 
Standard Deviation for your task, you are helping IMPRINT Pro to 
determine how widely varied (or unvaried) the distribution of all your 
different calculated task accuracies will be from the average (it is 
essentially the shape of the distribution curve.) In general, one standard 
deviation away from the task Mean Accuracy in either direction (greater 
than or less than the mean) accounts for somewhere around 68 percent of 
all computed task accuracies. Two standard deviations away from the 
mean account for roughly 95 percent of the computed task accuracies. 
Three standard deviations account for about 99 percent of the computed 
task accuracies. 

An easy rule of thumb for specifying the standard deviation is to compute 
the difference between the worst and best performance and divide it by 6. 

Example: If the worst performance is 40% steps correct and the best 
is 100%, then an estimate for the standard deviation would be 10% 
(((100 - 40)/6) = 10).
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Next, if you have not already done so at the top of the page, you must enter 
the task Accuracy Requirement. Each value that is pulled from your 
accuracy distribution will then be compared to this value. If a value falls 
above this requirement, the task is considered accurate enough to be a 
success, provided the Accuracy Measure dictates a higher value is better 
(for example,% Steps Correct,% Desired.) For this same situation, a value 
falling below this threshold would be one in which the task would be 
considered a failure. In a different context, however, where the Accuracy 
Measure determines that a lower value is better (for example, Minutes from 
Desired or Feet from Desired) an accuracy value that falls short of the 
Requirement value may be considered a success whereas a value that 
falls above the Requirement value would be considered a failure.

We realize that it is often difficult for users to think of accuracy in these 
terms, and that it is often easier to think of it in terms of the probability of 
success. To accommodate this fact, we have provided a Probability of 
Success field in which you may manually enter a value. If, however, you 
are uncertain about what this value should be based on the other values 
entered, you may calculate it using the Accuracy Calculator located on the 
Toolbar at the top of your screen.

1. Open the Accuracy Calculator.

2. Select the option button for Probability of Success. 

3. Enter in your data for the remaining three values in the fields provided. 

4. Click the Calculate button. The Probability of Success value is 
calculated using standard statistical procedures that compute the area 
under a Normal statistical curve. IMPRINT Pro is also careful to 
evaluate your accuracy measure to determine whether bigger values 
are better (for example, percent steps correct), or smaller values are 
better (for example, mils from desired). 

5. Click the Apply to Selected Task button – your new Probability of 
Success value appears in the Task window.

Note:
You may use the Accuracy Calculator to calculate any one of the four required 
values provided the other three are entered.

Editing Time and Accuracy

To change the values in this dialog box:

1. Click once to set the pointer in the box you want to edit.
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2. Type in the new value. 

Note:
By default, the format for the task Time Requirement value and other time 
values in IMPRINT Pro is HH:MM:SS.mm, and the colons are required. You 
may change the current time format to a different format through the Time tab 
in the Preferences dialog, located under the Edit menu.

Task Information Dialog Box – Effects Tab
In this dialog, you can enter arithmetic or logical expressions to control 
when a task is released during a model run and what effect its execution 
will have on other parts of the model (variables, tasks,.etc.) You can also 
enter task priority and interrupt strategy.

The following are detailed descriptions of the properties in the Effects tab.
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Task Priority. Task priorities are used to execute priority-based 
workload management strategies. The priorities range from 1.0 
(highest priority) to 5.0 (lowest priority). New tasks are assigned 
a priority level of 3.0 (medium). To change a priority level for a 
task, click in the task priority field and enter a priority value 
between 1.0 and 5.0, or click the drop box in the task priority field 
and select a priority from the list.

Note:
For all models imported or updated from previous versions of Pro using the 
convention of highest priority as 5 and lowest priority of 1, IMPRINT Pro will 
automatically convert, upon import, those previous priority values to the new 
convention where 1 is highest and 5 is lowest.

Interrupt Strategy. The interrupt strategy is used to describe 
whether the task can be resumed after being interrupted or if it 
needs to be restarted. Tasks in the Resume category can pick 
up where they left off. In contrast, tasks in the Restart category 
pay a time penalty for interruption. They must start over again. 
To change the interrupt strategy, select either Resume or 
Restart from the Interrupt Strategy box.

Release Condition. Release Condition is an expression that 
determines whether or not the task can execute. A task can 
execute only when the expression in the release condition 
evaluates to true. The default value is return (true);

A Release Condition can be useful in the event you have a 
mission which contains tasks that you want to execute only 
under certain conditions. For example, it would not make sense 
for a tank commander to issue a fire command while the loader 
is loading the ammunition. Rather, he must wait until the loading 
is complete. To ensure that tasks are released only when the 
state of system has reached an appropriate point or when 
required resources are available, you need to use a release 
condition return (loading == false); or return 
(loading==true); 

If you have used any multiple decision types in your model, you 
will need to use Release Conditions, Beginning and Ending 
effects, to rejoin the multiple paths at the proper point in the 
network.
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Release Conditions are used to check the state of a system 
before a task executes and suspend the execution of the task 
until a certain condition is met. A release condition is an 
expression that is False when the task is not available and has 
is True when the task is available. In order to restrict the 
conditions under which a task can execute, a release condition 
must be defined. To restrict the task's availability, define a 
release condition that is True only under the circumstances in 
which you want the task to execute. 

Semicolons delimit the release condition expressions. In 
building the expressions, you can use any of the arithmetic or 
logical operators, including the following:!<, &&, |, >, <, =,==, +, -
,*, and /. You can also use if-then-else and while-do statements. 
The assignment operator is =. The equivalence operator is ==. 
For more information on arithmetic or logical operators, see 
Expressions in IMPRINT Pro Syntax Reference Manual, Vol. 3 
of IMPRINT Pro User Guide.

You should exercise caution when adding expressions to a 
release condition for two reasons. First, a lockout condition can 
occur when a release condition is never met; the task is Locked 
out of the mission. When this occurs, you receive a Job can 
never be released message when the mission ends and a task 
is still waiting for its release condition to be met.

Second, it is very important that the release condition be used 
only for evaluating whether a job can be executed, rather than 
to initialize or set variables. This is because the release 
condition can be evaluated many times before a job is executed, 
causing all expressions in the release condition to be executed 
multiple times before the task actually is released, or started. 
For this reason, you should not use the release condition to 
increment variables. These sorts of expressions should be 
placed in the beginning effect.

Beginning Effect. This field contains optional expressions 
indicating what happens when the task begins execution. These 
expressions might be as simple as setting new values for one or 
more variables in your model, or they could be much more 
complicated expressions.
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Once the beginning effect occurs, the task execution time is 
calculated. As the beginning effect is evaluated, the 
corresponding node in the network diagram highlights if the 
node is visible in the network diagram. Lastly, once all code in 
the beginning effect code box has been evaluated, any 
snapshots which were set to trigger on the execution of this task 
will be taken.

You can use beginning effects with tactical decision branching. 
When a task is specified as having more than one following task 
with a tactical decision type, tactical expressions are used to 
specify which route is taken. The variables in the tactical 
expressions can be assigned different values in beginning or 
ending effects of other tasks to establish the true condition for 
the tactical decision. To view variables, double-click Variables 
below the mission you are defining in the Analysis Tree. A list of 
Variables will display. Click a variable in the list to display its 
properties in the Properties dialog box.

For details on return statements, see Return Statements in 
IMPRINT Pro Syntax Reference Manual, Volume. 3 of 
IMPRINT Pro User Guide.

Ending Effect. This field contains expressions indicating what 
happens when the task finishes execution.

To set an ending effect for a task, double-click the task, click the 
Effects tab at the top of the task dialog, and enter the desired 
expression(s).

You may access Variables to aid in specifying any effects. To 
view Variables, double-click Variables below the mission in the 
Analysis Tree. A list of variables will display. Click the individual 
Variable to display the properties in the Properties dialog box.

Task Information Dialog Box – Failure Tab
IMPRINT Pro provides several possible consequences of task failure due 
to accuracy from which you can choose. These include:

Changing the time or accuracy on another task.

Changing the following task.

Causing the mission to abort, which is reported as an accuracy 
failure.

No effect.
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Changes the operator assigned to a task.

Task repeats.

Probabilities are assigned to each of these consequences to control which 
ones are likely to be exercised in the event a task fails. If a task does fail 
during a model run, IMPRINT Pro pulls a random number from its stream 
and compares it to the probabilities entered to determine which failure 
consequence it must implement.

Note:
If you choose to use the effect that assigns a different following task in the 
event of failure (such as choice 2 on the Failure Tab), make sure that you do 
not assign a rejoin task as the new following task. This will cause the model to 
run incorrectly. For more information about Multiple decision type, see 
Decision Type in the “Task Information Dialog Box – Paths Tab” on page 157.
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Task Information Dialog Box – Crew Tab
When you click the Crew tab you will see two columns as follows:

Warfighter Name. Shows the list of Warfighters that are added 
to your analysis when you populated your IMPRINT Pro 
Warfighters node. 

For details on defining Warfighters, see “Warfighter Data” on 
page 67.

Assignment. For each task, you must identify a Primary 
Operator. You may optionally identify one or more Contingency 
Operators as well. Each task can only have one primary 
Warfighter assignment, but can have a maximum of six 
contingency Warfighters. Contingency Warfighters will perform 
the task in the event that the primary Warfighter experiences 
workload overload. The workload management strategies, 
discussed in “Operator Workload Management Strategies” on 
page 74 describe how this works.

Task Information Dialog Box – Taxons Tab
Tasks can be broken down into a separate set of categories called Taxons. 
This categorization is used to describe the workload composition of your 
task in a way that PTS moderators can utilize when the conventional 
workload definitions cannot. When taxons are applied to a task, they are 
used by IMPRINT Pro to adjust estimated task times and accuracies as 
appropriate whenever Personnel Characteristics, Training Frequency or 
Stressor adjustments are applied.

The taxons are grouped into four areas. These four taxon categories are:
148



Chapter 5: Mission Analysis
Perceptual

Cognitive

Motor

Communication

Taxons are assigned weight values ranging from 0.0 to 1.0. At most, three 
taxon weights can be used at a time, the sum of which must be 1.0. At the 
bottom of the screen, the total of the weight values is labeled Total 
Weight. IMPRINT Pro automatically adds the taxon weight values as you 
enter them. Click in the box to see the total.

Mapping Workload Values to Taxons
In earlier versions of IMPRINT (IMPRINT 7) only certain types of models 
(Goal Orientation and VACP) were able to have assigned taxons in order to 
exercise PTS moderators. Advanced models were excluded from this 
functionality. In IMPRINT Pro, all models can now have assigned taxon 
values and take advantage of the PTS Moderators option. 
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You may choose your own taxons for the tasks and enter your own taxon 
weights manually (as mentioned in the section above) or you may map 
existing workload demand values to taxons automatically. When mapping 
values automatically, however, it should be noted that each task is allowed 
only three taxon weights. In the event a task has more than three workload 
channels to which workload is assigned, all of which might map to different 
taxons, only the three highest workload scores will be chosen for taxon 
mapping. Once the selected workload channels are mapped to taxons, the 
three workload demand values are summed and normalized, determining 
the proportional weights of these corresponding taxons.

IMPRINT Pro maps the following workload channels and their 
corresponding demand values to taxons as shown in the table below:

Workload Demand Value Taxon Mapping

Visual without night vision goggles

3.0 - Visually Register/Detect All Visual workload scores (without 
night vision goggles) EXCEPT for 
Visually Read (see below) map to 
Visual Recognition/Discrimination.

3.0 - Visually Inspect/Check

4.0 - Visually Locate/Align

4.4 - Visually Track/Follow

5.0 - Visually Discriminate

6.0 - Visually Scan/Search/Monitor

5.1 - Visually Read Communication - Read and Write

Visual with night vision goggles

ALL Workload scores for Visual with night 
vision goggles are generally higher 
than those for Visual without night 
vision goggles. However, this scale 
does not have a scale benchmark for 
reading. Therefore all Visual with night 
vision goggles scores map to Visual 
Recognition/Discrimination.

Auditory

1.0 - Detect/Register Sound Does not map any taxon.

2.0 - Orient to Sound (general)

4.2 - Orient to Sound (selective)

4.3 - Verify Auditory Feedback
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3.0 - Interpret Semantic Content 
(speech) Simple (1-2 words)

Communication - Oral

6.0 - Interpret Semantic Content 
(speech) Complex (sentence)

6.6 - Discriminate Sound 
Characteristics

7.0 - Interpret Sound Patterns

Cognitive

1.0 - Automatic (simple association) All values below 7.0 map to 
Information Processing/Problem 
Solving1.2 - Alternative Selection

3.7 - Sign/Signal Recognition

4.6 - Evaluation/Judgement (single 
aspect)

5.0 - Rehearsal

5.3 - Encoding/Decoding, Recall

6.8 - Evaluation/Judgement (several 
aspects)

7.0 - Estimation, Calculation, 
Conversion

Numerical Analysis

Fine Motor

2.2 - Discrete Acuation (button, toggle 
trigger)

Fine Motor Discrete

2.6 - Continuous Adjustive (flight 
control, sensor control)

Fine Motor Continuous

4.6 - Manual (tracking) Fine Motor Discrete

5.5 - Discrete Adjustive (rotary, 
vertical thumb wheel, lever position)

Fine Motor Discrete

6.5 - Symbolic Production (writing) Communication - Read and Write

7.0 Serial Discrete Manipulation 
(keyboard entries)

Fine Motor Discrete

Other user values Fine Motor Discrete

Speech

Workload Demand Value Taxon Mapping
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When mapping to tasks automatically, you may choose to map workload 
scores for all tasks in your model at once, or you may map them 
individually on a task by task basis.

To Map Workload Values to Taxons by Individual Task:

1. Enter the workload demand values for your task under the Workload 
Demand Tab in the Task Information dialog box.

2. Click the Taxons tab.

3. At the bottom of the tab, click the Map Workload Values button.

Taxon weights corresponding to your task’s workload scores appear.

The number of taxons you may have in any one task is limited to three. If a 
task in your network contains more than three workload demand values, 
the three largest workload demand values are chosen for taxon mapping. 
These values are then normalized to a sum of 1.0

2.0 - Simple (1-2 words) All Speech values (including user 
defined) map to Communication - Oral4.0 - Complex (sentences)

Gross Motor

1.0 - Walking on Level Terrain Gross Motor Light

2.0 - Walking on uneven terrain

3.0 - Jogging on Level Terrain Gross Motor Heavy

3.5 - Heavy Lifting

5.0 - Jogging on Uneven Terrain

6.0 - Complex Climbing

Tactile

1.0 - Alerting Does not map to any taxons.

2.0 - Simple Discrimination

3.0 - Complex Symbolic Information

Workload Demand Value Taxon Mapping
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To Map Workload Values to Taxons Globally (all tasks):

1. Enter the workload demand values for all tasks under the Workload 
Demand Tab in the Task Information dialog box.

2. From the Moderators menu, choose the Map Workload to Taxons 
option.

A dialog box appears reminding you that all tasks with workload 
demand values but without taxons will have their demand values 
mapped to taxons.

3. Click the Ok button.

4. Workload scores for all tasks in the network map to taxon values. In the 
Taxons tab for each task, all applicable taxon categories are checked, 
and their corresponding taxon weights appear in the Taxon Weight 
fields.

Note:
All tasks whose workload demand values were previously mapped to taxons 
will not be affected by this action.

The Output window displays a summary of the tasks whose values 
were mapped.
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Workload Mapping Example

1. Assume a given task has the following workload assigned:
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2. Choose the option to map workload scores, either by clicking the Map 
Workload Values button on the task’s Taxons tab or by choosing the 
Map Workload to Taxons option through the Moderators menu. 
IMPRINT Pro allows a maximum of three workload scores to be 
mapped to taxons. In our example above, the Fine Motor 2.6 
Continuous Adjustive score is omitted.

3. The remaining workload scores are mapped to taxons as follows:

Channel Workload Score

VisualCrewstation 4.0 - Visually Locate/Align

Auditory/Crewstation 6.0 - Interpret Semantic Content

Cognitive/Crewstation 7.0 - Estimation/Calculation

Fine Motor/Crewstation 2.6 - Continuous Adjustive
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4. Workload scores are totalled:

5. Taxon weights are calculated by normalizing the workload scores:

The taxon mapping weight for Visual Recognition/Discrimination:

The taxon mapping weight for Communication - Oral:

The taxon mapping weight for Numerical Analysis:

Workload Score Mapped Taxon

4.0 - Visually Locate/Align Visual Recognition/Discrimination

6.0 - Interpret Semantic Content Communication - Oral

7.0 - Estimation/Calculation Numerical Analysis

4.0 6.0 7.0 17.0=+ +

4.0 17.0÷ 0.24=

6.0 17.0÷ 0.35=

7.0 17.0÷ 0.41=
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Task Information Dialog Box – Paths Tab
The Paths tab contains the Decision Type and Decision Code describing 
the conditions under each of the individual paths leaving a task are taken.

IMPRINT Pro uses three different decision types: Tactical, Probabilistic, or 
Multiple. The decision type determines the path or paths that an entity 
should take. A decision node displays in the network diagram as a 
diamond-shape on the end of a task node and contains a letter inside of it 
(T, P, or M) indicating the type of decision. 

Decision nodes are automatically added to a task by IMPRINT Pro. 
Whenever a task has more than one possible path emerging from it, the 
logic for the Decision code determines the paths that the entity takes.
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Decision Type. Displays the type of decision. Available types 
are:

Multiple. All of the following paths begin execution 
simultaneously following execution of the current task. When 
this happens, the entity exiting the current task splits into copies 
of itself, each following one of the paths. In some instances of 
Multiple branching logic, however, it is important to make sure 
that all branched entities eventually merge back into one single 
entity at a rejoin node before reaching the End task of the 
model. For more information see “Merging Split Entities” on 
page 168.

In Multiple branching, you may repeat a task back onto itself by 
drawing a path from the task’s decision diamond to the center of 
the node - a new path appears as a loop above the node in the 
network diagram, and a new code box appears in the Paths tab 
in the Task Information dialog box. This path will continue to 
loop back to this same task until this path’s code no longer 
evaluates to true.

The default decision type for a single path exiting a task is a 
Multiple decision type.
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Probabilistic. In the case of a Probabilistic node, more than 
one path might be linked to the current task, but only one of 
those paths may execute after the current task is completed. 
The likelihood of a path executing next is determined by a 
probability value that is set for this particular path in the current 
task’s routing conditions. The probability that a particular path 
follows is equal to its probability value in the Decision Code field 
divided by the sum of the probability values of all possible 
following paths.

Example: If the probability value is 25 percent for path A, you 
could enter .25, 1, or 25 in the Decision Code for path A and 
enter .75, 3, or 75 respectively, for the Decision Code for path B.

The likelihood of a task is taken as a ratio of the sum of the 
value for all tasks.

Tactical. The path with the tactical expression that evaluates to 
the highest value executes next; you supply the tactical 
expression as the routing condition.

In Tactical branching, you may repeat a task back onto itself by 
drawing a path from the task’s decision diamond to the center of 
the node - a new path appears as a loop above the node in the 
network diagram, and a new code box appears in the Paths tab 
in the Task Information dialog box. This path will continue to 
loop back to this same task provided this path’s code evaluates 
to the highest value among all paths.

In multiple routing, the 
entity splits into two or 
more entities with the 
same value.
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Note:
In Tactical decision branching, if all paths evaluate to true, the path drawn first 
is the path that is taken. If all paths evaluate to zero or false, one path must 
still be taken, namely the one that was drawn first.

Decision Code. Contains the conditions under which particular 
paths are taken. You can express the routing condition as a 
number or an expression. The number and name of the next task 
to be executed when the routing conditions are met display 
above the Decision Code box. You must include a return 
statement in the expressions defining the decision code. 

For details on return statements, see Return Statements in Syntax 
Reference Manual, Vol.3 of IMPRINT Pro User Guide.

Task Information Dialog Box – Workload Demand Tab
Workload demand values are entered based upon the nature of the 
demand. These values will be used to compute the first order workload 
components during model execution. The values should indicate the 
relative demand on each channel when performing a task.

Prior to entering workload demand values, however, you must first add 
your resources and interfaces, determine the resource-interface (RI) pairs 
and then assign the applicable workload value to each of these pairs for 
the given task. For more information on creating RI pairs, see“Defining 
Resource-Interface Channels” on page 197.

The Workload Demand dialog box displays two tabs: Interfaces and 
Values. In the Interfaces tab, you first check the boxes corresponding to 
the interfaces which apply to your task, for example “Radio” and “Steering 
Wheel”. This action then filters the Values tab to display workload boxes for 
only those RI channel pairs whose interfaces you selected, for example 
“Auditory-Radio” and “Fine Motor-Steering Wheel”. In these boxes you may 
then enter the desired workload amounts for each channel your task 
requires.
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By default, each task includes a starting interface called “Crewstation”, but 
you may choose to create your own interfaces in the Analysis Tree.

Once the interfaces appropriate to your task are checked, click the Values 
tab. A worksheet displays, showing all applicable resource-interface 
channels in the first column to the left. Demand values corresponding to 
these resource-interface channels display in the adjacent cells under the 
Demand Value column. Any demand values previously entered are 
displayed in the cells. The default demand value is zero. The worksheet 
scrolls left and right and up and down if necessary.
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If the channel involves one of the seven default resources (Auditory, 
Cognitive, Fine Motor, Gross Motor, Speech, Tactile and Visual) then 
demand value may be entered automatically.

To enter Automatic Task Demand Values:

1. Under the Demand Value column, click the cell corresponding to the 
RI-pair whose demand value you wish to set.

2. Click the Auto button to the right of the dialog box. This button displays 
as “...”.

The Automatic Task Demand Value dialog window opens. This 
window displays a scale of workload amounts from which to choose.

3. From the list of available demand values, select the one whose 
workload value and description most accurately reflects the workload 
required by this task. For more information, see Task Demands. 
162



Chapter 5: Mission Analysis
4. Click the automatic task demand value that best indicates the relative 
demand on the channel when performing the task, and then click OK.

The value appears in the Demand Value cell for that RI-pair in the 
Workload tab.

Alternatively, you may cancel out of the Demand Value dialog without 
selecting a demand value:
• Click Cancel to return to the Workload Demand tab. The Demand 

Value will remain unchanged with no new Demand Value entered in 
the Workload Demand dialog box.

• Click the  in the upper right hand corner of the Automatic Task 
Demand Value dialog box.

Note:
If you defined resources in addition to the default resources, you will not have 
the automatic entry option. To enter a demand value manually, click once in 
the demand field and use the numeric, backspace, and delete keys to 
manually enter a value.
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Editing Tasks

To edit a task:

1. To display the Task Description dialog box, do one of the following:
• On the network diagram, double-click the task.
• Double-click the Task node in the Analysis Tree.

The Task Description dialog box appears in the main IMPRINT Pro 
window, displaying all properties of this task. These same properties 
also display in the Properties window.

2. Edit the properties in the Task Description dialog box or Properties 
window as desired.

For details on task properties, see “Task Information” on page 184.

Deleting Tasks

To delete a task:

Do one of the following:
• Right-click the task in the Analysis Tree, and then select Delete 

Task from the menu that displays.
• Right-click the task on the network diagram and select Delete Task 

from the menu that displays.
• Select the task, and then press the Delete key on the keyboard. 

The task is removed.

Note:
When you select an network object, a green box displays around the item.

Copying Tasks

To copy a task:

Do one of the following:
• On the Network Diagram, right-click the task, and then select Copy 

Task from the menu that displays.
• In the Analysis Tree, right-click the task, and then select Copy Task 

from the menu that displays.
• Select the task, and then select Copy from the Edit menu.
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• Select the task, and then click the Copy button on the tool bar.

The selected task copies to the Windows clipboard. Once a task is 
copied, it can then be pasted into another function or network diagram 
in IMPRINT Pro.

Cutting Tasks

To cut a task:

Do one of the following:
• Right-click the task on the Network Diagram or and then select Cut 

Task from the menu that displays.
• Right-click the task in the Analysis Tree, and then select Cut Task 

from the menu that displays.
• Select the task, and then select Cut from the Edit menu.
• Select the task, and then click the Cut button on the tool bar.

The cut task appears highlighted in red in the Analysis tree. Once the 
cut task is pasted into another function or Network Diagram, 
IMPRINT Pro removes the task from its current location and adds it to 
the new location.

Pasting Tasks

To paste a task:

Copy or cut the task and do one of the following:
• Right-click the network diagram and select Paste Node(s) from the 

menu that displays.
• Right-click in the Analysis Tree, and select Paste Node(s) from the 

menu that displays.
• Select the Function or Network Diagram to which you want to paste 

the task, and then select Paste from the Edit menu.
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• Select the Function or Network Diagram to which you want to paste 
the task, and then click the Paste button on the tool bar.

The task appears in the selected network diagram and in the tree. If you 
used the Cut command, the cut task will be removed from its previous 
location once pasted to its new location.

Note:
If you are pasting the task to a network inside a different analysis, the Task 
Data Mapping dialog box will display. For more information on how to use the 
Task Data Mapping dialog, see “Pasting Objects to Mission Model or Analysis” 
on page 100.

Dummy Nodes
Sometimes it is convenient to use dummy nodes to clarify the flow of your 
mission. These dummy nodes can be either functions or tasks that will act 
as placeholders in the function or task list and in the sequence. If you add a 
dummy function, you must also add dummy task to that function. By not 
assigning times to these nodes, they will not take any time in the mission 
simulation model and thus will not have an impact on mission time. It is for 
this reason that some of the functions and tasks in the library models have 
a performance time estimate of 0.

Single, Multiple and Splitting Entities
The flow of any model is determined by the types, order and duration of the 
nodes defining it. For basic models, it is easy to picture this flow in the 
network diagram. More complex models, however, may have nodes which 
repeat or have multiple instances fire at the same time. To keep track of all 
these instances, it is helpful to use the concept of “entities.”

An “entity” is an imaginary element which flows through a network of tasks, 
the location of which describes the task in the network whose release 
condition, beginning effect or ending effect is currently being evaluated. 
Although tasks and functions in your model are driven by the order and 
duration you set for the individual tasks and functions in the model, it is 
sometimes easier to think of the flow of the model as a series of functions 
and tasks through which an imaginary element, or “entity”, travels. For 
example, directions from a house to the local store could be viewed as a 
distinct set of turns, straightaways and stoplights along a series of streets 
and highways. The streets and highways in this example are analogous to 
the tasks and functions added to the model and their distances analogous 
to function and task durations. The straightaways, turns and stops are 
similar to the paths in your network. To pinpoint the exact location along 
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the route being traveled at the current time, however, is much easier to 
conceptualize by imagining a car following the exact route of streets and 
highways, guided by the turns and stoplights prescribed. Similarly, an entity 
may also be thought of as the marker in the model indicating which task is 
currently being exercised in the model, guided by the path logic and code 
added.

Any model can be designed to use a single entity, multiple entities or 
splitting and merging entities.

Single Entity. Models comprised of simple networks that lead 
an entity though a simple chain of tasks and functions from Star 
to End will most likely have a single entity flowing through them. 
These types of models do not contain repeating or spinning 
tasks, multiple branching, External Events or Model.Start calls 
anywhere in the model. To illustrate this using the driving 
example above, we can picture a single car starting at the initial 
location which follows a simple series of streets to its ultimate 
destination. 

Multiple Entities. Multiple entities can be found in any model in 
which two or more tasks in a network are active at the same 
time. While the first entity might originate at the Start node of the 
model during model execution, the second entity (or any other 
additional entity) could be started at any point during the model 
run using an External Event, a looping task or Model.Start 
command from another node in the model. In the car example 
above, in addition to the original car on the route, several 
additional cars are added to the route and will drive along some 
of the exact same streets as the first node, just as multiple 
entities might enter the same exact tasks as the first entity. 
These cars might start at the beginning of the route as well or 
might instead pop up in the middle of the route at a particular 
time.

Splitting and Merging Entities. The most common occurrence 
of a splitting entity in a model is when a node splits off into 
multiple paths, and the “Multiple” path logic is followed. In this 
case, the entity leaving the original node then splits into several 
copies of itself to follow all branching paths. It is important to 
note, however, that splitting entities which are generated this 
way are different from the multiple entities mentioned above 
which generate “additional” entities through loops, Model.start 
commands and External Events, namely because any entity 
which splits at a branch must eventually merge back into one 
branch again at a later point in the model. The point at which the 
branches rejoin is referred to as the “rejoin node,” the location at 
which the split entities would ideally merge.
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Using the car example above, assume a car has a driver and 
three additional passengers. This car travels along the 
prescribed route in a neighbourhood, just as an entity would 
follow a path in a network. A decision is made, however, to stop 
the car at the local shopping mall where the driver goes into the 
grocery store for a gallon of milk, the first passenger goes into 
the post office to deliver a package, the second passenger picks 
up some coffee at the local cafe and the third picks up the dry-
cleaning. The single car full of people splitting up into four 
separate parties each running an errand represents the single 
entity splitting into four partial entities at a Multiple branch 
decision node. Just as each person in the group is capable of 
completing different errands at the shopping mall by his/herself, 
each of the partial entities along the multiple paths are all 
capable of completing separate tasks and advancing the 
simulation clock. Furthermore, just as all four passengers should 
wait at the car for everyone to return before continuing on the 
road, all partial entities flowing through the separate branches of 
the Multiple branch of a network should wait before the release 
condition of the rejoin node in order that all split entities may 
eventually merge back into a single entity. Once all entities from 
the original split have merged, the merged entity may continue 
on through the rest of the network. For more information see 
“Merging Split Entities” on page 168.

Merging Split Entities
Merging split entities at a rejoin node can be done two different ways:

To Merge Split Entities using Multiple Variables: 

1. Define a unique variable for every branch exiting a defined Multiple 
decision node in your network. For example, in the case of a decision 
node splitting into two branches, define two variables named A and B. 

2. In the ending effect of the last task in the first branch connecting to the 
rejoin node, add the following statement:

A=1;

3. In the ending effect of the last task in the second branch connecting to 
the rejoin node, add the following statement:

B=1; 
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4. Finally, In the release condition of the rejoin task, add the following 
statement:

return (A==1 && B==1); 

This statement ensures that the rejoin node starts only after both 
branches have finished. By suspending the release of the rejoin node 
until both branches have finished, both split entities are able to meet 
together and merge joining the two paths back to a single task, the 
entities merge into one entity again.

To Merge Split Entities using a Decrementing Variable:

1. Define a unique integer variable, for example variable A.

2. Set the initial value of A to the number of branches exiting the Multiple 
Decision node where the entity first splits. For example, if three tasks 
branch from a single task, set the initial value of Variable A to be 3.

3. In the ending effect of the last task in the first branch connecting to the 
rejoin node, add the following statement to decrement the value of A by 
one:

A--;

4. Repeat step 3 above until this statement appears in the Ending Effect of 
the last task in each branch connecting to the rejoin node.

5. In the Release Condition of the rejoin node, add the following 
statement:

return (A==0);

Each path, upon finishing, decrements the value of A by one. Once the 
third and final path has finished out, the value of A will have been 
reduced three times and become 0. It is at this point where all three 
entities, waiting in front of the release condition of the rejoin node, are 
merged into one entity which then flows into the rejoin node task.
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Tagging Entities
Entity Tagging is a method used to uniquely identify one or more entities in 
your model. A tag is an attribute assigned to an entity, much like a license 
plate is assigned to a car or a social security number is assigned to a 
person. By tagging entities, each entity can be followed throughout the 
model as it runs. Furthermore, a model can be designed to perform specific 
actions on specific entities or can cause an effect in a task (release 
condition, beginning effect or ending effect) to occur as a result of a 
specific tagged entity passing through.

As multiple entities flow through a model, it is possible that they can all flow 
through separately if the model is specifically designed to allow this. In 
cases where more entities are untagged and waiting in front of the same 
release condition (waiting for it to turn true), the entities will instead be 
merged together as one single entity before entering the beginning effect of 
this task. By tagging the entities earlier in the model, entities will retain their 
unique identification throughout the model run provided no other entity is 
assigned the same exact tag value elsewhere in the model.

By default, the first entity to run through the model during execution is 
assigned a tag value of 0. Tagging subsequent entities requires the 
following steps be followed:

1. Identify the location in the model where multiple entities are likely to be 
generated, such as a task looping back on itself while simultaneously 
branching off to a subsequent task, using the Multiple path logic. In this 
case, since both paths are taken the original entity will pass through to 
the next task while a new entity is generated and passes back through 
the start of the original task.

2. Determine the phase of that task where the unique identification of the 
entity must be set. In our looping example, the entity tag value can be 
changed either in the beginning effect or the ending effect of the task.
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3. Increment the tag value. To the desired effect of the task, add the 
following statement:

Entity.tag++;

Where “.tag” refers to the attribute of the entity passing through and 
“++” implies that the value of the tag assigned to the entity should be 
incremented by 1. After the entity passes through this task, its tag value 
is unique to the entity which passed through before it.

To illustrate entity tagging, consider the example below where airline 
passengers arrive at the airport and must go through security screening 
before proceeding to the gate. The first image below demonstrates the 
process for a single passenger:

To create multiple passengers in the model, multiple entities must be 
created in the “Passenger Arrives at Security Checkpoint” task. To 
create these multiple entities, create a loop from the end of this task 
back onto itself.

Since the task now has two paths leaving it, the decision diamond 
displays an “M” indicating “Multiple” path logic meaning any entity 
leaving the task will take both paths. Because the same entity must take 
both paths, however, it must create a new copy of itself (a new entity, 
but with an identical tag value) to follow the path back to the original 
task while it also takes the path   Until entities are uniquely tagged, 
however, all entities will share the same default tag value of 0 and could 
potentially merge further down in the model. To prevent this accidental 
merging of entities, open the Effects tab of the task, and add the 
command “Entity.Tag++;” to the ending effect of this task.
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Any task entering and leaving this task will automatically have its tag 
value incremented by one. The first entity to pass through this task in 
the model, with a default tag value of 0, will automatically be assigned a 
tag value of 1. As the entity splits at the multiple node, one instance of 
itself (tag value of 1) passes along to the next task, “Passenger 
Directed.” Meanwhile the second instance of this entity (also has a tag 
value of 1) returns back to the “Passenger Arrives at Security 
Checkpoint” task. This time as the task passes through, its tag value is 
incremented by one again, and it leaves with an entity tag value of 2. 
Each uniquely tagged entity can then be tracked throughout the model 
by monitoring the entity tag value.

Goals
By adding goals, you can model possible mission interruptions and the 
additional workload Warfighters may experience. Adding goals allows you 
to:

Identify goals that may or may not conflict with the main mission

Set initiating conditions to initiate goals
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Prioritize goals

Build task network models representing goals that run when 
goals are activated/encountered

Specify each goal’s impact on the mission and other goals

Adding Goals
Goals orientation logic can be added to the uppermost level of your 
mission. Goals are placed on the network diagram but do not connect to 
functions or tasks in your mission. 

To add a goal:

Do one of the following:
• Right-click the Network node in the Analysis Tree, and then select 

Add Goal from the menu that displays.
• From the task network palette, drag the Goal object to the network 

diagram.
• Right-click the network diagram, and then select Add Goal from the 

menu that displays.

The new goal displays in the network diagram.

Note:
IMPRINT Pro will name your new goal Goal. If you continue to add goals, 
each following goal will be named GoalX where X is the next integer. You can 
edit the name of the goal in the Name field in the Goal Properties dialog box.

Note:
IMPRINT 7 models whose mission types changed from Goal-Orientation to 
Advanced prior to import will potentially import into IMPRINT Pro with goals 
attached. This will occur if any goals remained before the mission type was 
changed. Once imported into IMPRINT Pro, these goals may then be deleted 
as required.

Displaying Goal Properties

To display the goal properties:

Double-click the goal object in the Analysis Tree.

A Goal Properties window displays.
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The top of the Goal Information window lists the ID, name and description 
of your chosen goal.

The Goal Properties window also displays three separate tabs:
• Info. Basic information about your goal, including Priority, impact on 

Mission, Time Requirement and Criterion, displays in this window.
• Initiating Condition. Enter code in the Initiating Condition tab to 

determine the triggering of this goal. A goal fires when its initiating 
condition evaluates to True.

• Goal Actions. Select the effect this goal has on other goals in your 
mission. Options include Abort, Interrupt and Nothing.

Goal Properties - Info Tab
The Info tab contains the following fields:
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Priority. A number assigned to a goal to determine its priority 
relative to other goals. You may set a higher priority goal to abort 
or interrupt a lower priority goal.

Mission Running. The value in this field determines the impact 
that this goal has on the current mission. You may designate that 
the goal may interrupt or do nothing to the mission.

Time Requirement. This value is the maximum acceptable 
performance time for this goal.

Criterion. This value is the percentage of times that this goal 
must meet its time standard to be considered successful.

Workload Management Suspension. This flag controls 
whether or not a workload strategy is suspended in if an operator 
who is currently working on a task is interrupted by a goal whose 
workload amount would put him or her in an overload situation. 
For example if an operator were driving a car and a cell phone 
call (represented by a goal function) occurred, there is a 
possibility that the total workload incurred by driving and 
answering the call would put the operator in an overload 
condition. By setting the Workload Management Suspension flag 
to True, the management strategy assigned to the operator is 
suspended, and the operator continues to do both tasks in the 
overloaded state. By setting the Workload Management 
Suspension flag to false, the management strategy you choose 
is allowed to take over to prevent the operator from continuing in 
an overloaded state. 

Goal Properties - Initiating Condition Tab
The Initiating Condition tab contains the following field:
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Initiating Condition. The initiation condition field allows you to 
define trigger conditions for initiating goals. Examples of trigger 
conditions are that performance is out of line with desired 
criteria; workload levels approach severe; or some other external 
condition. These trigger conditions must be represented by 
expressions in this field.

Goal Properties - Goal Actions Tab
The Goal Actions Tab contains the following fields:

Other Goal Name. This is the name of another goal in your 
mission upon which your selected goal will act.

Priority. This is the current priority assigned to the listed goal. 
The lower the number, the higher the priority, for example a goal 
with a priority of 1 has a higher priority than a goal with a priority 
of 5.
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Goal Action. This is the action which your selected goal will take 
on the listed goal. Options include Interrupt, Abort and Do 
Nothing.

Editing Goals
You can edit the goal in the Goal information dialog box or Properties 
window.

To edit a goal:

1. In the Analysis Tree, below the Network node, double-click the goal.

The Goal dialog box displays in the main window, displaying properties 
of this goal. The Properties window also updates to display the same 
information.

2. Make changes in the Goal dialog box or Properties window as desired.

Deleting Goals
Using the delete command to will delete the goal and all its associated date 
from the mission. 

To delete a goal:

Do one of the following:
• Select a goal in the Network Diagram or the Analysis Tree, and then 

press the Delete key on the keyboard. 
• Right-click the goal in the Analysis Tree, and then select Delete 

Goal from the menu that displays.
• Right-click the goal on the network diagram, and then select Delete 

Goal from the menu that displays.

The goal is removed.

Copying Goals
A goal and all its associated data can be copied and pasted into another 
network. 
177



IMPRINT Pro Basic Procedures
To copy a goal:

Do one of the following:
• Right-click the goal on the network diagram, and then select Copy 

Goal from the menu that displays.
• Right-click the goal in the Analysis Tree, and then select Copy Goal 

from the menu that displays.
• Select the goal in the Network Diagram on in the Analysis Tree, and 

then click the Copy button on the tool bar.
• Select the goal on the Network Diagram or the Analysis Tree, and 

then select Copy from the Edit menu.

The goal and all its associated data will be added to the Windows 
clipboard.

Cutting Goals

To cut a goal:

Do one of the following:
• Right-click the goal on the Network Diagram, and then select Cut 

Goal from the menu that displays.
• Right-click the goal in the Analysis Tree, and then select Cut Goal 

from the menu that displays.
• Select the goal in the Network Diagram or the Analysis Tree, and 

then click the Cut button from the tool bar.
• Select the goal in the Network Diagram or the Analysis Tree, and 

then select Cut from the Edit menu.

The cut goal highlights in red. When you paste the goal into another 
network, IMPRINT Pro removes the goal from its current location and 
pastes it to the new location.

Pasting Goals

To paste a goal:

Copy or cut the goal and do one of the following:
• Right-click the network diagram, and then select Paste Node(s) from 

the menu that displays.
• Right-click in the Analysis Tree, and then select Paste Node(s) from 

the menu that displays.
• Select the Network Diagram into which you want to paste the goal, 

and then select Paste on the Edit menu.
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• Select the Network Diagram into which you want to paste the goal, 
and then click the Paste button on the tool bar.

The goal appears in the selected Network Diagram and in the Analysis 
Tree under the node corresponding to that network. If you used the Cut 
command, the cut goal will be removed from its previous location.

Note:
If you are pasting the goal to a network node in a different analysis, the Task 
Data Mapping dialog box will display. For more information on how to use the 
Task Data Mapping dialog, see “Pasting Objects to Mission Model or Analysis” 
on page 100.

Adding Functions to Goals
When you build a goal network, it will have its own separate subnetwork. 
You can add functions, tasks, and comments to the subnetwork.

To add a function to a goal:

Do one of the following:
• Right-click the goal on the network diagram to which you want to add 

a function, and then select Add Function from the menu that 
displays.

• Right-click the goal in the Analysis Tree to which you want to add a 
function, and then select Add Function from the menu that displays.

• Open the goal network diagram, select the function object on the 
Palette, and drag it to the goal network diagram.

A new function appears below the goal in the Analysis Tree and in the 
goal diagram. 

Adding Tasks to Goals
By default, every goal contains a Start task and an End task in its 
subnetwork.  Additional tasks may be added as needed.

To add a task to a goal:

Do one of the following:
• Right-click the goal on the network diagram to which you want to add 

a task, and then select Add Task from the menu that displays.
• Right-click the goal in the Analysis Tree to which you want to add a 

task, and then select Add Task from the menu that displays.
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• Open the goal network diagram, select the task object on the Palette, 
and then drag it to the goal network diagram.

A new task appears below the goal in the Analysis Tree and in the goal 
diagram.

When adding new tasks to your goal subnetworks, it is important to keep in 
mind that the End task of the goal (the “999” task) should be the last task in 
the subnetwork to finish.  If one or more tasks in the subnetwork are started 
remotely by a Model.Start command from within an effect of another 
task, it is possible these tasks might not end prior to the 999 End task 
unless configured to do so.  To ensure that the subnetwork of any goal in 
your network having these kinds of tasks ends gracefully, the following 
steps are recommended:

To end goals having remotely-started tasks:

1. Add a new boolean variable, for example, “goalended”.

2. In the Ending Effect of the task that starts remotely, add the following 
code:

goalended == true;

3. In the Release Condition of the End task, add the following code:

Return goalended == true;

The End task of the goal subnetwork is released when the value of the 
variable is true.  This will only happen when the remotely-started task 
has already finished.

Adding Comments to Goals
Comments can be used to add headers for clarification, add other text to 
the diagram, and to display values of variables for display on the network 
diagram during the model run. 

To add a comment to a goal:

Do one of the following:
• Right-click the goal on the network diagram to which you want to add 

a comment, and then select Add Comment from the menu that 
displays.
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• Right-click the goal in the Analysis Tree to which you want to add a 
comment, and then select Add Comment from the menu that 
displays.

• Open the goal network diagram, select the comment object on the 
Palette, and then drag it to the goal network diagram.

A new comment appears below the goal in the Analysis Tree and in the 
goal diagram.

Review Goals, Functions and Task Data
IMPRINT Pro collects data from Goals, Functions and Tasks and 
summarizes this information in worksheets. You can view the worksheets 
by double-clicking the Network node in the Analysis Tree. 

To display Review Goals, Review Function and Review Tasks:

1. Double-click the Network node below a mission in the Analysis Tree.

A Review dialog box displays in the main window, and includes three 
tabs: Review Goals, Review Functions, and Review Tasks.

2. To view a particular window, select the corresponding tab at the top.

Review Goals
The purpose of this worksheet is to enable you to view all the goal data in a 
tabular format. These data are sorted in order of increasing goal function 
numbers. The worksheet scrolls left and right so that you can view all the 
columns. In addition, you can change the widths of individual columns by 
dragging their column dividers left or right. 

You cannot edit all the columns on this display. For instance, you cannot 
change the Goal ID or the parent function.
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Pasting Data from an Outside Application

Using the standard Windows shortcut keys (Ctrl+C and Ctrl+V), you can 
copy and paste data into this worksheet. This is handy if you have entered 
the data in an application such as Excel.

To paste data from outside your application:

1. Be sure that the columns in your source worksheet are in the same 
order and each column is in the same format (for example, 00:00:00.00 
for time values) as IMPRINT Pro expects. This will require that you 
format the entire sheet to a text format so that values in the format 
00:30:00.00 are not translated as 30:00.00. 

2. Go to your application and select the data that you want to paste into 
IMPRINT Pro. 

3. Copy the data to the Windows clipboard using Ctrl+C. Alternatively, 
you may right-mouse click and select Copy from the shortcut menu.

4. Open the Review worksheet.

5. Select the area into which you want to paste the data. 

6. Press Ctrl+V. Alternatively, you may right-mouse click and select Paste 
from the shortcut menu.

Be sure to double-check that the data are in the correct cells.
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Review Functions
The purpose of the Review Functions worksheet is to enable you to view all 
the function data in a tabular format. These data are sorted in order of 
increasing function identification numbers. The worksheet scrolls left and 
right so that you can view all the columns. In addition, you can change the 
widths of individual columns by dragging their column dividers left or right. 

You cannot edit all the columns on this display. However, you can change 
the function time standard and the function criterion data element values.

Pasting Data from an Outside Application

Using the standard Windows shortcut keys (Ctrl+C and Ctrl+V), you can 
copy and paste data into this worksheet. This is handy if you have entered 
the data in an application such as Excel.

To paste data from outside your application:

1. Be sure that the columns in your source worksheet are in the same 
order and each column is in the same format (for example, 00:00:00.00 
for time values) as IMPRINT Pro expects. This will require that you 
format the entire sheet to a text format so that values in the format 
00:30:00.00 are not translated as 30:00.00. 
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2. Go to your application and select the data that you want to paste into 
IMPRINT Pro. 

3. Copy the data to the Windows clipboard, using Ctrl+C. Alternatively, 
you may right-mouse click and select Copy from the shortcut menu.

4. Open the Review worksheet.

5. Select the area into which you want to paste the data. 

6. Press Ctrl+V. Alternatively, you may right-mouse click and select Paste 
from the shortcut menu.

Be sure to double-check that the data are in the correct cells.

Review Tasks
At the top of the Review Tasks window you will see the items Task Info, 
Task Demands, and Warfighter Assignments. Select the desired 
information by clicking the option button adjacent to the item.

Task Information 

The purpose of the Task Info worksheet is to enable you to view all the task 
data in a tabular format. These data are sorted in order of increasing 
function and task identification numbers. The worksheet scrolls left and 
right so that you can view all the columns. In addition, you can change the 
widths of individual columns by dragging their column dividers left or right. 
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You cannot edit all the columns on this display. For instance, you cannot 
change the Task ID, the parent function, or the task name. However, you 
can change most of the task performance data.

Pasting Data from an Outside Application:

1. Be sure that the columns in your source worksheet are in the same 
order and each column is in the same format (for example, 00:00:00.00 
for time values) as IMPRINT Pro expects. This will require that you 
format the entire sheet to a text format so that values in the format 
00:30:00.00 are not translated as 30:00.00. 

2. Go to your application and select the data that you want to paste into 
IMPRINT Pro. 

3. Copy the data to the Windows clipboard, using Ctrl+C. Alternatively, 
you may right-mouse click and select Copy from the shortcut menu.

4. Open the Review worksheet.

5. Select the area into which you want to paste the data. 
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6. Press Ctrl+V. Alternatively, you may right-mouse click and select Paste 
from the shortcut menu.

Be sure to double-check that the data are in the correct cells.

Task Demands

For each RI Channel and Task combination in the mission you will enter 
task demand values. These values will be used to compute the first order 
workload components during model execution. The values should indicate 
the relative demand on each channel when performing a task.

The window displays a worksheet with tasks and their respective parent 
functions displayed in the second and third columns from the left, and the 
resource-interface channels displayed across the top. The tasks are 
grouped by function, and the channels grouped by resource. The 
worksheet contains a cell for each demand value that would be required for 
any given RI channel and task pair. Any demand values previously entered 
display automatically. The default demand value is 0.00. The worksheet 
scrolls left and right and up and down if necessary.

Automatic Task Demands Value Dialog Box

If the channel involves one of the seven default resources (Auditory, 
Cognitive, Fine Motor, Gross Motor, Speech, Tactile and Visual) then you 
can enter a demand value automatically. 
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To enter a value:

1. Click in the cell of the Task Demands worksheet that corresponds to 
the desired task and channel.

2. Click the Auto button. This button appears as “...” on the right-hand 
side of the selected cell.

The Automatic Demands Value dialog box displays.

3. Click the desired demand value from the list.

4. Click OK.

IMPRINT Pro returns to the Task Demands worksheet. The selected 
Demand Value appears in the selected cell.

5. To cancel out of the Automatic Demand Value dialog and return to the 
Review Tasks tab, do one of the following:
• Click the Cancel button. 
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• Click the  in the upper right hand corner of the Automatic Task 
Demand Values dialog box.

No new Demand Value appears in the Task Demands dialog box.

Note:
If you defined resources in addition to the default resources, you will not have 
the automatic entry option. To enter a demand value manually, click once in 
the demand field and use the numeric, backspace, and delete keys to 
manually enter a value.

Demand Values for the Auditory Channel

If the channel involves the Auditory resource, IMPRINT Pro can suggest 
several different task demand values related to the auditory channel. The 
demand value chosen should be based on the nature of the auditory 
involvement required by the operator to perform the task at hand.

To select the desired task demand value:

1. Click the option that best describes the auditory involvement for that 
task.

2. Click OK.

IMPRINT Pro displays the demand value in the cell in the Task 
Demands worksheet.
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3. To close the window without specifying a value, click Cancel or click the 
 in the upper right hand corner.

Demand Values for the Cognitive Channel

If the channel involves the Cognitive resource, IMPRINT Pro can suggest 
several different task demand values related to the cognitive channel from 
which to choose. The demand value chosen should be based on the nature 
of the cognitive involvement required by the operator to perform the task at 
hand. 

To select the desired cognitive value:

1. Click the option that best describes the cognitive involvement for that 
task.

2. Click OK.

IMPRINT Pro will displays the selected demand value in the cell in the 
Task Demands worksheet. 

3. To close the window without specifying a value, click Cancel or click the 
 in the upper right hand corner.
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Demand Values for the Fine Motor Channel

If the channel involves the Fine Motor resource, IMPRINT Pro can suggest 
several different task demand values related to the fine motor channel from 
which to choose. The demand value chosen should be based on the nature 
of the motor involvement required by the operator to perform the task at 
hand. 

To select a desired fine motor value: 

1. Click the option that best describes the motor involvement for that task.

2. Click OK.

IMPRINT Pro displays the selected demand value in the cell in the Task 
Demands worksheet. 

3. To close the window without specifying a value, click Cancel or click the 
 in the upper right hand corner.

Demand Values for the Gross Motor Channel

If the channel involves the Gross Motor resource, IMPRINT Pro can 
suggest several different task demand values related to the motor channel 
from which to choose. The demand value chosen should be based on the 
nature of the gross motor involvement required by the operator to perform 
the task at hand. 
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To select a desired gross motor value: 

1. Click the option that best describes the gross motor involvement for that 
task.

2. Click OK.

IMPRINT Pro displays the selected demand value in the cell in the Task 
Demands worksheet. 

3. To close the window without specifying a value, click Cancel or click the 
 in the upper right hand corner.

Demand Values for the Speech Channel

If the channel involves the Speech resource, IMPRINT Pro can suggest 
several different task demand values related to the speech channel from 
which to choose. The demand value chosen should be based on the nature 
of the speech involvement required by the operator to perform the task at 
hand.

There are two options for the speech parameter: whether the operator 
must say one or two words or else an entire sentence. Assign a demand 
value for this parameter as follows:
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To select a desired speech value:

1. Click the option that best describes the number of words the operator 
must say.

2. Click OK.

IMPRINT Pro displays the selected demand value in the cell in the Task 
Demands worksheet. 

3. To close the window without specifying a value, click Cancel or click the 
 in the upper right hand corner.

Demand Values for the Tactile Channel

If the channel involves the Tactile resource, IMPRINT Pro can suggest 
several different task demand values related to the tactile channel from 
which to choose. The demand value chosen should be based on the nature 
of the motor involvement required by the operator to perform the task at 
hand. 

To select a desired tactile value: 

1. Click the option that best describes the motor involvement for that task.
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2. Click OK.

IMPRINT Pro displays the selected demand value in the cell in the Task 
Demands worksheet. 

3. To close the window without specifying a value, click Cancel or click the 
 in the upper right hand corner.

Demand Values for the Visual Channel

If the channel involves the Visual resource, IMPRINT Pro can suggest 
several different task demand values related to the visual channel. The 
demand value chosen should be based on the nature of the visual 
involvement required by the operator to perform the task at hand. 

To select the desired visual value:

1. Click the drop-down arrow on the Night Vision Goggles box to display 
the visual values of tasks that will be performed with or without night 
vision goggles.

2. Click the option that best describes the visual involvement for the task. 
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3. Click OK. 

IMPRINT Pro displays the selected demand value in the cell in the 
worksheet. 

4. To close the window without specifying a value, click Cancel or click the 
 in the upper right hand corner.

Note:
The Visual channel initially displays automatic demand values for the case 
where the operator does not use night vision goggles. To see a list of values 
corresponding to workioad incurred by an operator wearing night vision 
goggles, click the drop-down arrow next to the Night Vision Goggles field, 
and then select the With Night Vision Goggles option.

Warfighters Assignments

The Warfighter Assignments worksheet displays all tasks in the network 
and all Warfighters which are assigned to them. The first three columns in 
the worksheet display the Task ID, parent functions and names of the tasks 
in the network. Each subsequent column represents an individual 
Warfighters in the mission. At the intersection of any given task row and a 
Warfighter column is a combo box where the Warfighter assignment for 
that task is designated. Available assignments are Primary, Contingency 
and no assignment.
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A Warfighter or automation device must be assigned to each task in the 
mission. Each task can be assigned one primary operator. Each primary 
operator should be qualified and able to perform the task. 

It is also possible to assign up to six contingency Warfighters or devices. A 
contingency Warfighter will perform the task in the event that the identified 
primary Warfighter experiences workload overload. Tasks can be 
reallocated during the simulation only to the designated contingency 
operator. The workload management strategies, discussed in Chapter 4: 
“Warfighter Data”, describe how this works.

Operators that have primary responsibility cannot also be assigned 
contingency responsibility. 

RI Pairs
RI Pairs are the resources-interfaces channels used by the operators to 
perform tasks in a mission. In the Analysis Tree below the RI Pairs node, 
IMPRINT Pro automatically displays five default resources: 

Auditory

Cognitive

Fine Motor
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Gross Motor

Tactile

Speech

Visual

You can add and delete resources from the list. However, if you define 
additional resources, you must assign their task demand and conflict 
values manually. 

You also need to develop the interface list for your mission. Interfaces are 
controls and displays that the operator utilizes to perform the tasks in the 
mission. In the Analysis Tree below the RI Pairs node, IMPRINT Pro 
automatically displays a single interface:

Crewstation

You can add and delete interfaces from the list as desired. 

Displaying Resources and Interfaces

To display Resources and Interfaces;

1. Click the + adjacent to RI Pairs node in the Analysis Tree.

The Resources and Interfaces nodes display below the RI Pairs node in 
the Analysis Tree:

2. Click the + adjacent to Resources node to see a list of Resources; click 
the + adjacent to Interfaces node to see a list of Interfaces. 

Adding RI Resources
Seven default workload resources are provided within IMPRINT Pro. You 
can add more resources to the list if you desire. Each resource must have 
a unique name.

To add a resource:

1. Right-click Resources in the Analysis Tree.
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2. Select Add Resource from the menu that displays.

The new Resource is added to the list below the Resource node in the 
Analysis Tree. 

Note:
IMPRINT Pro will name your new resource Resource. If you continue to add 
resources, each following resource will be named ResourceX where X is the 
next integer.You can edit the name of a new resource in the Name field in the 
Resource Properties dialog box. Default resources can not be edited.

Adding RI Interfaces

To add an Interface:

1. Right-click the Interfaces node in the Analysis Tree.

2. Select Add Interface from the menu that displays.

The new interface is added to the list below the Interface node in the 
Analysis Tree. 

Note:
IMPRINT Pro will name your new interface Interface. If you continue to 
add interfaces, each following interface will be named InterfaceX where X 
is the next integer. You can edit the name of the interface in the Name field in 
the Interface Properties dialog box.

Defining Resource-Interface Channels
Resource-Interface channels, or RI Pairs, are defined by pairing up one 
resource with one interface, otherwise known as a “channel”. For 
example, pairing up a Fine Motor resource with a Gunner Station interface 
would result in the Fine Motor/Gunner Station channel.

It is also possible that two channels may conflict with each other in a 
workload situation, in which case it is possible to assign Channel Conflict 
Values.

Channels and Conflicts are defined at the RI Pairs level of your Analysis. 
Demands on each channel, however, must be specified for each task 
individually at the task level.
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To display Resource-Interface Channels and Conflicts:

Double-click the RI Pairs node in the Analysis Tree.

The RI Pairs dialog box displays. This dialog box includes two tabs: 
Channels and Conflicts. The Channels tab is selected by default.

The Channels tab comprises a matrix with interfaces down the first 
column and the resources across the top row. Each cell located at the 
junction of a resource and an interface in the matrix contains a single 
check box. When the box is checked, IMPRINT Pro combines that 
particular resource and interface to form a new channel. This channel 
then appears in the Workload Demand tab of the Task Information 
window for any task you select and is available for assigning workload 
to that task. Any previous resource-interface designations are indicated 
by checks in the boxes. The worksheet scrolls left, right, up and down to 
view Resource-Interface channels as desired.

Creating Resource and Interface Pairs

To mark or unmark a resource-interface channel:

Click the check box inside the cell corresponding to the interface and 
the resource names.

IMPRINT Pro changes the checked cell to an unchecked cell and vice 
versa. You can assign each interface to up to five resources by 
checking up to five cells in the worksheet.

For every interface that Warfighters utilize in performing either primary or 
contingency tasks, you should assign at least one resource.

Define Resource-Interface Conflicts
Click the conflict tab to access a matrix of conflict values among your 
resource-interface channels.
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As tasks are performed by an operator, workload demands are made on 
the operator’s limited resources across the various workload channels. 
Whenever two or more tasks are performed simultaneously by the same 
operator, these tasks compete (interfere) for resources across these 
channels. This competition, known as conflict, contributes to the overall 
workload an operator will experience and the likelihood that performance 
will deteriorate below its single task level (Wickens, 2002, 2005). Two tasks 
will compete (interfere) with each other more to the extent that they share a 
common resource. This amount of conflict between any two resource-
channel pairs is set by the user in the RI Pairs window under the conflicts 
tab.

There are three possible classes of conflict between tasks that are 
performed concurrently:

Class 1: Identical tasks (e.g., two keyboarding tasks)

Class 2: two different tasks but with identical resource conflict 
(e.g. a keyboarding task and a writing task, both with the same 
fine motor demands.)

Class 3: two different tasks with different resource channels. 
(e.g., visual search V and problem solving C). Here resource 
conflict will exist, although it may be diminished from cases 1 
and 2. 

In all three cases, the amount of resource conflict is embedded within the 
conflict matrix; you will typically choose default values which are based 
upon multiple resource theory or enter values manually. 
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Importantly, there is one other factor that may, in some cases, modify the 
interference conflict in the case of two tasks demanding the same 
resource, namely the way in which various types of tasks may be 
represented by the exact same channel pair in your model. For example, 
two fine motor typing tasks using the same hand will interfere more than 
the same typing task using different hands, yet both tasks might be 
represented by the same fine motor-keyboard channel. Two visual tasks 
separated by 20 degrees of visual angle will interfere more than two 
separated by 2 degrees, yet they might also be represented by the same 
visual-crewstation channel. Channel conflict values are meant to represent 
the average conflict between channels globally for all tasks in your network 
and do not differentiate between any two tasks that could be represented 
by the same channel. To accommodate for this issue in the case of the 
visual task example above, you may choose to use your current visual-
interface channel for the workload performed in the 20 degree case and 
then add a new visual-interface (2) channel for which you can set unique 
demand values for the 2 degree case. You may then set the desired 
conflict value between these similar but unique channels in the conflicts 
matrix of the RI Pairs window. You would probably use the default conflict 
value for 2 degrees, but raise this to a much higher value at 20 degrees 
since it is nearly impossible to process inputs for two visual sources 
separated by 20 degrees.

Conflict values range from 0.00 to 1.00. A conflict value of 0.00 means that 
the two channels do not interfere with each other at all. A conflict value of 
1.00 means that the two channels are in total conflict. This conflict 
automatically causes a workload overload condition, since the two 
channels cannot be utilized at the same time. 

When you run a model for which conflicts are defined, you can review a list 
of all occurrences of channel conflict in the model run through the Channel 
Conflict Report. In the event an operator is given two simultaneously 
conflicting tasks to perform but instead hands off one of those tasks to a 
contingency operator because of his/her workload strategy, the original 
operator’s workload is now reduced to that of a single task. In this case, the 
operator is no longer in a conflict situation (which would require a minimum 
of two simultaneous tasks) thus the report shows no record of conflict for 
that instance.

IMPRINT Pro has two modes available to you for assigning the conflict 
values: 

1. Automatic mode. Assign conflict values between resources based on 
expert opinion and research. First, begin by selecting a channel 
(clicking its row in the matrix) and then clicking the Auto button; 
IMPRINT Pro, in some cases, may prompt you for sub-parameters 
related to this channel, for example after clicking the Auto button for an 
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Auditory-Crewstation channel you might be prompted to specify 
whether the channel carries verbal information or tonal information by 
checking the corresponding check box. After selecting additional 
parameters, where applicable, IMPRINT Pro then populates the cells in 
the conflict matrix with the corresponding default conflict values. 
Automatic mode is only available for channels that utilize one of the 
seven default resources (auditory, cognitive, fine motor, gross motor, 
speech, tactile and visual). 

2. Manual mode. Manually enter your own conflict value for the channel. 
Channels that utilize other resources then the five default resources 
(auditory, cognitive, fine motor, gross motor, speech, tactile and visual) 
must have conflict values manually entered.

The Conflicts window displays a worksheet with the resource-interface 
channels displayed both down the left column and across the top. The 
channels are grouped by resource. Any previously defined conflict values 
are displayed in the worksheet cells. The default conflict value is 0.00.

Entering Conflict Value

To enter a conflict value in automatic mode:

1. Click the cell under the RI Pairs column corresponding to the resource-
interface pair requiring conflict values. 

All cells in the selected row highlight in blue.

2. Click the Auto button at the top of the dialog box.

For some resources a new dialog box opens, depending on the 
resource. 
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3. If applicable, select the parameter appropriate to your channel’s 

resource, and then click OK.

The conflict values recommended by IMPRINT Pro for the parameter 
you selected automatically display in the cells in the worksheet. See 
additional details in “Automatic Data Entry” on page 203.

Note:
For resources which do not have additional parameters, the Auto button 
automatically fills in the cells with default conflict values.

To manually enter a conflict value: 

1. Click the cell corresponding to the resource-interface pairs requiring 
conflict values.

2. Use the keyboard to enter a conflict value from 0.00 to 1.00. 
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Automatic Data Entry
When the Auto button is clicked, for some channels an Automatic Data 
dialog box displays. The options appearing in these Automatic Data boxes 
are characteristics of the selected channel that determine how much 
conflict occurs between and within the channels, based on human 
workload research. Once the automatic data dialog box is open, you can 
click the option button adjacent to option that best fits the resource-
interface channel you are defining, and then click OK.

Automatic Data for Auditory

Options available on the Automatic Data for Auditory dialog box:

Channel caries Verbal information. This channel involves 
speech.

Channel carries Tonal information. This channel involves 
sound.

Note:
You can also choose to not select either of these parameters.

Automatic Data for Cognitive

The option available on the Automatic Data for Cognitive dialog box is:

Channel is spatial. This channel involves peripheral vision.
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You may check the Channel is Spatial option or leave it unchecked.

Automatic Data for Fine Motor

The option available on the Automatic Data for Motor dialog box is:

Channel requires verbal information

The requirement of verbal information for a fine motor task refers to the 
requirement of receiving verbal instruction while performing the fine motor 
task. For example, manipulating the control column of an aircraft while 
receiving verbal instruction over the radio is a fine motor task which 
requires verbal information.

 You may check the Channel requires verbal information option or leave 
it unchecked.

Automatic Data for Visual

Options available on the Automatic Data for Visual dialog box include:

Channel has verbal information. This channel involves 
speech.

Channel requires foveal fixation. This channel requires focus.
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You can check one, both or neither of the options for the Visual channel.

Note:
Channels involving the default resources Gross Motor, Speech and Tactile do 
not have additional parameters. For these resources, clicking on the Auto 
button automatically populates the matrix with their default conflict values.

Macros
Custom or user-defined macros are useful when you need to perform the 
same calculation or procedure several times in mission. Instead of retyping 
the necessary expressions every place you need them, you can first create 
the macro once for a mission. Then, wherever you need the calculation or 
procedure to be performed in the mission, you simply type the name of the 
macro followed by parentheses (  ).

Because you can assign more than one expression to a macro, you can 
use macros to perform procedures. For example, suppose you want to 
assign values to several variables based on the state of the simulation at 
various points in the mission. You could define a macro called 
SystemChange( ). Whenever the macro is executed, IMPRINT Pro 
executes all of the expressions in the macro and returns the value of the 
last expression.

Displaying Defined Macros
If a macro has already been defined for your mission, you can display the 
macro below the Macro node in the Analysis Tree and the main window. If 
no macros have been defined for your mission, see “Adding Macros” on 
page 206.

To display defined macros:

Do one of the following:
• In the Analysis Tree, click the + adjacent to Macros item to expand it. 

A list of defined macros displays in the Analysis Tree.
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• In the Analysis Tree, double-click the Macros node to display the list 
of macros in the main window. 

Adding Macros

To add a macro:

In the Analysis Tree, right-click the Macros node, and then select Add 
Macro from the menu that displays.

The new macro is added below the Macro node in the Analysis Tree.

Note:
IMPRINT Pro names the new macro Macro. If you continue to add Macros, 
each following macro will be named Macro1 and is numbered, increasing by 
one for each addition. You can edit the name of the macro in the Macro 
information dialog box or the “Displaying Macro Information and Parameters” 
on page 206 window name box. 

Displaying Macro Information and Parameters 
The Macro Description dialog box displays the name of the macro at the 
top. The dialog box also includes macro properties on the two tabbed 
dialogs: Macro Info and Parameters.

To display a macro dialog box:

1. In the Analysis Tree, click the + adjacent to Macros node to expand it.

2. Double-click the macro name (for example, Macro1).

The Macro dialog box displays in the main window. 
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Renaming Macros

To rename a macro:

Do one of the following:
• Set the cursor in the Macro Name field in the Macro Description 

dialog box, and then type in a new name.
• Click the Macro in the Analysis Tree to select it, and in the Properties 

Window edit the contents of the Name field as desired.

Macro names must begin with a letter or underscore and can be 
followed by zero or more letters, numbers, and underscore characters. 
Macro names are case-sensitive. The C# language reserves 76 words 
for its own use. Do not use any of these keywords as macro names. For 
a list of reserved names, see “Adding Variables” on page 213.

The new macro name is added to the list of macros in the Analysis Tree 
and the main window.

Macro Info Tab
The Macro Info tab is the first tab in the Macro Description dialog box.
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To open the Macro Info tab:

Click the Macro Info tab in the Macro Description dialog box.

Following is a detailed description of the properties on the Macro Info 
tab.
• Name. This field contains the macro name.
• Return Type. This field contains the variable type for the return 

value. Selections include integer, floating, string, boolean, entity, 
arbitrary, object, and void. Void types do not return a value. For 
descriptions, see Variable Types in “Variable Properties” on 
page 214.

• Is Array. Checking this box indicates the return value is an array. An 
array is an ordered set of variable values that are indexed to a single 
variable name. An array can be a one-dimensional list, a two-
dimensional table of rows and columns, or a multi-dimensional array.

• Dimensions. Contains the indexes for the return value when it is an 
array. Type the upper index for each dimension, separated by a 
comma. By default the lower index for each dimension is zero. For 
example, if you enter 30, 40, 50, 60, you are defining a four-
dimensional array with indices of 0-29, 0-39, 0-49, and 0-59. There is 
no limit on the number of dimensions you can use.

• Code. Contains the expressions defining the macro. To return a 
value from the macro, you must include a return statement in the 
macro definition. The variable type for the return value is specified in 
the Return Information tab. For details on return statements, see 
Return Statements in IMPRINT Pro Syntax Reference Manual, Vol.3 
of IMPRINT Pro User Guide.

Macro Parameters Tab
The Parameters tab is the second tab in the Macro Description dialog box. 
It contains optional variables that a macro can assign to a local variable 
inside the macro.

To open the Parameters tab:

Click the Parameters tab.

The Parameters dialog box displays.
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To add a parameter:

1. Click the Add button on the Parameters dialog box.

2. Enter the Name, Type, Array information, and Array dimensions.

To delete a parameter:

1. Select the parameter.

2. Click the Delete button on the Parameters dialog box.

For details on the variable properties, see “Variable Properties” on 
page 214.

Editing Macros

To edit a macro:

1. In the Analysis Tree, click the + adjacent to Macros node to expand it, 
then double-click the macro you want to edit. 

The Macro Description dialog box displays in the main window and the 
associated Properties window for the macro displays. 

2. Make changes to the Macro properties as desired.

For details on macro properties, see “Displaying Macro Information and 
Parameters” on page 206.
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Copying Macros
You can copy macros and then paste them into another mission or 
analysis.

To copy a macro:

Do one of the following:
• Right-click the macro in the Analysis Tree you want to copy, and then 

select Copy from the menu that displays.
• Select the macro you want to copy, and then select Copy on the Edit 

menu.
• Select the macro you want to copy, and then click the Copy button 

on the tool bar.

Cutting Macros
You can cut a macro to remove it from its location to another location in the 
analysis.

To cut a macro:

Do one of the following:
• Right-click the macro you want to cut, and then select Cut Macro 

from the menu that displays.
• Select the macro you want to cut, and then click the Cut button on 

the tool bar.
• Select the macro you want to cut, and select Cut on the Edit menu.

The cut macro highlights in red and remains in its location on the 
Analysis Tree until you paste the macro to another Macro node. Once 
you perform the Paste command, the macro will be removed from its 
current location and appear in its new location.

Pasting Macros
Macros can be copied or cut, then pasted to a Macro node in other 
missions.

To paste a macro:

1. Copy or cut the macro.
210



Chapter 5: Mission Analysis
2. Do one of the following:
• Right-click in the macro node in the Analysis Tree to which you want 

to paste the macro, and then select Paste Macro from the menu that 
displays.

• Select the Macro node to which you want to paste the macro, and 
select Paste on the Edit menu.

• Select the Macro node to which you want to paste the macro, and 
click the Paste button on the tool bar.

The macro appears below the destination Macro node. If you used the 
Cut command, the cut macro will be removed from its previous position.

Deleting Macros

To delete a macro:

1. Select the macro in the Analysis Tree.

2. Do one of the following:
• Right-click the macro, and then select Delete Macro from the menu 

that displays.
• Press the Delete key on the keyboard. 

The macro is deleted.

Batch Initialization Macros
Because IMPRINT Pro macros are called prior to model execution, it is 
possible to create a macro which alters the values of your model’s 
variables before each run in the simulation. This method is known as batch 
initialization.

To Enable Batch Initialization:

1. Right-mouse click the Macros node in the tree, and then select the 
option Add Macro from the shortcut menu.

2. Double-click the macro to display its properties. In the Macro Name 
field, rename the macro “BatchInitialization”. 

3. Set the Return Type of this macro to Void.
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4. In the Macro Code box, set any variable to the desired value for a 
model run. Remember: the value Model.RunNumber is available if you 
wish to set the value of a variable based on the current run number. Do 
not include any parameters in this macro.

5. Set the Number of Runs on the Execution Settings page.

6. Run the model.

If present, this macro will be called before the model begins execution.

Variables
You may add variables to an IMPRINT Pro mission. All variables 
associated with the mission display in the Analysis Tree below the 
Variables node and in the main window when you double-click the node. 
You can display variable descriptions, and add, edit, and delete variables. 
You can also create watches to observe the changes in variables during 
mission execution. For details on watches, see “Variable Watches Tab” on 
page 291.

IMPRINT Pro recognizes global and local variables. Only global variables 
need to be defined. For details on the differences between the two variable 
types, see Variable Scoping in IMRPINT PRO Syntax Reference Manual, 
Vol.3 of IMPRINT Pro User Guide.

For a list of system variables, see “System Variables” on page 218.

Displaying Defined Variables

To display defined variables:

Do one of the following:
• In the Analysis Tree, click the + adjacent to Variables node to 

expand it.

A list of defined variables displays in the Analysis Tree. 
• Double-click the Variable node.

A list of Variables display in the main window.
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Adding Variables

To add a variable:

1. In the Analysis Tree, right-click the Variables node.

2. Click Add Variable from the menu that displays.

The new variable is added below the Variable node in the Analysis 
Tree.

Note:
IMPRINT Pro names the new variable Variable. If you continue to add 
variables, each following variable will be named Variable1 and is numbered, 
increasing by one for each addition. You can edit the name of the variable in 
the Variable Parameter dialog box or in the Name field in the Variable 
Properties dialog box.

Variable names must begin with a letter or underscore and can be 
followed by zero or more letters, numbers, and underscore characters 
(examples: abc, _abc, _aa12). Variable names are case-sensitive.

The C# language reserves 76 words for its own use. Do not use these 
keywords as variable names. The following key words should not be 
used when defining your own variables:

abstract, as, base, bool, break, byte, case, catch, char, checked, 
class, const, continue, decimal, default, delegate, do, double, else, 
enum, event, explicit, extern, false, finally, fixed, float, for, foreach, 
goto, if, implicit, in, int, interface, internal, is, lock, long, namespace, 
new, null, object, operator, out, override, params, private, protected, 
public, readonly, ref, return, sbyte, sealed, short, sizeof, stackalloc, 
static, string, struct, switch, this, throw, true, try, typeof, unit, ulong, 
unchecked, unsafe, ushort, using, virtual, void, and while.
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Displaying Variable Descriptions

To display a variable description:

1. In the Analysis Tree, click the + adjacent to Variables node to expand it.

2. Double-click the variable name.

The Variable Description dialog box displays in the main window, 
displaying properties of the variable. If using Custom Layout 1 view, 
these same properties appear in the Properties window.

Variable Properties
The properties used to define a variable include the variable type, the initial 
value, whether or not the variable is an array, indexes for an array, and any 
variable notes.

Following are detailed descriptions of the variable properties.

Variable Name. This field contains the name of the variable.

Variable Type. This field contains the variable type. Selections 
include boolean, entity, floating point, integer, object, string, void, 
and hashtable.

Boolean variables are variables that are true or false only. 
Boolean variables are often used as flags to indicate whether a 
condition is true or false.

Entity variables point to a specific entity in the mission.
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Floating Point variables, also called doubles or real numbers, 
are numbers that are not whole numbers. Floating point 
numbers can range between 5.0 x 10-324 to 1.7 x 10308; 
precision in IMPRINT Pro is fifteen significant digits. 
IMPRINT Pro displays floating point variables with four digits to 
the right of the decimal point. Variables that store clock values 
or measurements of other continuous quantities should be 
defined as floating point, because they can contain noninteger 
values.

Hashtable variables map keys to values.

Integer variables are any whole number between 
approximately-2 billion and +2 billion (+2,147,483,648 and -
2,147,483,647 inclusive). Variables that count discrete objects 
should be defined as integers.

Object variables are variables that accept all types of values, 
from string to integer to floating point. These types of variables 
are mainly used with the Suspend and Resume functions that 
require a value of both a string and an integer. For example, if 
you wanted to Suspend task 3 with tag 3, then the Suspend 
function would require an array that holds both a string (for the 
task ID) and an integer (for the task tag). An object array would 
allow for this.

String variables are variables that consist of alphanumeric 
characters. You can use string variables in any expression. 
When you create a string variable, it does not need to be 
enclosed in quotes in the Initial Value text box. However, you 
must enclose the string variable in quotes if it is used in any 
other place, such as string1 = IMPRINT Pro is great.

Void types do not return a variable.

Is Array. This check box indicates whether or not the variable is 
an array. An array is an ordered set of values or elements 
identified by a single name. Each array element is referred to by 
the array’s name and the element’s position in the array. The 
position is indicated by a set of index values enclosed in square 
brackets and separated by commas; index values can be 
constants or expressions. Arrays can contain integers or real 
numbers, but not both.

Following is an example of an array named Array1. The 
dimensions of the array are 4 x 2. To reference the cell with the 
value 98, you would use Array1[2,1].
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Initial Value. Contains the initial value you assign for the 
variable. If the variable is an array, the initial value applies to all 
elements. You can also supply an initial value for a non-array 
variable or an element of an array by defining a external event 
that executes at time zero. Defining an initial value this way is 
equivalent to defining it in the Initial Value field. If you set the 
values in the Event Queue, you can make the value of the 
variables change at different times (for example, staffing shift 
changes).

Cultural. This field indicates whether or not the variable will be 
available to the user in Cultural Templates.

Editing Variables

To edit a variable:

1. In the Analysis Tree, click the + adjacent to Variables node to expand it, 
and then double-click the variable you want to edit. 

The Variable Description dialog box appears in the main window, 
displaying properties of this variable. The Properties Window also 
updates to display this same information.

2. Make changes to the variable’s properties as desired.

For details on variable properties, see “Variable Properties” on 
page 214.

Copying Variables
You can copy variables and then paste them into another mission.

Col 0 Col 1

Row 0 12 43

Row 1 8 9

Row 2 8 98

Row 3 7 58
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To copy a variable:

Right-click the variable in the Analysis Tree you want to copy, and then 
select Copy from the menu that displays.

The variable and all its associated data will be copied to Windows 
clipboard.

Cutting Variables
You can cut a variable to move it to another analysis.

To cut a variable:

1. Right-click the variable you want to cut.

2. Select Cut from the menu that displays.

The variable highlights in red and remains in its same location in the 
Analysis Tree until you paste it to a new location. Once you perform a 
Paste command, the variable will be removed from its old location.

Pasting Variables
Variables can be copied or cut, then pasted into other missions.

To paste a variable:

Copy or cut the variable and do one of the following:
• Right-click in the variable node in the Analysis Tree to which you 

want to paste to, and select Paste Variable from the menu that 
displays.

• Select the Variable node to which you want to paste the variable, and 
select Paste on the Edit menu.

• Select the Variable node to which you want to paste the variable, and 
click the Paste button on the tool bar.

The variable will appear below the destination Variable node. If using 
the Cut command, the cut variable will be removed from its previous 
location once it is pasted to the new location.
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Deleting Variables

To delete a variable:

1. In the Analysis Tree select the variable you want to delete. 

2. Do one of the following:
• Press the Delete key on the keyboard. 
• Right-click the variable and select Delete Variable from the menu 

that displays.
• The variable is deleted.

System Variables
IMPRINT Pro uses the following system variables:

Clock. Clock records elapsed time (in simulation time seconds) 
since the beginning of mission execution. You can use Clock in 
any expression in a mission, but use care in changing its value. 
To record the time at which an event occurred, set another 
variable equal to Clock as an effect of the event, for example, 
FinishTime= Clock. You can also use the variable Clock 
when the time controls what happens, for example:

if (Clock >= 1200)
{
Operators= CrewSize;
}

Model. Model is used to control model actions, such as 
Model.Start or Model.Pause. These are represented in 
the Analysis Tree below the Variables node by the single item 
Model(MAAD.Simulator.Model).

Task. Task includes all property attached to each task in the 
network model.
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Snapshots
Snapshots record the values of selected variables at specified points 
during mission execution. By default, IMPRINT Pro includes several 
snapshots that are used in the Operations Results reports. Data 
automatically collected include: workload levels for each operator, task 
status information (busy, not busy, suspended, stopped), and task failure 
information. The Snapshot feature may also be used to define custom data 
collection where you specify the variable values to collect at runtime. You 
can define new snapshot files, modify existing snapshot files, and delete 
existing snapshot files from this window.

Data collection snapshots can be triggered in several ways. You can 
specify snapshots to occur at specific clock times (one-time or repeating), 
when a task begins or ends, or when the model run ends. Any snapshots 
which are set to occur when a task begins are taken at the very end of the 
Beginning Effect of that task. Any snapshots which are set to occur when a 
task ends are taken at the very end of the Ending Effect of that task.

For each snapshot, the following information must be supplied:

A name for the snapshot file in which the data will be stored

The trigger type (End of Run, Clock, Begin Task, End Task)

The name of the triggering function and task, if the snapshot has 
a task trigger

The start time, stop time, and repeat interval, as applicable, if the 
snapshot has a clock trigger 

The names of the variables whose values IMPRINT Pro should 
record

IMPRINT Pro displays snapshot data as a worksheet in the Operational 
Results reports. The name of this worksheet is the same name you give 
your snapshot in the Snapshot Information window. 
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Displaying Defined Snapshots

To display defined snapshots:

In the Analysis Tree, click the + adjacent to Snapshot node to display a 
list of snapshots below the node.

Adding Snapshots

To add a snapshot:

In the Analysis Tree, right-click the Snapshots node, and select Add 
Snapshot on the menu that displays.

Note:
IMPRINT Pro names the new snapshot Snapshot. If you continue to add 
Snapshots, the following snapshot will be named Snapshot1 and each 
consecutive snapshot is numbered, increasing by one for each addition. You 
can edit the name of the snapshot in the Snapshot description dialog box or 
the Snapshot Properties window name box.

Displaying Snapshot Descriptions

To display a snapshot description:

1. In the Analysis Tree, double-click the snapshot name to open the 
Snapshot Description dialog box.

2. Enter the properties defining the snapshot.

Properties are described in “Snapshot Properties” on page 221.
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Snapshot Properties
The Mission Name and Snapshot name display at the top of the Snapshot 
description dialog box. You can change the name from the default. 
Snapshot names must begin with a letter or underscore and can be 
followed by zero or more letters, numbers, and underscore characters. 
Spaces are not allowed. Snapshot names are case-sensitive.

To name a snapshot:

1. Double-click a snapshot in the Analysis Tree to open up the Snapshot 
Description dialog box.

2. Click in the Snapshot Name field in the Snapshot Description dialog 
box.

3. Enter a name to which the data will be stored (maximum of 8 
characters). 

Below the Mission name and the Snapshot name two tabs display in the 
Snapshot dialog box:

Snapshot Info tab 

Snapshot Variables tab 
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Snapshot Info Tab
The Snapshot Info tab includes Trigger Type, Function, Task, start time for 
the snapshot, a stop time, and repeat interval, as applicable, if the 
snapshot has a clock trigger. Following are detailed descriptions of 
Snapshot properties found on the Snapshot Info tab:

Trigger Type. Contains the condition to trigger the snapshot. 
Select from the following drop-down list:

Clock. Triggers the snapshot at a specific time. The system 
variable Clock is automatically included in every snapshot 
description that you add, but you can delete it.

Begin Task. Triggers the snapshot at the beginning of the task.

End Task. Triggers the snapshot at the end of the task.

End of Run. Triggers the snapshot at the end of the run.

None. The snapshot never triggers.

Based upon the trigger type selected, IMPRINT Pro will enable 
or disable other properties to be defined.

Function. For task-based triggers, click the drop-down arrow in 
this field, and then select the parent function of the desired 
trigger task.

Task. For task-based triggers, click the drop-down arrow in this 
field, and then select the desired task.

Start Time. For time-based triggers, enter the start time in this 
field.

Stop. Once this box is checked, the Stop Time box becomes 
enabled.

Stop Time. Contains the Stop Time if the snapshot has a clock 
trigger.

Is Repeating. Select this check box for the snapshot to be 
repeating. 

Interval. When you select the Is Repeating check box, the 
Repeat interval field, specified in this field, is enabled. 
222



Chapter 5: Mission Analysis
Snapshot Variables Tab
In order to define snapshots of variables in IMPRINT Pro, your mission 
must have defined variables below the Variables node in the Analysis Tree. 

To specify the variables for which IMPRINT Pro will store values:

1. Select the Snapshot Variables tab.

2. Click the Add button.

A defined variable displays in the Variable Name column with a drop-
down arrow to the right of the box.

3. Click the drop-down arrow to the right of the variable.

IMPRINT Pro displays the list of available variables that have been 
defined for the mission and may be added to the snapshot. 

4. Choose a different variable from the list by clicking it, or choose to keep 
the default variable by clicking outside the list.

The listed variable is added to the snapshot.

5. Repeat Steps 2-4 for each variable whose values you wish to add to 
your snapshot file.
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Editing Snapshots

To edit a snapshot:

1. Double-click the snapshot you want to edit.

The Snapshots Description dialog box displays in the main window, 
displaying properties of this snapshot. The Properties Window also 
updates to display the same information.

2. Make changes to the snapshot properties as desired.

For details on snapshot properties, see “Snapshot Properties” on 
page 221.

Deleting Snapshots

To delete a snapshot:

1. In the Analysis Tree, select the snapshot you want to delete.

2. Do one of the following:
• Right-click the snapshot, and then select Delete Snapshot from the 

menu that displays.
• Press the Delete key on the keyboard. 

The snapshot is deleted.

Showing Snapshot Results
You can show the results of the snapshot data you have collected for your 
mission.

To show results:

1. After executing the mission, in the Analysis Tree right-click the listed 
snapshot you have defined for data collection (for example, 
Snapshot1).

2. Select Show Results from the menu that displays.

A new Snapshot tab appears in the main IMPRINT Pro window, 
displaying snapshot data for the selected variables. This same data 
appears in Operations Results reports when the Snapshot report option 
is selected.
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Exporting Snapshot Results Files
You can export result data for snapshot information. A different file is 
created for each snapshot.

To export the results file:

1. After executing the mission, in the Analysis Tree right-click the 
snapshot you have defined for data collection.

2. Select Export Results File.

The Export Snapshot result file dialog box displays.

3. In the Save in box, browse and select the destination folder in which 
snapshot data should be saved.

4. In the File name box, enter a file name.

5. In the Save as type box, select which format which you want to save 
the snapshot results in:
• HTML
• .XML
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6. Click Save.

The exported snapshot data exports to the name and location you 
specified.

Opening Snapshot Files in Excel
You can export snapshot data files from IMPRINT Pro and open them in 
another application, such as Excel, for analysis.

External Events
External events provide a way for you to cause certain events to occur at 
specific times during mission execution. These can be one-time events or 
they can repeat at regular intervals. External events are often used to 
change variable values and thereby change the state of the mission. For 
example, you could have a variable called Temperature that would 
increase at one-hour intervals during the day, and decrease at night. You 
could then make the time for a specific task such as warming up an engine 
dependent upon the current temperature. 

External events assign values to variables independent of when an entity 
begins or ends a task, or enters or departs a queue. External events 
supersede what is happening in the task network.

Adding External Events

To add an external event:

In the Analysis Tree, right-click the External Events node and select 
Add External Event from the menu that displays.

A new external event displays below the External Event Node in the 
Analysis Tree.

Note:
IMPRINT Pro names the new external event ExternEvent. If you continue to 
add external events, the next external event will be named 
ExternalEvent1; each following event is numbered, increasing by one for 
each addition. You can edit the name of the external events in the External 
Events description dialog box or the External Events Properties window name 
box.
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Displaying External Events
You can display a list of external events associated with the mission in the 
Analysis Tree below the External Events node and in the main window. 

To display a list of external events in the Analysis Tree:

Click the + adjacent to External Event node.

A list of defined external events display below the External Event node.

To display external events in the main window:

In the Analysis Tree, double-click the External Events node. 

The External Events dialog box displays a worksheet of any previously 
defined events in rows with columnar headings. Data includes:
• Name
• Appearance time
• Function Triggered
• Task Triggered
• Description

Displaying External Event Properties

To display external event properties:

1. In the Analysis Tree, click the + beside External Events node to expand 
the list of external events below the node.

2. Double-click the external event name (for example, 
ExternalEvent1).

External Event properties display in the main window.
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External Event Properties
The External Event dialog box contains an appearance time box, a 
description for the event, and the Function and Task triggered for the 
scheduled event.

Following are detailed descriptions of External Event properties. 

Appearance time. The appearance time identifies the time that 
the event occurs during the mission. Click in the appearance 
time field to enter an appearance time for the external event.

Description. A textual description of the external event.

Function Triggered. The function triggered property identifies 
the function that will begin when this external event occurs.

Task Triggered. The task triggered property identifies the task 
that will begin when this event occurs. Before specifying a task to 
be triggered, you must identify the parent function of that task. 
To specify the function and task that are triggered, click in the 
appropriate field, and select the name from the list.

Editing External Events

To edit an external event:

1. In the Analysis Tree, click the + beside External Events node to 
expand the list of external events below the node.

2. Double-click the external event you wish to edit.
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3. Click in the box whose value you wish to change, and edit it as 
necessary.

Copying External Events
You can copy external events and then paste them to another mission.

To copy an external event:

Right-click the event in the Analysis Tree you wish to copy, and then 
select Copy External Event from the menu that displays.

The external event and all its associated data copies to Windows 
clipboard.

Cutting External Events
You can cut an external event to move it to another mission.

To cut an external event:

1. Right-click the event you wish to cut.

2. Select Cut External Event from the menu that displays.

The external event highlights in red and remains in its location in the 
Analysis Tree until you paste it to a new location. Once you perform a 
Paste command, the external event will be removed from its old 
location.

Pasting External Events
External events can be copied or cut and then pasted into other missions.

To paste an external event:

Right-click in the External Event node in the Analysis Tree to which you 
want to paste the cut or copied event, and select Paste External Event 
from the menu that displays.

The external event appears below the External Event node to which 
you pasted it. If you used the Cut command, the cut event will be 
removed from its previous location.
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Deleting External Events

To delete an external event:

1. In the Analysis Tree, click the + adjacent to External Events node to 
expand the list below the node.

2. Select the event you wish to delete.

3. Do one of the following:
• Right-click the event, and then select Delete External Event from 

the menu that displays.
• Press the Delete key on the keyboard. 

The external event is deleted.

Viewing the Execution of External Events

To view the execution of external events:

1. In the View menu, select the Windows command and then select 
Event Queue from the window that displays. 

2. From the Execution menu, select Begin Simulation.

External events display in the Event Queue window during mission 
execution.

Charts
The Chart option allows you to display a plot of one mission variable 
against another. Since the value of your model’s variables is determined at 
run-time, the points representing these variables’ values are plotted on the 
chart at run time as the animation progresses.
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Adding Charts

To add a chart:

1. Right-click the Charts node in the Analysis Tree.

2. Select New Chart from the menu which displays.

A new Chart displays below the Charts node in the Analysis Tree. 

Note:
IMPRINT Pro names the new chart Chart. If you continue to add charts, the 
first new chart will be named Chart1, and each following chart will be 
numbered, increasing by one for each addition. You can edit the name of the 
chart in the Chart Properties dialog box in the main window or the Chart 
Properties window name field.

Displaying a list of Charts
You can display a list of charts associated with the mission in the Analysis 
Tree below the Chart node and in the main window. 
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To display a list of charts in the Analysis Tree:

Click the + adjacent to Charts node.

A list of defined charts displays below the Charts node.

To display a list of charts in the main window:

In the Analysis Tree, double-click the Chart node. 

This action will display a list of Charts in the main window.

Displaying a Chart
The Chart Display window appears upon executing the model. The window 
plots the updated values of your selected variables in chart-form as the 
simulation progresses. The entire chart is not available until the simulation 
ends.

To display a chart: 

1. From the Utilities menu, enable the Display Charts option.

The Display Charts option opens the chart display window at model 
run-time.

2. From the Utilities menu, enable the Display Trace option.

The Display Trace option enables the chart display to refresh as 
subsequent points are calculated during the model run. Without the 
Display Trace option enabled, the chart cannot be viewed while the 
model runs.

3. Run the model.

The Chart display window appears, plotting the selected variables as 
the simulation progresses. 
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Data appears in both graphical and tabular formats. To view the exact 
value of a plotted point, position the cursor on the point - a tooltip 
appears over the point, listing the X and Y values of the point. The table 
at the bottom highlights the corresponding values.

Chart Properties
When creating a chart for display, the Chart Information Tab and the Chart 
Properties window can be used to select one or more variables to plot 
along time or against another variable. These windows also allows you to 
specify the minimum and maximum display ranges and to select colors and 
shapes of the plotted points.

To display Chart Properties:

Double-click of the chart listed below the Chart node in the Analysis 
Tree.

The Chart Information tab displays.
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The Properties Window updates to display the same information.

• Name. The name of the selected chart.
• Description. The description of the selected chart.
• Chart Type. The method by which data displays in the chart, for 

example, data may be presented in the formats of line charts, pie 
charts and scatter charts.

• Show Chart. Click this button to jump to the chart display.
• Automatic Plotting. Checking this box enables the chart to plot a 

data point on the chart for each event in the simulation.
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• Enable X-Axis Range. Checking this box enables the X-Axis Min 
and X-Axis Max fields if a smaller display range is desired. Once 
checked, enter the desired X-Axis Min and X-Axis Max values. If left 
unchecked, the chart displays the entire time range for the duration 
of the simulation run and all carbon-dating points provided those 
points also fall within range of the selected y-axis limits.

• X-Axis Min. The starting value of the range of values displayed 
along the chart’s x-axis.

• X-Axis Max. The ending value of the range of values displayed 
along the chart’s x-axis.

• Enable Y-Axis Range. Checking this box enables the Y-Axis Min 
and Y-Axis Max fields if a smaller display range is desired. Once 
checked, enter the desired Y-Axis Min and Y-Axis Max values. If left 
unchecked, the chart displays the entire time range for the duration 
of the simulation run and all corresponding points provided those 
points also fall within range of the selected x-axis limits.

• Y-Axis Min. The starting value of the range of values displayed 
along the chart’s y-axis.

• Y-Axis Max. The ending value of the range of values displayed 
along the chart’s y-axis.

Creating a Chart Series
The series of points displayed in the chart window occur as a result of 
plotting one variable against another. Creating this series first requires 
deciding which two variables in your mission to use. By default, all missions 
contain the variable Clock which is useful for plotting any variable against 
time. Next, each of the two variables is assigned either the X or Y axis.

To create a chart series

1. In the Chart information window, click the Series List tab.

2. To add a new series, click the Add... button.

A new series description line appears in the list.

3. Under the X column, select the variable to display along the x-axis from 
the drop-down menu in the cell.
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4.  Under the Y column, select the variable to display along the y-axis from 
the drop-down menu in the cell.

5. From the Color column, select a color for the points in the series.

6. From the Shape column, select the shape of the point markers on the 
chart using the drop-down list provided.
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7. Run the model.

The chart display window appears, and the chart draws as the 
simulation runs.

Chart Tools
The Chart display window comes with a variety of tools that can be used to 
customize your chart. These tools may be found at the top of the chart 
display window.
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Options include:

 Personalized Charts. 

 Copy to Clipboard. Save the chart display of your data as a 
bitmap or metafile which may then be pasted into an image 
editing application. Alternatively you may save all point data to a 
text file.

 Print. Print the chart display.

 Gallery. Change the display format of your data.

 Anti-Aliasing. Smooth any lines connecting the points in the 
display.

 Palette Selector. Change the palette of available colors for 
the symbols, lines and background display.

 3D/2D. Choose a two-dimensional or three-dimensional 
display of your data.

 Axes Settings. Modify the appearance of the axes tables 
and markings.

 Point Labels. Show or hide data point labels next to your 
points. 

 Data Grid. Show or hide the data grid below the chart 
display. The data grid contains all data in a tabular format.

 Legend Box. Show or hide the Legend Box on the display. 
The Legend Box correlates the chart symbols with the data 
series.

 Zoom. Zoom into any portion of the chart.  To enable this 
feature click the Zoom button, and then select the portion of the 
chart to Zoom by left clicking and dragging your mouse around 
the desired area.
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 Properties. Access all properties of your chart display in a 
convenient Properties dialog box.

Copying Charts

To copy a chart:

1. Right-click the chart.

2. Select Copy Chart from the menu that displays.

Once you have copied the chart, you can paste to a Chart node in 
another analysis.

Cutting Charts

To cut a chart:

1. Right-click the chart template.

2. Click Cut Chart from the menu that displays.

The cut chart highlights in red in the Analysis Tree until it is pasted into 
a new mission. Once pasted, the cut chart disappears from its original 
location.

Pasting Charts
Charts can be copied or cut, then pasted into other missions.

To paste a chart:

Right-click the chart node in the Analysis Tree to which you want to 
paste the cut or copied chart, and then select Paste Chart from the 
menu which displays.

The chart appears below the destination Chart node. If you used the 
Cut command, the cut chart will be removed from its previous location.
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Deleting Charts

To delete a chart:

Do one of the following:
• Right-click the chart in the Analysis Tree, and then select Delete 

Chart from the menu that displays.
• Select the chart in the Analysis Tree, and then select the Delete 

button on the keyboard. When prompted, click Yes to delete the 
selected chart.

The selected chart disappears from the Analysis Tree.

Cultural Templates
Once you have created the basic task network model for your analysis, you 
can use cultural modeling to further define your model. Cultural modeling is 
the application of cultural or country based influences on human behavior 
or performance within a human performance model. Given a situation with 
the same physical conditions and the same resources, people from 
different cultures or countries may react to the situation and apply their 
resources differently. A cultural difference exists when the average 
reaction of a population from one culture differs from that of another.

IMPRINT Pro allows users to create and save profiles, or templates, which 
define the relevant cultural properties for each culture modeled and the 
values derived from cultural data that are assigned to those properties. 
One or more templates can be defined by the user. At execution time, the 
user selects the template that is to be used.

Adding Cultural Templates

To add a cultural template:

1. Right-click the Cultural Templates node in the Analysis Tree.
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2. Select Add Cultural Template from the menu that displays.

A new Cultural Template displays below the Cultural Template node in 
the Analysis Tree. 

Note:
IMPRINT Pro names the new cultural template Cultural Template. If you 
continue to add cultural templates, the new cultural template will be named 
Cultural Template1 and each following is numbered, increasing by one for 
each addition. You can edit the name of the cultural template in the Cultural 
Template Properties dialog box in the main window or the Cultural Template 
Properties window name box.

Displaying Cultural Templates
You can display a list of cultural templates associated with the mission in 
the Analysis Tree below the Cultural Template node and in the main 
window. 

To display a list of cultural templates in the Analysis Tree:

Click the + adjacent to Cultural Template node.

A list of defined cultural templates displays below the Cultural Template 
node.

To display cultural templates in the main window:

In the Analysis Tree, double-click the Cultural Template node. 

This action will display a list of Cultural Templates in the main window.
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Cultural Template Properties
When building a cultural profile, select the cultural properties that are 
affected by a selected culture, and assign the appropriate values for those 
properties based on the cultural data. IMPRINT Pro also allows you to 
specify default values for each cultural parameter. The default value is 
used when cultural data for a parameter is not available.

Use the cultural template dialog box to edit the cultural template name, to 
add or delete cultural parameters, and to set values.

To display Cultural Template Parameters:

Double-click of the cultural templates listed below the Cultural Template 
node in the Analysis Tree.

The Cultural Template Parameter dialog box displays.
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Adding Cultural Parameters
Before you can add a cultural parameter, you must create a list of variables 
whose Cultural option is set to True. This option appears at the bottom of 
the Variables dialog box for any selected variable. If no variable’s Cultural 
flag is set to True and you attempt to add a cultural parameter, you will get 
an error message telling you that IMPRINT Pro is unable to add a new 
Cultural Template Parameter. Furthermore, you will not be able to proceed 
any further in creating your cultural parameter.

To add a parameter:

Do one of the following:
• Click the Add Parameter button, and then click the drop-down arrow 

and select a parameter from the list. 
• Right-click the cultural template in the Analysis Tree, and then select 

Add Parameter from the menu that displays. 

A new Cultural Parameter displays in the Cultural Parameter dialog 
box. You may change the variable in the parameter box by clicking in 
the box, clicking the drop-down arrow on the right side, and then 
selecting a new variable from the list which displays.

Copying Cultural Templates

To copy a cultural template:

1. Right-click the cultural template.
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2. Select Copy Cultural Template from the menu that displays.

Once you have copied the cultural template, you can paste to a Cultural 
Template node in another analysis.

Cutting Cultural Templates

To cut a cultural template:

1. Right-click the cultural template.

2. Click Cut Cultural Template from the menu that displays.

The cut cultural template highlights in red in the Analysis Tree until it is 
pasted into a new mission. Once pasted, the cut cultural template 
disappears from its original location.

Pasting Cultural Templates
Cultural templates can be copied or cut, then pasted into other missions.

To paste a cultural template:

Right-click the cultural template node in the Analysis Tree to which you 
want to paste the cut or copied template, and then select Paste 
Cultural Template from the menu that displays.

The cultural template appears below the destination Cultural Template 
node. If you used the Cut command, the cut template will be removed 
from its previous location.

Deleting Cultural Templates

To delete a cultural template:

Do one of the following:
• Right-click the cultural template in the Analysis Tree, and then select 

Delete Cultural Template from the menu that displays.
• Select the cultural template in the Analysis Tree, and then select the 

Delete button on the keyboard.

The selected template disappears from the Analysis Tree.
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Comments
You can use comments to add clarification to the network diagram and to 
display values of variables on the network diagram as the mission runs. For 
example, you could place the name, description, and last revision date of 
the mission as a title on the network diagram. You could also place 
comments describing the different path logic in places where you had a 
decision node with multiple path routing. The following illustration shows 
the use of comments in the title and in path routing.

You can position comments in the same way as any other network object. 
A list of comments associated with the mission displays in the Analysis 
Tree below the Network node. You can display comment descriptions and 
add, edit, and delete comments.

Adding Comments

To add a comment:

Do one of the following:
• From the Palette, drag the Comment object to a location on the 

Network Diagram. 
• Right-click in the network diagram, and select Add Comment from 

the menu that displays.

A new comment object appears in the Network Diagram; a new 
comment node appears in the Analysis Tree.
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Displaying Comment Text

To display a comment text:

On the Network Diagram or in the Analysis Tree, double-click the 
comment.

The Comment dialog box displays in the main window.

Adding Variables to Comments 
The Comment box can be used to display variables on the network 
diagram during mission execution. As an example, you might want to 
display the rate of entities arriving at a task and the size of a queue as the 
mission executes.

Before you can add a variable to the comment box, you must create a list 
of variables below the Variables node. If you attempt to add more variables 
to the comment display than are available, you will get an error message 
telling you that IMPRINT Pro is unable to add a new variable. 
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To add a variable to the comment:

Click the Add Variable button.

A variable will be added from the list defined variables below the 
Variables node.

To change the variable:

1. Click the new variable in the box to display the drop-down arrow. 

2. Click the drop-down arrow to select from a list of available variables.

3. Select a new variable from the list.

The next time you execute the mission, the comment box will display 
the variables you have selected and their respective values.

Editing Comments

To edit a comment:

1. On the network diagram, double-click the comment.

The Comment dialog box displays in the main.

2. Click in a box and make your changes.

Deleting Comments

To delete a comment:

1. On the network diagram, select the Comment box.

2. Do one of the following:
• Right-click the comment in the Analysis Tree, and then select Delete 

Comment from the menu that displays.
• Press the Delete button. 

The comment is deleted.
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Workload Monitors
Workload monitors display or “monitor” the ongoing workload values for 
any operator. They appear as green boxes in the Network Diagram, 
displaying the Warfighter being monitored, that same Warfighter’s total 
workload at an instant in time, and the total number of ongoing tasks he or 
she is performing at the time which are contributing to the workload value. 
A separate workload monitor is required for each operator whose current 
workload you wish to display.

You can position workload monitors in the same way as any other network 
object. A list of workload monitors associated with the mission displays in 
the Analysis Tree below the Network node. You can add, edit, display and 
delete workload monitors.
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Adding Workload Monitors

To add a workload monitor:

Do one of the following:
• From the Palette, drag the Workload Monitor object to a location on 

the Network Diagram. 
• Right-click in the network diagram, and select Add Workload 

Monitor from the menu that displays.

A new workload monitor object appears in the Network Diagram; a new 
workload monitor node appears in the Analysis Tree.

Displaying Workload Monitors Properties

To display workload monitor properties:

On the Network Diagram or in the Analysis Tree, double-click the 
workload monitor whose properties you wish to view.

The workload monitor dialog box displays in the main window. The only 
property describing the workload monitor is the Warfighter whose 
workload you wish to display. This information displays in the 
Warfighter field.
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Changing the Workload Monitor Warfighter 
Workload monitors contain a single editable field which displays the 
Warfighter whose workload you wish to display. You may change the 
designated Warfighter to any other Warfighter defined as an Operator in 
your analysis.

To change the workload monitor warfighter:

1. Double-click the workload monitor in the Analysis Tree or in the 
Network Diagram to open the Workload Monitor dialog.

2. The Workload Monitor dialog displays.

3. Click the drop-down arrow next to the Warfighter field to select from a 
list of available operators.

4. Select a new Warfighter from the list.

The Warfighters field updates to display the newly selected Warfighter 
whose workload will display in the Network Diagram window.

Copying Workload Monitors

To copy workload monitor:

1. Right-click the workload monitor.

2. Select Copy Workload Monitor from the menu that displays.

Once you have copied the workload monitor, you can paste to the 
Network node or in the network diagram of another analysis.
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Cutting Workload Monitors

To cut a workload monitor:

1. Right-click the workload monitor.

2. Click Cut Workload Monitor from the menu that displays.

The cut workload monitor highlights in red in the Analysis Tree until it is 
pasted into a new mission. Once pasted, the cut workload monitor 
disappears from its original location.

Pasting Workload Monitors
Workload Monitors can be copied or cut, then pasted into other missions.

To paste a workload monitor:

Right-click the Network node in the Analysis Tree to which you want to 
paste the cut or copied workload monitor, and then select Paste 
Node(s) from the menu that displays.

The workload monitor appears below the Network node in the 
destination analysis. If you used the Cut command, the cut workload 
monitor will be removed from its previous location.

Deleting Workload Monitors

To delete a workload monitor:

1. On the network diagram, select the workload monitor to be deleted.

2. Do one of the following:
• Right-click the workload monitor in the Analysis Tree, and then select 

Delete Workload Monitor from the menu that displays.
• Press the Delete button. 

The workload monitor is deleted.
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Subchapter 5.3 Creating Missions with the 
Mission Means Framework (MMF) Mission 
Builder

As an alternative to creating a mission within the IMPRINT Pro application, 
you may begin to configure missions using the Mission Means Framework, 
or MMF Mission Builder. The MMF Mission Builder is an external 
application which allows you to enter basic task-type data which can later 
be imported into IMPRINT Pro. The MMF Mission Builder offers the 
following advantages:

Basic mission-level data may be entered by users who do not 
have access to a copy of IMPRINT Pro but wish to create the 
starting framework of a mission model including missions, tasks, 
functions and operators.

The MMF Mission Builder includes the pre-defined Universal 
Joint Task Lists, or UJTLS, which may be incorporated into your 
IMPRINT Pro model. Tasks may be imported in sets or 
individually.

Data created by this tool exports to an .xml file which can then be imported 
into IMPRINT Pro as a new analysis or as new data to an existing analysis. 
Following the import, paths and logic must then be added to your model 
using the Network Diagram, Properties window and/or informational tabbed 
windows for the nodes in your model.

Installing the MMF Mission Builder
In order to use the MMF Mission Builder, you must first install it on your 
computer.

To install the MMF Mission Builder:

1. Locate the MMFBuilder.msi installer file included with your 
installation of IMPRINT Pro.  This file may be found in the following 
directory once IMPRINT Pro is installed:

C:\Program Files\IMPRINT Pro 3.0\MMF Mission Builder Setup

Alternatively, the setup.exe file may be used to install the MFF 
Mission Builder.
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2. Double-click this file.

The installer launches.

3. In the Select Installation Folder dialog, click Next to install the MMF 
Mission Builder to the default folder listed in the Folder field.

Alternatively, you may click the Browse button to install the application 
to a different folder on your system.

You may also choose to have the MMF builder available to “Everyone” 
using the computer or to just your own user account by clicking the 
corresponding radio button in the sectoin below the Folder field.
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4. Click Next.

The Confirm Installation dialog appears.  Do one of the following:
• Click Cancel to exit out of the MMF Mission Builder installation.
• Click Back to go back to a previous page in the installation wizard.
• Click Next once again to proceed with the installation with all 

selected settings.
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Upon clicking Next, the installation proceeds.  Once the installer 
finishes a message displays, indicating the install is complete.
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Note:
To ensure your installation of the MMF Mission Builder includes all the latest 
files, you will be prompted to remove any previously-installed versions of the 
MMF Mission Builder, if any exist, before installing or updating to the latest 
version.

To start the MMF Mission Builder:

1. Navigate to the MMF Mission Builder icon on your system’s desktop.

2. Double-click the MMF Mission Builder icon to launch the application.

The MMF Mission Builder launches.
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MMF Mission Builder Window Overview
The default configuration for the MMF Mission Builder window consists of a 
container window with a title bar, menu bar and status bar at the top. 
Further down inside the container window, separate data windows and 
their own tool bars display for your Operators lists and Purpose/Mission 
lists.

Note:
Many of the windows within the MMF Mission Builder are blank until you 
begin to add data. 

The following illustration shows the components of the MMF Mission 
Builder window. Each of these components is described in greater detail in 
the remaining sections of this chapter.
257



IMPRINT Pro Basic Procedures
MMF Mission Builder Window Components
This section describes the window components in the MMF Mission Builder 
window.

The MMF Mission Builder window has the following components:

Title Bar

Menu Bar

Status Bar

Data Windows

Tool Bar
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Title Bar
The title bar displays at the very top of the IMPRINT Pro window and 
contains the name and version of the currently open analysis.

Menu Bar
The menu bar displays below the title bar at the top of the IMPRINT Pro 
window and contains a single menu named File. The File menu includes 
the following basic commands: 

New. Create a new template for export. 

Open. Open an existing template.

Save. Save your template data to file for continued editing in a 
later session of the template or for importing into IMPRINT Pro.

Save As.  Save your template data to a new file name.

Exit.  Exit the application.

Status Bar
The Status Bar displays helpful messages about the status of your mission.
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Data Windows
The MMF Mission Builder data windows are used for adding and editing 
your MMF data. There are two tabs contained within this part of the 
window:

Operators. Use this tab to add, delete and display both 
Personnel and Materiel operators. The specialty type for 
Personnel operators is set using fields in this tab.

Purpose/Mission. Use this tab to add, delete and display 
Purpose/Mission data, including missions, functions, goals and 
tasks.

Tool Bar
The MMF Template tool bar displays inside the Data Windows and 
provides quick access to commonly used commands. This tool bar is 
available for the Operators tab only. However, separate tool bars exist for 
the Personnel  section and the Materiel section of the Operators 
Window. Each command displays as a button on the tool bar which may 
be clicked to access the command. Options include:

Move First. Select the first operator in your list.

Move Previous. Select the previous operator in your list.

Move Next. Select the next operator in your list.

Move Last. Select the last operator in your list.

Add New. Add a new operator.

Delete. Delete the currently selected operator.

As you move the pointer over each button, a tooltip displays the 
corresponding command name.  
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Creating a Mission using the MMF Mission 
Builder
This section explain how to add elements to your mission using the MMF 
Mission Builder. For more information on each element see “Subchapter 
5.2 Working With Missions” on page 106.

Understanding the MMF Mission Builder Elements
The MFF Mission Builder was designed as a means for incorporating 
Universal Joint Task List (UJTL) data into IMPRINT Pro.  Therefore, many 
of the elements within the Mission Builder use naming conventions used by 
the UJTL, several of which vary from the conventional names used by 
IMPRINT Pro.  When a data file from the MMF Mission Builder is imported 
into IMPRINT Pro, however, the names used by the MMF Mission Builder 
are then automatically translated into IMPRINT Pro names.

Knowing these translations, the MMF Mission Builder can also be used to 
create non-MMF missions for import into IMPRINT Pro.   Use the guideline 
below to relate the MMF terms to IMPRINT Pro terms.

Table 1: MMF and IMPRINT Pro Terminology
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IMPRINT Pro Term MMF Term Definition

Analysis Name Mission Context This will become your IMPRINT 
Analysis Name.  Can be a 
system (e.g. Tank) or mission 
area  (e.g. Consequence 
Management Operations).

Warfighter/Operator Human Component This will equate to an operator 
within the Warfighters section 
of your analysis.

Warfighter/Operator 
(automated)

Materiel Component This will equate to an 
automated operator within the 
Warfighters section of your 
analysis.

Mission Purpose/Mission This will become an operational 
mission within your IMPRINT 
Analysis.

Function Function/Capability High level actions that equate 
to reqirements to deliver 
capabilities.  Functions must 
contain at least one task, and 
can contain other functions.  
Most data entered in IMPRINT 
will not be entered at the 
function level.

Task Task This is the lowest level 
breakdown of steps to perform 
the mission.  Human 
performance data, such as task 
time and mental workload, is 
included in tasks.
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Knowing the IMPRINT Pro equivalents of the MFF Mission Builder data 
elements, the MFF Template can be used to create any generic analysis 
for IMPRINT Pro which might not be MFF-related.  Simply refer to the 
guide above for the desired IMPRINT Pro data elements you wish to add to 
your mission and the name under which those elements can be found in 
the MMF Mission Builder.

Required Data Elements
You may use the MMF Mission Builder to define all the available 
components it contains or to define only a subset of those components.  If 
the components you wish to add comprise only tasks, you must first add at 
least one Human or Materiel Component under the Components tab to act 
as the default operator for those tasks when they are added and ultimately 
imported into IMPRINT Pro.

Adding Components (Operators)
Components in the MMF Mission Builder are equivalent to “Operators” in 
IMPRINT Pro.  At least one default component is required if tasks are to be 
added to your MMF mission.  This component acts as the default 
component (and ultimately the default operator once imported into 
IMPRINT Pro) for all tasks until you reassign the task(s) to a different 
component.  The default component may be either of type Human or 
Materiel.

To add a component:

1. Click the Components tab.

2. Choose the type of component you wish to add.  Options include:

Goals Leveraged 
Capabilities

These will become goal 
networks within your mission.  
They represent high level 
actions, similar to functions, 
that equate to deliver 
capabilities.  Often times goals 
will represent responses to 
OPFOR actions or potential 
actions within a mission that will 
not always be performed.

IMPRINT Pro Term MMF Term Definition
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Human Component.  Human Componets in the MMF Mission 
Builder are the equivalent of “non-automated operators” in 
IMPRINT Pro.

Materiel Components.  Material Components in the MMF 
Mission Builder are the equivalent of “automated operators” in 
IMPRINT Pro.

3. Under the desired operator type, click the Add New button on the 
corresponding toolbar.

A new component appears in the window.  All new Human Components 
are labeled “HumanComponent” by default, and all new Materiel 
Components are labeled “MaterielComponent” by default.

Editing Components
Editable properties of Human Components include name and specialty 
type.  For Materiel Components, only the name may be changed.
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To edit a component name:

1. Double-click the component whose name you wish to change.

The field changes to a text-editing field.

2. Type the desired name in the field.

To edit a component specialty:

1. Choose an component whose specialty you wish to change.

2. From the Specialty drop-down list on the right side of the selected 
component, click the drop-down arrow to view a list of available 
specialties from which to choose.

3. Select a new specialty for the selected component by clicking it.

The Specialty field updates to display the new specialty.

Deleting Components
To delete a component:

1. Click the Components tab to display the list of components.

2. Select the component you wish to delete by clicking it.

3. Click the Delete “X” button on the toolbar.

The selected component disappears from the list.

Adding Purpose/Missions (Missions)
Purpose/Missions in the MMF Mission Builder are the equivalent of 
“Missions” in IMPRINT Pro.

To add a purpose/mission:.

1. Right-mouse click inside the Purpose/Mission window.

2. From the shortcut menu, select Add Purpose/Mission.
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A new Purpose/Mission listing appears in the window.  All purpose/
missions added to the MMF Mission Builder default to “Mission”.

Editing Purpose/Missions
Editable properties of missions include the Mission/Purpose Name.

To edit a purpose/mission:

1. Select the mission to edit in the Purpose/Mission window by clicking it.

The window on the right side displays the purpose/mission name.

2. Edit the purpose/mission name as desired by typing a new name in the 
field provided.

Note:
The Name property of the mission is the only mission-level property which can 
be altered.
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Deleting Purpose/Missions
To delete a purpose/mission:

Right-click the mission you wish to delete in the Purpose/Mission 
window.

From the shortcut menu that appears, select Delete.

The selected purpose/mission disappears from the window.

Adding Function/Capabilities (Functions)
Function/Capabilities in the MMF Mission Builder are the equivalent of 
“Functions” in IMPRINT Pro.

To add a function:

1. In the Purpose/Mission window, right-click the mission to which a new 
function should be added.

2. From the shortcut menu that appears, select Add Function/Capability.

The new function/capability is added underneath the selected mission.  
All function/capabilities added to the MMF Mission Builder default to 
“Function”.

3. Click the plus “+” sign next to the selected mission.
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The new function/capability appears at the next level below the mission.

Editing Function/Capabilities
Editable properties of function/capabilities include the Function/Capability 
Name.

To edit a function/capability:

1. Select the function/capability to edit in the Purpose/Mission window by 
clicking it.

The window on the right side displays the function/capability name.

2. Edit the function/capability name as desired by typing a new name in 
the field provided.

Note:
The Name property of the function/capability is the only Function-level 
property which can be altered.

Adding Leveraged Capabilities (Goals)
Leveraged Capabilities in the MMF Mission Builder are the equivalent of 
“Goals” in IMPRINT Pro.

To add a leveraged capability:

1. In the Purpose/Mission window, right-click the mission to which a new 
leveraged capability should be added.

2. From the shortcut menu that appears, select Add Leveraged 
Capability.
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The new leveraged capability is added underneath the selected 
mission.

3. Click the plus “+” sign next to the selected purpose/mission.

The new leveraged capability appears at the next level below the 
mission.  All leveraged capabilities added to a mission are initially 
labeled “Goal”.

Editing Leveraged Capabilities
Editable properties of leveraged capabilities include the Name property.

To edit a leveraged capability:

1. Select the leveraged capability to edit in the Purpose/Mission window 
by clicking it.

The window on the right side displays the leveraged capability name.
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2. Edit the leveraged capability’s name as desired by typing a new name 
in the field provided.

Note:
The Name property of the leveraged capability is the only property which can 
be altered.

Adding Tasks
Tasks in the MMF Mission Builder are the equivalent of “Tasks” in 
IMPRINT Pro.

To add a task:

1. In the Components tab add a new component if one does not already 
exist.

At least one component is required in any MMF Mission Builder 
analysis that has tasks in order that a default component may be 
assigned to these tasks as they are added.  This assignment may be 
changed to a different component at any time.

2. In the Purpose/Mission window, right-click the mission or function 
below which a new task will be added.

3. From the shortcut menu that appears, select Add Task.

4. Click the plus “+” sign next to the selected mission/function.

The new task appears at the next level below the mission/function.
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Task Properties
To view task properties:

Click a task in the Purpose/Mission tree.

Properties for the selected task appear in the pane to the right.

Editable task properties include the following:

Name. The name of the selected task.

Mean Time. The average duration of the selected task.

Standard Deviation. Optional variability which may be factored 
into the selected task’s time.

Primary Operator. The operator performing the task.
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Single Task Demands. The amount of workload the task 
demands over the seven default resources-interface channels. 

Editing Tasks
To edit a task:

1. Select the task you wish to edit by clicking it in the window on the left.

The properties for the selected task appear in the window on the right.

2. Edit the properties of the selected task as desired by selecting from or 
by typing directly in the fields provided.

Adding tasks from the Universal Joint Task List 
(UJTL)
The Universal Joint Task List is a set of universal pre-defined tasks which 
can be imported directly into your template. Tasks can be imported in 
groups categorized by Operational Area or by Levels of War or imported 
as individual tasks.

Operational Area.  A group of task which together comprise or 
help support a specific mission or operation to be used as the 
framework for mission analysis and structured training event.1  

Levels of War.  The Levels of War option contains four sub-
categories of tasks:  Strategic National, Strategic Theater, 
Operational Level, Tactical Level.

Individual Tasks.  Import any task from the UJTL template as a 
task or function in your template.

UJTL Tasks by Operational Area
Available operational areas include the following:

1. CJCSM 3500.04E, 25 August 2008, p. B-A-1

Operational Areas
AIR ASSAULT COUNTERTERRORISM NUCLEAR

AIRBORNE DEFENSIVE COUNTER-AIR OFFENSIVE COUNTERAIR

AMPHIBIOUS DELAY PEACE ENFORCEMENT
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When importing a group of tasks by operational area, the “Operational 
Area” selected becomes a function in the template while all tasks contained 
by it become the function’s subfunctions and subtasks.  Only those tasks 
which cannot be further broken down import as tasks.

ANTISUBMARINE 
WARFARE

DEPLOYMENT PEACEKEEPING

ANTITERRORISM DESTROY ENEMY BASES PEACEMAKING

AREA DEFENSE DESTROY ENEMY NAVAL 
FORCES

PURSUIT

ARMS CONTROL DOMESTIC 
CONSEQUENCE 
MANAGEMENT

REAR AREA SECURITY

ATTACK ENVIRONMENTAL 
ASSISTANCE

RECEPTION, STAGING, 
ONWARD MOVEMENT, AND 
INTEGRATION

BARRIER OPERATIONS EXPLOITATION RECONNAISSANCE, 
SURVEILLANCE

BLOCKADE FOREIGN CONSEQUENCE 
MANAGEMENT

RETIREMENT

CAMPAIGN PLANNING FOREIGN INTERNAL 
DEFENSE

SEARCH AND RESCUE

CIVIL DISTURBANCE HUMANITARIAN 
ASSISTANCE

SEIZE ADVANCED BASES

CIVIL SUPPORT INFORMAITON WARFARE SHOW OF FORCE

COMBAT SEARCH AND 
RESCUE

JOINT INTERDICTION SPACE

COMMAND AND CONTROL 
WARFARE

MARITIME INTERCEPTION STRATEGIC ATTACK

COUNTERDRUG MOBILE SUPPORT 
COUNTERINSURGENCIES

COUNTERPROLIFERATION MOBILIZATION SUPPORT INSURGENCIES

CAMPAIGN PLANNING MOVEMENT TO CONTACT SUPRESSION OF ENEMY 
AIR DEFENSES

CIVIL DISTURBANCE NATION ASSISTANCE THEATER MISSILE 
DEFENSE

CIVIL SUPPORT NONCOMBATANT 
EVACUATION

THEATER NUCLEAR

WITHDRAWAL

Operational Areas
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UJTL Tasks by Levels of War
The Levels of War option contains four sub-categories of tasks:

Importing a Group of UJTL Tasks

To import a group of UJTL tasks:

1. If not already open, click the Purpose/Mission tab to access a list of 
missions in your template.

2. Select the mission into which you wish to import one or more UJTL 
tasks.

3. Right-mouse click the desired mission.  

From the shortcut menu that appears, select Import UJTL Tasks...

Level of War Definitiona

a. CJCSM 3500.04E, 25 August 2008, pp. B-A-2 - B-A-3

Strategic National 
Military Tasks 
(SN)

Tasks which are national and Multinational level 
objectives adn guidance which are 
accomplished by the development and use of 
national resources.

Strategic Theater 
Tasks (ST)

Tasks which foster the development of theatre 
plans used to achieve objectives and providing 
forces/capabilities in accordance with strategic 
plans.

Operational Level 
(OP)

Tasks which link tactics and strategy by 
establishing operational objectives, initiating 
actions and applying resources.

Tactical Level 
(TA)

Task which are built around planning and 
executing battles and engagements to 
accomplish military objectives.  Each Service 
publishes a tactical task list.
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 The UJTL Dialog box appears.

4. In the UJTL Dialog box, select one of the following:
• Levels of War
• Operational Area

All task subgroups belonging to the selected group appear in the panel 
on the right.

5. Select a level of war or operational area which include the tasks you 
wish to add to your data file.

The selected level and all tasks below it are added to your mission data 
file.
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6. Click Ok.

The tasks corresponding to the selected Level of War or Operational 
Mission appear in the Purpose/Mission Tree.

Tasks may also be selected individually.  To select an individual task 
simply navigate down to the lowest level in the selected subgroup, and 
then choose the task to add.

Saving Template Data
To save template data:

1. From the File menu option, select Save.

A Save As dialog box appears.
276



Chapter 5: Mission Analysis
2. In the Save In... field at the top, browse to the location on your system 
where you wish to save your file.

3. In the File Name field, enter a name for your template data file.

4. Click the Save button.

The template data saves to the specified name and location with a .mff 
file extension.  This file can be opened in future sessions of the MMF 
Mission Builder application or may be imported directly as a new 
analysis in IMPRINT Pro using the New Analysis from Imported Data 
option from the File menu or Analysis Tree.  The file may also be 
imported into an existing analysis using the Import Data option 
available by right-mouse clicking on any analysis in the Analysis Tree.

Importing MMF Mission Data into IMPRINT 
Pro
The .xml file to which MFF Mission Builder data saves can be imported 
directly into IMPRINT Pro either as a new analysis or into an existing 
analysis.

Importing MMF Data as a New Analysis
To import an MMF Mission Builder data file as a new analysis:

1. Open IMPRINT Pro.

2. From the File menu select New Analysis from Imported Data.

3. In the submenu that appears, select From MMF Data.

4. In the submenu that appears, select Local Server.

5. From the Local Server submenu, choose the folder on your local server 
in which the new analysis should be added.

6. In the dialog box provided, browse to the location of your MMF data file.

7. Select the desired file, and then click Ok.

IMPRINT Pro imports the selected template data file. All imported data may 
be viewed in the analysis tree under the analysis name you specified in 
your template.
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Importing MMF Data into an Existing Analysis
To import an MMF Mission Builder data file into an existing analysis:

1. Open IMPRINT Pro.

2. Choose an analysis in the analysis tree into which a data file from the 
MMF Mission Builder will be imported.

3. Right-mouse click the desired analysis.  From the shortcut menu that 
appears, select Import Data.

4. From the shortcut menu that appears, select MMF Data.

A browse dialog box appears.

5. In the browse dialog box, select the desired file for import by clicking it.

6. Click the Open button.

IMPRINT Pro proceeds to import the MMF Mission Builder data file.

Once IMIPRINT Pro has finished importing the MMF Mission Builder 
data file a message displays, indicating the import was successful.  The 
imported data then appears in the analysis tree under the selected 
analysis.

To import an MMF Mission Builder data flle as a new analysis:

1. Open IMPRINT Pro.

2. From the File menu select New Analysis from Imported Data.

3. From the submenu that appears select MMF Data.

4. From the submenu that appears select Local Server.

5. From the submenu that appears select the folder in the analysis tree to 
which the new analysis should be added.

A browse dialog box appears.

6. In the browse dialog box, select the desired MMF Mission Builder data 
file (.mmf) for import by clicking it.
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7. Click the Open button.

IMPRINT Pro proceeds to import the MMF Mission Builder data file.

Once IMIPRINT Pro has finished importing the MMF Mission Builder 
data file a message displays, indicating the import was successful.  The 
imported data then appears in the analysis tree under the selected 
analysis.

Subchapter 5.4 Running the Mission

Once you have created a mission and defined the mission properties, you 
are ready to run the mission. Execution options allow you to you start, 
resume, pause, or halt mission execution; step through mission execution 
one event at a time; and change the speed of execution. 

This chapter also contains a discussion of potential sources of errors in 
logic and syntax that may affect mission execution and describes how to 
use the syntax checker provided by IMPRINT Pro to correct them.

Displaying the Execution Settings
Execution settings are found underneath the Execution menu. You have 
the option of selecting settings for an Operational model or Maintenance 
model at the top of the Settings dialog box. 

In an Operations model, the settings control the number of runs for the 
mission, the random number seed, the collection of PTS Adjustments, 
Perfect Accuracy, and Workload Strategies data. You will also have the 
option of running the mission with the Cultural Templates option checked.

To display execution settings:

From the main menu, select Execution, and then select Settings.

The Execution Settings dialog box displays. 

Note:
By default, the Execution Settings window displays the Maintenance Model 
settings. All Operations Model settings, however, are grayed out until an 
Operation mission has been selected from the Analysis tree.
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Editing Execution Settings
Execution settings should be checked prior to running a model. Execution 
Settings are saved as part of the model settings at the mission level. 

To edit execution settings:

1. From the main menu, select Execution, and then select Settings.

The Execution Settings dialog box displays.

2. Edit the execution properties as desired.

Execution Setting Properties
You can use IMPRINT Pro to create and execute two types of models:

Operations Model. An Operations model is used to estimate the 
workload associated with the performance of a new weapon 
system. This is accomplished by building a task network of each 
operational mission that the system will be required to 
accomplish.

Maintenance Model. The Maintenance model is used to 
estimate maintenance man-hour requirements for a given 
scenario in order to attain acceptable system availability.

Operations Model Execution Properties
Following is a detailed description of the settings properties for an 
Operations model.

Number of times to run the mission. Set this box to the 
number of times to run the mission. If the number is greater than 
one, the execution times, paths of execution, and other 
probabilistic events are will vary for each run based on the 
distribution you have entered. 

Random Number Seed. Set this box to the number 
IMPRINT Pro should use to generate random numbers for 
calculating task execution times and taking probabilistic paths 
through the network. The random number seed is a number 
between approximately -2 billion and +2 billion (inclusive). The 
same seed always produces the same set of random numbers in 
the same order, and thus the same results.
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PTS Adjustments. Check this box to use the task times and 
accuracies that were adjusted as a result of the combined 
applied Personnel Characteristics, Training Frequencies, and 
Stressors on the Calculator menu.

Perfect Accuracy. Check this box to run the model in a setting 
of perfect accuracy in which case the probability of success for 
every task is automatically assumed to be 100%. Because it is 
impossible for any task to fail under this condition, any failure 
consequences set for a task will not be exercised as a result.

Workload Strategies. Check this box to enable the workload 
strategies defined for each Operator Warfighter in the Analysis 
Tree, described in the Workload Management in “Warfighter 
Data” on page 67.

Animation On. The Animator window displays a two 
dimensional graphical depiction of your model as it executes. 
The data displayed in the Animator window depends on the 
model type you choose to run: if an operational mission is 
selected, the Animator window displays workload data for crew 
members in your operational mission; if a maintenance scenario 
is selected, the Animator window displays queue data, combat 
data, reliability and availability data and maintenance summary 
data for the scenario. Before enabling this option, go to the 
Windows option under the View menu, and select the Animator 
option to add the display window to your current layout.

Cultural Modeling. Check this box to select different cultural 
templates to apply to the model as it runs.

Executing the Operations Model
To execute the operations model:

1. Select a mission below the Mission node in the Analysis Tree.

2. From the Execution menu, select Settings.

3. If not already selected, click the Operations Model tab near the top of 
the Settings dialog box.

IMPRINT Pro loads the data for the currently-selected operations 
mission model; the mission name appears at the top of the dialog box.
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4. Edit the execution settings as desired.

5. To begin execution of the mission do one of the following:
• From the Execution menu, select Begin Simulation.
• Click the Begin Simulation button on the tool bar.

Note:
Unlike previous IMPRINT models which end when the first entity reaches the 
Ending Effect of the Model End task (999), all models in this version and 
forward will continue to run as long as there are items in the Event Queue. If 
you wish to simulate the behavior of older versions of IMPRINT Pro, you must 
explicitly add the call Model.Halt(); in the Ending Effect of Task 999.

Viewing Operations Model Data During 
Execution
IMPRINT Pro uses several different windows to display model data during 
execution. Some windows show the values of chosen variables while 
others display logic errors, such as an array index out of bounds or division 
by zero. IMPRINT Pro also includes several built-in tools to quickly locate, 
debug and correct these errors in the model.
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Network Diagram. The Network Diagram displays the network 
of tasks and functions comprising your mission in the form of 
differently-colored shapes known as “nodes”. Nodes highlight as 
entities pass through them model run. The Network Diagram 
also displays paths to show the relationship between the various 
nodes. Use this display to check the sequencing of your tasks 
and to check path logic.

Animator Window. The Animator Window displays operator 
workload data during an operations model run. Use this display 
to check for unevenly distributed workload among operators, 
excessively high workload values encountered by any single 
operator and the effect of workload strategies.

Output Tab. The Output window displays messages about 
actions which occur during a model run. Any syntax errors are 
indicated and may be useful for debugging your model.

Event Queue Tab. The Event Queue window allows you to view 
the events as they occur. Events are labeled by Name, ID, 
Group, Tag and Time. Change the execution speed to a slower 
speed if the model executes too quickly for you to observe the 
events as they occur.

Variable Watches Tab. This window allows you to select the 
variables you want to monitor during model execution and create 
a watches for them. The Watch displays the variable name, 
value and variable type. 

Search Tab. The Search window lets you search the entire 
model or selected components for a string of text.

Comment. Comment boxes can display the values of variables 
you select or text strings you specify inside a Comment box in 
the Network Diagram.

IMPRINT Pro displays the Output, Variable Watches, Event Queue, and 
Search windows in the same window below the IMPRINT Pro main 
window. Each window has a tab assigned to it. You can display any of the 
four windows by clicking on the appropriate tab. You can close any of the 
windows by clicking the  in the upper right hand corner. See below for a 
complete description of the Output, Variable Watches, Event Queue, and 
Search tabs.
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Network Diagram
The Network Diagram allows you to watch entities moving through the task 
network - this is known as Network Animation. When an entity is in a task 
or function, the task or function highlights in blue as beginning effect of that 
task (or any subtask belonging to the function) is evaluated. The number of 
entities in a task or queue are indicated by numbers that display above the 
task.

In the sample task network below, Task 3 has two entities actually in the 
task while five entities are waiting in queue to enter the task.

Enabling the network animation can cause a model to run more slowly. In 
the event you with to speed up your model run, disable the network 
animation by closing or hiding the Network Diagram window.

Animator Window
The Animator Window displays Warfighter data during an operations model 
run. This data includes the following:

 Workload Value. The amount of workload the operator is 
currently taking on is indicated by a colored bar on a scale.

Maximum Workload Value. This value is the maximum amount 
of workload an operator has encountered over all points in the 
model run thus far. 

Number of Active Tasks. The number of task an operator is 
performing at the present moment in the model run.

Active Workload Strategy. The Animator Window displays the 
default workload management strategy assigned to the operator 
and/or strategy C if it overrides the default. Strategy C will 
override strategies E and F in the event an overload condition 
occurs and a contingency operator is not assigned.
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Workload Threshold. The workload threshold assigned to an 
operator in his or her Warfighter properties window displays as a 
red line at the corresponding point along the operator’s workload 
scale. The exact threshold value displays next to it.

Output Tab
The Output window displays the actions that just finished happening in a 
running mission. These actions, known as Trace Data, display as follows:

Clock values for beginning effects

Clock values for ending effects 

Clock values for external events 

Syntax errors

Whether or not the plugins are successfully loaded when 
IMPRINT Pro is started

Application errors

When a run begins and completes, the following messages will display:

Simulation Complete. An indication that the model run was 
successful and that reports are available for viewing.
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Duration. The time required to process all model runs since the 
last time the Begin Simulation button was pressed.

Clock. The amount of time the model ran within the context of 
the mission or scenario. For example, if you run a scenario for 
3.00 days in the Execution Settings window, the Clock time 
reported would be 72.00 hours

Displaying Trace Data

To display trace data in the Output window:

1. From the View menu, click Windows, and then click Output from the 
menu that displays. 

2. Under the Utilities menu, click the Display Trace option to enable it (a 
check mark next to the option ensures it is enabled.)

3. From the Execution menu, click Begin Simulation.

As the mission runs the trace data displays in the Output window.

Note:
If the Display Trace option is disabled during the model run, the Output 
window will report minimal information about the model run.
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Saving Trace Data Output to File
You can save the results in the Output window to a file, save the results to 
the Windows clipboard, and clear the data in the window.

To save Output to file:

1. Right-click the Output window.

2. Select Save Output to File from the menu that displays.

The Save As dialog box displays.
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3. Select the destination of the folder from the Save in box.

4. Type a file name in File name box.

5. Click Save.

The contents of the Output window save to a file on your system.

Copying Trace Data Output to Clipboard

To copy output to Windows clipboard:

1. Right-click the Output window.

2. Select Copy Output to Clipboard from the menu that displays.

The contents of the Output window automatically copy to the Windows 
clipboard. You can then paste the data to an external application.

Copying Selected Trace Data Output
This option can be used to save specific sections of the Output window as 
desired.
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To copy selected output:

1. Select the trace date you want to copy by highlighting it in the Output 
window.

2. Right-click the Output window.

3. Click Copy Select Output from the menu that displays.

The data copies to the Windows clipboard. You can then paste the data 
to an external application.

Clearing the Output Window
With each consecutive model run, IMPRINT Pro clears the results from all 
previous model runs in the Output window. You may, however, clear the 
results in the Output window at any time independent of running the model.

To clear the Output window:

Do one of the following:
• Right-click the Output window and click Clear Output from the menu 

that displays.
• From the Edit menu click Clear Output.
• Press the shortcut keys Ctrl+Shift+L.

The Output window clears.

Event Queue Tab
The Event Queue window displays the list of events as they occur during 
model execution. These events include the execution of tasks, Beginning 
and Ending effects within a task, and any defined scheduled events. Each 
event listed is color coded as shown in the following table.
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The type of Event, ID, Group, Tag, and Time display.

Viewing Execution of External Events

To view the execution of external events:

1. Do one of the following:
• From the View menu, click Windows, and then select Event Queue 

from the menu that displays.
• Click the Event Queue tab from the bottom of the Output window 

area.

2. Execute the model by selecting the Execution menu and clicking 
Begin Simulation. Alternatively you may click the Begin Simulation 
button on the tool bar.

Events display in the Event Queue window as the model runs.

Event Color

Beginning Effect Dark Blue

Ending Effect Green

Suspended Beginning Effect Medium 
Blue

Suspended Ending Effect Lime 
Green

Evaluate Queue Magenta

Leaving Queue Purple

Waiting Without Queue Red

External Events Yellow

Snapshots Eggplant
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Variable Watches Tab
As an added method of debugging your model, IMPRINT Pro includes the 
Variable Watches window. This window allows you to select the variable 
whose value you want to monitor during model execution and create a 
Watch for it. The Watch displays the variable name, value and variable 
type. 

Adding Watches

To add a watch:

1. Do one of the following:
• From the View menu, select Windows, and then click Variable 

Watches from the menu that displays.
• Click the Variable Watches tab from the bottom of the Output window 

area.

The Variable Watches window displays.
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2. Click the cell below the name box to type the name of the variable.

You can only create a watch for a defined variable. If you enter the 
name of an undefined variable, the watch is ignored.

You can enter specific array values for a variable name. For example, if 
you have an array named ArrayName in the task network, you can 
specify a particular item in the array such as ArrayName[5]. For the 
purpose of a watch, the index must be an integer constant value and 
not a variable (for example, ArrayName[Variable] is not valid).

3. From the Execution menu, click Step Simulation.

4. Press the shortcut keys Ctrl+T to step through the simulation.

Variable values and types display in the Variable Watch box.
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Editing Watches

To edit a watch:

1. From the View menu, select Windows, and then click Variable 
Watches from the menu that displays.

The Variable Watch window displays.

2. Click the cell of the variable whose watch you want to edit, and edit the 
variable name as desired.

Deleting Watches

To delete a watch:

1. From the View menu, select Windows, and then click Variable 
Watches from the menu that displays.

The Watch window displays.

2. Press the Delete key on the keyboard.

The watch is deleted.
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Search and Replace Tab
The Search provides the option for locating strings of text in the model. You 
may either search the entire model or select components only. The 
components you can search depend on the type of model (Maintenance or 
Operations) that is checked in the Execution Settings window. 
Components available for search in the Operations model are:

Everything (all components)

Warfighters

RI Pairs

Resources

Interfaces

Goals, Functions, and Tasks

Macros

Snapshots

Variables

External Events

Cultural Templates

Displaying the Search window

To display the Search window:

Do one of the following:
• From the View menu, select Windows, and then click Search from 

the menu that displays.
• Select the Search tab at the bottom of the Output window.

The Search window displays.

Searching in an Operations Model
If you are running an Operations model, the Search options for the 
Operations Model display.
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Searching for Text

To search for text:

1. In the Find What box of the Search window, type the text string you 
want to find.

By default, the search feature is not case-sensitive. Check the Match 
Case box if you want to find a string with the same capitalization (for 
example, Time is different than time). 

Space characters are allowed in the string.

2. In the Look In section, select the model elements to search by clicking 
the adjacent box(s).

3. Click the Find button.

IMPRINT Pro searches for the text string and displays each occurrence 
of that string in the field on the right side of the Search window. 

You can stop the search at any time by clicking the Stop Search 
button.

4. Click  to close the Search dialog box.
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Checking for Syntax Errors
IMPRINT Pro allows you to check your model for syntax errors using the 
Check for Errors option located in the Execution menu and the tool bar. 
The Syntax Checker scans the entire model and immediately reports any 
errors in the Output window.

To check for syntax errors:

1. From the View menu, select Windows, then click Output.

The Output window displays.

2. Do one of the following:
• From the Execution menu, click Check for Errors. 
• Click the Check for Errors button on the tool bar.

Any errors that are detected display in the Output window.

3. To open the dialog box where the error occurs, double-click the error.

IMPRINT Pro generally indicates the nature of the problem in the error 
message, such as “unrecognized word” for a misspelled or undeclared 
variable or macro, or “semicolon expected at end” for a missing semi-
colon.

Common problems include typographical errors in an expression, 
omitting a semi-colon, forgetting to define a variable or using the wrong 
case for a variable name. Because IMPRINT Pro distinguishes between 
upper and lower case letters, name, NAME, and Name are considered 
to be different and unique variables.

For more information on common syntax errors and possible solutions, 
see IMPRINT Pro User’s Manual Volume 3, Appendix: Checking for 
Errors.

Controlling Execution 
IMPRINT Pro provides commands to start, stop, pause, resume, and step 
through execution of a model. You can also set the speed for mission 
execution.
296



Chapter 5: Mission Analysis
Starting and Resuming Mission Execution
To start or resume mission execution:

Do one of the following:
• From the Execution menu, click Begin Simulation.
• Click the Begin Simulation button on the tool bar.
• Press the shortcut keys Ctrl+G.

The mission executes or resumes execution.

Note:
Before executing the mission, check the execution preferences to make sure 
the model is set to run as desired.

Pausing Mission Execution
You can temporarily pause mission execution. When mission execution is 
paused, you can make changes to the model attributes such as the values 
of variables.

To pause mission execution:

1. To pause mission execution do on of the following:
• From the Execution menu, click Pause Simulation.
• Click the Pause button on the tool bar.
• Press the shortcut keys Ctrl+P.

The mission pauses executing.

2. When you are ready to resume mission execution, click Begin 
Simulation from the Execution menu.

Stepping Through Mission Execution
You can step through mission execution one event at a time. This method 
of execution is useful for debugging a mission. This command is available 
only when the mission has not yet begun execution or when mission 
execution is paused.

To step through mission execution:

1. Do one of the following:
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• From the Execution menu, click Step Simulation.
• Click the Step Simulation button on the tool bar.
• Press the shortcut keys Ctrl+T.

IMPRINT Pro executes the next event and pauses.

2. Select Step Simulation again.

IMPRINT Pro executes the next event and pauses.

3. To resume continuous execution, click Begin Simulation from the 
Execution menu.

Stopping Mission Execution
You can stop the current execution of a mission at any point. When you 
halt mission execution, it cannot be resumed. The run is terminated and 
must start over.

To stop mission execution:

Do one of the following:
• From the Execution menu, click Halt Simulation. 
• Click the Halt Simulation button on the tool bar.
• Press the shortcut keys Ctrl+H. 

The current execution stops. 

To stop mission execution temporarily and then resume it, use the Pause 
command. If you click Begin Simulation after you have halted an 
execution, a new run is started.

Setting the Execution Speed
You can control the speed of real time mission simulation from the 
IMPRINT Pro tool bar. Execution speeds are 25%, 50%, 100%, 200%, 
400%, and 800%; each execution speed is twice as fast as the speed listed 
above it.

To set the execution speed:

Do one of the following:
• From the Execution menu, click Simulation Speed.
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• Click the Simulation Speed button on the tool bar.

Select the execution speed from the list that displays.

Subchapter 5.5 Mission and Personnel 
Reports

Use the Reports menu to review one or more of the many reports in 
IMPRINT Pro pertaining to a model that you have just run. 

To view reports:

1. Click the Reports menu.

You will be presented with a submenu from which you can select the 
type of report (Operational Results, Maintenance Results, Personnel 
Attributes Reports and Cross Analysis Report) to be reviewed.

2. Click the report set you want to view.

You will be presented with an additional interface displaying all 
available reports for the type you selected.

3. Check the report options you want, and then click OK. 

IMPRINT Pro creates a new Microsoft Excel workbook that contains a 
separate worksheet for each selected report and graph. A sample 
report workbook is shown in the following figure.

Each report can be accessed by clicking on its corresponding tab at the 
bottom of the workbook. You can obtain a printed copy of the report by 
selecting the Print icon located at the top of the screen in the tool bar.

Note:
Running and viewing reports following a model run requires that the user 
wishing to run and view those reports has the lock on the analysis containing 
that model. For any model which is unlocked or which is locked by another 
user on your network, reports will not be available after the model run. For 
more information on locking and unlocking analyses, see the IMPRINT Pro 
User Guide Volume 1: Basic Procedures, Appendix D: Local Server and 
Remote Server Setup.
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Sample Mission Results Report
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Operational Results Reports
Several reports are available after an Operations Model (Mission) has 
completed.

To display operational model reports:

1. From the Reports menu, click Operational Results. 

A dialog box displays showing all report options.

2. Check the reports you want to see, and then click the OK button. 

3. If the Specialty Usage report is selected or if the Check All button is 
pressed, the Assign Grade Levels dialog displays, prompting you to 
select grade levels (E1-E9) for each of the Operators in your model. 

Operations Model Report Selection Dialog
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4. For each listed operator, select a corresponding grade level from the 
drop-down list under the Grade column, and then click the OK button.

If the Workload Graph is checked, the Workload Over Time dialog 
box displays, prompting you for the range of time over which workload 
should be graphed.
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Enter the desired Start Time and End Time for the range of data you 
wish to graph, and then click the OK button.

5. If the Operator Workload Detail report is checked, click the Group or 
Ungroup radio button to group or ungroup the data by simulation clock 
time.

6. Click OK.

Excel launches, and all selected reports appear in an Excel workbook 
format. Select the report you want to view by clicking the corresponding 
tab at the bottom of the workbook.

Workload Over Time Dialog
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Mission Performance
The Mission Performance report provides information on how the Achieved 
Mission Time, the performance time that was simulated in a run, compares 
with the Mission Time Requirement set by the user.

Times Performed. Displays the number of times the mission 
was performed.

Standard. Displays the Time Requirement you chose for the 
mission. The Time Requirement is the longest performance time 
that can be tolerated and have the mission still be considered a 
success. When IMPRINT Pro executes your mission model, the 
performance time that is predicted by aggregating your individual 
tasks will be compared to this standard to ensure that your 
design can meet the mission level time requirement.

Minimum, Maximum, Mean, and Std. Dev. Displays the 
minimum, maximum, mean and standard deviation of the 
mission performance times across all runs.

% Met Time. Displays the percentage of time the mission 
performance time meets the Mission Time Requirement.

% Met Accuracy. Displays the percentage of time that the 
mission completed without aborting due to a task failure.

Sample Mission Results Report
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% Met Both Time and Accuracy. Displays the percentage of 
time in which both Mission Time Requirement and Accuracy are 
met simultaneously.

Results. The last column in this report shows the overall results 
of the mission simulation. If the proportion of times that the 
mission met the time and accuracy requirements meets or 
exceeds the total mission criterion that you set, then the 
message will say that the mission does meet the performance 
criterion. If the proportion is less than the mission criterion, then 
the message will say the mission does not meet the performance 
criterion.

Mission Results by Run
The Mission Results by Run report displays mission performance times for 
all runs which took place during execution of a mission model. This report 
is helpful in locating a particular run of interest based on mission 
performance time. Since IMPRINT collects thousands of records for any 
model run, several of the reports in the Operations Results reports display 
data for only the first run. If you wish to view all task, function and workload 
data for a specific run in the rest of the reports, you must lookup the RNS 

Mission Performance Report
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(random number seed) displayed in this report, set this number to the 
Random Number Seed box in the Execution Settings dialog, and then 
execute the model. The specific run will now become run 1, and all data will 
be available for that run. This technique allows modelers of simple and 
complex models to perform as many runs as necessary while not over 
taxing system memory and storage.

The Mission Performance by Run Report displays the following columns:

Run. The run number.

Mission Performance Time. The time it takes the mission to 
complete for the listed run. 

RNS. The random number seed used in the listed run. The 
random number seed is used to calculate task execution times 
and to cause other variability, such as taking different 
probabilistic paths, through the network. The random number 
seed is a number between approximately -2 billion and +2 billion 
(inclusive). The same seed always produces the same set of 
random numbers in the same order, and thus the same results.

Accuracy Results. Displays whether or not there is a failure 
consequence. The failure consequence column might explain 
why some mission performance times for a run were cut short.

Histogram Data and Frequency. Data for the Mission Results 
Histogram.

 For more information see “Mission Results by Run Histogram” on 
page 307.
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Mission Results by Run Histogram
The Mission Results Histogram is a frequency distribution bar chart of the 
mission performance time for each run. The mission performance time data 
is divided into separate bins. Each bin is an equal time interval based upon 
the (maximum mission performance time - minimum mission performance 
time)/the number of bins. The number of bins is calculated via a commonly 
accepted algorithm for histograms. Each bin becomes a bar on the bar 
chart that shows the mission performance time distribution over all runs. 
This allows you to see, at a glance, if the mission performance times are 
distributed normally over the course of all the models runs. 

Note:
For less than 10 runs, the total number of bins displayed is one.

Mission Results by Run Report
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Function Performance
The Function Performance Report includes: 

ID. The ID of the listed function.

Function. The name of the listed function.

Times Performed. The number of times the listed function was 
performed over the course of all runs.

Note:
Any instance of a function in which the function starts and/or initializes but 
does not end will not be counted in the Times Performed total.

Standard. Indicates the Function Performance Time 
Requirement. The Time Requirement is the longest performance 
time that can be tolerated and have the function still be 
considered a success. When IMPRINT Pro executes your 
mission model, the performance time that is predicted by the 
aggregation of all tasks in this function will be compared to this 
requirement to ensure that your design can meet the function 
level time requirement. If you did not enter a time requirement, it 
will default to zero (00:00:00.) Therefore, if you have already 

Mission Results Histogram
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entered nonzero task times in your functions but have not yet 
changed the time requirement, it will probably cause the 
percentage of time your functions meet this time requirement to 
be 0%.

Minimum, Maximum, Mean, and Std. Dev. The minimum, 
maximum, mean, and standard deviation of the performance 
times. These fields will be blank for functions that did not 
execute, or in other words, for functions in which times 
performed is zero.

% Met. The percentage of time for which the Function 
Performance Time Requirement is met.

Task Performance
The Task Performance Report is a detailed report that provides 
performance data on all tasks in your mission model, including the tasks 
which did not fire during the model run. This report also includes a 
summary of the performance accuracy that was predicted for each task.

The following information displays for each task:

ID. The ID number of the listed task.

Function. The name of the listed task’s parent function.

Function Performance Report
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Task. The task name.

Operator. The operator who performed the task.

Times Performed. The total number of times this task was 
performed over all mission runs.

Note:
Any instance of a task in which the task starts and/or initializes but does not 
end will not be counted in the Times Performed total. For more information on 
the behavior of these tasks within the model run see “Workload Strategy 
Trace” on page 323.

Time section of report:
Standard. The time requirement set for this task in the Time 
Requirement field. The time requirement is the longest 
performance time that can be tolerated and have the task still be 
considered a success.

Minimum, Maximum, Mean, Std. Dev. The next four columns 
display the Minimum, Maximum, Mean and Standard Deviation 
of the task time. These are calculated from the simulation 
execution for all runs combined.

% Met. The percentage of time that the task met the required 
time, or Standard.

Accuracy section of report:
Accuracy Standard. The Accuracy Requirement for the task as 
set by the user.

Accuracy Measure. The Accuracy measure (for example, 
“percent steps correct”).

% Met. The percentage of time the task met the accuracy 
requirement.

Mission Aborts. The percentage of time in which the task led to 
mission failure.

Overall section of report:
% Met Both Time and Accuracy. The percentage of time in 
which both the Task Performance Time Requirement and 
Accuracy Requirement are met simultaneously.
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Results. Displays whether or not the task met the Task and 
Accuracy Criterion. This Criterion is the minimum percentage 
of time a task must meet both the time requirement and the 
accuracy requirement simultaneously in order to be considered 
successful. IMPRINT Pro determines the % of time that the task 
meets both these requirements; if this number is equal to or 
greater than the number you set in the Criterion field in the task 
properties window, you will also see a message that says the 
task does meet the performance criterion. Otherwise you will see 
a message that the task does not meet the performance 
criterion.

Below is an example report where although the highlighted task met the 
Time Requirement (00:10:00.00) 47.4% of the time and the Accuracy 
Requirement of (25%) 48.7% of the time independently, the percentage of 
time in which the task met the required time and accuracy simultaneously 
(21.43%) fell short of the performance criterion (25%).

Task Performance Report
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Task Sequence Chart
The Task Sequence Chart displays all task activity that occurred during a 
model run in the form of a Gantt chart.  A timeline representing mission 
time displays along the bottom of the chart while tasks list along the right 
hand side of the chart.  Instances of tasks are represented by colored bars 
at the same level as the listed task, the placement of which corresponds to 
the start time and end time of the task in the model run.  A task’s duration 
at any one instance is represented by the length of the corresponding bar 
in the chart as measured against the timeline below.

For more information on Critical Path see “Mission Time Drivers” on 
page 313.

Task Failure
The Task Failure report provides a summary of all tasks that failed due to 
accuracy during mission execution and the consequences that occurred as 
a result, for each run. For any task, these failure consequences are defined 
in the Failure tab of that task. Use this report to verify that the 
consequences of failure for a task have been defined appropriately.

The Task Failure Summary provides the following information:

Run. The number of the run containing the failed task.

Function Name. The function containing the failed task.

Task Name. Name of the task that failed.

Time. The time at which the failure occurred.
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Consequence of Failure. The consequence that was applied as 
a result of the task having failed. Possible consequences of the 
failed task include the following:

The task is degraded in time.

The task is degraded in accuracy.

A new task (user-specified) immediately follows.

The mission fails, and as a consequence, aborts.

No effect on the mission.

The operator and/or task assignment changes.

The task repeats. 

Mission Time Drivers
The Mission Drivers Summary identifies the tasks in the mission that make 
up the critical path through the network. The critical path is the necessary 
path or sequence from start to finish which determines the time needed for 
completion. It is also the longest most time-consuming path in the network 
thus leading to the mission performance time. Use it to identify a time flow 
impediment to the mission. 

Task Failure Report
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The report lists the following in temporal order (from time 0.000 seconds to 
mission completion):

ID. The ID number of the listed task.

Function Name. The function containing the task.

Task Name. The name of the task that is on the critical path.

Beginning Time. The time that the task started.

Ending Time. The time that the task ended.

Performance Time. Task ending time minus task beginning 
time, i.e. task duration.

Note:
The Mission Time Driver report omits all zero-time tasks along the critical path 
of the model. If you wish to view all tasks comprising the sequence of events 
your model run, including zero-time tasks, refer to the Workload Strategy 
Trace report.

Mission Time Drivers Chart
The Mission Time Drivers Chart displays only a subset of information 
contained by the Task Seqence Chart, specifically those tasks which 
contribute to the critical path of the mission.   

Mission Time Drivers Report
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All critical path task activity that occurred during a model run displays in the 
form of a Gantt chart.  A timeline representing mission time displays along 
the bottom of the chart while tasks list along the right hand side of the 
chart.  Instances of tasks are represented by colored bars at the same level 
as the listed task, the placement of which corresponds to the start time and 
end time of the task in the model run.  A task’s duration at any one instance 
is represented by the length of the corresponding bar in the chart as 
measured against the timeline below.

For more information on Critical Path see “Mission Time Drivers” on 
page 313.

Operator Workload Summary
The Operator Workload Summary provides information about the total 
workload demand placed on an operator during the first run of a mission. 
To see the listings for a specific operator, scroll down the report until the 
data corresponding to the desired operator appears. The following 
information displays:

Clock. The simulation clock time. Clock times are driven by any 
change in the model during the run, such as a task beginning or 
a task ending.

Operator. The name of the operator incurring workload.

Threshold. The operator’s workload threshold value as set on 
the operator’s properties dialog.

Sum of Data Over Time 

Overall Workload. The sum of all single task demand values 
and all conflict values (inter-channel and intra-channel) of all 
ongoing tasks that an operator is currently performing at a given 
instant in time.

Single Task Demand. The sum of all single task demands of all 
ongoing tasks that an operator is currently performing at a given 
instant in time. These demand values are set in the Workload 
Demand tab of the Task Properties window which is available by 
double-clicking a task in the Analysis Tree or in the Network 
Diagram.
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Total Conflict Value. The sum of the total conflict values of all 
ongoing tasks that an operator is currently performing at a given 
instant in time. A channel conflict occurs when resource-
interface pairs compete for the operator's attention. These 
values are defined in the Conflicts tab which is available by 
double-clicking the RI-Pairs node in the Analysis Tree. See 
examples below:

Example 1: Two simultaneous identical tasks both having a 
“fine motor/keyboard” resource-interface channel requirement 
would cause a channel conflict if, in fact, a conflict value were 
assigned to that combination. This is an example of Intra-
channel conflict, a conflict which occurs when channel pairs use 
the same resource.

Example 2: Two simultaneous tasks both using the same “fine 
motor” resource but different interfaces, such as a keyboarding 
task (keyboard) and a writing task (pen). This is also an 
example of Intra-channel conflict, a conflict which occurs when 
channel pairs use the same resource.

Example 3: Two simultaneous tasks, one of which has a “fine 
motor/keyboard” channel requirement while the other has a 
“visual/computer screen” channel requirement, would potentially 
have a channel conflict if, in fact, a conflict value were assigned 
to that combination. This is an example of Inter-channel conflict, 
a conflict which occurs among channel pairs using different 
resources.

Auditory, Cognitive, Fine Motor, Gross Motor, Speech, 
Tactile and Visual. The sum of all single task demands on a 
particular resource at a given instant of time, considering all 
ongoing tasks. These sums are grouped by resource, both 
default resources and any user-added resources, and are 
reported by individual operator (scroll down the report to access 
similar data for subsequent operators.)
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Operator Workload Detail
The Operator Workload Detail report is similar to the Operator Workload 
Summary report in that it provides information about the total workload 
demand placed on an operator at certain points during the model run. In 
the Workload Detail report, however, for each clock time reported all 
ongoing tasks are listed separately. For each task, single-task demands for 
each interface pair also display. 

Clock. The simulation clock time. Clock times are driven by any 
change in the model during the run, such as a task beginning or 
a task ending.

Operator. The operator assigned to the task.

Function Name. The parent function of the task.

Task Name. The task occurring at the reported clock time.

Sum of Data Over Time: 

Operator Workload Summary Report
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Overall Workload. The sum of all single task demand values 
and all conflict values (inter-channel and intra-channel) of all 
ongoing tasks that an operator is currently performing at a given 
instant in time.

Single Task Demand. The sum of all single task demands of all 
ongoing tasks that an operator is currently performing at a given 
instant in time. These demand values are set in the Workload 
Demand tab of the Task Properties window which is available by 
double-clicking a task in the Analysis Tree or in the Network 
Diagram.

Total Conflict Value. The sum of the total conflict values of all 
ongoing tasks that an operator is currently performing at a given 
instant in time. A channel conflict occurs when resource-
interface pairs compete for the operator's attention. These 
values are defined in the Conflicts tab which is available by 
double-clicking the RI-Pairs node in the Analysis Tree. See 
examples below:

Example 1: Two simultaneous identical tasks both having a 
“fine motor/keyboard” resource-interface channel requirement 
would cause a channel conflict if, in fact, a conflict value were 
assigned to that combination. This is an example of Intra-
channel conflict, a conflict which occurs when channel pairs use 
the same resource.

Example 2: Two simultaneous tasks both using the same “fine 
motor” resource but different interfaces, such as a keyboarding 
task (keyboard) and a writing task (pen). This is also an 
example of Intra-channel conflict, a conflict which occurs when 
channel pairs use the same resource.

Example 3: Two simultaneous tasks, one of which has a “fine 
motor/keyboard” channel requirement while the other has a 
“visual/computer screen” channel requirement, would potentially 
have a channel conflict if, in fact, a conflict value were assigned 
to that combination. This is an example of Inter-channel conflict, 
a conflict which occurs among channel pairs using different 
resources.
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Auditory, Cognitive, Fine Motor, Gross Motor, Speech, 
Tactile and Visual. The sum of all single task demands on a 
particular resource at a given instant of time, considering all 
ongoing tasks. These sums are grouped by resource, both 
default resources and any user-added resources, and are 
reported by individual operator (scroll down the report to access 
similar data for subsequent operators.)

Task Demands by Resource-Interface Pairs:

This section of the report shows the demands that any currently 
ongoing task is placing on each of the individual resource-
interface pairs. By default, all analyses include the default 
interface “Crewstation.”

Grouped vs. Ungrouped
When selecting the Operator Workload Detail report in the reports selection 
dialog, you are presented with the option of choosing a Grouped or an 
Ungrouped version of the report:

Grouped. For each instant of time reported in the Workload 
Detail report, the Sum of Data Over Time columns display their 
respective cumulative data values totaled over all tasks 
occurring at that given instant. For example, for a single time 
instant in which five tasks simultaneously occur, only one Overall 
Workload value will appear in a single cell adjacent to the five 
tasks, representing the total overall workload for all five of those 
tasks at that instant in time.

Ungrouped. For each instant of time reported, the Sum of Data 
Over Time columns display the same respective cumulative 
workload data sums for all tasks occurring at that given instant 
as the Grouped report displays. These same values, however, 
are repeated next to each task listed, even though they 
represent the sum for all tasks together. In the event you wish to 
re-sort the data by task, these sum values will always 
accompany the task.
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Channel Conflict
The Channel Conflict Summary shows you information about the conflict 
between any two resource-interface channels that an operator experiences 
over the course of a mission run. A conflict occurs when two or more tasks 
compete for that operator’s same resource. For example, an operator 
trying to listen to two radios at the same time, each of which are 
transmitting different messages, would cause a conflict in that operator’s 
auditory resource. If the interfaces of both were slightly different, for 
example a radio and a telephone, conflict would still occur in the auditory 
resource, but the channel conflict type would be of a different category. 

The conflict values between channels are set in the Conflicts tab which is 
available by double-clicking the RI-Pairs node in the Analysis Tree. The 
following are examples of the two categories of channel conflict:

Example 1: Two simultaneous identical tasks both having a 
“fine motor/keyboard” resource-interface channel requirement 
would cause a channel conflict if, in fact, a conflict value were 
assigned to that combination. This is an example of Intra-
channel conflict, a conflict which occurs when channel pairs use 
the same resource.

Operator Workload Detail Report
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Example 2: Two simultaneous tasks both using the same “fine 
motor” resource but different interfaces, such as a keyboarding 
task (keyboard) and a writing task (pen). This is also an 
example of Intra-channel conflict, a conflict which occurs when 
channel pairs use the same resource.

Example 3: Two simultaneous tasks, one of which has a “fine 
motor/keyboard” channel requirement while the other has a 
“visual/computer screen” channel requirement, would potentially 
have a channel conflict if, in fact, a conflict value were assigned 
to that combination. This is an example of Inter-channel 
conflict, a conflict which occurs among channel pairs using 
different resources.

The report displays the following information for each operator:

Resource Interface Pairs 1 and 2. The resource-interface pairs 
being analyzed for conflict. A resource-interface pair is a 
combination of any resource with any interface, for example the 
combination of “fine motor” and “keyboard.” These combinations 
are assigned in the Channels tab of the Resource-Interface 
Channels and Conflicts window, which is available by double-
clicking the RI Pairs node in the Analysis Tree and selecting the 
Channels tab

Conflict Value. The conflict value assigned between any two 
resource-interface channel pairs. This value is assigned in the 
Conflicts tab of the Resource-Interface Channels and Conflicts 
window, which is available by double-clicking the RI Pairs node 
in the Analysis Tree and selecting the Conflicts tab.

Number of Times Assessed. The number of times a conflict 
between any two resource-interface channel pairs is assessed. 
Conflicts are assessed each time there is a workload state 
change in the model and counted when any ongoing, non-zero 
time tasks at that time are experiencing channel conflict. For 
example if task A is running in the background while task B ends 
and task C starts in its place, task C might immediately have 
conflict with the ongoing task A at which point conflict between 
this pair is assessed as “1” and counted as “1”. If a second new 
task also having workload, task D, starts just shortly after task C, 
task D similarly contributes to a workload state change for the 
entire model in which case all channel conflicts for all pairs are 
once again assessed. The actual conflict between A and C 
remains the same, but the “Number of Times Assessed” for this 
pair now displays as “2”. These data are reported for the first 
mission run only.
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Use this report to determine circumstances where an operator is 
repeatedly having conflicts between resources-interfaces channels. 
Conflicts are reported for the first run only.

Note:
For any operator whose conflicting tasks are reallocated to a contingency 
operator through workload strategy E or F, the resultant conflict for that 
primary operator for that instant of time is zero thus no records of conflict are 
reported for that instant.

Workload Graph
The Workload Graph displays each operator's total workload throughout 
the mission timeline for the first mission run. A unique Workload graph 
displays for each designated operator. 

The workload is displayed as a step graph on an x-y axis. The x 
(horizontal) axis represents time and the y (vertical) axis represents the 
workload index. Each operator's workload profile is displayed in a different 
color. The key is located in the window.

The default time scale ranges from time 0.00 seconds through mission 
completion time and displays for the first run only.

Channel Conflict Summary Report
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Workload Strategy Trace
The Workload Strategy Trace Report shows an ongoing history of model 
execution by listing each task as its status changes.

Clock Time. The simulation clock time. Clock times are driven 
by any change in the model during the run, such as a task 
beginning or a task ending.

Operator. The operator assigned to the task.

Function Name. The parent function of the task.

Task Name. The task experiencing a status change.

Strategy. The workload strategy assigned to the operator 
performing the task. This strategy may consequently affect the 
Workload total and the Current Task Total depending on the 
strategy assigned in the Warfighter’s properties window.

Workload. The amount of workload experienced by the operator 
assigned to the task, at the reported clock time.

Workload Graph
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Task Status. The state of the task as a result of a Release 
Condition, Beginning Effect, Ending Effect or any other factor 
within the task network affecting the operation of this task. Status 
values include the following:

Initialize. This task is the next task to be considered by the 
listed operator. If the Release Condition of this task evaluates as 
“True,” this task will start. If the Release Condition evaluates as 
“False,” the task never starts. An initialized task increases the 
Current Task Total number by 1. The ModelStart tasks is the 
only task whose Initialize condition does not display in the 
report. 

Started. The task’s Release Condition is true, and the task is 
performed by the Operator. A Started task shares the same 
contribution to the Current Task Total for the same Operator as 
when it was an Initialized task.

Ended. The task has been performed to completion by the 
Operator. An Ended task decreases the previously-reported 
Current Task Total for the same Operator by 1.

Resumed. A previously suspended task is once again being 
picked up by the Operator. A Resumed task increases the 
previously-reported Current Task Total for the same Operator by 
1.

Restarted. A previously stopped task is once again assumed by 
the listed Operator. A Restarted task increases the previously-
reported Current Task Total for the same Operator by 1.

Stopped. The listed task terminates. A Stopped task decreases 
the previously-reported Current Task Total for the same 
Operator by 1.

Suspended. The task is currently put on hold until conditions 
are met such that it may resume. A suspended task decreases 
the previously-reported Current Task Total for the same 
Operator by 1.

Not Started.  The operator’s assigned strategy is applied in the 
release condition of a task, and as a result the task does not 
start.

Current Task Total. The total number of tasks currently 
assigned to the Operator, including the named task except in the 
case when the Task Status is Ended.
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Snapshots
The Snapshot Report allows you view the values of variables and the 
method by which they are triggered. Snapshots are defined in the 
Snapshot Properties window, which is available by double-clicking a listed 
snapshot under the Snapshots node in the Analysis Tree.

Workload Strategy Trace Report
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Stressor Settings
You can apply five different stressors (cold, heat, noise, MOPP, and 
sleepless hours) to tasks in the Settings option of the Moderators menu. 
The Stressor Settings report allows you to view all the stressors you set for 
the model. The report will display the following information:

Function Name. The parent function of the task.

Task Name. The task that the stressor has been applied.

Warfighter.The name of the operator who will perform the task.

Specialty. A three-character designation representing the 
operator’s specialty.

Stressor. The type of stressor.

Level. The level at which the stressor has been applied.

Snapshot Report
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Goal Status Report
The Goal Status report shows the status of the mission and all goals within 
it every time the status of the mission or any goal changes during the 
model run. For each clock time listed, the status of the mission lists first, 
followed by the status of all goals in order of goal priority (highest priority 
goals listed at the top.)

Run. The number corresponding to the model run. 

Clock. The simulation clock time at which a status change 
occurred in the model, either in the mission or in a goal 

Mission or Goal. The mission or goal whose status is being 
reported.

Status. The current state of the listed goal or mission.

The Goal Status report displays the following possible status changes:

Not started. The listed goal has not yet started (goals only).

Running. The listed goal or mission is currently running.

Stressor Settings Report
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Interrupted. The listed goal or mission has been interrupted by 
another goal. Only goals having a higher priority can interrupt 
other goals in the mission. All goals are able to interrupt the 
mission.

Ended Normally. The listed goal or mission completes.

Aborted. The listed goal is aborted (terminated) by another goal 
in the mission. A goal can abort only lower-priority goals. Goals 
cannot, however, abort the mission.

Specialty Utilization Report - Operations Model
For users who regularly use the Army Military-Civilian Cost System 
(AMCOS) to estimate the cost of using a fixed number of military personnel 
for a specific number of years, the Specialty Utilitization Report is designed 
to provide you information about the utilization of all the specialties in your 
model run which may then be used as a basis for the data you enter into 
AMCOS.

Goal Status Report
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In general, AMCOS requires that you enter specialty, the number of people 
of each specialty, and all years of service to be included in your cost 
estimate so that it can give you an estimation on how much it costs to 
support these specialties for those years. After having run an IMPRINT Pro 
model, you may use the Specialty Utilization Report to gain a better 
understanding on the types and quantities of personnel you need based on 
your model run results.

The Operations Specialty Usage report includes the following data:

Specialty Rank. The specialty and rank which categorize the 
operator whose usage is being reported.

# of Specialty. The number of operators in the model of the 
specialty and rank specified who contributed to the total usage 
time.

Time. The cumulative amount of time all operators having the 
designated specialty and rank spent performing tasks in the 
model, for example, the cumulative amount of time that all 19K 
E4 operators spent time on tasks in the 

Before entering data into AMCOS based on this report, the idea of 
“utilization” according to IMPRINT Pro must be understood. In the 
Operations model, utilization is considered to be the total time an operator 
spends actually working on tasks and is not the amount of time an operator 
is simply available. These two concepts differ in the case of suspended 
tasks where an operator is present but no actual work is being done on that 

Operator Specialty Usage Report
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task by an operator. If the operator, however, is pulled onto a different task 
while the first task is suspended, the amount of time that operator works on 
the second task is added to the total utilization amount reported by the 
Specialty Utilization Report. In short, the utilization is a sum of all time the 
operator spent performing any task within the network. More detailed 
information about the individual tasks performed by an operator can be 
found in the Workload Strategy Report, the report on which the Specialty 
Utilization Report is based.

It is also important to note that the utilization reported by the Specialty 
Utilization Report is for the total duration of the model; if the total clock time 
of your model run is any less than one year, the utilization hours reported 
will not correlate directly with the expected values AMCOS requires, which 
are specifically the full years that you need a specialty. You must project 
out from the utilization summary the number of people of a certain specialty 
you need and the number of years your specialty must be available; this 
interpolation of the data may require more expertise beyond what the 
Specialty Utilization Projection Report can provide. The quantities of each 
specialty and the years for which they are required could vary depending 
on how many people of each specialty your mission requires and how 
many similar missions you intend to execute within the course of a year.

AMCOS requires users to enter data in four steps: Properties, Faces and 
Spaces, Cost Summaries and Output. The part of AMCOS to which your 
IMPRINT model run results apply is the Faces and Spaces step where 
you add information about the personnel required. This part of AMCOS is 
depicted in the image below:

The Faces and Spaces page contains the following fields:

PayPlan
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Group

Subgroup 

Area 

Locality 

Grade

Inventory

The only fields where IMPRINT report data applies are in the Group, 
Subgroup, Grade and Inventory fields.

Applying IMPRINT Pro report data to AMCOS
To apply IMPRINT Pro report data to AMCOS:

1. Select the desired group from the drop-down list.

Note:
In IMPRINT Pro, all specialties from which you may select your 
Warfighters are grouped together in one list. In AMCOS, however, 
specialties are categorized into different groups. The first two 
characters in a specialty code defines the group to which that specialty 
belongs. 

The selected group appears in the Group field, and the SubGroup 
drop-down list is enabled.
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2. From the SubGroup drop-down menu, select the desired subgroup 
(specialty).

The selected subgroup appears in the SubGroup field.

3. From the Grade drop-down menu, select the pay grade which applies 
to the selected Group-SubGroup combination.
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In the IMPRINT Pro Operations model, Operators do not, by default, 
have an E-level assigned to them. In the process of generating the 
IMPRINT Pro reports, however, you will first be prompted to select an 
E-level for each operator. Once the values are selected, they appear in 
the Operator Specialty Usage Report, the report on which you can then 
base your AMCOS data. The selected grade appears in the Grade 
field.

4. The Inventory section displays a box for each year you are choosing to 
project costs. In each box provided, enter the number of personnel for 
which costs are to be projected.
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5. Click the Insert button in the lower-left corner of the screen.

The specialty data you entered is added to the list at the top of your 
AMCOS screen. You may repeat these steps for all specialties to be 
included in your cost projection. Once you have finished entering 
specialty information, you are finished with the portion of AMCOS which 
requires data from IMPRINT. Proceed with the remaining steps in 
AMCOS as normal.

Graph Data 
The Graph Data Report displays all data use to generate the Workload 
graphs. The Graph Data report contains duplicate rows of data which are 
added for graphing purposes. These extra rows allow the data to be shown 
as a “step chart,” an enhancement than enables the report to show 
workload over time.

The graph data included in this report shows all operators in one dataset. 
Only one graph will be generated from this data.
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Personnel Forecast Report
For every operator in your analysis having a unique specialty, the 
Personnel Forecast Report displays the number of people of that specialty 
who will be available over the course of the next five years. Estimates are 
broken down by E-level (E3, E4...E9).

To create a Personnel Forecast Report:

1. From the Reports menu, click Personnel Forecast.

The Personnel Forecast report dialog box displays.

2. In the Personnel Forecast report dialog, check the boxes corresponding 
to the data you wish to view. Available options are:

Graph Data Report

o
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• Personnel Forecast: this report displays forecast data for all unique 
specialties in your list of operators in a single report. For every year 
forecasted, the report breaks down the number of forecasted 
personnel for that specialty by E-level (E3, E4...E9). Data are 
presented in a tabular format.

• Personnel Forecast Graphs: for each unique specialty in your list of 
Operators, a new graph report is create, displaying that specialty’s 
forecast data in the form of a three-dimensional bar chart. For every 
year forecasted, the report breaks down the number of forecasted 
personnel for that specialty by E-level (E3, E4...E9).

3. Click OK.

Microsoft Excel launches, and the reports display.

In the example below, the report is run for five different helicopter 
repairman specialties: 15M, 15R, 15S, 15T and 15U. The generated report 
displays estimates on how many personnel of each specialty category will 
be available through the year 2012.

Note:
In the example below, IMPRINT Pro omits the 15M specialty due to the 
unavailability of data for this specialty.
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The Personnel graphs display the same information in the form of a bar 
chart.

Personnel Forecast Report
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Cross Analysis Report
The Cross Analysis Report allows you to display the results of one or more 
missions (or scenarios) side-by-side and compare their summary data.

To run the Cross Analysis Report:

1. Run the missions in your models that you wish to compare.

2. From the Reports menu, select Cross Analysis Report.

A report selection dialog appears.

Personnel Forecast Report
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3. If you wish to compare Mission runs, click the Operations Model radio 
button.

A list of all missions run in the current session of IMPRINT Pro appear.

4. Check the box for each mission you wish to include in your comparison.

5. Click OK.

Excel launches, and the Cross Analysis report appears.

Summary data for all selected missions displays.

6. Follow comparison of equipment scenarios, click the Maintenance 
Model radio button.
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7. Check the box for each scenario you wish to include in your 
comparison.

8. Click OK.

Excel launches, and the Cross Analysis report appears.
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Summary data for all selected scenarios displays.
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This chapter describes the IMPRINT Pro Equipment analysis capability. 
The chapter is divided into subchapters that describe how to enter the data 
needed to describe the system equipment, the properties for operational 
scenarios, settings that control mission execution methods used to analyze 
the results data, and how to create charts displaying the values of variables 
during execution. 

The objective of the Equipment module is to help you estimate 
maintenance manhour requirements for your system. This module lets you 
enter properties that control such items as the maintenance manpower 
pools, the spare availability, and the combat damage potential. These 
properties, coupled with a mission schedule and the data describing the 
maintenance actions that your system may need are combined in a 
stochastic maintenance simulation. The primary purpose of the simulation 
is to predict the maintenance manhours required to attain an acceptable 
system availability.

Introduction to Equipment Analysis 

To conduct an IMPRINT Pro analysis of the maintenance manhour 
requirements to support a particular system, follow these steps:

1. Divide the system into separately maintained components. For each 
component described, provide the following information:
• How often the component needs to be maintained (such as rounds 

fired, time operated)
• The type of repair task that needs to be performed (remove & 

replace, repair, inspect, troubleshoot, and so on.)
• Whether the maintenance is preventive or corrective
• The maintenance organizational type at which the task needs to be 

performed (for example, ORG, DS, GS)
• The type and number of maintainers that are needed to perform the 

repair task
• How long it will take to perform each repair task
• Probability of mission abort
• Whether a contact team could perform the maintenance
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• Adjust estimated task times and accuracies by setting PTS levels.

This information will be contained in the IMPRINT Pro Repair Task 
dialog box with a column for each of the maintenance properties listed 
above for each Repair Task. The data will be used as input to the 
IMPRINT Pro maintenance simulation model.

If you are using IMPRINT Pro to evaluate the maintenance 
requirements for a proposed new system in the acquisition cycle, you 
can enter the component maintenance properties from scratch or from 
a system design. However, it is more likely that you will begin by 
copying maintenance properties from a similar library system and then 
modifying existing components and/or adding new components to 
reflect the system you are trying to evaluate.

If you are using IMPRINT Pro for a different purpose, such as unit 
design, you may want to simply copy a library system and use it as is, 
using the same components and maintenance actions and modifying 
only the types of maintainers, maintenance levels, or other properties 
for the existing components.

2. Build a simulation scenario that will define the conditions under which 
the system you are modeling will be used and the amount of usage the 
components in each system will incur. Scenario segments will 
determine subsystem usages and probabilities for combat damage. 
Each scenario can contain multiple segments. 

3. Define the unit configuration and support properties for each scenario. 
These properties include:
• Maintenance shift manning (size, type). This parameter defaults to 

the minimum possible shift manning, as well as one shift per day that 
is eight hours long. IMPRINT Pro calculates the minimum shift 
manning by examining each repair task to find the minimum number 
of people in each specialty that will enable any given task to be 
performed.

• Spare parts (availability, wait times). This is also an optional 
parameter and is specified at the subsystem level. This parameter 
defaults to 100% availability, and a zero wait time.
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Subchapter 6.1 Equipment Data

Equipment data consists of several items:

Subsystems. Subsystems are typically something like an engine, 
landing gear, or main gun.

Components. Components are subsets of subsystems. 
Components are the individual pieces of equipment that have 
repair tasks attached. You can enter or edit maintenance data for 
all repair tasks associated with the components.

Repair Tasks. Repair tasks are attached to individual pieces of 
component equipment. 

Subsystems
An equipment analysis consists of several subsystems. Subsystems are 
typically items like an engine, landing gear, or main gun.

Displaying Subsystems
To display a subsystem:

Double-click the Subsystems node.

This action will display a list of all the major subsystems for the system 
that you are modeling in the main window.
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Subsystems information includes the following:

Subsystem. The first column will display a list of all subsystems 
you have added to your equipment analysis. A major subsystem 
is typically something like an engine, landing gear, or main gun.

Equipment Group Name. The second column contains the 
Equipment Group name or equipment type. There are three 
possible equipment types, Armaments, Mobility, and Other.

The equipment type of each subsystem determines how the 
usage will be accrued to each component in the subsystem and 
the basis on which each component will require maintenance.

Mobility subsystems will accrue usage and require 
maintenance based on the distance travelled by the system.

Armaments subsystems will accrue usage and require 
maintenance based on rounds fired from that subsystem.

Other subsystems accrue usage and require maintenance 
based on the time the system is operated.

Date Last Modified. The third column shows the date you last 
made changes to your Equipment analysis.
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Adding Subsystems
To add a subsystem:

1. In the Analysis Tree, right-click the Subsystems node. 

2. Select Add Subsystem from the menu that displays. 

Note:
IMPRINT Pro will name your new subsystem Subsystem. If you continue to 
add subsystems, each following subsystem will be named SubystemX 
where X is the next integer. You can edit the name of the subsystem in the 
Name field in the Subsystems dialog box.

Copying Subsystems
To copy a subsystem:

1. In the Analysis Tree, right-click the subsystem (for example, 
Subsystem1) below the Subsystem node. 

2. Select Copy Subsystem from the menu that displays.

Cutting Subsystems
To cut a subsystem:

1. In the Analysis Tree, right-click the subsystem below the Subsystem 
node. 

2. Select Cutting Subsystem from the menu that displays.

When you paste the subsystem to another Equipment mission, 
IMPRINT Pro will remove the subsystem from its current location to the 
new location.

When you click in the Analysis Tree, the subsystem will be highlighted 
in red and remain in its position until you paste it to a new position. 
Once you perform a Paste command, the subsystem will be removed 
from its old position.
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Pasting Subsystems
To paste a subsystem:

1. Copy or cut a subsystem.

2. Right-click the Subsystem node in the equipment model that you want 
to add the subsystem to. 

3. Select Paste Subsystem from the menu that displays.

Deleting Subsystems
To delete a subsystem:

1. In the Analysis Tree, right-click the subsystem (for example, 
Subsystem1) below the Subsystem node.

2. Select Delete Subsystem from the menu that displays.

Components
Subsystems are decomposed into components. Components are the 
individual pieces of equipment that have repair tasks attached. You can 
enter or edit maintenance data for all repair tasks associated with the 
components.

Displaying Components
To display the list of components for the subsystem:

1. In the Analysis Tree, click the + adjacent to the Subsystem node.

A Components node will display under the subsystem.

2. Double-click the Components node.

A list of components displays below the Component node in the 
Analysis Tree and in the main window.
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Adding Components
To add a component:

1. In the Analysis Tree, right-click the Components node. 

2. Select Add Component from the menu that displays.

IMPRINT Pro adds a component to the Analysis Tree below the 
Components node and to the list of components on the Components 
Information dialog box in the main window.

Note:
IMPRINT Pro names the new component Component. If you continue to add 
Components, each following component will be named Component and is 
numbered, increasing by one for each addition. You can edit the name of the 
component in the Components Properties Window name box.

Deleting Components
To delete a component:

1. In the Analysis Tree, right-click the component (for example, 
Component1) below the Components node.

2. Select Delete Component from the menu that displays.

Cutting Components
To cut a component:

1. In the Analysis Tree, right-click the component child node (for example, 
Component1) below the Components node. 

2. Select Cut Component from the menu that displays.

When you click in the Analysis Tree, the component is highlighted in 
red. When you paste the component to another Equipment scenario, 
IMPRINT Pro will remove the component from its current location to the 
new location.
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Copying Components
To copy a component:

1. In the Analysis Tree, right-click the component (for example, 
Component1) below the Component node.

2. Select Copy Component from the menu that displays.

Pasting Components
To paste a component:

1. Copy or cut a component.

2. Right-click the Components node in the Equipment analysis that you 
want to add the component to. 

3. Select Paste Component from the menu that displays.

Displaying Component Information
To display component information:

Double-click the component child node (for example, Component1) to 
see a Component information screen in the main window.

The Subsystem Name and Equipment Group Name display on the 
component information screen.
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Repair Tasks
You can attach Repair Tasks to individual pieces of component equipment. 
Repair tasks require maintainers which affect your maintenance manpower 
estimates. There are 33 different repair task types available for selection. 
Examples include Adjust and Repair, Inspect, Remove and Replace, Test 
and Check, and Troubleshoot. 

Displaying Repair Task Lists
To display repair tasks for each component:

1. In the Analysis Tree, click the + beside component child node (for 
example, engine, fuel pump, or Component1).

The Repair Tasks node will display below the component node.

2. Click the +  adjacent to Repair Tasks node.

A list of repair tasks will display below the Repair Tasks node in the 
Analysis Tree.

Adding Repair Tasks
Below the Repair Tasks node IMPRINT Pro allows you to add repair tasks. 
You can add each of these repair tasks twice.

To add a repair task:

1. In the Analysis Tree, right-click the Repair Tasks node.
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2. Select Add Repair Task from the menu that displays.

One of the following repair tasks or Maintenance Actions will be added 
below the Repair Tasks node: 
• Access
• Adjust
• Adjust & Repair
• Align
• Calibrate
• Camouflage
• Clean
• Debug
• Disassemble/Assemble
• Dispose
• Evaluate
• Fault Location
• Inspect 
• Install
• Load/Unload
• Lubricate
• Mission Profile Change
• Monitor
• Operate
• Overhaul
• Package/Unpackage
• Preserve
• Process
• Rebuild
• Remove
• Remove & Replace
• Repair
• Service
• Set Up
• Test & Check 
• Transport
• Transport Preparation
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• Troubleshoot

Note:
The Remove and Replace repair task is the only task type for which a wait 
time for spare parts (entered in the Spares tab of the scenario) can accrue. 
This total time accrued appears in the Logical Summary report.

Displaying Repair Task Data
IMPRINT Pro compiles all of the repair tasks and the associated data for 
each component in a worksheet. You can display the worksheet and make 
changes to the repair tasks.

To display repair task data in the main window:

Double-click the Repair Tasks node.

Repair Task data displays in the main window.

The Subsystem and Component names for the repair task will display in 
the boxes at the top of the window.

Displaying Repair Task Properties
Each component could require several possible maintenance actions or 
types of repair. Each individual action is associated with a set of 
maintenance properties.
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To display repair task properties:

In the Analysis Tree, double-click the repair task (for example, Adjust 
and Repair) below the Repair Tasks node.

The Properties dialog box for the repair task will open in the main 
window. You can review or edit the repair task as required.

The Subsystem and Component that the repair task is attached to 
displays at the top of the dialog box.

Action. You can assign maintenance actions for each 
component by clicking the arrow to the right of the Repair Task 
box and selecting one of the five maintenance actions in the 
drop-down list. These five maintenance actions include: Adjust & 
Repair, Inspect, Remove & Replace, Test & Check, and 
Troubleshoot.

Maintenance Type. Click the arrow to the right of the 
Maintenance Type box to select one of the two types of 
maintenance actions:

Preventive. Preventive maintenance is scheduled at fixed 
intervals. 
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Corrective. Corrective maintenance is required when a 
component fails because of usage or combat damage.

Organizational Level. This is an indication of the maintenance 
level that will perform the maintenance action. Click the box to 
the right of the Organizational Level box to select one of the 
three possible maintenance levels:

Organizational (ORG). Typically, this is referred to as the first 
level of maintenance. It usually is associated with maintenance 
that is performed at the unit level. ORG level maintenance is 
always performed “On Equipment.” That is, the system is 
unavailable for missions until the maintenance is complete.

Direct Support (DS). Second level of maintenance. DS 
maintenance can either be performed “On Equipment” or “Off 
Equipment.” On equipment maintenance makes the system 
unavailable during the time that maintenance is being 
performed. An example of an on equipment task is changing a 
tire or a filter. Off equipment maintenance are repairs that are 
performed once a part has been removed from the system. The 
system itself remains available for missions. An example of an 
off equipment task is fixing a hole in a tire after you have already 
replaced the tire with a spare. All Org level maintenance is 
assumed to be performed “On Equipment.” All GS level 
maintenance is assumed to be performed “Off Equipment.”

General Support (GS). Third level of maintenance. GS level 
maintenance is always performed “Off Equipment.” This means 
that the system can return to the mission while the component is 
being repaired. Most often, this is relevant for “remove and 
replace” maintenance actions. After IMPRINT Pro has 
determined that a spare is available, the system will be fitted 
with the spare component and will return to “available” status. 
Meanwhile, any outstanding repair actions for that system will 
be performed on the component that has been removed.

Specialty and Skill Level. This is the first military occupational 
Specialty and skill level that are required to perform the 
maintenance. IMPRINT Pro accepts two Specialties so there are 
two Specialty and Skill Level fields. You can click the arrow to 
the right of the Specialty box to select another Specialty. 

Number of Specialty. This contains the number of maintainers 
of each Specialty that are required to perform the maintenance. 
Click in the box to edit.
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Mean Operational Units Between Failure (MOUBF). This is 
the number of operational units between failure, or more 
accurately stated the number of operational units between the 
need for this maintenance action. Depending on the “Type” for 
this subsystem the units could be rounds fired, distance traveled, 
or the amount of time that the system has been operating. The 
actual time that this action will occur in the simulation will be 
drawn from a negative exponential distribution embedded in 
IMPRINT Pro with a mean equal to the MOUBF you enter. Unlike 
the Mean Time To Repair, however, the distribution type and 
standard deviation of this value is not editable.

Mean Time To Repair (MTTR). This value represents the 
average time it takes to perform this maintenance action. This 
value and the standard deviation for the repair time (MTTR 
Standard Deviation) and the Distribution type are used to 
generate a simulated time for this maintenance action. 

% Abort. This value represents the percentage of time that the 
need for this maintenance action will cause the entire system to 
abort the current segment and require that the maintenance 
action be done immediately. In the case of a repeating segment, 
segments will resume on schedule once the required 
maintenance action is complete. If the abort % is set to 0%, the 
segment is not aborted and continues even if the repair task 
comes up; the required maintenance, however is done once the 
segment is over. If the scenario run ends before the repair task 
can begin, the repair task will never occur since it is outside the 
window of the scenario run. If the abort % is set to 100%, in all 
cases any time this repair task comes up the segment is 
immediately aborted and maintenance begins. For all values in 
between, the need to abort a segment is based on the probability 
of the value entered.

If a repair task’s % Abort value is set to 100% but there is no 
ongoing segment at the time the repair task kicks in, then there 
is no segment to abort in the first place. Therefore it is possible 
to have repair tasks (having abort %100) occur within a scenario 
of repeating segments and for that task to not affect the total 
operating hours. If a segment in a repeating series is aborted by 
a repair task, the series resumes when the next scheduled 
segment is set to occur.

Contact Team (CT). This cell indicates (True/False) if this 
maintenance action can be performed by a contact team. If the 
contact team is enabled (flag set to “True”) then the maintenance 
action is routed to the contact teams as long as the following 
parameters are met: 1) the number of maintenance tasks waiting 
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in the queue is less than the total number of tasks all the contact 
teams combined are capable of handling, and 2) the number of 
maintainers needed to perform the maintenance is less than the 
number of maintainers on the contact team.

Crew Chief (CC). This cell indicates (True/False) if the repair 
task can be routed to the Crew Chief. When a repair task is 
flagged for the Crew Chief (flag set to “True”), the repair will go to 
the Crew Chief if the repair task is needed, provided the spare 
part is available. If the spare part is not available, the system 
repair is instead routed to the task’s default maintenance 
organization and is delayed for the time needed to procure the 
spare part. Sending a repair task to the Crew Chief also requires 
that at least one operator in the Warfighters Operators list be a 
designated Crew Maintainer; any operator designated as such 
must have its Crew Maintainer check box in its properties 
window checked. If no operator is a designated crew maintainer, 
a message appears upon starting a simulation run that the model 
contains no crew maintainers, and the model is temporarily 
suspended. By clicking “Ok” to this message, the model resumes 
its run, but all maintenance repair actions flagged for the crew 
chief are instead routed to the default maintenance org level.

Copying Repair Tasks
To copy a repair task:

1. In the Analysis Tree, right-click the repair task (for example, Adjust 
and Repair) below the Repair Task node. 

2. Select Copy Repair Task from the menu that displays.

Cutting Repair Tasks
To cut a repair task:

1. In the Analysis Tree, right-click the repair task you want to cut.

2. Select Cut Repair Task from the menu that displays.

When you click in the Analysis Tree, the repair task is highlighted in red. 
When you paste the repair task to another component or model, 
IMPRINT Pro removes the repair task from its current location and 
places it in to the new location.
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Pasting Repair Tasks
To paste a repair task:

1. Copy or cut the desired repair task.

2. Right-click the Repair Tasks node that you want to paste your task to.

3. Select Paste Repair Task from the menu that displays. 

The pasted task displays below the Repair Task node.

Note:
If you paste a repair task having a Maintenance Action and Maintenance Type 
identical to an existing Repair Task under the same node, the Select 
Maintenance Action dialog box will appear, prompting you to choose a new 
Maintenance Type and/or Action for this task from the list of remaining 
available combinations.

Selecting Maintenance Actions 
To select a maintenance action:

1. Select the Maintenance Action and Maintenance Type combination that 
best fits the repair action you want to model.
358



Chapter 6: Equipment Analysis
2. Click OK.

The repair action will be pasted to the Repair Tasks node in the 
Component.

Deleting Repair Tasks
To delete a repair task:

1. In the Analysis Tree, right-click the repair task (for example, Adjust 
and Repair) below the Repair Tasks node.

2. Select Delete Repair Task from the menu that displays.

Importing Maintenance Task Data from a 
Template
As an alternative to adding subsystems, components and repair tasks one 
item at a time through the Analysis Tree, you can enter all maintenance 
data into an Excel template which can later be imported into IMPRINT Pro 
in a single action. The template required to do this, 
importIMPRINTPRO.xlt, is included in the IMPRINT Pro directory on 
your machine.

Adding Data to the Maintenance Template
To add data to the maintenance template:

1. Navigate to the IMPRINT Pro root directory on your system. If you 
chose to install IMPRINT Pro using the default settings, the root 
directory is C:\Program Files\IMPRINTPro.

2. Locate the file called importIMPRINTPRO.xlt. This file is the 
IMPRINT Pro Maintenance Template.
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3. Double-click the file.

Microsoft Excel launches, and the IMPRINT Pro Maintenance Template 
opens.

The Maintenance Template contains fields for entering subsystem, 
component or repair task data. Each row corresponds to a separate 
repair task, each of which must be unique.

4. Enter the desired maintenance data in the template. All required fields 
are highlighted in red.
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Once you have finished entering data into the template, you are ready 
to export your data.

Exporting data from the Maintenance Template
To export data from the Maintenance Template:

1. From within the Maintenance Template, click the Create Data Import 
File button located at the top of the template.

The Save Copy As dialog appears.

2. From the Save in field at the top of the window, browse to the location 
to which you wish to export your maintenance template data for import 
into Pro.
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3. Enter a new name in the Filename field or use the default name 
provided.

The default name is unique to the date and time the template is 
exported.

4. Click the Save button.

The exported template data saves to the selected location and name.

Importing Maintenance Template data into IM-
PRINT Pro
You can use the Import Maintenance Data option in IMPRINT Pro to 
import maintenance data you have exported from the IMPRINT Pro 
Maintenance Template.

Note:
The option to import maintenance data into an analysis is available only to the user 
having the lock on the analysis. For more information on locking and unlocking 
analyses see IMPRINT Pro User Guide Volume 1 - Basic Procedures, Chapter 1: 
Basic Procedures, Understanding the Analysis Environment, Locking and Unlocking 
Analyses.

To import maintenance template data into IMPRINT Pro:

1. Launch IMPRINT Pro.

2. Create or load the analysis into which you wish to import your 
maintenance template data.

3. From the File menu, select Import Maintenance Data...

4. From the Import Maintenance Data... submenu, select Import from 
Spreadsheet.

A dialog immediately prompts you to save your changes in the current 
analysis. Click Yes if you wish to save your model prior to import. 
Otherwise click No.
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5. In the Open dialog which appears, browse to the location of your data 
file exported from the maintenance template. The file you select must 
have the extension “.maintPRO.”

6. Select the file, and then click the Open button.

A message displays, indicating the status of the imported data.

7. View the imported maintenance data in the Analysis Tree under the 
Equipment node for the model you have selected.
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Map Maintenance Tasks to Taxons
IMPRINT Pro automatically maps taxon weights to the repair tasks in a 
maintenance scenario. The Maintenance Task Taxon Mappings dialog 
allows you to modify the mapping of taxons and taxon values for 
maintenance tasks. You can return to the default values set by 
IMPRINT Pro by clicking on the Reload Defaults button at the bottom of the 
dialog. 

Modifying the taxons is only one part of using them. Taxons work in 
conjunction with stressors assigned to repair task types to impact 
calculated repair task times. 

Example: In the Maintenance Task Taxon Mappings dialog, shown 
below, the repair task called “Adjust and Repair” involves some fine 
motor discrete action. On the stressor by taxon table, Table 2 on 
page 521, you can see that the stressor “COLD” affects the task time of 
a task involving a fine motor discrete action. Applying this stressor will 
impact the repair task time because of the nature of the task.
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To map maintenance tasks to taxons:

1. Click Map Maintenance Tasks to Taxons below the Moderators 
menu.

The Map Maintenance Tasks to Taxons dialog displays.

2. Do one or more of the following:
• Adjust taxons by clicking the drop down arrow to the right of the 

Taxon box, and then select a taxon from the list that displays.
• Adjust taxon weight by clicking in the Taxon Weight box, and then 

type a new value.
• Return to default values by clicking the Reload Defaults button.

Note:
To see the impact of taxons on the task times, you need to remember to set 
stressors on the “Stressors” dialog in the Moderators menu, and check the PTS 
Adjustments box in the Executions Settings menu before you run the model.
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Subchapter 6.2 Scenarios 

You can develop many scenario data sets for each system. For example, 
you might want to create one scenario for a thirty-day run and another 
scenario that contains input parameters for a ten-day run. When you have 
selected a scenario, this option also lets you add mission segment data for 
that scenario.

This interface contains the list of scenarios available for your maintenance 
model. To view more information about a scenario, double-click it. This will 
let you edit and review the scenario properties.

Displaying Scenarios
To display scenarios:

Double-click the Scenario node below the Equipment node in the 
Analysis Tree.

A list of Scenarios will display in the main window.
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Adding Scenarios
To add a scenario:

1. In the Analysis Tree, right-click the Scenario node.

2. Select Add Scenario from the menu that displays.

A new scenario is added to the list below the Scenario node on the 
Analysis Tree and to the list in the main window.

Note:
IMPRINT Pro names the new scenario Scenario. If you continue to add 
Scenarios, the new scenario will be named Scenario1 and each following 
scenario is numbered, increasing by one for each addition. You can edit the 
name of the scenario in the Scenario Properties Window name box.

Displaying Scenario Data
To display scenario data:

Double-click the scenario (for example, Scenario1) below Scenario 
node in the Analysis Tree.

A tabbed dialog box will display in the main window including 
Segments, Fuel Supply, Ammo Supply, Travel Times, Spares, 
Maintenance Crew, and Contact Team.

Segments Tab
Select the Segment tab to view the list of segment missions that have been 
added to the Scenario. 
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Fuel Supply Tab
Select the Fuel Supply tab to view the fuel supply properties. 

To calculate the number of trips required by the transporter during your 
scenario run, check the Use Fuel Supply box, and then enter the following 
information:

Transporter Name. The transporter name.

Capacity (gallons). The fuel capacity of the transporter, in 
gallons.
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Load Time per Trip. The amount of time required to load the 
fuel into the transporter.

Maximum number of daily trips. The maximum number of trips 
the transporter can make in a single day. This number affects the 
number of warfighters and transporters required by your 
scenario; a greater number of trips a transporter can make in a 
day means less overall transporters required.

Specialty 1 and 2. The type of specialty required to man the 
transporter. Select the desired specialty by clicking the drop-
down arrow adjacent to the Specialty box and selecting from the 
list provided. If the one you desire is not listed, you must return to 
the Warfighters node to add it under the Supply and Support 
Personnel node. Once added, the new specialty displays in the 
combo box and may then be selected. For each specialty you 
choose, enter the skill level and quantity required in the Level 
and Number fields.

IMPRINT Pro will use this information to calculate the number of 
transporters and the associated manpower required to supply the 
necessary fuel for your scenario. After executing the maintenance model 
for this scenario, the supply results will be presented in the Supply and 
Support Results report.

Ammo Supply Tab 
Select the Ammo Supply tab to display the Ammo supply information. 

Ammo Supply properties include a scenario name at the top of the dialog 
box and a description of the scenario. Other properties include:

Transporter Name. The Transporter Name.
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Weapon System. The subsystem to which the transporter 
belongs. This subsystem must be of type “Armament”.

Capacity (# rounds). The number of rounds of ammunition.

Load Time Per Trip (hours). The amount of time required to 
load the transporter with ammunition, in hours.

Specialty 1 and 2. The type of specialty required to man the 
transporter. To select the desired specialty, start by clicking the 
Specialty cell; a drop-down arrow appears. Click the drop-down 
arrow, and select a specialty from the list provided. If the one you 
desire is not listed, you must return to the Warfighters node to 
add it under the Supply and Support Personnel node. Once 
added, the new specialty displays in the combo box and may 
then be selected. For each specialty you choose, enter the 
quantity required in the Number fields.

Max # Daily Trips. The maximum number of trips the transporter 
can make in a single day. This number affects the number of 
warfighters and transporters required by your scenario; a greater 
number of trips a transporter can make in a day means less 
overall transporters required.

Use the Add and Delete buttons to add or delete transporters from the list. 
You may add one transporter for each subsystem of type “Armament” in 
your list of subsystems.

Travel Time Tab
Select the Travel Time tab to enter the average number of hours it takes to 
travel from the location of system breakdown to the selected maintenance 
facilities. These maintenance facilities will be labeled as Org, DS and GS 
unless you edit the organizational level names.
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Travel time properties include:

Travel Time. The travel time you enter, in hours, represents 
round trip travel. This time is added to the maintenance time for a 
system to accurately reflect system availability. It does not affect 
maintenance manhours. It only affects the total time to repair the 
system.

Enter the travel times to move the system to and between the 
different maintenance levels. These travel delay times will be 
used to predict how long it will take to transport the system, or 
the component, to the appropriate organizational level. Note that 
in the maintenance analysis, for any system requiring multiple 
repairs at multiple levels, all first level (ORG) maintenance is 
performed first, then second level (DS), and then third level 
(GS). The travel time is a one-time assessment for each system 
each time it completes a mission segment and needs 
maintenance. To change travel times, click in the box and enter 
time. 

Contact Team. You can also enter the amount of time for a 
Contact Team to reach the system which needs to be repaired.

Spares Tab
Select the Spares tab to specify (by subsystem) the percent of time a spare 
part will be available when needed for a repair action and, if not available, 
the delay time until it will be available.
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Spares properties include:

% Available. This optional capability lets you enter the 
probability a spare part is available if needed for maintenance. 
You can enter a different probability for each subsystem in the 
IMPRINT Pro repair task worksheet. 

Wait in Hours. The time a system must wait (in hours) for a 
spare part to become available if needed.

Spare availability only affects Remove and Replace tasks being 
performed at the first (for example, Unit, Org, or AVUM) level of 
maintenance.

Note:
In order for the Crew Chief to be able to work on a particular subsystem, % 
Available must be set to 100% for that subsystem. Spares affect only the 
Repair and Replace tasks at the 1st level (ORG) which are the only tasks that 
the Crew Chief would be able to perform.

Maintenance Crew Tab 
Select the Maintenance Crew tab to define the shift manning for each 
specialty performing tasks at each maintenance level type [for example, 
Organizational (Org), Direct Support (DS), General Support (GS)]. You can 
also identify shift manning for more than one shift. If you have edited the 
names of the different maintenance levels, your new labels will replace the 
ones shown.
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To set the shift manning, you use a worksheet that contains the number of 
people within each specialty for each maintenance shift that can work in 
parallel throughout your scenario. When you click one of the maintenance 
organizational type buttons (Org, DS, or GS), IMPRINT Pro displays the 
worksheet for that level.

The Scenario name will display at the top of the Maintenance Crew 
worksheet. Maintenance Crew Properties include the following:

Shift Length. The numbers of hours in a shift.

Shifts per day. The number of shifts of this length in a 24-hour 
period; shift length is constrained such that the shift length X 
shifts per day cannot exceed 24 hours.

Performed at level. The maintenance shift level whose data you 
are entering. Click the drop down arrow to select an 
organizational level (Org, DS, or GS). To edit the maintenance 
organizational level names, see “Editing Maintenance Org 
Levels” on page 387. 

Specialty. This column includes all of the specialties that are 
marked as maintainers under the Warfighters section of 
IMPRINT Pro. For details on choosing the maintainer role for a 
Warfighters, see “Displaying Maintainers” on page 78.

Skill Level. This is the skill level for the Specialty. Skill levels 
include 10, 20, 30, 40, or 50.
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Minimum. Identifies the minimum number you can enter for 
manning of each Specialty at each organizational level. This 
minimum is calculated by examining your repair tasks to find the 
maximum number of people in a given Specialty needed on a 
single repair task. This ensures that your crew will be able to 
perform every task that could occur. 

Maintenance Shift number. There is one column for each of the 
shifts per day.

Click in a cell of the worksheet to edit the contents of the cell. Select an 
entire row or column by clicking the row number or column name. 

By default, when you run a maintenance model in IMPRINT Pro, the 
Execution Settings window is automatically set to run the model in an 
unconstrained mode. This means that IMPRINT Pro will initially ignore the 
shift manning in this worksheet, and that at any time a maintainer is 
needed to perform a maintenance action, that maintainer is assumed 
available and an unlimited number of repair tasks can be performed in 
parallel. To activate these optional crew constraints from this shift manning 
worksheet when running your scenario, however, you must first check the 
Crew Limits On option in the Execution Settings Maintenance Model 
dialog box prior to running your model.

To evaluate which Specialties are the most heavily utilized, we recommend 
you refer to the Headcount Histogram Report. This is discussed in detail 
under “Reports” in IMPRINT Pro User Guide, Vol. 1 IMPRINT Pro Basic 
Procedures.

Contact Team Tab
Select the Contact Team tab to define properties that determine how 
IMPRINT Pro will model contact teams.
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Contact Team properties are:

Number of Contact Teams. The number of contact teams 
available for the entire scenario.

Number of maintainers in each Contact Team. The number of 
multi-functional maintainers in each contact team.

Maximum number of repair actions that can be waiting for 
Contact Team attention at one per Team. The maximum 
number of repair actions that can be waiting for Contact Team 
attention at once per team. If this number is exceeded, 
maintenance actions are then routed to the selected 
maintenance levels (Org, DS and GS).

The general rule in the IMPRINT Pro maintenance model is that when 
enabled, the contact team will perform all possible maintenance actions 
until the maximum number of repair actions in the queue is exceeded.

Copying Scenarios
Copy a scenario to add a new scenario that has a data set exactly like the 
scenario. You should give the replicated scenario a name that is different 
than the original scenario.

To copy a scenario:

1. In the Analysis Tree, right-click the scenario below the Scenario node.

2. Select Copy Scenario from the menu that displays.
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Cutting Scenarios
To cut a scenario:

1. In the Analysis Tree, right-click the scenario below the Scenario node.

2. Select Cut Scenario from the menu that displays.

The scenario is highlighted in red. When you paste the scenario to 
another Equipment mission, IMPRINT Pro will remove the scenario 
from its current location to the new location.

Pasting Scenarios
To paste a scenario:

1. Copy or cut the scenario you want to paste.

2. Right-click the Scenario node in the Equipment mission that you want to 
paste to.

3. Select Paste Scenario from the menu that displays.

Deleting Scenarios
To delete a scenario:

1. In the Analysis Tree, right-click the scenario (for example, Scenario1 
or Ten Days of Missions) below the Scenario node.

2. Select Delete Scenario from the menu that displays.

IMPRINT Pro will delete the Scenario from the Analysis Tree and the 
list in the main window. It will also delete all information associated with 
that scenario, such as segment data. 

Segments
Each scenario is composed of a set of mission segments. These segments 
can be thought of as missions, in which a number of your systems are 
exercised. During a segment, the components accrue usage, which can 
lead to component failure.
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You can define several segments for each scenario. For example, if you 
are modeling a large number of systems, you may want to define different 
segments for smaller subsets of your total number of systems.

Displaying Segments
To display a segment mission:

1. In the Analysis Tree, double-click a scenario child node (for example, 
Scenario1).

A Segment node displays below the Scenario child node on the 
Analysis Tree, and the Scenario Data dialog box displays in the main 
window with the Segment tab selected.

2. Double-click the Segment node.

A list of Segment missions appear below the Segment node and in the 
main window.

Note:
Do not confuse these missions with the operational missions described in 
Chapter 5: “Mission Analysis.” While they are similar concepts, none of the 
data you entered under Mission will affect the results of your Equipment 
analysis.
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Adding Segments
To add a segment:

1. In the Analysis Tree, right-click the Segment node.

2. Select Add Segment from the menu that displays.

Note:
IMPRINT Pro names the new segment Segment1. If you continue to add 
segments, each following segment will be named SegmentX where X is the 
next integer. You can edit the name of the segment in the Name field in the 
Segment Properties dialog box. 

Displaying Segment Data
To display segment data:

Double-click the segment name (for example, Segment1).

A dialog box displays in the main window including tabbed windows: 
Segment Info, Consumables, and Combat Damage. 
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Segment Info
Select the Segment Info tab to display segment information in the main 
window. Segment properties include: 

Segment Start Time and Segment Start Day. These boxes 
work together to identify the start time of this segment. These 
values default to 0.0 and 1. If you were to leave the default 
values in both of these boxes, this mission would begin at time 0 
on day 1. 

Cancellation Time. If the minimum number of systems required 
for the segment cannot be met by the Segment Start Time, the 
simulation will wait until the Cancellation Time (the amount of 
time beyond the Segment Start Time) to check once more for the 
minimum number of systems. If the minimum number of systems 
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is available at this Cancellation Time, the segment will proceed. 
If the minimum number of systems is not met by the Cancellation 
Time, the segment is cancelled. In the case of a repeating 
segment, once the cancellation time is past the segments will 
once again attempt to resume at the next scheduled time 
interval.

Segment Priority. When more than one segment has been 
defined to occur at the same time, the segments must compete 
for available systems. In this box, you can enter a priority 
number for each segment. The segment with the higher priority 
value will get available systems first. If several segments have 
the same priority number, the first one on the list will be filled 
first. A priority of 1 is higher than a priority of 5.

Use Mission for Duration Time. Check this box to use the 
duration of an operational mission model run as your segment 
Duration Time. 

Duration Time. This value indicates the number of operational 
hours a system is out on a mission (the proposed elapsed time 
between its departure and its return, provided no combat 
damage is sustained while it is out.) Additionally, this time is 
used to determine usage for the equipment on which failures are 
triggered by time. If using a time from an operational mission 
model run as your Duration Time, check the Use Mission for 
Duration Time check box, and then select the desired mission 
from the drop-down list.

Number per Departure Group. This value controls the number 
of systems that are sent out in each group. A group can also be 
referred to as a “frag”.

Time Between Departures in minutes. This value is the time 
between departure groups.

Repeating. A Repeating segment, indicated by a check in this 
box, is one in which IMPRINT Pro’s maintenance model will 
attempt to restart the same segment after a specified amount of 
time. You can identify the frequency of the segment (for 
example, “repeats every eight hours”) using the Repeat Mean 
Time and Standard Deviation fields (see explanations below.)

Repeat Mean Time. The Mean Time represents the average 
number of hours past the Segment Start time at which the 
segment will attempt to restart. This value applies only if the 
Repeating check box is checked.
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Standard Deviation. Enter a Standard Deviation to add 
variability to your Repeat Mean Time. To calculate a standard 
deviation, simply compute the difference between the worst and 
best performance and divide it by 6. This value applies only if the 
Repeating check box is checked.

Minimum Number of Systems. This value is the minimum 
number of systems that must be available for deployment in 
order for the segment to proceed. If the minimum number of 
systems is met at the segment start time, the system groups 
depart as scheduled. If the minimum number is not met by the 
segment start time, the simulation will wait until the segment 
cancellation time, at which time it will then check for system 
availability once more. If the minimum number of systems is still 
not met by the cancellation time, all departure groups in this 
segment are then cancelled. Although this number determines 
the minimum number of systems required for a segment, it 
should be noted that the number of systems actually made 
available to your entire scenario run is controlled by the value 
entered in the Number of Systems field in the Maintenance tab 
of the Execution Settings window.

Maximum Number of Systems. This value is the maximum 
number of systems that would be assigned to your segment if 
available. Although this number determines the maximum 
number of systems required for a segment, it should be noted 
that the number of systems actually made available to your 
entire scenario run is controlled by the value entered in the 
Number of Systems field in the Maintenance tab of the 
Execution Settings window.
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In the sample segment pictured above, the simulation must wait 
until 10:00am (Segment Start Time) to start the segment. At 
this time, the simulation checks for a minimum of five available 
aircraft (Minimum number of systems) in order that the 
segment may proceed. If these aircraft are not available, at 
10:00am, the simulation will wait until one hour later, i.e., 
11:00am (Cancellation Time) to recheck for the minimum 
number of aircraft. If five aircraft are not available by this time, 
the segment is cancelled, and no aircraft depart. 

The segment is scheduled to release two aircraft (Number per 
Dept. Group) every 0.6 hours, i.e. 10 minutes (Time between 
departures.) We would therefore expect our aircraft groups to 
leave at 10:00am, 10:10am and 10:20am. If only 5 aircraft are 
available for the segment, the last aircraft departs by itself at 
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10:20am. Each aircraft sent out is predicted to be out for a total 
of four hours (Duration Time), round trip. If two aircraft leave 
every 10 minutes starting at 10:00am, we would expect the 
aircraft groups to return approximately four hours later at 
2:00pm, 2:10pm, and 2:20pm, provided no combat damage is 
sustained. If the Time between departures was left at 0 hours, 
there would be no set delay between groups thus all 5 aircraft 
(or 6 if 6 are available) would depart at the same time (10:00am) 
and return at the same time (2:00pm). 

The segment is set to repeat every eight hours (Repeat Mean 
Time). In this example, the simulation will once again restart the 
process of sending out aircraft at 18, 26 and 34 hours for n days 
of simulation into the model run, provided the minimum number 
of systems is available.

Combat Damage 
To view and modify the combat damage properties for this segment, click 
the Combat Damage tab in the Mission Data dialog box. 

Combat properties will display in the main window.

Contact Damage properties include the following:

% of Combat Hit. The hourly probability that a system will 
sustain a combat hit.

% of Attrition. Given a combat hit, the probability that the 
system is a total loss.
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System Replacement Time. If the system is killed, the number 
of hours before the system can be replaced.

System Repair Time if damaged. If the system can be 
repaired, the amount of time needed to complete the repairs. 

The repair time will impact system availability; however it is not included 
in the maintenance manhour requirements reports. This is because 
IMPRINT Pro doesn’t know which component(s) need repair due to 
combat damage, and therefore, doesn’t know which Specialty would be 
needed. Consequently, all time spent performing combat damage 
repair is reported in the Combat Damage report, and is not attributed to 
any particular Specialty.

Consumables
Click the Consumables tab to view and modify Consumables data. 
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For each of the subsystems, there is an assigned Equipment Group Name 
of Armament, Mobility, or Other. For each Armament subsystem, you need 
to specify the number of rounds of ammunition that will be fired from the 
weapon that contains that subsystem during this segment.

Consumable properties include:

Distance per hour per segment. You can enter the distance 
your system will travel during each hour of the segment, which is 
needed before the segment begins.

Load Time per segment. You can enter any load time required 
for this segment. Load time refers to the time needed to repair 
the system to perform the segment. The load time will not require 
maintenance manhours, but could affect system availability.
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System Fuel Usage (gallons/distance unit). You can also 
enter the amount of fuel used by the system in gallons per 
distance unit. This value is used to help IMPRINT Pro calculate 
the Supply and Support requirements of each scenario.

The distance traveled and rounds fired are used to accrue usage to the 
components of systems as they perform the segments. Ultimately, this 
will cause components to fail, based on the Mean Operational Units 
Between Failure (MOUBF) of each component.

Copying Segments
To copy a segment:

1. In the Analysis Tree, right-click the segment you want to copy.

2. Select Copy Segment from the menu that displays.

Cutting Segments
To cut a segment:

1. In the Analysis Tree, right-click the segment you want to delete below 
the Segment node.

2. Select Cut Segment from the menu that displays.

The segment is highlighted in red. When you paste the segment to 
another Equipment mission, IMPRINT Pro will remove the segment 
from its current location to the new location.

Pasting Segments
To paste a segment:

1. Copy or cut the segment you want to paste.

2. Right-click the Segment node in the Equipment mission that you want 
to paste to.

3. Select Paste Segment from the menu that displays.
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Deleting Segments
To delete a segment:

Select the segment and do one of the following: 
• Select Delete Segment from the menu that displays.
• Click the Delete button.

The segment is deleted.

Editing Maintenance Org Levels
This option allows you to change the names of the maintenance 
organizational levels. You are limited to 10 characters. Once you edit these 
levels, the new names will show up on all interfaces and reports that refer 
to the maintenance organizational levels.

To edit org levels:

1. From the Edit menu, select Preferences.

The Preference dialog box displays with tabs: Specialty, Time, 
Temperature, Shapes and Colors, and Maintenance Org Levels.

2. Select the Maintenance Org Levels tab.

The Org Levels dialog box displays. 

Click inside the Org Level boxes to type your changes.

3. To save the Org Level changes, click OK.
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4. To cancel the Org Level changes, click Cancel.

Subchapter 6.3 Running the Equipment 
Scenario

Once you have created an equipment model with subsystem and scenario 
parameters defined, you are ready to run the scenario. Several settings 
control scenario execution which are available through the Execution 
Settings window.

Displaying the Execution Settings
The option to access the Execution Settings window is found underneath 
the Execution menu. All settings for the Maintenance model are available 
through the Maintenance tab of this window. 

In a Maintenance model, the settings control length of the run, the random 
number seed, and the number of systems. You will have the option to 
collect PTS Adjustments data, and can check the Crew Limits On check 
box allowing IMPRINT Pro to ignore the shift manning on the Maintenance 
Crew dialog box.

To display execution settings:

From the main menu, select Execution, and then select Settings.

The Execution Settings window displays. If you already have a scenario 
currently selected, then the Execution Settings window, by default, displays 
the Maintenance Model settings.

Maintenance Scenario Execution Properties
The following is a detailed description of the execution properties for a 
Maintenance scenario.

Length of Run. You may select the time period over which to 
execute your model. The default time period is one day.
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Random Number Seed. You can set the number used to 
generate random numbers for calculating task execution times 
and taking probabilistic paths through the network. The random 
number seed is a number between approximately -2 billion and 
+2 billion (inclusive). The same seed always produces the same 
set of random numbers in the same order, and thus the same 
results.

Number of Systems. You can select the number of systems to 
run. In Segments, you specify the minimum number of systems 
required for a segment. In Execution Settings, you can quickly 
change the number of actual systems you have available for use 
at the time you want to run the model. The number of systems 
defaults to one.

PTS Adjustments. You may chose to run the maintenance 
model with or without adjustments. If you check PTS 
Adjustments, any applications of stressors, training frequency, or 
personnel characteristics will be used to modify Mean Time to 
Repair (MTTR) data for each task. If you do not check PTS 
Adjustments, the maintenance model will be run with the original 
(or baseline) MTTR data.

Crew Limits On. You can check this box to run the scenario in a 
constrained mode, using the maintenance crew constraints you 
entered in the Maintenance Crew dialog box. If you do not check 
this box, IMPRINT Pro will run in an unconstrained mode, and 
will ignore the shift manning on the Maintenance Crew 
worksheet.

Executing the Maintenance Model
To execute the maintenance model:

1. Select a Maintenance scenario in the Analysis Tree.

2. From the Execution menu, select Settings.

The Settings dialog box displays.

3. If not already selected, click the Maintenance Model tab at the top of 
the Settings dialog box. 

IMPRINT Pro loads the data for the currently-selected maintenance 
model and displays the scenario name in the top of the dialog box. 
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4. If a different scenario is desired, use the drop-down list box at the top of 
the dialog box to select the scenario you want to execute. 

5. Adjust the remainder of the execution settings as desired.

6. To begin execution of the model do one of the following:
• From the Execution menu, select Begin Simulation.
• Click the Begin Simulation button on the tool bar.

Execution options allow you to you start, resume, pause, or halt scenario 
execution; step through scenario execution one event at a time; and 
change the speed of execution. For more information, see “Subchapter 5.4 
Running the Mission” on page 279.

Viewing Scenario Model Data During 
Execution
IMPRINT Pro uses several different windows to display model data during 
execution. Some windows show the values of systems in use and 
cumulative repair hours while others display logic errors, such as an array 
index out of bounds or division by zero. IMPRINT Pro also includes built-in 
tools to quickly locate, debug and correct any errors in the model.

Animator Window. The Animator Window displays scenario 
data during an operations model run.

Output Tab. The Output window displays messages about 
actions which occur during a model run. Any syntax errors are 
indicated and may be useful for debugging your model.
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Search and Replace Tab. The Search window lets you search 
the entire model or selected components for a string of text. You 
may also optionally replace any found text with a new string of 
text you provide.

Animator Window
The Animator Window displays Warfighter data during an operations model 
run. This data includes the following:

Queue Data. The number of systems waiting for maintenance 
and the cumulative amount of time spent waiting by one or more 
systems displays for each Org level.

Maintenance Summary. The Maintenance Summary section 
displays the total number of preventive and corrective 
maintenance manhours across all org levels.

Combat Data. The Combat Data section describes the total 
number of systems sent out on missions, the number of systems 
which have sustained damage and require repair and the 
number of systems lost.

Reliability and Availability. This section describes the number 
of systems and segments which were requested accomplished.

Shift Manned. The Shift Manned section displays a check mark 
to indicate whether the current clock time falls in one of the shifts 
or not. For example, two shifts lasting eight hours apiece will 
occur from clock time 0.00 hours to 8.00 hours and 8.00 hours to 
16.00 hours. Any point during the model which takes place from 
0.00 hours to 16.00 hours occurs during a manned shift thus the 
check mark appears next to “Yes”. Any point during the model 
which takes place from 16.00 hours to 24.00 hours occurs during 
the non-manned shift thus the check mark appears next to “No”. 

Mode. The Mode section displays a check mark to indicate 
whether or not the Crew Limits On option is checked in the 
Execution Settings window. If this option is selected, the number 
of maintainers available is constrained to the numbers entered in 
the shift manning columns of the Maintenance Crew tab for the 
chosen scenario.

Clock. The current clock time in the simulation run.

Day. The current day in the simulation run.
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Percent Time Elapsed. The Percent Time Elapsed value is the 
amount of simulation clock time which has elapsed relative to the 
total run time of the model (length of run in days.)

Output Tab
The Output window displays the actions that just finished happening in a 
running mission. These actions, known as Trace Data, display as follows:

Clock values for beginning effects

Clock values for ending effects 

Clock values for external events 

Syntax errors

Whether or not the plugins are successfully loaded when 
IMPRINT Pro is started

Application errors

When a run begins and completes, the following messages will display:

Simulation Complete. An indication that the model run was 
successful and that reports are available for viewing.

Duration. The time required to process all model runs since the 
last time the Begin Simulation button was pressed.

Clock. The amount of time the model ran within the context of 
the mission or scenario. For example, if you run a scenario for 
3.00 days in the Execution Settings window, the Clock time 
reported would be 72.00 hours

Displaying Trace Data

To display trace data in the Output window:

1. From the View menu, click Windows, and then click Output from the 
menu that displays. 

2. Under the Utilities menu, click the Display Trace option to enable it (a 
check mark next to the option ensures it is enabled.)
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3. From the Execution menu, click Begin Simulation.

As the scenario runs the trace data displays in the Output window.

Note:
If the Display Trace option is disabled during the model run, the Output 
window will report minimal information about the model run.

Saving Trace Data Output to File
You can save the results in the Output window to a file, save the results to 
the Windows clipboard, and clear the data in the window.

To save Output to file:

1. Right-click the Output window.

2. Select Save Output to File from the menu that displays.

The Save As dialog box displays.

3. Select the destination of the folder from the Save in box.
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4. Type a file name in File name box.

5. Click Save.

The contents of the Output window save to a file on your system.

Copying Trace Data Output to Clipboard

To copy output to Windows clipboard:

1. Right-click the Output window.

2. Select Copy Output to Clipboard from the menu that displays.

The contents of the Output window automatically copy to the Windows 
clipboard. You can then paste the data to an external application.

Copying Selected Trace Data Output
This option can be used to save specific sections of the Output window as 
desired.

To copy selected output:

1. Select the trace date you want to copy by highlighting it in the Output 
window.
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2. Right-click the Output window.

3. Click Copy Select Output from the menu that displays.

The data copies to the Windows clipboard. You can then paste the data 
to an external application.

Clearing the Output Window
With each consecutive model run, IMPRINT Pro clears the results from all 
previous model runs in the Output window. You may, however, clear the 
results in the Output window at any time independent of running the model.

To clear the Output window:

Do one of the following:
• Right-click the Output window and click Clear Output from the menu 

that displays.
• From the Edit menu click Clear Output.
• Press the shortcut keys Ctrl+Shift+L.

The Output window clears.

Search and Replace Tab
The Search provides the option for locating strings of text in the model. You 
may either search the entire model or select components only. The 
components you can search depend on the type of model that is checked 
in the Execution Settings window. Components available for search in the 
Maintenance model are:

Everything (all components)

Warfighters

Subsystems

Components

Repair Tasks

Scenarios

User Stressors
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Displaying the Search window

To display the Search window:

Do one of the following:
• From the View menu, select Windows, and then click Search from 

the menu that displays.
• Select the Search tab at the bottom of the Output window.

The Search window displays.

Searching in a Maintenance Model
If you are running a Maintenance model, the Search window for the 
Maintenance model displays.
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Searching for Text

To search for text:

1. In the Find What box of the Search window, type the text string you 
want to find.

By default, the search feature is not case-sensitive. Check the Match 
Case box if you want to find a string with the same capitalization (for 
example, Time is different than time). 

Space characters are allowed in the string.

2. In the Look In section, select the model elements to search by clicking 
the adjacent box(s).

3. Click the Find button.

IMPRINT Pro searches for the text string and displays each occurrence 
of that string in the field on the right side of the Search window. 

You can stop the search at any time by clicking the Stop Search 
button.

4. Click  to close the Search dialog box.
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Checking for Syntax Errors
IMPRINT Pro allows you to check your model for syntax errors using the 
Check for Errors option located in the Execution menu and the tool bar. 
The Syntax Checker scans the entire model and immediately reports any 
errors in the Output window.

To check for syntax errors:

1. From the View menu, select Windows, then click Output.

The Output window displays.

2. Do one of the following:
• From the Execution menu, click Check for Errors. 
• Click the Check for Errors button on the tool bar.

Any errors that are detected display in the Output window.

3. To open the dialog box where the error occurs, double-click the error.

Due to the fact that the maintenance model is a stochastic model, errors 
encountered through the syntax checker have the potential to occur far 
less frequently than in the operations model. However, any issues that 
do arise will appear in the Output window. IMPRINT Pro generally 
indicates the nature of the problem in the error message, for example, 
displaying the message “unrecognized word” for a misspelled or 
undeclared variable.

For more information on common syntax errors and possible solutions, 
see IMPRINT Pro User’s Manual Volume 3, Appendix: Checking for 
Errors.

Controlling Execution 
IMPRINT Pro provides commands to start, stop, pause, resume, and step 
through execution of a model. You can also set the speed for mission 
execution.
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Starting and Resuming Scenario Execution
To start or resume scenario execution:

Do one of the following:
• From the Execution menu, click Begin Simulation.
• Click the Begin Simulation button on the tool bar.
• Press the shortcut keys Ctrl+G.

The mission executes or resumes execution.

Note:
Before executing the scenario, check the execution preferences to make sure 
the model is set to run as desired.

Pausing Scenario Execution
You can temporarily pause scenario execution. When scenario execution 
is paused, you can make changes to the model attributes such as the 
values of variables.

To pause scenario execution:

1. To pause scenario execution do on of the following:
• From the Execution menu, click Pause Simulation.
• Click the Pause button on the tool bar.
• Press the shortcut keys Ctrl+P.

The scenario pauses executing.

2. When you are ready to resume scenario execution, click Begin 
Simulation from the Execution menu.

Stepping Through Scenario Execution
You can step through mission execution one event at a time. This method 
of execution is useful for debugging a mission. This command is available 
only when the mission has not yet begun execution or when mission 
execution is paused.

To step through scenario execution:

1. Do one of the following:
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• From the Execution menu, click Step Simulation.
• Click the Step Simulation button on the tool bar.
• Press the shortcut keys Ctrl+T.

IMPRINT Pro executes the next event and pauses.

2. Select Step Simulation again.

IMPRINT Pro executes the next event and pauses.

3. To resume continuous execution, click Begin Simulation from the 
Execution menu.

Stopping Scenario Execution
You can stop the current execution of a scenario at any point. When you 
halt scenario execution, it cannot be resumed. The run is terminated and 
must start over.

To stop scenario execution:

Do one of the following:
• From the Execution menu, click Halt Simulation. 
• Click the Halt Simulation button on the tool bar.
• Press the shortcut keys Ctrl+H. 

The current execution stops. 

To stop scenario execution temporarily and then resume it, use the Pause 
command. If you click Begin Simulation after you have halted an 
execution, a new run is started.

Setting the Execution Speed
You can control the speed of real time scenario simulation from the 
IMPRINT Pro tool bar. Execution speeds are 25%, 50%, 100%, 200%, 
400%, and 800%; each execution speed is twice as fast as the speed listed 
above it.

To set the execution speed:

Do one of the following:
• From the Execution menu, click Simulation Speed.
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• Click the Simulation Speed button on the tool bar.

Select the execution speed from the list that displays.
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Subchapter 6.4 Analyzing Equipment 
Results

When you run a scenario, IMPRINT Pro produces reports containing data 
from the scenario run based on parameters that you set up in the 
Execution Settings dialog box. These reports include trace, task, and 
snapshot data in the form of a workbook and can be viewed using 
Microsoft Excel.

Note:
Running and viewing reports following a model run requires that the user 
wishing to run and view those reports has the lock on the analysis containing 
that model. For any model which is unlocked or which is locked by another 
user on your network, reports will not be available after the model run. For 
more information on locking and unlocking analyses, see the IMPRINT Pro 
User Guide Volume 1: Basic Procedures, Appendix D: Local Server and 
Remote Server Setup.

Maintenance Model Results Reports
To create maintenance model reports:

1. From the Reports menu, select Maintenance Results. 

When you make this menu selection, a new dialog box will display 
prompting you to check the reports you want to generate for that 
scenario. 

2. Select each report you want to view by clicking its check box to the left.
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3. Click OK.

IMPRINT Pro uses Microsoft Excel to generate and display the selected 
Scenario reports.

Each of the individual reports are presented as separate tabs at the bottom 
of the Excel Workbook. To navigate between reports, click the labeled 
tabs. For more information on using Microsoft Excel, please refer to the 
Microsoft Excel help feature.

Maintenance Summary Report
The Maintenance Summary report contains four data items that summarize 
the maintenance actions that were generated during the simulation:

Total Operating Hours (simulated).

Average Preventive Maintenance Hours. Calculated by taking 
the total amount of manhours in this category, and dividing it by 
the total number of systems in the scenario.

Average Corrective Maintenance Hours. Calculated by taking 
the total amount of manhours in this category, and dividing it by 
the total number of systems in the scenario.

Sample Maintenance Model Results Report
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Average Maintenance Per Operating Hour. The average 
maintenance manhours simulated per operational hour, 
calculated by dividing the sum of the preventive and corrective 
maintenance manhours by the total operating hours for all 
systems.

Daily Maintenance Report
The Daily Maintenance report contains the amount of maintenance 
manhours that were simulated at all organizational level types (for 
example, ORG, DS, GS) for both preventative maintenance and corrective 
maintenance. 

The values in this report are totals across all systems.

Maintenance Summary Report
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Reliability and Availability Report
The Reliability and Availability report has two parts:

Reliability Summary. The Reliability Summary includes 
measures for the number of Segments Requested and the 
number of Segments Accomplished during the simulation. An 
“accomplished” segment is one whose minimum required 
number of systems was met at the start of the segment, i.e., the 
request for the segment could be fulfilled; it does not necessarily 
mean that the segment completed.

The report also includes measures for the number of times 
systems were requested and the number of times that those 
system requests were accomplished. The Systems Requested 
number will always reflect the maximum number of systems 
value you enter for a segment. This is because this number 
represents the ideal number of systems to send out in the 
segment; the segment may still proceed, however, if the 
minimum number of systems you set for the segment is met. 
The Systems Accomplished number, however, will reflect the 
number of systems which were actually assigned to 
accomplished segments. In other words, if a segment requires a 
minimum of two systems and a maximum of four systems, the 
segment will be accomplished if 2, 3 or 4 systems are available; 
the number of systems accomplished in this case will be the 
number that go out on the segment (2, 3 or 4), provided the 

Daily Maintenance Report
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minimum (2) is met. If only one system is available at the time of 
request, the segment’s minimum cannot be met thus the 
segment does occur. Since the segment does not occur and no 
systems go out, the number of systems accomplished goes to 
zero. 

Availability Summary. The Availability Summary includes the 
following calculated values:

Average inherent availability = ((scenario length in hours x # 
of systems) minus (total clock hours on corrective 
maintenance)) divided by (scenario length in hours x # of 
systems)

Average achieved availability = ((scenario length in hours x # 
of systems) minus (total clock hours on corrective + preventive 
maintenance)) divided by (scenario length in hours x # of 
systems)

Note:
Inherent and achieved availability consider the total number of days simulated 
in hours (for example, 365 * 24), minus the number of clock hours spent in 
maintenance. Therefore, if two or more Soldiers are working at the same time 
on the same system, they are counted just once. Similarly, if two maintenance 
tasks are being worked on at the same time, it is only counted once.)

Readiness = segments accomplished divided by segments 
requested

This report includes all segments that completed through the midnight of 
the last day of the simulation.
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Maintenance Hit Matrix Report
This report is an exhaustive listing of the maintenance tasks that occurred 
during your simulation. The columns of the report are:

Subsystem Name

Component Name

Task Name

Type of Maintenance. Preventive or Corrective.

Level. Organizational level type at which the maintenance action 
will be performed (for example, ORG, DS, GS).

Specialty 1. First Specialty that was assigned to perform the 
maintenance action.

Number. Number of maintainers of the first Specialty that must 
work together to perform the task.

Specialty 2. Second Specialty that was assigned to perform the 
maintenance action.

Number. Number of maintainers of the second Specialty that 
must work together to perform the task.

Reliability and Availability Report
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Occurrence. The number of times the task was triggered during 
the simulation, or occurrences.

Manhours. Total maintenance manhours simulated on the 
maintenance action.

This maintenance hit matrix also includes maintenance tasks that never 
occurred. You will identify those actions by noting the zeros in the 
“Occurrences”, or number of occurrences, column. If many of your tasks 
have not occurred, it indicates that your simulation did not run long enough 
for the system to require these maintenance tasks (such as the mean 
operational units between failure (MOUBF) for the tasks are longer than 
the simulation time period). This probably indicates that you should 
lengthen the simulation run, and re-execute the model.

Since maintenance tasks are triggered by comparing their MOUBF to a 
standard exponential curve of accrued usage on each component in the 
system, there is some randomness associated with simulating when the 
maintenance task will occur. For this reason, we recommend that you 
execute the IMPRINT Pro scenario with a variety of random number seeds 
to ensure that you have generated a representative set of results.

In the event a need for maintenance is triggered during your model run but 
it does not trigger an abort (either because the abort % for that 
maintenance task is set to 0% or because the probability of an abort is too 
low), the implementation of maintenance will be postponed until the 
segment has finished. If the model run completes before the segment has 
a chance to finish, those tasks which were postponed until the end of the 
segment will never take place thus they will not be reflected in the 
Maintenance Hit Matrix has having occurred.

Maintenance Hit Matrix Report
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Contact Team Hit Matrix 
The contact team hit matrix report has results displayed only if the 
maintenance task has been performed at the contact team level.

This report is an exhaustive listing of the maintenance tasks that occurred 
during your simulation. The report scrolls up and down. The columns of the 
report are:

Subsystem Name

Component Name

Task Name

Maintenance Task Type (Preventive or Corrective)

Specialty that was needed to perform the maintenance action 
(note that CT is used to denote a member of the crew)

Number of Contact Team maintainers needed to perform the 
task

The number of times the task was triggered during the simulation

Total maintenance manhours simulated on the maintenance 
action 

If the contact team does not perform any maintenance action for the run 
then this report does not have any results.
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Crew Chief Hit Matrix Report
The Crew Chief Hit Matrix report has results displayed only if the 
maintenance task has been performed at the crew level. 

This report is an exhaustive listing of the maintenance tasks that occurred 
during your simulation. The report scrolls up and down. The columns of the 
report are:

Subsystem Name

Component Name

Task Name

Maintenance Task Type (Preventive or Corrective)

Specialty that was assigned to perform the maintenance action 
(note that CC is used to denote a member of the crew)

Number of maintainers needed to perform the task

The number of times the task was triggered during the simulation

Total maintenance manhours simulated on the maintenance 
action

If the crew does not perform any maintenance action for the run then this 
report does not have any results.

Contact Team Hit Matrix Report
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Daily Reliability Report
For each day of the scenario, the daily reliability report provides a summary 
of the number of segments requested, the number of segments 
accomplished (generated by the simulation), and the percentage of the 
requested segments that were accomplished.

Similarly, the daily reliability report also provides a summary of the number 
of systems requested, the number of systems accomplished (generated by 
the simulation), and the percentage of the requested systems that were 
accomplished.

For more information on requested and accomplished segments and 
systems, see the Reliability and Availability Report.

Crew Chief Hit Matrix Report
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Supply and Support Report
This report contains the fuel and ammunition requirements for supporting a 
mission. These support requirements are based on the daily fuel and 
ammunition requirements for a particular scenario entered under 
Equipment node and the capacity and manpower available per transporter 
entered in the Scenario mission node. The columns of the report are:

Subsystem Name

Transporter Name

Total # of trips needed

Specialty. First Specialty that was assigned to transport the fuel.

Number. Number of the transporters of the first Specialty that 
must work together to perform the task.

Specialty. Second Specialty that was assigned to transport the 
fuel.

Number. Number of the transporters of the second Specialty 
that must work together to perform the task.

Daily Reliability Report
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IMPRINT determines the Supply and Support requirements as follows:

1. IMPRINT Pro calculates the Total # of Trips Needed by assessing the 
systems’ fuel and ammunition usage over the course of the scenario 
and then by determining how many trips are required to supply for this 
usage.

2. The total number of trips per scenario is divided by the number of days 
in the scenario to determine the average number of trips a transporter 
will make in one day.

3. Dividing the average number of trips per day by the maximum number 
of trips a transporter can make in one day results in the average 
number of transporters needed per day. This number is then rounded to 
the next highest integer.

4. The average number of transporters needed per day is then multiplied 
by the number of individuals of a set specialty (e.g., MOS 1) who are 
required to man one transporter at any one time. This results in the total 
number of warfighters of a particular specialty that are required to run 
all similar transporters for the entire scenario. This step is repeated for 
the second specialty, if used.

Maintainability Report
This report includes simulated maintenance manhours per operational 
hour. This measure is calculated by dividing the total manhours of 
maintenance performed on each subsystem by the total number of 
operational hours of the scenario. 

Supply and Support Report
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This report also includes simulated manhours per hour. This measure is 
calculated by dividing the total manhours of maintenance performed on 
each subsystem by the total length of the scenario (in hours).

Maintainability Graph
This graph provides a histogram of the manhours needed to perform 
maintenance on each subsystem of your system. The histogram includes 
two types of data: 1) the number of maintenance manhours per operational 
hour (typically referred to as the maintenance ratio), and 2) the number of 
maintenance manhours per hour of the scenario. 

The histogram provides a graphical presentation of the same data that are 
displayed in the Maintainability report.

Maintainability Report
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Headcount Frequencies Report
This report provides a measure of Specialty utilization, or more specifically, 
it illustrates the frequency with which different numbers of people in each 
specialty were used and over all organizational level types (for example, 
ORG, DS, GS). This report is based on the entire length of the simulation, 
not just the times during the simulation that this Specialty was busy or on 
duty. 

The highest bin for which a > 0% utilization is shown will never exceed the 
shift manning levels you set for that Specialty and that organizational level 
type. Additionally, if the highest bin shown has a relatively high frequency, 
as in the example of 20% of the time three people being used, then it is 
possible that you have constrained this Specialty so tightly that it is 
reducing system availability.

Maintainability Graph
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As an example, consider the report shown in the figure above. Notice that 
in the Specialty column, the results for the 45E20 at the ORG Level show a 
frequency of 97.29% for the crew size of 0. This means that for most of the 
scenario time (97.29% of the time), zero 45E20 specialties were in use. By 
contrast, for 2.19% of the scenario time, at least two people of the 45E20 
specialty were in use. If the scenario was 10 days long, then the 45E20 
was busy for (2.19% x (240 hours)) =  5.256 hours. The total percentage of 
time that any 45E20 maintainer was required is 2.71% - this translates to 
6.504 hours.

We recommend that you perform the first IMPRINT Pro maintenance 
model run with the shift manning levels unconstrained. This will result in a 
simulation that optimizes system availability from the perspective of 
manpower. Put another way, the simulation will assume that the manpower 
required to perform any maintenance action will be available. After running 
the IMPRINT Pro maintenance model in the unconstrained mode, you 
should examine this Headcount Frequency report for guidance on how to 
best constrain your shift manning pools (such as to minimize the effect on 
system availability). We recommend that you focus on reducing manpower 
pools for Specialties that have low utilizations.

Manhour Requirements Report
This report has three columns. They are organizational level, Specialty, 
and Direct Maintenance Manhours. This report is useful for identifying the 
Specialties that are performing the most maintenance.

HeadCount Frequencies Report
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Manhour Requirements Graph
The Manhour Requirement Graph is a histogram that presents the same 
data as are in the Manhour Requirements Report. Each Specialty at each 
organization level (GS, ORG and DS) is shown as an individual bar in the 
histogram. The height of the bar indicates the number of manhours 
expended by that Specialty at that organizational level throughout the 
scenario.

Manhour Requirements Report
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Combat Damage Report
This is a brief report that lists the number of combat hits that were 
simulated for all your systems throughout the entire length of the simulation 
run. This report also lists the number of simulated attritions, or kills. Finally, 
this report also shows the required repair time in total number of hours. 

It should be noted that these metrics are stochastically driven because of 
the combat parameters entered earlier in IMPRINT Pro. These combat 
parameters are mission-specific and include the probability of combat hit 
per hour, the probability of attrition or repair, and the time it takes to either 
replace a destroyed system or repair a damaged system.

Manhour Requirements Graph
418



Chapter 6: Equipment Analysis
Logistical Summary Report
The Logistical Summary Report includes two measures. These measures 
are the amount of time systems spent waiting for spare parts and the 
amount of time systems spent waiting for maintainers. Each of these 
measures are reported by organizational level.

If there is an excessive amount of time in which systems are spent waiting 
for spare parts, you will want to either increase the probability that spares 
are available or decrease the amount of time required to procure a spare 
on the Spares tab in Equipment node.

If there is an excessive amount of time in which systems are spent waiting 
for maintainers, you will either want to increase the number of people in 
your manpower pools, or you should increase your shift lengths, or you 
could decrease the operational profile for your systems. Each of these 
options are available in the Equipment portion of IMPRINT Pro.

Combat Damage Report
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Stressor Settings Report
You can apply five different stressors (cold, heat, noise, MOPP, and 
sleepless hours) to tasks in the Settings option of the Moderators menu. 
The Stressor Settings report allows you to view all the stressors you set for 
the model. The report will display the following information:

Function Name. The parent function of the task.

Task Name. The task that the stressor has been applied.

Warfighter.The name of the operator who will perform the task.

Specialty. A three-character designation representing the 
operator’s specialty.

Stressor. The type of stressor.

Level. The level at which the stressor has been applied.

Logistical Summary Reports
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Specialty Utilization Report - Equipment Model
For users who regularly use the Army Military-Civilian Cost System 
(AMCOS) to estimate the cost of using a fixed number of military personnel 
for a specific number of years, the Specialty Utilitization Report is designed 
to provide you information about the utilization of all the specialties in your 
model run which may then be used as a basis for the data you enter into 
AMCOS.

In general, AMCOS requires that you enter specialty, the number of people 
of each specialty, and all years of service to be included in your cost 
estimate so that it can give you an estimation on how much it costs to 
support these specialties for those years. After having run an IMPRINT Pro 
model, you may use the Specialty Utilization Report to gain a better 
understanding on the types and quantities of personnel you need based on 
your model run results. 

Before entering data into AMCOS based on this report, the idea of 
“utilization” according to IMPRINT Pro must be understood. In the 
Maintenance model, utilization is considered to be the total time any 
maintainer spends actively working on repair tasks (direct maintenance 
manhours) and is not the amount of time an maintainer is simply available, 
or in other words, not simply the model run time. Secondly, in the case 
where a repair task requires more than one person, the utilization is 

Stressor Settings Report
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considered the total of all maintainers’ hours collectively and not simply the 
clock time it took for the task to be turned around. For example, if two 
maintainers both worked on the same repair task for four hours apiece, the 
total direct maintenance manhours for this task is eight hours. More 
detailed information about the individual repair tasks performed by 
maintainers can be found in the Manhours Requirements report, the report 
on which the Specialty Utilization Report is based.

It is also important to note that the utilization reported by the Specialty 
Utilization Report is for the total duration of the model; if the total clock time 
of your model run is any less than one year, the utilization hours reported 
will not correlate directly with the expected values AMCOS requires, which 
are specifically the full years that you need a specialty. You must project 
out from the utilization summary the number of people of a certain specialty 
you need and the number of years your specialty must be available; this 
interpolation of the data may require more expertise beyond what the 
Specialty Utilization Projection Report can provide. The quantities of each 
specialty and the years for which they are required could vary depending 
on how many people of each specialty your mission requires and how 
many similar missions you intend to execute within the course of a year.

AMCOS requires users to enter data in four steps: Properties, Faces and 
Spaces, Cost Summaries and Output. The part of AMCOS to which your 
IMPRINT model run results apply is the Faces and Spaces step where 
you add information about the personnel required. This part of AMCOS is 
depicted in the image below:

The Faces and Spaces page contains the following fields:

PayPlan

Group
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Subgroup 

Area 

Locality 

Grade

Inventory

The only fields where IMPRINT report data applies are in the Group, 
Subgroup, Grade and Inventory fields.

Applying IMPRINT Pro report data to AMCOS
To apply IMPRINT Pro report data to AMCOS:

1. Select the desired group from the drop-down list.

Note:
In IMPRINT Pro, all specialties from which you may select your 
Warfighters are grouped together in one list. In AMCOS, however, 
specialties are categorized into different groups. The first two 
characters in a specialty code defines the group to which that specialty 
belongs. 

The selected group appears in the Group field, and the SubGroup 
drop-down list is enabled.
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2. From the SubGroup drop-down menu, select the desired subgroup 
(specialty).

The selected subgroup appears in the SubGroup field.

3. From the Grade drop-down menu, select the pay grade which applies 
to the selected Group-SubGroup combination.
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If you are basing your selection in AMCOS on the data from the 
Maintenance Manhour Requirements report, it is important to note that 
in place of an E-level value for Warfighters, IMPRINT Pro displays a 
pay grade value instead. These values translate as follows:

The selected grade appears in the Grade field.

4. The Inventory section displays a box for each year you are choosing to 
project costs. In each box provided, enter the number of personnel for 
which costs are to be projected.

Grade E-Level

10 E1-E3

20 E4

30 E5

40 E6

50 E7

60 E8-9
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5. Click the Insert button in the lower-left corner of the screen.

The specialty data you entered is added to the list at the top of your 
AMCOS screen. You may repeat these steps for all specialties to be 
included in your cost projection. Once you have finished entering 
specialty information, you are finished with the portion of AMCOS which 
requires data from IMPRINT. Proceed with the remaining steps in 
AMCOS as normal.
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Moderators

In IMPRINT Pro you can create your own custom performance moderators 
to affect time or accuracy of the tasks in your model. A new moderator is 
added to your analysis as either a new Custom Stressor or a Custom 
Training Moderator. Each moderator modifies task time and accuracy 
according to the algorithm you define. 

Adding and implementing a new custom moderator first requires identifying 
the moderator, for example, you may wish to specify a new method of 
training which makes use of a web-based product rather than using an 
instructor. In this case, the new method could be added as a new custom 
training moderator called “Web Training.” Next, the levels of the moderator 
must be specified, for example, available training options might include 
once, twice, three times and four times per month in which case four 
unique levels of impact must be defined for the moderator. Next, each 
level’s impact must be represented by an algorithm you create - these 
algorithms link levels of the moderator to performance impacts by taxon 
and then applying the moderator to the individual tasks as needed. For 
example, if research supports a theory that more frequent training with this 
new product enhances the accuracy of tasks requiring cognitive workload, 
specifically in the areas of information processing and problem solving, an 
algorithm designed to increase the value of task accuracy as a function of 
the Information Processing/ Problem Solving taxon would be appropriate.

Once defined a custom moderator is available for use by all Operations 
and Maintenance models in your analysis. Using Custom Moderators 
allows you to embed your own experimental findings into an IMPRINT Pro 
model. 

Custom Stressors

The Customs Stressors node is located below the Forces node in the 
Analysis tree.
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Displaying a List of Custom Stressors
To display a list of all custom stressors in the main window:

In the Analysis Tree, double-click the Custom Stressors node.

A list of Custom Stressors will display in the main window.

Adding Custom Stressors
To add a custom stressor:

1. In the Analysis Tree, right-click the Custom Stressor node.

2. Select New Custom Stressor from the menu that displays.

IMPRINT Pro adds a Custom Stressor child node to the Analysis Tree 
below the Custom Stressors node.

Note:
IMPRINT Pro will name your new stressor Custom Stressor. If you 
continue to add Custom Stressors, each following stressor will be named 
StressorX where X is the next integer.
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Deleting Custom Stressors
To delete a stressor:

Do one of the following:
• In the Analysis Tree, right-click the stressor you want to delete, and 

select Delete Custom Stressor from the menu that displays.
• Select the stressor you want to delete, and then click the Delete key.

IMPRINT Pro removes the custom stressor child node from below the 
Custom Stressors node.

Cutting Custom Stressors 
To cut a stressor:

1. In the Analysis Tree, right-click the custom stressor you want to cut 
below the Custom Stressor node.

2. Select Cut Stressor from the menu that displays.

When you right-click the Custom Stressor node in the analysis to which 
you want to move the Custom Stressor, the cut stressor will be 
highlighted red. When you perform the paste command, the cut Custom 
Stressor will be removed old position to the new position.

Copying Custom Stressors
To copy a custom stressor:

1. In the Analysis Tree, right-click the custom stressor below the Custom 
Stressor node.

2. Select Copy Stressor from the menu that displays.

The stressor will be copied to the Windows clipboard.
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Pasting Custom Stressors
To paste a custom stressor:

1. In the Analysis Tree, right-click the custom stressor node of the analysis 
to which you want to paste the cut or copied stressor.

2. Select Paste Custom Stressor from the menu that displays.

The stressor and all its associated data pastes to the Custom Stressor 
node in the selected analysis.

Displaying the Custom Stressors Dialog Box
The Custom Stressors dialog box is used to create the algorithms needed 
to affect time or accuracy in the model.

To display the Custom Stressor dialog box:

Double-click a Custom Stressor (for example, Custom Stressor1).

The Custom Stressor dialog box displays.
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Adding Custom Stressor Levels
To add a custom stressor level:

Do one of the following:
• In the Custom Stressor dialog box, click the Add Level button.
• In the Analysis Tree, right-click Custom Stressor (for example, 
Custom Stressor1) and select Add Stressor Level from the 
menu that displays.

A level is added to the dialog box.
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Deleting Stressor Levels
To delete a stressor level:

1. In the Custom Stressor dialog box, select the level you want to delete.

2. Click the Delete Level button.

Defining Time and Accuracy
Each level added to your stressor contains two algorithm fields:       

Accuracy Algorithm

Time Algorithm

These fields contain the algorithms you specify for the level’s effect on task 
time and accuracy.

Unlike in previous versions of IMPRINT, neither the Custom Stressors nor 
Training Moderators use “Increase” or “Decrease” fields. Effects on task 
time and accuracy are instead calculated as follows:

Effects on Time. Any value calculated for a Time Moderator will 
be added to 1.0, and the result used to multiply the Time value of 
each task. If the value calculated by the algorithm is positive, 
task time increases; if the value calculated by the algorithm is 
negative, task time decreases.
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Effects on Accuracy. Any value calculated for an Accuracy 
Moderator will be subtracted from 1.0, and the result used to 
multiply the accuracy value of each task. If the value calculated 
by the algorithm is positive, task accuracy decreases; if the value 
calculated by the algorithm is negative, task accuracy increases.

Creating Algorithms for Accuracy and Time
A custom stressor algorithm is an expression made up of one or more of 
the nine taxons available in IMPRINT Pro. As the algorithm is being 
developed, it may be checked for syntax and tested with numerical 
replacements for the taxons.

Creating the Algorithm Expression
To create algorithms for accuracy and time:

1. Double-click the Custom Stressor.

2. In the Custom Stressor dialog box, choose a level whose algorithm you 
wish to add or modify.

3. For the selected level, click the cell under the Accuracy Algorithm 
column or the Time Algorithm colum.

An ellipses displays to the right of the Algorithm box.
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4. Click the ellipses  to the right side of the right side of the algorithm 
cell.

The Define Accuracy/Time Stressor dialog box displays.
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The Custom Stressor name and Stressor Level name appear at the top 
of the dialog box.  The Stressor Level name may be edited as desired 
by typing a new name directly Stressor Level field.

5. Create an equation using the buttons provided in the Algorithm 
Parameters section of the dialog box. The algorithm displays in the 
Expression box as it is developed.
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Decimal points must follow a number. Operators must follow a number 
or workload taxon. The workload taxons you enter into the equation 
refer to the weights given to the taxons in individual tasks.

To backspace, click Backspace.

To clear the equation, click Clear.

To cancel the equation, click Cancel.

6. To save the equation, click OK.

The new algorithm displays in the selected algorithm column of the 
Custom Stressor dialog box.

Checking Algorithm Syntax
To check syntax for algorithms for accuracy or time:

Click the Check Syntax button at the bottom of the Custom Stressor 
dialog box.

The algorithm in the Expression box is checked for syntax errors, and a 
message displays in the Check Syntax dialog box.
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Testing Accuracy and Time Algorithms
To test accuracy or time algorithms:

1. Click the Test Algorithm button at the bottom of the Custom Stressor 
dialog box.

The Expression field in the dialog box is replaced by the Test 
Algorithm window. 
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The Test Algorithm window displays the algorithm at the top. The 
window also includes Parameter fields corresponding to the nine 
taxons in IMPRINT Pro tasks, a Calculate button and a Value field.

2. In the enabled taxon fields, enter the values you wish to test for those 
taxons in the algorithm.

3. Click the Calculate button.

The resultant value displays in the Value field.
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Applying Custom Stressors
To apply the custom stressors:

1. From the Moderators menu, select Settings.

A shortcut menu appears.

2. From the Settings shortcut menu, select Stressors.

The Stressors dialog box displays.

3. For each task that applies, select the desired level of each stressor from 
the drop-down boxes provided.

Viewing Custom Stressor Results
To view custom stressor results:

1.  From the Moderators menu, select Results.

The PTS Results dialog box displays.

2. Check the Stressors check box on the right hand side of the dialog 
box.

3. Click the Apply button.

The dialog box displays the following values for each task:

Previous. The value(s) before moderators are applied 

Adjusted. The value(s) after moderators are applied.

Delta. The difference between the Previous and Adjusted value.
439



IMPRINT Pro Basic Procedures
Custom Training Moderators

The Custom Training Moderators node is located below the Forces node in 
the Analysis tree. Beyond the default training moderators included in the 
PTS section of IMPRINT, custom training moderators may be applied on a 
per-task basis rather than per-operator only.

Displaying a List of Custom Training 
Moderators
To display a list of custom training moderators in the main window:

In the Analysis Tree, double-click the Custom Training Moderators 
node.

A list of Custom Training Moderators displays in the main window.

Adding Custom Training Moderators
To add a custom training moderator:

1. In the Analysis Tree, right-click the Custom Training Moderator node.
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2. Select New Training Moderator from the menu that displays.

IMPRINT Pro adds a Training Moderator child node to the Analysis 
Tree below the Custom Training Moderators node.

Note:
IMPRINT Pro will name your new custom training moderator Training 
Moderator. If you continue to add training moderators, each following 
moderator will be named Training ModeratorX where X is the next 
integer.

Deleting Custom Training Moderators
To delete a stressor:

Do one of the following:
• In the Analysis Tree, right-click the stressor you want to delete and 

select Delete Custom Training Moderator from the menu which 
displays.

• Select the stressor you want to delete and click the Delete key.

IMPRINT Pro removes the Custom Training Moderator child node from 
below the Custom Training Moderators node.

Cutting Custom Training Moderators 
To cut a stressor:

1. In the Analysis Tree, right-click the Custom Training Moderator you 
want to cut below the Custom Training Moderator node.

2. Select Cut Stressor from the menu that displays.

When you right-click the Custom Training Moderator node in the 
analysis that you want to move the Custom Training Moderator to, the 
cut Custom Training Moderator will be highlighted red. When you 
perform the paste command, the cut Custom Training Moderator will be 
removed old position to the new position.
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Copying Custom Training Moderators
To copy a Custom Training Moderator:

1. In the Analysis Tree, right-click the custom training moderator below the 
Custom Training Moderator node.

2. Select Copy Stressor from the menu that displays.

The stressor will be copied to the Windows clipboard.

Pasting Custom Training Moderators
To paste a stressor:

1. In the Analysis Tree, right-click the custom training moderator node for 
the analysis you want to paste to.

2. Select Paste Custom Training Moderator from the menu that 
displays.

The stressor and all its associated data will be pasted to the Custom 
Training Moderator node in analysis you pasted to.

Displaying the Custom Training Moderators 
Dialog Box
You will use the Custom Training Moderators dialog box to create the 
algorithms needed to affect time or accuracy in the model.

To display the Custom Training Moderator dialog box:

Double-click a Custom Training Moderator (for example, Custom 
Training Moderator1).

The Custom Training Moderator dialog box displays.
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Adding Custom Training Levels
To add a stressor level:

Do one of the following:
• In the Custom Training Moderator dialog box, click the Add Level 

button.
• In the Analysis Tree, right-click Custom Training Moderator (for 

example, Custom Training Moderator1) and select Add 
Stressor Level from the menu that displays.

A level is added to the dialog box.

Deleting Custom Training Levels
To delete a stressor level:

1. In the Custom Training Moderator dialog box, select the level you want 
to delete.
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2. Click the Delete Level button.

Defining Time and Accuracy
Each level added to your training moderator contains two algorithm fields:       

Accuracy Algorithm

Time Algorithm

These fields contain the algorithms you specify for the level’s effect on task 
time and accuracy.

Unlike in previous versions of IMPRINT, neither the Custom Stressors nor 
Training Moderators use “Increase” or “Decrease” fields. Effects on task 
time and accuracy are instead calculated as follows:

Effects on Time. Any value calculated for a Time Moderator will 
be added to 1.0, and the result used to multiply the Time value of 
each task. If the value calculated by the algorithm is positive, 
task time increases; if the value calculated by the algorithm is 
negative, task time decreases.

Effects on Accuracy. Any value calculated for an Accuracy 
Moderator will be subtracted from 1.0, and the result used to 
multiply the accuracy value of each task. If the value calculated 
by the algorithm is positive, task accuracy decreases; if the value 
calculated by the algorithm is negative, task accuracy increases.

Creating Algorithms for Accuracy and Time
Similar to the custom stressor algorithm, a custom training moderator 
algorithm is an expression made up of one or more of the nine taxons 
available in IMPRINT Pro. Apart from the custom stressor algorithm, 
however, the custom training moderator allows you the additional option of 
factoring task difficulty (T) or simply the sum of all the single task demand 
values into your algorithms. As the algorithm is being developed, it may be 
checked for syntax and tested with numerical replacements for the taxons.

Creating the Algorithm Expression
To create algorithms for accuracy and time:

1. Double-click the custom training moderator.
444



Chapter 7: Custom Performance Moderators
2. In the Training Moderator dialog box, choose a level whose algorithm 
you wish to add or modify.

3. For the selected level, click the cell under the Accuracy Algorithm 
column or the Time Algorithm colum.

An ellipses displays to the right of the algorithm box.

4. Click the ellipses  to the right side of the right side of the algorithm 
cell.

The Define Accuracy/Time Algorithm dialog box displays.
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5. Create an equation using the buttons provided in the Algorithm 
Parameters section of the dialog box. The algorithm displays in the 
Expression box as it is developed.

Decimal points must follow a number. Operators must follow a number 
or workload taxon. The workload taxons you enter into the equation 
refer to the weights given to the taxons in individual tasks.

To backspace, click Backspace.

To clear the equation, click Clear.

To cancel the equation, click Cancel.
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6. To save the equation, click OK.

The new algorithm displays in the selected algorithm column of the 
Custom Training Moderator dialog box.

Checking Algorithm Syntax
To check syntax for algorithms for accuracy or time:

Click the Check Syntax button at the bottom of the Custom Stressor 
dialog box.

The algorithm in the Expression box is checked for syntax errors, and a 
message displays in the Check Syntax dialog box.
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Testing Accuracy and Time Algorithms
To test accuracy or time algorithms:
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1. Click the Test Algorithm button at the bottom of the Custom Stressor 
dialog box.

The Expression field in the dialog box is replaced by the Test 
Algorithm window. 

The Test Algorithm window displays the algorithm at the top. The 
window also includes Parameter fields corresponding to the nine task 
taxons plus task difficulty, a Calculate button and a Value field.

2. In the enabled taxon fields, enter the values you wish to test for those 
taxons in the algorithm.
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3. Click the Calculate button.

The resultant value displays in the Value field.

Using Custom Training Moderator 
Templates
IMPRINT Pro includes three pre-defined training moderator templates: 
Delivery Method, Frequency and Recency.  Each template contains four 
or more unique pre-defined evels appropriate to the template chosen:

Delivery Method: Web-based/remote, Classroom, Simulator-
based, Hands on instruction/practice.

Frequency:   Once a week or more, 2 or 3 times a month, Once 
a month, less than once a month, less than twice a year.

Recency.  Within days, 30 days, 60 days, Over 3 months.

Use these templates as a starting point to define your custom training 
moderator.

To use a custom training moderator template:

1. Right-mouse click the Custom Training node in the Analysis Tree.

2. Select one of the following:
• New Delivery Method Moderator
• New Recency Moderator
• New Frequency Moderator
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The new custom training moderator appears in the tree.

3. Double-click the new custom training moderator.

A new tab displays, showing the five default levels included with the 
moderator selected.  Edit the name(s) of the moderator and of the 
training levels contained by it as desired.

4. Add the desired algorithms to the levels provided.  For more information 
see “Creating the Algorithm Expression” on page 444.
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Applying Custom Training Moderators
To apply the custom training moderators:

1. From the Moderators menu, select Settings.

A shortcut menu appears.

2. From the Settings shortcut menu, select Training.

The Training Settings dialog box displays.

3. Click the Custom Training radio button.

4. For each task that applies, select the desired level of each training 
moderator from the drop-down boxes provided.

Viewing Custom Training Moderator Results
To view custom training moderator results:

1.  From the Moderators menu, select Results.

The PTS Results dialog box displays.

2. From the Settings shortcut menu, select Training.

The Training Settings dialog box displays.

3. Check the Training check box on the right hand side of the dialog box.

4. Click the Apply button.

The dialog box displays the following values for each task:

Previous. The value(s) before moderators are applied 

Adjusted. The value(s) after moderators are applied.

Delta. The difference between the Previous and Adjusted value.
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This chapter describes the IMPRINT Pro Force analysis capability. The 
chapter is divided into sections that describe how to enter the data needed 
to describe a force unit, the properties of those force units, settings that 
control force model execution, methods used to analyze the results data, 
and how to create reports displaying the results of executing the force 
model. 

The objective of the Force Analysis module is to help you predict the 
manpower needed to perform the routine and unplanned work done by a 
force unit. Similar to the Define Equipment module in IMPRINT Pro, the 
Force Analysis module operates using a stochastic model which relies on 
various inputs you provide. Inputs required are discussed in the sections 
below.

Introduction to Force Analysis

To conduct an IMPRINT Pro analysis of a Force Unit, follow these steps:

1. Define a Force Unit.

The Forces node contains the individual force units you choose to add 
to your model. A Force Unit is a group of individuals, defined by their 
job, who perform a variety of activities according to schedules. When 
more than one schedule exists, these schedules run in parallel when 
you run the Forces model. 

2. Define schedules for your Force Unit.

When you choose to create a force unit, you might choose to rotate 
your available personnel through different activities by setting up 
several different schedules. For example, one group might perform their 
work activities during the day (schedule A), and a second group might 
perform their work activities at night while the first group sleeps 
(schedule B). Although the two different groups operate on different 
schedules, both groups work together as a force unit to make sure that 
the work required in a given time period gets done. You can choose to 
make your force module even more detailed by creating separate 
schedules for each type of Job you add. For example, if you have a 
driver, navigator and an analyst all performing on a similar schedule 
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during the day, it may be of interest to vary each operator’s schedule 
slightly so that an activity of “guard duty” is covered by at least one of 
these individuals throughout the time period. Staggering this activity 
would result in three slightly different schedules.

3. Develop a list of planned activities to be performed by the Force Unit.

Most of the activities you will add to a schedule will be Planned 
activities. These activities have a designated start time in your schedule 
and will last until the next scheduled activity is set to occur. Examples of 
these activities include “work,” “personal time,” “sleep,” and “hygiene.” 

4. Develop a list of unplanned activities to be performed by your Force 
Unit.

Activities factored into your schedule may also include Unplanned 
activities, which also have a set start time but whose duration may vary 
depending on the mean time, standard deviation and distribution you 
choose to specify in the activity’s properties. Example unplanned 
activities may include “illness,” “emergency” and any other activity that 
would interrupt a normal schedule. Unplanned activities may also be set 
to repeat over time. Unplanned activities require that you specify a 
minimum number of crew members of which role categories/ are 
required to respond in order that the unplanned activity may be 
considered successful.

5. Develop a list of Jobs comprising your Force Unit.

The final component in the Forces module is the set of Jobs you choose 
to create. As mentioned previously, example jobs may include “Driver,” 
“Pilot,” “Navigator,” or “Analyst,” all of whom are required to perform 
activities. The properties of any job you create include a default rank 
and specialty. For example, the job of “Driver” might be specified as 
requiring an E5 rank and 19K specialty. The schedule(s) you design 
might require that you have several such job operators to cover all 
planned and unplanned activities within it.

6. Assign roles to your jobs.

A person who is able to perform a job may be able to do so in more than 
one capacity. For example, an individual who is qualified for the job of 
“Pilot” may also be qualified to be a “Co-pilot” and at times may be 
required to fill that roll instead. To add this additional latitude within the 
job, the IMPRINT Pro Forces module includes a set of role categories, 
which are referred to as Leader, Sub-Leader and Member. When 
creating jobs, you specify the exact roles existing within each job 
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description and the total number of individuals belonging to this job 
description that you have available for each schedule; these numbers 
ultimately tell the schedule how many Leaders, Sub-Leaders and 
Members you have at any one time to respond to an unplanned activity. 
For example, a schedule may contain an unplanned activity (aerial 
response to ground attack) requiring 3 Leaders (pilots), 3 Sub-Leaders 
(co-pilots) and 5 Members (additional crew). If the total number of 
Leaders among all job operators available to respond to this unplanned 
activity is less than the required number, the unplanned activity cannot 
successfully be conducted. This result would then be reported in the 
reports data provided by IMPRINT Pro after the Forces model is run. 

7. Set the Activities Trump Matrix.

For any schedule having both planned and unplanned activities, an 
unplanned activity will likely conflict with an ongoing planned activity. 
Only one activity may be performed at any given time. To determine 
which activity continues and which activity is halted, you must set a 
priority for each activity pair through the Activities Trump Matrix.

8. Run the Force Analysis model.

You may run the Force Analysis model at any point during the 
development of your force analysis. Execution options include setting 
the length of the model run (in days) and changing the random number 
used.

9. Run the Force Analysis reports.

The Force Analysis reports may be viewed any time after the model has 
been executed. The Force Analysis reports display data for both 
planned and unplanned activities.

Force Analysis Data

Force Analysis Data consists of the following items:

Force Units. Groups of individuals who perform activities 
according to a schedule.

Schedules. A pre-defined sequence of activities, planned and 
unplanned, over a specific amount of time.
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Planned Activities. Routine tasks. Examples may include guard 
duty, hygiene, eating and sleeping.

Unplanned Activities. Activities interrupting a normal schedule. 
Examples may include fire and emergency.

Activities Trump Matrix. A matrix used to set task priority within a 
schedule for when any two activities overlap.

Jobs. The occupations held by one or more members of the 
Force Unit. Each job is defined by a name, specialty, rank and 
role. Examples may include Tank Driver, Navigator and Analyst.

Force Units
Force Units are the first sub-nodes located under the Forces node in the 
Analysis Tree.

Displaying Force Units
To display forces in the Analysis Tree:

In the Analysis Tree, right-click the +  adjacent to Forces node.

The forces defined for your analysis display in a list below the Forces 
node.

Adding Force Units
To add a force unit:

1. Right-click the Forces node in the Analysis Tree.

2. Select Add Force Unit from the menu that displays.
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A new Force Unit displays in the list below the Forces node.

Displaying Force Unit Properties
To display Force Unit Information:

To view force unit properties, double-click the desired force unit - a list 
of force units for the currently-selected analysis displays in the main Pro 
window. Also displayed are the Number of Schedules defined for each 
force unit. 

Schedules
For each force unit defined, you may define an unlimited number of 
schedules. A schedule corresponds to a sequence of activities which will 
be common to one or more job operators for a specified number of days. 
As an example, a force unit that is divided into two groups might have one 
group operating on a daytime schedule (shown below) where crew 
members are doing work-related activities during the day and sleeping at 
night while the other group assumes a second schedule in which work-
related activities are performed at night and sleep occurs during the day.
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Sample schedule:

In the IMPRINT Pro Forces module, these schedules appear simply a 
timeline representing any length of time. For every activity added, a start 
time is required. The duration of any single activity is automatically set to 
the number of hours between its own start time and the start of the next 
scheduled activity so that all minutes in the schedule are accounted for.
 

For more information see “Adding Planned Activities to a Schedule” on 
page 464.

Time Activity

0:00 - 6:00AM Sleep

6:00AM-8:00AM Hygiene

8:00AM-12:00PM Guard

12:00PM-4:00PM Personal Time

4:00PM-8:00PM Guard

8:00PM-10:00PM Personal Time

10:00PM -12:00AM Hygiene
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Displaying a List of Schedules
To display a list of schedules for the selected force unit:

Double-click the Force Unit node in the Analysis Tree.

A list of schedules displays in the main IMPRINT Pro window.

For each schedule defined, the duration of the schedule displays in the 
adjacent box. The duration corresponds to the number of days the 
schedule runs.

When you run the Forces model for a particular force unit, all schedules 
corresponding to the unit run in parallel. Any schedule having a duration 
less than the duration of the model run will repeat until the model run 
ends. 

Adding a Schedule
To add a Schedule:

In the Force Unit properties window, click the Add Schedule button.

A new schedule listing appears in the Schedules list.
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Deleting a Schedule
To delete a Schedule:

In the Force Unit properties window, click the Delete Schedule button.

The selected schedule disappears from the Schedules list.

Force Activities
Each force unit may have its own defined list of activities that are 
performed in a schedule. Activities belong to one of two categories: 
Planned and Unplanned. A planned activity is one which is set to occur at 
a specific clock time and lasts for a specific number of hours in your 
schedule. Unplanned activities are also driven by a user-specific Start 
times. Their durations, however, are controlled by Mean, Standard 
Deviation and Distribution parameters set in the Unplanned Activities 
properties box. When an unplanned activity comes up, the current ongoing 
planned activity will be overtaken or “trumped” if the new activity has the 
higher priority according to the Activities Trump Matrix.
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Displaying Activity Categories
To display activity categories:

Click the +  adjacent to Activities node.

The following activity categories appear below the Activities node:

• Planned. An activity which is set to occur at a specific clock time and 
lasts for a specific number of hours in your schedule.

• Unplanned. An activity which is set to occur at a specific clock time 
but whose duration is controlled by Mean, Standard Deviation and 
Distribution parameters set in the Unplanned Activities properties 
box.

Planned Activities
A planned activity is an activity which is set to occur at a specific clock time 
and lasts for a specific number of hours in your schedule.

See:

Displaying Planned Activities

Adding a Planned Activity

Displaying and Editing Planned Activity Properties

Deleting a Planned Activity
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Displaying Planned Activities
To display a list of planned activities:

Click the +  adjacent to Planned node.

A list of planned activities lists below the Planned node in the tree.

Adding a Planned Activity
To add a planned activity:

1. Right-click the Planned node.

2. Select Add Planned Activity from the menu that appears.

A new planned activity appears underneath the Planned node. 

Double-click the listed activity to view its properties in the main 
IMPRINT Pro window.
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Displaying and Editing Planned Activity Properties
To display Planned Activity properties:

Double-click the desired planned activity under the Planned node in the 
Analysis Tree.

The properties of the planned activity display in the main Pro window. 
Properties include:
• Unit Name. The unit to which the planned activity is assigned.
• Activity. The name of the activity performed.
• Sleep Activity. A flag for indicating whether or not the activity 

involves sleep. In the event a schedule requires one or more job 
operators for which more than the required number of equally-
qualified operators are available, the operators considered to be the 
least fatigued, i.e., who most recently participated in Sleep Activity, 
are called on to perform in the schedule. 

The properties of an activity may be changed as desired either through the 
activities window or properties window. To edit the name of an activity, 
simply type the new name in the Activity field. To edit the Sleep state, click 
the drop-down arrow, and select the desired option from the list.

Changing the properties through the Activities window.

Changing the activity properties through the Properties window.
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The Analysis Tree displays the edited activity.

Deleting a Planned Activity
To delete a planned activity:

1. Right-click the desired planned activity in the Analysis Tree.

2. Select Delete Planned Activity from the menu that appears.

A selected activity disappears underneath the Planned node.

Adding Planned Activities to a Schedule
Any activity added underneath the Planned category may be added to one 
or more schedules you define for your force. Before adding these activities 
into your schedule, you must first define them in the Activities node under 
the categories of Planned. For more information, see “Force Activities” on 
page 460.

A schedule represents a fixed amount of time over which a set of serialized 
activities are performed. When a new activity is added to a schedule, that 
activity consists of a Start time and an End time within that fixed time 
period. The same activity may be added to a single schedule more than 
once. 
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To add planned activities to your schedule:

1. Double-click the Planned node in the Analysis Tree.

The Schedules tab appears in the main window, containing a separate 
sub-tab for each schedule you add under your force unit node.

2. Click the corresponding schedule tab to which activities are to be 
added.

3. Click the Add Activity button to add activities to your schedule.

A new activity row appears in the schedule, displaying the default 
activity name, Start Time and End Time.

4. Click the cell of the desired activity listing to view a drop-down list of 
activities from which to choose. Available activities include those which 
are defined under the Planned activities node.
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The selected activity name appears in the cell.

5. Continue adding activities to your schedule as desired.

6. Enter the Start Time for your activity. Times are in hours and minutes 
(HH:MM).
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IMPRINT Pro automatically sets the End Time for each activity to 
match the Start Time of the next activity set to occur, eliminating any 
gaps in the schedule.

Removing a Scheduled Activity
To remove scheduled activities:

1. Click the tab corresponding to the schedule to which an activity is to be 
removed.
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2. Click the desired activity to select it.

3. Click the Remove Activity button.

The selected activity is removed from the schedule.

Unplanned Activities
Unplanned activities are those which are set to occur at specific clock times 
but whose likelihood to occur and duration are controlled by Mean, 
Standard Deviation and Distribution parameters. These activities represent 
interruptions to the normal schedule and add variability, for example 
emergencies, illnesses and unforseen threats. Unplanned activities have 
additional properties for being repeatable and for requiring a minimum 
number of job operators of specific role categories.

Viewing Unplanned Activities
To view unplanned activities, 

Click the +  adjacent to Unplanned node.

A list of unplanned activities lists below the unplanned node in the tree.

Alternatively, you may double-click the Unplanned node to see a list of 
these activities in the main Pro window.
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This window also displays all properties of your activities in a tabular 
format. You may edit properties of your unplanned activities in this 
interface or by opening up the properties window for each task 
separately.

Adding an Unplanned Activity
To add an unplanned activity:

1. Right-click the Unplanned node.

2. Select Add Unplanned Activity from the menu that appears.

A new unplanned activity appears underneath the unplanned node.

Displaying and Editing Properties of an Unplanned 
Activity
To display Unplanned Activity properties:

Double-click the desired planned activity under the unplanned node in 
the Analysis Tree.

The properties of the unplanned activity display in the main Pro window. 
Properties include:
• Unit Name. The unit to which the unplanned activity is assigned.
• Activity. The name of the activity performed.
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• Sleep Activity. A flag for indicating whether or not the activity 
involves sleep. In the event a schedule requires one or more job 
operators for which more than the required number of equally-
qualified operators are available, the operator(s) considered to be 
the least fatigued, i.e., the operator(s) who gets the most sleep up 
until the actual point of time of the unplanned activity on the same 
day of the activity are called on to perform the unplanned activity in 
the schedule. For example, in the case where a Driver and Gunner 
have both received 8 hours of sleep before an unplanned activity on 
Day 1 in a schedule, both would be equally qualified to handle the 
unplanned activity in which case one operator will be pulled at 
random to address the activity. In the event the entirety of Driver’s 
sleep was in Day 1 (16:00-24:00), and part of Gunner’s sleep started 
on Day 1 (20:00-24:00) but continued into Day 2 (00:00-04:00), an 
unplanned activity occurring on Day 2 at 05:00 would cause the 
Gunner to be pulled since the Gunner has had more sleep than 
Driver on the actual day of the activity up until the point of the 
unplanned activity (four hours total). 

• Interrupt Strategy. A flag indicating whether an unplanned activity 
can resume or must restart if the personnel available to man this 
activity changes since its start. For example, assume an unplanned 
activity occurs which requires a fixed number of leaders, subleaders 
and members from a pool of available personnel. If a second 
unplanned activity occurs which also requires a fixed number of 
personnel, IMPRINT Pro checks to see if any unused personnel 
remain in the pool available to all unplanned activities or if excess 
personnel (any beyond the required minimum) must instead be 
pulled from the first (or any other) unplanned activity. If personnel 
must be pulled from the first unplanned activity and there are enough 
of them to man the second unplanned activity, those excess 
personnel will be assigned to the second activity as required. Since 
the number of personnel assigned to the first unplanned activity has 
now changed since the activity started, IMPRINT Pro either restarts 
or resumes this activity based on the value you set in this field.

• Duration. The amount of time the activity lasts, entered as a mean 
time. You may optionally add a standard deviation and distribution 
type to add variability to your activity duration.

• Repeating Activity. An option indicating the activity repeats. If this 
box is selected, enter the amount of time after which the activity 
should repeat since it last started. You may optionally add a standard 
deviation and distribution type to add variability to your repeat mean 
time.

• Manning. The number of required and desired crew members types 
for this activity. Crew member types include Leader, Sub-Leader 
and Member. These designations are specified in the properties of 
the jobs you add to your Force Unit.
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• Schedule Start Time/Day. The time and day on which the 
unplanned activity is set to occur. If a standard deviation and 
distribution type have been selected for your activity, the time you set 
in the Start Time and Day fields will act as an approximate time.

• Schedule Cancel Time/Day. The cancellation time of an unplanned 
activity. At the start time of the unplanned activity, IMPRINT Pro 
checks to see if the required number of people specified in the 
Manning category can be met. If the required number can be met, 
the activity proceeds. If the required number cannot be met, the start 
of the activity is delayed by 15 minutes, and a status entry appears in 
the Unplanned Activity Status report indicating as such at the 
corresponding clock time. IMPRINT Pro will then continue to check 
every 15 minutes afterwards to see if the required can be met until 
the Cancellation time arrives. If the required number still cannot be 
met by the Cancellation time, the unplanned activity is cancelled, and 
the activity is noted as “failed” in the output reports.

• Stop(End) Time/Day. The time and day on which the unplanned 
activity in progress must stop.

To edit a property where a box exists, simply enter the value in the box.

To edit a property from a list, click the arrow on the right-hand side of 
the property field, and then from the list which appears select the 
desired value.

The following is an example of an unplanned activity entitled 
“Emergency Response”. This activity is not a sleep activity. If the 
personnel available for this activity changes after the start of the activity 
but the minimum required is still available, the response to the activity 
resumes with those personnel still available to address the activity. The 
mean time for this activity is approximately three hours, and it is set to 
471



IMPRINT Pro Basic Procedures
repeat approximately every eight hours until the start of day three. In 
order for this activity to successfully occur, a minimum of one leader, 
two Sub-Leaders and three Members must be available before the 
cancellation time and day (hour 1 on day 1). 

Deleting an Unplanned Activity
To delete a unplanned activity:

1. Right-click the unplanned activity in the Analysis Tree.

2. Select Delete Unplanned Activity from the menu that appears.

A selected activity disappears underneath the Unplanned node.

Activities Trump Matrix
The Activities Trump Matrix displays all activities in a single matrix which is 
useful for determining which activity, planned or unplanned, has priority 
over another activity, essentially “trumping” it. All activities are listed along 
the top-most row and left-most column and are divided into subcategories 
of Planned and Unplanned. At the intersection of the column representing 
your first activity and the row representing your second activity is the name 
of the activity that takes priority when both are set to occur simultaneously.
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Displaying the Activities Trump Matrix
To display the Activities Trump Matrix

Double-click the Activities node in the Analysis Tree.

A matrix showing all activities, both planned and unplanned, displays in 
the main window.

Changing the Trumping Activity
To change the trumping activity:

1. Locate the cell in your matrix which corresponds to the two activities in 
conflict.

2. Click the cell to display a drop-down list containing both activity names.

3. Click the name of the activity to have priority.

The selected activity now displays in the cell.
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In this example, an emergency response or a fire trumps all other 
planned activities. Between these two activities, however, a fire takes 
priority over an emergency response. 

Jobs
A job is an occupation held by one or more members of the Force Unit. 
Examples of jobs include Tank Driver, Gunner, and Navigator. For each job 
in a force unit, you will need to specify the rank and specialty required for 
that job.

You must also define the role (i.e., level of participation) or roles that this 
job will fill should an unplanned activity occur. Roles are Leader, Sub-
Leader and Member. When the Force model runs through its planned 
activities, unplanned activities will also occur; to meet the needs of the 
unplanned activity, Leaders, Sub-Leaders and Members of all job types 
must be interrupted from what they are doing to address this activity. The 
number of warfighters of each job description that you make available for 
each schedule will greatly determine the success in meeting these 
activities.

Once a job is described, for each schedule in the force unit you must 
indicate the number of warfighters of this job type that need to be available 
during each of the schedules defined for this force unit. 
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Displaying Jobs
To display jobs:

Click the +  adjacent to Jobs node.

Jobs appear below the Activities node.

Adding Jobs
To add a job:

1. Right-click the Jobs node.

2. Select Add Job from the menu that appears.

A new job appears underneath the Jobs node.

Displaying and Editing Job Properties
To display Job properties:

Double-click the job under the Jobs node in the Analysis Tree.

The properties of the selected job display in the main Pro window. 
Properties include:
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• Name. The job name. This is a brief description of the overall activity 
the crew member performs in this role, for example: Driver, Gunner 
or Navigator.

• Rank. The rank, or official standing, of the crewmember that may 
perform this job. You may select a rank by clicking the cell to display 
the drop-down list. Options include: E1-E3, E4, E5, E6, E7 and E8-
E9.

• Specialty. The crewmember specialty required for the job. Available 
specialties include the default specialty 00A plus any additional 
specialties added under the Warfighters node of your analysis.

• Role. The level of participation an individual in a job will have in an 
unplanned activity if one occurs. This participation can be one or 
more of the following types: Leader, Sub-Leader and Member. A 
crewmember may be assigned one or more roles in the same job 
profile. When the crew member is factored into the schedule to 
perform a job, however, he or she may be called out to help address 
an unplanned activity that pops up, such as a fire or an emergency. 
This unplanned activity will require a specific number of leaders, sub-
leaders and members in order to be addressed. A crewmember may 
act in only one of those roles at any time. For example, an unplanned 
activity requiring five 19K E-6 crew members could require that at 
least two of those crewmembers be designated Leaders and three 
Members. A crew member who fulfills the requirements of the Leader 
may not simultaneously fulfill the additional requirement of a 
Member.

• Schedule Availability. The number of available operators of this 
job, by schedule.

To edit a property where a box exists, enter the value in the box.

To edit a property from a list, click the arrow on the right-hand side of 
the property field, and then from the list that appears select the value.
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Running the Force Analysis Model

Once you have created your activities, schedule, and jobs for your force 
unit, you are ready to run the force model. 

When you run the Forces model for a particular force unit, all schedules 
corresponding to the unit run in parallel for the number of days you set in 
the Execution window. Any schedule having a duration less than the 
duration of the model run will repeat until the model run ends.

Setting the Force Model Execution Settings
Prior to running your Force model, you may want to check and/or alter the 
execution settings for the model run.

To display Force model execution settings:

1. Confirm a Force unit is selected in the tree.

2. From the Execution menu, select the Settings.

The Execution Settings window appears, containing three tabs. Each 
tab corresponds to a different type of model you can run in 
IMPRINT Pro.

3. Click the Force Model tab.

The following execution settings display:

Force Unit. The force unit selected for the model run. To change 
the force unit click, the drop-down arrow in the field provided, 
and then select the unit from the list.
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Length of Run. The number of days the schedules continue to 
run when you run the model. To change the desired length of 
run, type in the desired length in days in the box.

Random Number Seed. The random number seed used in 
combination with the mean times, standard deviation and 
distribution types for unplanned activities to add variability to 
your activity times. To change the desired random number seed, 
type in the desired seed number in the box.

Executing the Forces Model
To execute a force model:

1. Select the desired force unit in the Force Model Execution Settings 
tab.

2. Set the Length of Run and Random Number Seed as desired.

3. Click the Play button in the tool bar at the top of the IMPRINT Pro 
application window.

The Output window displays simulation run data as the model runs. 
Once the model run completes, a “Simulation Complete” message 
appears at the bottom of the window.
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Viewing Force Analysis Reports

After running the force model for the desired force unit, you can view the 
results of your model run using the Reports option.

Note:
Running and viewing reports following a model run requires that the user 
wishing to run and view those reports has the lock on the analysis containing 
that model. For any model which is unlocked or which is locked by another 
user on your network, reports will not be available after the model run. For 
more information on locking and unlocking analyses, see the IMPRINT Pro 
User Guide Volume 1: Basic Procedures, Appendix D: Local Server and 
Remote Server Setup.

To view force analysis reports:

1. From the Reports menu, select Force Model Results.

A dialog box appears, showing all available reports for your model run.

2. Select the check boxes of the reports you want to view, and then click 
the Ok button.

Microsoft Excel launches, and the reports you selected appear as 
separate sheets in a workbook. Click the tab at the bottom of the 
workbook corresponding to the report you want to view.

Force Report Selection Dialog
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Activity Detail Report
The Activity Detail report provides data on each instance of an activity. 
Instances may be entire activity cycles (start through end) or any portion of 
the activity cycle in which case an activity occurs (resume through 
suspend, resume through end). You may choose to display activity details 
for planned activities, unplanned activities or both.

Job. The job leader, sub-leader and/or member participating in 
the ongoing planned activity. Each individual belonging to a 
particular job is tagged for trackability. For example, if three 
Drivers having identical properties are made available for 
Schedule 1, and all three drivers are used in the planned activity, 
then the three individual operators would be tagged as Driver[1], 
Driver[2] and Driver[3]. 

Schedule. The schedule to which the job belongs.

Activity. The ongoing activity.

Start Day. The day in the model run that the activity started.

Sample Force Report
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Start Time. The time on the Start Day that the activity started.

End Day. The day in the model run that the activity ended.

End TIme. The time on the End Day that the activity ended.

Duration. The time elapsed between the activity Start Day/Time 
and the activity End Day/Time.

Total Time by Job Report
The Activity Time Total by Job by Schedule report tells you how much time 
each job spends on each activity, by schedule, both cumulatively and on 
average. For example, you can find out how much time all Drivers in 
Schedule 1 spent on the activity “Personal Time,” as a group and as 
individuals, over the course of the model run.

This report includes the following data:

Activity Detail Report
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Job. The job leader, sub-leader and/or member participating in 
the ongoing planned activity. Each individual belonging to a 
particular job is tagged for trackability. For example, if three 
Drivers having identical properties are made available for 
Schedule 1, and all three drivers are used in the planned activity, 
then the three individual operators would be tagged as Driver[1], 
Driver[2] and Driver[3]. 

Schedule Name. The schedule to which the job belongs.

Activity. The activity being performed.

# of Jobs. The number of people who participated in the activity 
over the course of the model run.

Min Activity Time (Hours). The minimum amount of time that 
any job performer of the designated job type spent on the listed 
activity.

Max Activity Time (Hours). The maximum amount of time that 
any job performer of the designated job type spent on the listed 
activity.

Total Activity Time. The cumulative amount of time spent on 
the listed activity by all personnel of the same job type and 
schedule, over the course of the entire model run. 

If an activity is added to a schedule multiple times or if it repeats 
during the course of the model run, the Total Activity Time 
reflects the cumulative amount of time all instances of this 
activity lasted. This total does not include any time elapsed 
when the activity is suspended.

Average Activity Time. The average amount of time a single 
participant of a particular job type and schedule spent on the 
listed activity. This amount is calculated as the Total Activity 
Time divided by the # of Jobs.
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The same information displays in the form of a bar chart called the Time 
Total by Job Chart.

Total Time By Job Report
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Total Time by Schedule Report
The Activity Time Total by Schedule report is an easy way to see how 
different schedules portion out time for the same activity, regardless of job 
type. For example, the activity “sleep” might take an average of 8 hours in a 
24-hour schedule while it takes an average of 6 hours in a different 24-hour 
schedule. 

Schedule Name. The schedule to which the job belongs.

Activity. The activity being performed.

# of Jobs. The number of people, from all jobs, who participated 
in the activity over the course of the model run.

Min Activity Time (Hours). The minimum amount of time that 
any job performer spent on the listed activity.

Total Time by Job Chart
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Max Activity Time (Hours). The maximum amount of time that 
any job performer spent on the listed activity.

Total Activity Time (Hours). The total amount of time spent on 
a particular activity by all personnel within the same schedule 
over the course of the entire model run. If an activity is added to 
a schedule multiple times or if it repeats during the course of the 
model run, the Total Activity Time reflects the cumulative amount 
of time all instances of this activity lasted. This total does not 
include any time elapsed when the activity is suspended.

Average Activity Time (Hours). The average amount of time an 
individual job performer on the designated schedule spends on 
the listed activity. This amount is equivalent to the Total Time 
divided by the number of people assigned to this schedule.
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Time Total by Individual Job
The Time Total by Individual Job report tells you how much total time was 
spent on a given activity by an individual job participant from a specific 
schedule, over the entire course of the model run. For example, you can 
find out how much cumulative time Gunner #2 (Gunner[2]) from Schedule 4 
spent on the activity “Training” over the entire course of the model run. If 
the job performer performs the activity multiple times or if the activity 
repeats during the course of the model run, all instances of the activity are 
reflected in this total. This total does not include any time elapsed when the 
activity is suspended.

This report includes the following data:

Job. The job leader, sub-leader and/or member participating in 
the ongoing planned activity. Each individual belonging to a 
particular job is tagged for trackability. For example, if three 
Drivers having identical properties are made available for 
Schedule 1 and all three drivers are used in the planned activity, 
then the three individual operators would be tagged as Driver[1], 
Driver[2] and Driver[3]. 

Schedule. The schedule to which the job belongs.

Activity. The ongoing activity.

Time Total by Schedule Report
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Total Time. The total amount of time a single job participant 
spent on the listed activity.

Unplanned Activity Status Report
The Unplanned Activities Status report displays the ongoing status of any 
unplanned activities which are either in progress or are delayed due to 
insufficient Job Leaders, Sub-Leaders or Members available to address the 
activity.

When an unplanned activity’s required minimum personnel cannot be met, 
the model will check every 15 minutes during the run for the availability of 
required personnel to meet the unplanned activity. If the required personnel 
are available, the activity resumes. If the required personnel are 
unavailable, the status reports as “Delayed”. If the Stop Time or the 
Cancellation Time of the unplanned activity arrives before the activity can 
be addressed, the activity status reports as “Failed”. Any activity which is 
trumped by a higher-priority activity will initially report as “Interrupted” and 
then “Delayed” until the required minimum can be met or until the activity’s 
Stop Time or Cancellation Time arrives.

Activity. The ongoing unplanned activity.

Total Time by Individual Job Report
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Start Day. The day in the model run that the activity started.

Clock (Hours). The clock time at which a change in an activity 
status occurs and is being reported.

Status. The current state of the activity at the reported clock 
time. Possible status reports include the following:

Scheduled. The time at which the unplanned activity is 
scheduled to occur and when the first check is made to see if 
the minimum personnel required for the activity (leaders, 
subleaders and members) can be met. If the minimum required 
personnel can be met, the activity starts, and the status to follow 
is “Started”.

Started. The required personnel for the activity can be met, and 
the activity begins at the listed clock time.

Interrupted. The activity is trumped by a higher-priority activity. 
The status following an interrupted activity is “Delayed”.

Delayed. The ongoing activity is temporarily suspended due to 
the unavailability of required personnel. Following the delay, the 
model will continue to check every 15 minutes for the required 
personnel until either the minimum personnel are met and the 
activity starts or until the Cancellation Time is reached at which 
point the activity is terminated.

Successful. The ongoing activity completes at the listed clock 
time.

Failed. The activity’s cancellation time arrives before the 
manning requirements can be met, and the activity is 
terminated.

Roles Not Met. The roles required by the unplanned activity 
which could not be met display in this column. The roles listed 
are “leader,” “subleaders” and/or “members”; quantities unmet, 
however, are not listed.
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Specialty Utilization Report - Forces Model
For users who regularly use the Army Military-Civilian Cost System 
(AMCOS) to estimate the cost of using a fixed number of military personnel 
for a specific number of years, the Specialty Utilitization Report is designed 
to provide you information about the utilization of all the specialties in your 
model run which may then be used as a basis for the data you enter into 
AMCOS.

In general, AMCOS requires that you enter specialty, the number of people 
of each specialty, and all years of service to be included in your cost 
estimate so that it can give you an estimation on how much it costs to 
support these specialties for those years. After having run an IMPRINT Pro 
model, you may use the Specialty Utilization Report to gain a better 
understanding on the types and quantities of personnel you need based on 
your model run results. 

Unplanned Activity Status
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Before entering data into AMCOS based on this report, the idea of 
“utilization” according to IMPRINT Pro must be understood. In the Forces 
model, utilization is considered to be the total time a job, for example 
“Driver” (all leaders, subleaders and members of this job type, combined) 
spends on unplanned activities and is not the amount of time an job is 
simply scheduled for regular planned activities. In the case where an 
unplanned activity is trumped by another unplanned activity, resulting in the 
first activity’s suspension, the initial time spent on the first unplanned 
activity is still counted towards the utilization time total; the amount of time 
of the suspension, however, is not unless the trumping activity is also an 
unplanned activity. In this case, only those job performers who left the first 
activity to participate in the trumping activity will have their time counted; 
any leftover leaders, subleaders and members from the first activity who 
are not utilized for the second will not be counted in the second. In short, 
the utilization is a sum of all time the job spent performing any unplanned 
activity within the force unit. More detailed information about the individual 
tasks performed by an individual job can be found in the Unplanned Activity 
Detail report, the report on which the Specialty Utilization Report is based.

It is also important to note that the utilization reported by the Specialty 
Utilization Report is for the total duration of the model; if the total clock time 
of your model run is any less than one year, the utilization hours reported 
will not correlate directly with the expected values AMCOS requires, which 
are specifically the full years that you need a specialty. You must project 
out from the utilization summary the number of people of a certain specialty 
you need and the number of years your specialty must be available; this 
interpolation of the data may require more expertise beyond what the 
Specialty Utilization Projection Report can provide. The quantities of each 
specialty and the years for which they are required could vary depending 
on how many people of each specialty your mission requires and how 
many similar missions you intend to execute within the course of a year.

AMCOS requires users to enter data in four steps: Properties, Faces and 
Spaces, Cost Summaries and Output. The part of AMCOS to which your 
IMPRINT model run results apply is the Faces and Spaces step where 
you add information about the personnel required. 

 This part of AMCOS is depicted in the image below:
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The Faces and Spaces page contains the following fields:

PayPlan

Group

Subgroup 

Area 

Locality 

Grade

Inventory

The only fields where IMPRINT report data applies are in the Group, 
Subgroup, Grade and Inventory fields.

Applying IMPRINT Pro report data to AMCOS
To apply IMPRINT Pro report data to AMCOS:

1. Select the desired group from the drop-down list.
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Note:
In IMPRINT Pro, all specialties from which you may select your 
Warfighters are grouped together in one list. In AMCOS, however, 
specialties are categorized into different groups. The first two 
characters in a specialty code defines the group to which that specialty 
belongs. 

The selected group appears in the Group field, and the SubGroup 
drop-down list is enabled.

2. From the SubGroup drop-down menu, select the desired subgroup 
(specialty).

[

492



Chapter 8: Force Analysis
The selected subgroup appears in the SubGroup field.

3. From the Grade drop-down menu, select the pay grade which applies 
to the selected Group-SubGroup combination. It should be noted that in 
the IMPRINT Pro Forces model, the grade, also referred to as the “E-
level” or “rank”, is attached to any job you create through the Rank field 
in the Job properties window.
493



IMPRINT Pro Basic Procedures
The selected grade appears in the Grade field.

4. The Inventory section displays a box for each year you are choosing to 
project costs. In each box provided, enter the number of personnel for 
which costs are to be projected.
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5. Click the Insert button in the lower-left corner of the screen.

The specialty data you entered is added to the list at the top of your 
AMCOS screen. You may repeat these steps for all specialties to be 
included in your cost projection. Once you have finished entering 
specialty information, you are finished with the portion of AMCOS which 
requires data from IMPRINT. Proceed with the remaining steps in 
AMCOS as normal.
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IMPRINT Pro contains a powerful plugin interface that allows developers to 
extend the runtime functionality of the simulator. This API provides 
extensibility and flexibility that far exceed the External Model Call 
functionality of IMPRINT 7, yet is much easier to create, debug and use.

Using Plugins

In IMPRINT Pro, using plugins in a model is simply a matter of calling a 
method defined on a plugin object, passing to it those values desired, and 
using the result (if any). This can be done from any code window in the 
program: Effects, Release Conditions, or Expressions.

The syntax for using a plugin method in a code window is:

ExternalVariables.<PluginName>.<PluginMethodName>
<parameters>)

If the plugin method returns a value, it can be assigned to any local or 
global Imprint Variable, just as with any method: 

int cubeValue = ExternalVariables.ExtraMath.Cube(3);
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Any public method defined in the plugin class will be available to all 
analyses in IMPRINT Pro. Any use of a plugin method will be checked for 
type compatibility by the Syntax Checker, so that modelers will know 
immediately if there are problems with their code.

Creating Plugins
IMPRINT Plugins are code libraries (.dll files) that are loaded when 
IMPRINT Pro is launched. In order to be recognized by the Plugin Loader, 
all of the following must be true:

The .dll file must be created in the Microsoft .NET framework.

The assembly must have an IMPRINTPluginAttribute defined.

The plugin class in the assembly must implement two interfaces 
in code: IExternalVariableProvider and IImprintPlugin.

• Any class that will be added by the plugin must have a default 
constructor.

• The .dll file must be in the IMPRINT Pro directory.

Creating an IMPRINT Pro Plug-In
To create an IMPRINT Pro Plug-in:

1. Start Visual Studio, and click New and then Project from the File menu.

2. On the New Project page, select Class Library from the Templates 
panel.

3. Name your project, and then click OK.
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The Visual Studio Environment displays.
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Setting Up the Project
To set up the project:

1. Delete the file Class1.cs from the Solution Explorer tree.

2. Select the project node in the tree, right-click and then click Add > 
Existing Item.
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3. Select the two source-files Plugin.cs and SampleClass.cs (included 
with IMPRINT Pro):
• Plugin.cs. This file allows IMPRINT Pro to recognize the files you 

have created in Visual Studio as plugins.
• SampleClass.cs. This file is a sample class template for creating 

IMPRINT Pro plugins.

4. Click OK

5. Right-click the References node, and select Add Reference.

6. Select the Browse tab, and navigate to the IMPRINT Pro directory.

7. Select the file MAAD.Plugins.ImprintPluginLoader.dll, and click OK.
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Writing the Code for Plugins
To write the code:

1. Rename SampleClass.cs and the SampleClass class as desired.
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Double-click the class in the tree to open up its page. Rename in the 
Public Class line as well.

2. Write any desired functionality into the class; anything declared public 
will be accessible from IMPRINT Pro.

3. Open the Plugin.cs file.
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4. In the IIMPRINTPlugin section of Plugin.cs, change the return values 
of the plugin's properties as desired.

Note:
The Name, Author, Date and Description fields must all have properties in 
order for the plugin to work in IMPRINT Pro. You may enter null values if 
desired.
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5. In the IExternalVariableProvider section, replace the name 
'SampleClass' in the typeof() expression to the new name of the class.

Use the following option for allowing the visible plugin to display as the 
name of its class:

// Fill the list with a VariableName object for each class that you 
want to expose to Imprint.

result.Add(new VariableName(typeof(SampleClass)));

Use the following option for allowing the visible plugin to display as the 
name in quotes prior to the “typeof” designation:

// Alternatively, this line would add a “OldEMC” instance, but name it 
“EMC”

result.Add(new VariableName(“EMC”, typeof(OldEMC)));

In the second example above, the plugin will appear in the Plugins list 
as “EMC.”
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6. Further down in the  IExternalVariableProvider section, set the 
assembly references and the namespace aliases.  Together, these 
methods enable multiple .dll files to be called from within the same 
plugin.

Assembly Reference.  Used to tell IMPRINT Pro the name of 
any other .dll files where it must look.  Any .dll that is referenced 
here must exist in the IMPRINT Pro base directory.

Namespace Alias.  Used to  set the names of the namespaces 
in which it should look if multiple namespaces exist.

Both the Assembly References and the Namespace Aliases accept a 
string input, and in turn output an array of strings.  

In the example below Secondlibrary.dll is added as an assembly 
reference while SecondLibrary is added as a namespace.

These methods must be defined in the Plugin class even if the plugin 
will not use any external references or namespaces.  In that case, they 
should return empty string arrays. 

Note:
Although this sample is written in C#, it is possible to write plugin code in any 
.NET language so long as it conforms to the restrictions above. 
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Building the Plugin
To build the plugin:

1. Right-click on the project node and select Build.

2. On the Build tab, set the Output path to the IMPRINT Pro directory.

3. Build the project.

4. Once your plugin is built, copy it into the IMPRINT Pro root directory. 
The next time you start up IMPRINT Pro, the plugin name will appear in 
the Output window in the list of loaded plugins.

Note:
For reasons of reference integrity and compatibility, user-created .dlls should 
reside in the IMPRINT Pro directory. It is important to pay careful attention if 
adding or deleting .dlls in this directory so as to avoid compromising existing 
IMPRINT Pro application files

Displaying Plugins
Plugin .dll files you add to the IMPRINT Pro directory show up in the 
following two places in the IMPRINT Pro application window:

1. Output window. When you start up an IMPRINT Pro session, all 
plugins used by IMPRINT Pro display in text in the Output window. Any 
user-defined plugins appear in the second group of plugins listed.
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2. Analysis Tree. The same user-defined plugins also appear under the 
Installed Plugins node in the tree.

To View a List of Plugins in the Tree:

Click the plus “+” sign next to the Installed Plugins node in the tree.

Any plugins added to the IMPRINT Pro directory appear as a list in the 
tree.

Viewing the Parts of a Plugin in the Tree
The IMPRINT Pro Analysis Tree displays the various levels of information 
comprising your plugin. 

Plugin Class
The first level below the plugin node is the Class level.
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To view the class level:

Click the plus “+” sign next to your plugin. 

The Class level displays. All classes for the plugin display as a list and 
are accompanied by a red icon on the left.

In the example above, the plugin Sample Math contains a class called 
“ExtraMath”.

Plugin Methods and Plugin Properties
The second level of a plugin, just below the Class level, includes Methods 
and Properties of the plugin.

To view Methods and Properties:

Click the plus “+” sign next to the class in the tree.

The Methods and Properties of the plugin display.

Methods. Methods appear in the tree with a purple icon. The 
name of the method is followed by a set of parameters enclosed 
in parentheses. These parameters are the types of values you 
would expect to provide the as input to the plugin when called.
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In the example above, the first method Cube expects a floating 
point, or Double, to be passed to it when the method is called 
whereas the second method Cube expects an integer. The third 
Cube method expects a string value which it will refer to as “s” 
within the plugin code itself.

Properties. Properties appear in the tree with a green icon. The 
name of the property is followed by a set of parameters enclosed 
in parentheses. Depending on how the plugin is written, the 
parameters within the parentheses might indicate values which 
can be passed to a function (parentheses “( )”) or a value which 
you can expect to get but with no option to initially pass values to 
it first (square brackets “[ ]”).

In the example above, the property Pi returns a specific Double 
value when the plugin is called. No parameters can be passed 
to this property.

Adding Hover Text to a Plugin
Hover text, also known as a “tooltip”, displays when hovering the mouse 
over a listed plugin in the tree. This text will only appear if it has been 
added by the plugin developer as an attribute of the plugin. If this attribute 
is attached to a Plugin Class, the text of the attribute will be displayed when 
you hover over that class's tree node. If this attribute is attached to a 
Method or Property within the class, the text will be displayed when the you 
hover over the tree node corresponding to that Method or Property.

The following text is an example of code which can be added to a plugin to 
create hover text:

using System;
using System.Collections.Generic;
using System.Text;
using System.ComponentModel;
using MAAD.Plugins.ImprintPluginLoader;
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namespace MAAD.Plugins.ExtraMath
{

[ToolTipText("This is the ExtraMath class of the Sample 
Plugin")]

public class ExtraMath
{

[ToolTipText("The value of pi")]
public double Pi
{

get { return Math.PI; }
}

[ToolTipText("Returns the Cube of the given floating-
point number")]

public double Cube(double number)
{

return number * number * number;
}

[ToolTipText("Returns the Cube of the given integer")]
public int Cube(int number)
{

return number * number * number;
}

[ToolTipText("Nothing to see here...")]
public string Cube(string s)
{

string three = string.Join(" ", new string[] { 
s, s, s });

string nine = string.Join(Environment.NewLine, 
new string[] { three, three, three });

return nine;
}

}
}
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Appendix A: Technical Description of 
Stressor Implementation

Evaluation of Human Performance under Diverse Conditions via Modeling 
Technology

Dr. Laurel Allender, Ms. Lucia Salvi, Dr. David Promisel

U.S. Army Research Laboratory Human Research and Engineering 
Directorate

Aberdeen Proving Ground, Maryland, U.S.A

Streamlined system acquisition and resource constraints are realities of 
military test and evaluation today. However, the pressure of saving time 
and dollars cannot be permitted to eliminate the assessment of total 
system performance - that is, the soldier, the hardware, and the software. 
Assessing combined soldier-system performance is as critical as ever. To 
address the challenges of the future battlefield requirements documents 
being written for military systems today regularly require operation in cold 
and hot conditions; in nuclear, biological, and chemical (NBC) 
environments; and over extended time periods. More and more functions 
are required to be automated, which does not necessarily make the job 
easier but, more likely, changes the nature of the job, the crew size, the 
task allocation, and the skills and abilities needed to do the job. These 
kinds of system requirements generate soldier-system dynamics that will 
affect overall system performance and must be evaluated throughout the 
system acquisition, design, and ultimately, the test and evaluation process.

In addition to the time and cost-effectiveness considerations that are 
givens for test and evaluation, regulations governing human use and test 
participant safety must also be considered. It is simply not permitted to test 
systems under all of the actual conditions in which they are required to 
operate. Certain hazardous conditions, for example, NBC operations, must 
be approximated. It is being proposed here that modeling not only provides 
a reasonable alternative for the approximation of performance under 
diverse--even extreme--conditions, but it also can be accomplished within 
the time and cost constraints. Existing data can be used to extrapolate to 
other conditions. Once a baseline model is built, excursions are typically 
straightforward. Modeling can be used iteratively to evaluate different 
conditions or to conduct sensitivity analyses and comparisons. 
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Over and above the ways in which modeling technology helps to address 
the time, cost, and safety concerns of test and evaluation, it offers a logical 
and sound approach to estimating human performance. It is a task-analytic 
approach that lends itself to good documentation and the building of audit 
trails. It can be used to help quantify what are, all too often, largely 
subjective assessments. It can also compensate for, or be used to extend 
operational field data that come with certain innate limits such as 
uncontrollable extraneous variables, small sample size, and non-
repeatability. Modeling too, has its limitations; however, in combination with 
more traditional test and evaluation methods, for example, in a model-test-
model mode, it can provide valuable estimates of human performance 
under a wide variety of conditions.

The IMPRINT Tool

The U.S. Army Research Laboratory Human Research and Engineering 
Directorate has developed a modeling and analysis tool, the Improved 
Performance Research Integration Tool (IMPRINT). The IMPRINT tool 
grew out of common U.S. Air Force, Navy, and Army manpower, 
personnel, and training (MPT) concerns identified in the mid-1970's: How 
to estimate MPT constraints and requirements early in system acquisition 
and how to enter those considerations into the design and decision-making 
process. The U.S. Navy first developed the HARDMAN (Hardware vs. 
Manpower) Comparability Methodology (HCM). The Army then tailored the 
manual HCM, which became known as HARDMAN I, for application to a 
broad range of weapon systems and later developed an automated 
version, HARDMAN II. In HARDMAN I and II, however, there was no direct 
link between MPT and performance. To directly remedy this shortcoming, 
the U.S. Army began the development of a set of software analysis 
modules in the mid-80’s (Kaplan, 1988). This set of modules was called 
HARDMAN III, and although the name was the same, it used a 
fundamentally different approach for addressing MPT concerns than 
previous methods. It provided an explicit link between MPT variables and 
soldier-system performance. IMPRINT, while being an improvement over 
HARDMAN III, for the purpose of the discussion here, is essentially 
HARDMAN III in the WindowsTM environment. 

The mechanism for the MPT-performance link is task network modeling 
provided by the commercially- available Micro Saint task network 
simulation modeling engine, PC software designed for describing and 
analyzing task networks. The modeling capability offered can be further 
characterized based on three distinctions (Law & Kelton, 1991): (1) static 
vs. dynamic, (2) deterministic vs. stochastic, and (3) continuous vs. 
discrete. A static model does not address system effects over time, 
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whereas a dynamic model represents a system as it changes with time. A 
deterministic model does not represent any probabilistic, or random, 
elements. A stochastic model does encompass random elements and 
produces output that contains random error. A discrete model refers to 
instances where the variables characterizing the system change 
instantaneously at separated points in time. A continuous model is the 
converse, with variables that change continuously with time. In some 
instances, systems can be treated as either discrete or continuous, 
depending on the objectives of the analysis. 

Using these definitions then, IMPRINT can be described as a dynamic, 
stochastic, discrete event modeling tool. When certain assumptions hold, 
namely, that the system of interest can be adequately described by task 
activities and networked sequencing, that dynamic processes and random 
variability are of interest, and that any continuous tasks can be fairly 
transformed into discrete tasks, then IMPRINT is an appropriate tool to use 
to represent and analyze soldier-system performance. 

The basic modeling capability in IMPRINT requires the decomposition of a 
system mission into functions which, in turn, are decomposed into tasks. 
The functions are linked together into a network describing the flow of 
events. The network can include various types of branching logic such as 
parallel branches, probabilistic branches, and repeating branches. Within 
each function, the tasks are sequenced using the same types of branching 
logic options. At the task level, estimates of task performance time and 
accuracy means and standard deviations are input along with the 
consequences of the failure to perform a task accurately enough. The 
failure consequence options are no effect, total mission abort, repetition of 
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that or some other task, or subsequent degradation of some other task. 
The data entered are assumed to be representative of performance under 
“typical” or baseline conditions. Also, standards of performance can be 
entered to provide benchmarks for performance adequacy at the mission, 
function, and task levels. A sample IMPRINT screen depicting both the 
function and task level networks is shown in Figure 1.

IMPRINT executes a mission model task-by-task by first drawing a task 
time from the distribution as defined by the mean and standard deviation 
input for each task. (IMPRINT Pro assumes a default normal distribution 
although other distribution options are available). Then it calculates the 
probability of success for the task based on the accuracy inputs. Next it 
determines, for this instance, whether there is an accuracy failure. After 
checking for a given task, IMPRINT Pro proceeds through the task and 
function networks in accord with the established branching logic and 
analyzes the output according to the standards. When the model execution 
is completed (which can be anywhere from 1 to 999 repetitions), reports of 
estimated performance at each of the three levels are generated along with 
the comparisons to the standards. Although any given model and its 
associated assumptions must be scrutinized, this approach is particularly 
useful for comparisons across systems or system conditions.

Sample IMPRINT Function and Task Network Windows
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Environmental Stressors in IMPRINT 

Along with the basic task network simulation modeling capability, the 
IMPRINT tool includes specific algorithms or look-up tables--environmental 
stressors--to assess performance under diverse conditions. Recall that the 
task performance data entered in the baseline model are assumed to 
represent performance under “typical” conditions. The embedded 
environmental stressors automatically adjust performance to account for 
the changes expected under different levels of the stressors. Currently, 
IMPRINT includes five environmental stressors: protective clothing (that is, 
Mission-Oriented Protective Posture or MOPP), heat, cold, noise, and 
hours since last sleep (see Figure 2). The application of a stressor will 
result in either less accurate task performance, longer times to complete 
the task, or both. Stressors may be applied to an individual task or to all the 
tasks assigned to a particular job or Military Occupational Specialty 
(Specialty) for the mission. When the model is re-run, the new, or 
“stressed,” task performance time and/or accuracy are used as the task 
estimates that are “rolled up” in the task, function, and mission reports and 
compared against the standards. Importantly, the results can also be 
compared with the baseline model predictions. (See Dynamics Research 
Corporation, & Micro Analysis & Design, 1993) for more complete 
documentation.)

IMPRINT Window Showing the Environmental Stressor Options
517



IMPRINT Pro Basic Procedures
As a side note, IMPRINT also models the effects of two task performance 
shaping functions, based upon personnel characteristics and training 
frequency and recency. The personnel characteristics function uses both 
standardized Specialty entrance scores and the general Armed Forces 
Qualification Test (AFQT) scores. Different from the stressors, which only 
degrade performance, applying the performance shaping functions can 
result in either better or worse performance, depending on the level 
selected. For example, increasing the frequency of training results in 
improved performance, whereas decreasing the frequency lowers 
performance. IMPRINT also models the mental workload associated with 
task performance. Workload profiles can be developed for crew members, 
or, in the advanced mode, the interaction of workload and performance can 
be evaluated to include workload coping strategies and task-workload 
conflicts. Although these functions provide important analytic capabilities, 
the focus of the paper from this point is solely on the environmental 
stressors.

Before discussing each stressor in turn, it is important to note that not all 
tasks are affected in the same way or by the same stressor. To 
accommodate this, IMPRINT uses a task category weighting scheme. Nine 
categories or taxons used to describe a task (see Table 10-1) (Fleishman 
& Quaintance, 1984). Category weights are assigned to each task so that 
the various stressor effects are likewise weighted. In this way, each task 
contributes only the appropriate amount of change to the “stressed” 
performance at the mission level. Every task can be categorized with as 
many as three taxons. For example, operating a tractor and semi-trailer 
may involve driving a vehicle that is classified as “fine motor continuous” 
and may involve giving or receiving instructions, which is classified as 
“communication (oral).” Additionally, weights, which must sum to 1.0, are 
used to describe the degree to which a particular task manifests a 
particular taxon. In the example cited, operating a tractor and semi-trailer 
task might be composed of .75 fine motor continuous and .25 
communication (oral). Modification of the taxon weights also allows for the 
consideration of new technology. For example, an automatic reloading 
device could change a heavy lifting or gross motor heavy task to a fine 
motor discrete task where only the manipulation of controls is required. 
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Table A-1: IMPRINT Taxons, Descriptions, and Task Examples

Taxons Definitions Examples

Visual Requires using the 
eyes to identify or 
separate targets or 
objects

Seeing something move 
and then recognizing it as 
an enemy tank

Numerical Requires performing 
arithmetical or 
mathematical 
calculations

Measuring an azimuth on a 
map with a protractor 

Estimating the distance 
between two points on a 
map

Cognitive 
(Problem 
Solving and 
Decision 
Making)

Requires processing 
information mentally 
and reaching a 
conclusion

Locating a fault in an 
electrical system after 
troubleshooting 

Selecting the best firing 
position for a machine gun

Fine Motor 
Discrete

Requires performing a 
set of distinct actions in 
a predetermined 
sequence mainly 
involving movement of 
the hands, arms, or 
feet with little physical 
effort

Assembly and 
disassembly of the M-16 
rifle 

Starting the engine of a 
truck

Fine Motor 
Continuous

Requires uninterrupted 
performance of an 
action needed to keep 
a system on a desired 
path or in a specific 
location

Driving a vehicle 

Tracking a moving target

Gross Motor 
Heavy

Requires expending 
extensive physical 
effort or exertion to 
perform an action

Lifting an artillery round 

Loosening a very tight bolt 
with a wrench
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Table 10-2 details which task taxons are affected by which stressors in the 
current IMPRINT software. It also shows whether the task performance is 
degraded by time, accuracy, or both. Since degradation factors are 
processed as multipliers, the degradation factors affecting time will be 
greater than 1.0 to increase the performance time. On the other hand, the 
degradation factors affecting accuracy will be less than 1.0 to decrease the 
performance accuracy from the pre-existing accuracy level. The overall 
degradation resulting from a specified stressor is directly proportional to the 
weighting assigned to the affected taxon(s) comprising the task. 

Gross Motor 
Light

Requires moving the 
entire body (that is, not 
just the hands) to 
perform an action 
without expending 
extensive physical 
effort

Getting into a prone firing 
position 

Evacuating a tank

Communication 
(Read and 
Write)

Requires either 
reading text or 
numbers that are 
written somewhere or 
writing text or numbers 
that can be read

Reading a preventive 
maintenance check list for 
a vehicle 

Writing a letter home

Communication 
(Oral)

Requires either talking 
or listening to another 
person

Giving a situation report by 
radio 

Receiving a password from 
someone while on guard 
duty

Table A-1: IMPRINT Taxons, Descriptions, and Task Examples (Cont.)

Taxons Definitions Examples
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where T = Affects task time only

A = Affects task accuracy only

TA= Affects task time and accuracy

Effect of MOPP
The effect of MOPP gear on task performance is modeled as a function of 
levels of MOPP gear and task taxon. As shown in Table 10-2, MOPP 
affects the time that it takes to complete tasks described by the visual, fine 
motor discrete, gross motor light, and communication (oral) taxons. The 
degradation factors were derived from a series of studies conducted by the 
former Ballistic Research Laboratory (Wick, 1988) where the measure of 
performance degradation for each task was the time difference between 
performing the task in Battle Dress Uniform (BDU) and performing it in 
MOPP 4. Each task was later described in terms of ten human ability 
codes. These codes were mapped to the IMPRINT taxons and the 
degradation factor for each taxon was computed as the average of the 
mapped degradation factors by human ability code. MOPP level 0 is 

Table A-2: Listing of the IMPRINT Environmental Stressors and the Taxon 
Types Affected by Either Time or Accuracy or Both 

Taxon MOPP Heat Cold Noise Sleepless 
Hours

Visual T A T

Numerical A TA

Cognitive A TA

Fine Motor 
Discrete

T A T

Fine Motor 
Continuous

Gross Motor Light T T

Gross Motor 
Heavy

Communication 
(Read & Write)

A

Communication 
(Oral)

T A A
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equivalent to BDU and therefore has a degradation factor of 1 that 
correlates to “no degradation.” Degradation factors are applied as 
multipliers against the time that it takes to complete a task in BDUs. The 
most degraded performance is under MOPP 4 for fine motor discrete tasks 
and for oral communication tasks that take 1.7 times as long to perform. 
(The entire set of matrices of degradation factors for the stressors is not 
provided here but is available from the author on request.) 

Effect of Heat
IMPRINT models the effects of heat on task performance accuracy as a 
function of dry bulb temperature and relative humidity using degradation 
factors based on various published reports and documents. Research 
relating heat stress to inaccurate performance (for example, Ramsey & 
Morrissey, 1978) was referenced. The MIL-HDBK-759-A (1981) was used 
to determine the effective temperature for different combinations of dry 
bulb temperature and relative humidity. And, data on the average number 
of mistakes per manhour as a function of effective temperature from the 
Bioastronautics Data Book (1981) were included in the derivation of the 
heat degradation factors. The derived factors applied solely to sedentary 
type tasks. Thus, the taxons affected are visual, numerical, cognitive, fine 
motor discrete, communication (read and write), and communication (oral). 
No degradation in accuracy performance is seen until the temperature 
reaches approximately 113o F (or 45o C) and the humidity reaches 
approximately 50%. Performance falls to essentially zero when the 
temperature reaches approximately 130o F (or 55o C) and the humidity 
reaches approximately 80%. 

Effect of Cold
Cold weather degradation factors affecting task time performance are 
modeled in IMPRINT as a function of ambient temperature and wind 
velocity. Two functional relationships were developed from a study 
(Teichner, 1958) that related wind chill to percentage of performance loss. 
One relationship was developed for visual reaction time, thus providing the 
data for the visual and fine motor discrete taxons; the other was developed 
for manual skills, providing the data for the gross motor light taxon. The 
degradation factors for cold are computed as the percent loss of 
performance as a function of wind chill, wind chill being a function of wind 
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velocity and ambient temperature. Time effects range from a minimum of 
1.03 times as long for temperatures of approximately 35o F (or 1o C) and a 
wind velocity of approximately 10 knots to a maximum of 1.70 times as 
long for temperatures of approximately -40o F (or -40o C) and a wind 
velocity of greater than 50 knots. Note that this degradation does not 
account for prolonged exposure to cold and wind.

Effect of Noise 
The way in which IMPRINT models the effect of noise on task performance 
is based on the effectiveness of voice communications as a function of 
noise level and distance between the speaker and the listener. As shown in 
the Table 10-2, the degradation that results from various noise levels 
affects the accuracy with which a task that requires oral communications 
between two or more people is performed. The effect of noise on task 
accuracy and the resultant degradation factors were derived from a graph 
in MIL-STD-1472C. Distances modeled range from 1 to greater than 20 
feet and noise levels range from 50 to greater than 110 dB PSIL. 
Approximately midway through the ranges modeled, accuracy of 
performance essentially drops to zero, as might be expected.

Effect of Sleepless Hours
In IMPRINT, sleepless hours refers to extended operations or the lack of 
sleep. It is important to note that sleep deprivation is the only 
environmental stressor that causes degradation in both the time to perform 
a task and the accuracy with which it is performed. IMPRINT models the 
stress of continuous operations as a function of hours since last sleep. 
Ranges of hours since last sleep go from 24 hours to greater than 96. At 
the 96-hour range, time to perform tasks is essentially doubled and 
accuracy has dropped to zero. The factors included in IMPRINT were 
derived from a review of several studies (Belenky et al., 1987), which found 
that the only taxons that are affected by lack of sleep are numerical and 
cognitive. Of note, in contrast to cognitive performance, physical strength 
and endurance are relatively unaffected by lack of sleep and can be 
restored by simple rest.
523



IMPRINT Pro Basic Procedures
Multiple Taxons with Multiple Stressors

Many combinations of multiple stressors and taxons are also implemented 
in IMPRINT. Table 10-3 shows the possible combinations of stressors and 
the associated taxons. When two or more different stressors affect a task’s 
taxon in time or accuracy, the overall degradation is not just the sum of the 
individual degradations. In fact, the overall degradation is less than the 
sum of the individual degradations. As more stressors are added, they 
have less than the full effect on performance. Normally, the most severe 
stressor will have a full effect on performance. As additional stressors are 
added, they will have less and less impact on performance accuracy and 
time. This phenomenon is approximated with a power function (Harris 
1985).

Table A-3: Possible Combinations of Stressors and Taxons Implemented in 
IMPRINT

Stressors Taxons

MOPP & Heat Visual

Fine Motor Discrete

Communication (oral)

MOPP & Cold Visual

Fine Motor Discrete

Gross Motor Light

MOPP & Noise Communication (oral)

Heat & Noise Communication (oral)

Heat & Sleepless 
Hours

Numerical

Problem Solving

MOPP & Heat & 
Cold

Visual

Fine Motor Discrete

MOPP & Heat & 
Noise

Communication (oral)
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IMPRINT Verification, Validation, and Accreditation 
(VV&A)

HARDMAN III, the IMPRINT predecessor was subjected to a formal VV&A 
process, the first of its type in the U.S. Army. The first phase, which is 
applicable here, comprised the core task network modeling capability and 
the effects implemented as additions to or modifications of the task data--
mental workload estimation and environmental degradation, personnel 
characteristics, and training. A review board of representative users, 
policy-makers, technical experts, and soldier proponents evaluated the 
findings against eight criteria: configuration management, software 
verification, documentation, data input requirements, model granularity, 
validity of modeling techniques and embedded algorithms, output, and 
analysis timelines. All criteria were satisfied and formal accreditation was 
granted in January 1995 with only limited caveats (see Allender et. al, 
1995).

Since the environmental stressors were transitioned to IMPRINT without 
modification, the basic VV&A transitioned as well. Of note, although this 
portion of the software was approved and the basic approach of degrading 
time and/or accuracy of performance on a task-by-task basis was 
supported, the consensus was that all the algorithms warrant updating and 
that new algorithms need to be developed to fill the voids. Referring to the 
Table 10-2, and to the dates of some of the environmental stressor 
references, it is clear that there are substantial voids and that there is 
certainly new research that should be accounted for in this arena.

Examples of the Method for Test and Evaluation

One example of the implications of this modeling approach to the test and 
evaluation arena was reported by Allender, McAnulty, and Bierbaum 
(1992). They describe the application of the predecessor HARDMAN III 
software to the analysis of potential options for reducing turnaround time in 
an Apache Forward Arming and Refueling Point (FARP). Once the 
baseline was constructed, three options were compared: adding a new 
equipment component, adding personnel, and changing reloading tactics, 
that is full vs. half reload of one ammunition type. The level of effort 
involved in the evaluation of options was only a fraction of the baseline 
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development costs and certainly only a fraction of comparable field trials. 
Since the modeling effort was conducted at the same time as the test 
planning was under way, the results were available to the test planners to 
help focus testing and to serve as a validation reference. They asserted 
that the results were appropriate to be used in interaction with testing, not 
as a substitute.

Another example is the work reported by McMahon, Spencer, and 
Thornton (1995). Within months of a final milestone review, an NBC 
reconnaissance system called the Fox had been given an “unacceptable” 
operational assessment at the completion of a large-scale field test. The 
central issue was that a four-seat vehicle had not been modified to fit the 
new three-person crew. The operator was forced to switch positions 
repeatedly in order to do the job, which caused safety problems and 
unacceptable performance. Coupled with modeling of proposed changes to 
the equipment and display layout, two mission models were built: the 
baseline and the proposed re-design. The mission model predicted 
substantially reduced workload and improved performance. Subsequently, 
the system was retro-fitted for a limited, two-week test which validated the 
model predictions. From this example the time, cost, and even safety 
benefits of using modeling in conjunction with testing are quite evident. 

Proposed Environmental Stressor Developments

The examples provided in the previous section are good evidence for the 
utility of modeling in the test and evaluation arena; however, a 
comprehensive application of the environmental stressors for test and 
evaluation has not been completed. This is clearly a priority. Also, the 
shortcomings, voids, and need for updates to the stressors are obvious. 

At this time, the literature in this area is being re-surveyed in order to 
develop a prioritized list of stressor updates, enhancements, and additions. 
Criteria for the prioritization are user need and availability of generalized 
data. Several other organizations have also identified this type of work as 
critical and plans for leveraging and cooperation are under way. Work of 
note includes that being performed under the auspices of the United 
Kingdom Defence Evaluation Research Agency Centre for Human 
Sciences, the Integrated Performance Modeling Environment. The U.S. 
Defense Special Weapons Agency (formerly the Defense Nuclear Agency) 
has published work in this area also (for example, Anno, Dore, & Roth, 
1996). Close at hand, the U.S. Army Research Laboratory Human 
Research and Engineering Directorate is currently investigating databases 
on various dimensions of psychological stress as related to performance 
for inclusion in IMPRINT.
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In conclusion, the IMPRINT tool offers a modeling technology for 
evaluating human performance under diverse conditions. Based on sound 
task analysis, network modeling, and environmental stressor degradation 
algorithms tailored to task type, assessments of performance under 
diverse conditions can be used to augment test and evaluation today. With 
continued development, the capability to perform these types of analyses 
will be further enhanced.
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Appendix B: Human Performance 
Micromodels

IMPRINT Pro uses the following types of micromodels:

Perceptual Micromodels

Motor Micromodels

Cognitive Micromodels

Special Micromodels

Perceptual Micromodels

The following table contains the basic parameters for perceptual 
micromodels.

Model Value or Equation Reference

Eye Movement 
Time (target 
located in eye 
field)

100 msec (travel time only) Houtmans, M. J. M. and 
Sanders, A. F. 
Perception of Signals 
Presented in the 
Periphery of the Visual 
Field. Acta Psychologica, 
55, 143-155, 1984.; 
Sanders & Houtmans 
1985. Considers travel 
time only.

Head Movement 
Time (target 
located in head 
field)

200 msec (travel time only) Houtmans, M. J. M. and 
Sanders, A. F. 
Perception of Signals 
Presented in the 
Periphery of the Visual 
Field. Acta Psychologica, 
55, 143-155, 1984.; 
Sanders & Houtmans 
1985. Considers travel 
time only.
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Motor Micromodels

The following table contains the basic parameters for Motor micromodels.

Eye Fixation Time 100 msec - 500 msec Houtmans, M. J. M. and 
Sanders, A. F. 
Perception of Signals 
Presented in the 
Periphery of the Visual 
Field. Acta Psychologica, 
55, 143-155, 1984.; 
Sanders & Houtmans 
1985.

Search Time (Tm + Tf)N where
N = number of fixations
Tm = movement time
Tf = fixation time

Sanders & Houtmans 
1985.

Reading Rate 52 words/min (5 saccades per 
word), 261 words/min (1 
saccade per word), 652 
words/min (1 saccade per 
phrase), Assumes: 5-letter 
words, 2.5 words or 13 
characters per phrase

Card et al., 1983. 
Assumes 1 saccade (eye 
fixation) per word, 5-letter 
words.

Listening Rate: 2.4 words/sec Miller and Licklider, 1950. 
Accuracy is a function of 
signal-to-noise ration (in 
dB) and noise 
interruption frequency

Model Value or Equation Reference

Model Value or Equation Reference

Basic Parameters

Hand Movement (Fitt's 
Law-Welford Variant)

IM log2 [D/S + 0.5] where T = 
Movement Time
D = Distance between targets
S = Size of Targets
IM = Slope Constant =.1 sec/bit

Welford, 1968
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Hand Controls

Pushbutton or Toggle 400 msec Harris, R. M., 
Iavecchia, H. P., 
and Bittner, A. C., 
Jr. The HOS 
Micromodels. 
Proceedings of 
the Human 
Factors Society 
32nd Annual 
Meeting, 1988, 
pp. 1051-1055.

Rotary Dial 730 msec Harris, R. M., 
Iavecchia, H. P., 
and Bittner, A. C., 
Jr. The HOS 
Micromodels. 
Proceedings of 
the Human 
Factors Society 
32nd Annual 
Meeting, 1988, 
pp. 1051-1055.

Cursor Movement with 
Trackball

IM * log2 (d/s + 0.5) where
IM = constant = 100 msec/bit
d = cursor distance to be 
moved
s = display symbol width

Harris, R. M., 
Iavecchia, H. P., 
and Bittner, A. C., 
Jr. The HOS 
Micromodels. 
Proceedings of 
the Human 
Factors Society 
32nd Annual 
Meeting, 1988, 
pp. 1051-1055., 
1988 from Fitt's 
Law.

Model Value or Equation Reference
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Cursor Movement with 
Mouse

1.03 +.06 log2 (D/S +.5) sec
D = Distance to target
S = Size of target

Card, S. K., 
Moran, T. P., and 
Newell, A. The 
Psychology of 
Human-
Computer 
Interaction. 
Erlbaum 
Associates Pub., 
1983. Includes 
time for the hand 
to initially adust 
its grasp on the 
mouse and time 
to make the 
selection with the 
mouse button.

Cursor Movement with 
Joystick

KD +.100 log2 (D/S +.5) sec 
where
KD = intercept distance for 
distance D
D = Distance moved
S = Size of target

Card et al., 1983

Cursor Movement with 
Step Keys

98 +.074 (Dx/Sx + Dy/Sy) sec, 
where
Dx=Horizontal distance to 
target
Dy=Vertical distance to target
Sx=Size of a vertical step 
(default =.456 cm)
Sy=Size of a horizontal step 
(default =.246 cm).

Card, S. K., 
Moran, T. P., and 
Newell, A. The 
Psychology of 
Human-
Computer 
Interaction. 
Erlbaum 
Associates Pub., 
1983.

Model Value or Equation Reference
532



Appendix B: Human Performance Micromodels
Cursor Movement using 
Text Keys

.66 +.209 Nmin sec. where

.209 = Keystroke rate (in sec/
keystroke) which approximates 
the typing rate for random 
words
Nmin = minimum number of 
keystrokes.

Card, S. K., 
Moran, T. P., and 
Newell, A. The 
Psychology of 
Human-
Computer 
Interaction. 
Erlbaum 
Associates Pub., 
1983.

Single Finger Keying 
Rate

.140 [.060 =.200] sec Card, S. K., 
Moran, T. P., and 
Newell, A. The 
Psychology of 
Human-
Computer 
Interaction. 
Erlbaum 
Associates Pub., 
1983.

Typing Rate .209 sec/keystroke Card, S. K., 
Moran, T. P., and 
Newell, A. The 
Psychology of 
Human-
Computer 
Interaction. 
Erlbaum 
Associates Pub., 
1983.

Walking Rate 0.19 sec/foot Harris, R. M., 
Iavecchia, H. P., 
and Bittner, A. C., 
Jr. The HOS 
Micromodels. 
Proceedings of 
the Human 
Factors Society 
32nd Annual 
Meeting, 1988, 
pp. 1051-1055.

Model Value or Equation Reference
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Cognitive Micromodels

The following table contains the basic parameters for cognitive 
micromodels.

Speech

Speech rate 3.4 words/sec (large 
vocabulary)
2.4 words/sec (small 
vocabulary)

 McCormick, E. J. 
Human Factors 
Engineering (3rd 
Ed.), NY:  
McGraw-Hill 
Book Co., 1970.

Model Value or Equation Reference

Model Value or Equation Reference

Perceptual Process τP = 100 msec Card, S. K., Moran, T. P., 
and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.

Decision Process τC = 70 msec Card, S. K., Moran, T. P., 
and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.

Motor Process τM = 70 msec Card, S. K., Moran, T. P., 
and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.
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Simple Reaction Times - 
On/Off Response

τP + τC + τM = 240 msec Card, S. K., Moran, T. P., 
and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.

Simple Reaction Times - 
Physical Match

τP + 2τC + τM = 310 msec Card, S. K., Moran, T. P., 
and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.

Simple Reaction Times - 
Name Match

τP + 3τC + τM = 380 msec Card, S. K., Moran, T. P., 
and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.

Simple Reaction Times - 
Class Match

τP + 4τC + τM = 450 
msec

Card, S. K., Moran, T. P., 
and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.

Choice Reaction Time K * log2 (n+1) where
k is a constant 
representing simple RT 
and is set at 150 msec.
n is number of possible 
alternatives

Hick's Law as discussed 
in Card, S. K., Moran, T. 
P., and Newell, A. The 
Psychology of Human-
Computer Interaction. 
Erlbaum Associates 
Pub., 1983.

Mental Rotation 
(Visualization)

1 sec + (R / 50o per sec) 
where: 
R = amount of rotation 
from initial perceived 
view to final visualized 
view (in degrees)

Shepherd and Metzler, 
1971

Model Value or Equation Reference
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Special Micromodels

The following table contains the basic parameters for special micromodels.

Model Value or Equation Reference

Prioritization (that 
is, of targets)

.310[n(n+1) / 2] where: 
n = number of targets in a sector. 
This formula treats prioritization 
as a unidimensional [worth] 
pairwise comparison between all 
possible targets in a sector.

McCarthy, J., and 
Plocher, T. (Unpublished 
data), February 1990. 
Treats prioritization as a 
unidimensional pairwise 
comparison between all 
possible targets.

Terrain 
Association

Two stage process:
Stage 1. Reduce size of area of 
uncertainty: Time = 5 sec. 
(Performed once every time a 
completely new view is 
encountered.)
Stage 2. Pinpoint own location 
Time = 2 sec. Per terrain 
matching attempt. (Four to seven 
matching attempts required to 
pinpoint own location. Other job 
activities are typically 
interspersed in between terrain 
matching attempts.)

Cross, K. D., Rugge, S. 
M., and Thorndyke, P. W. 
Cognitive Process in 
Interpreting the Contour 
Line Portrayal of Terrain 
Relief. Technical Report, 
Contract No. N0014-80-
C-0508, Office of Naval 
Research, Dec. 1982.
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A

Accuracy Measure
Accuracy Measure is a unit corresponding to the nature of how your task’s 
accuracy is measured. This unit helps IMPRINT Pro to determine whether 
your task is more or less accurate when the number pulled from the 
accuracy distribution is greater or less than the requirement you set. For 
example, assume that your Accuracy Measure is set to Percent Steps 
Correct and your Accuracy Requirement is set to 80. If the number pulled 
from the Accuracy distribution is 85, then IMPRINT Pro will consider this 
accuracy value to be a success since 85% is better than 80% in the context 
of Percentage of Steps Correct. If, however, you intend choose the unit of 
Measure Feet from Desired, IMPRINT Pro will consider this accuracy value 
of 85 to be a failure since 85 is less accurate that 80 in the context of Feet 
from Desired.

Accuracy Requirement
The Accuracy Requirement is the minimum acceptable accuracy for a task 
in order for it to be considered a success. 

Accuracy Standard Deviation
The Accuracy Standard Deviation specifies how tightly all the various 
values in the distribution are clustered around the Mean Accuracy value.

Activities Trump Matrix
A matrix used to set task priority within a Force Unit schedule for when any 
two activities overlap.

Analysis Description
A brief description of the analysis found in the Properties window. The 
Analysis Description is optional. 

Analysis Name
The Analysis Name can be 20 characters long and can include spaces and 
symbols. When an analysis is added, IMPRINT Pro automatically 
generates an analysis name that the user may edit in the Properties 
window. However, when an analysis is saved, the user will need to enter a 
name in the dialog provided.
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Analysis Version
The Analysis Version can be 20 characters long and can include spaces 
and symbols. When an analysis is added, IMPRINT Pro automatically 
generates an analysis version that the user may edit in the Properties 
window. When an analysis is saved, the user will need to enter a version 
number in the dialog provided.

Array
An ordered set of variable values that are indexed to a single variable 
name. An array can be a one-dimensional list, a two-dimensional table of 
rows and columns, or a multi-dimensional array.

B

Beginning Effect
An expression used to change the values of variables in the model as a 
result of a task starting.

C

Clock
System variable that records elapsed time in simulation time units since the 
beginning of model execution. The Clock variable can be used in any 
expression in a model.

Contingency Operators
One or more contingency operators may be selected for each task. During 
the task reallocation process, a contingency operators will be considered if 
workload overload occurs during mission execution.

Crew Ratio
Crew Ratio is the average number of crews available for each new system 
in the unit. In some cases where systems are required to operate 
continuously there may be multiple crews for each system.

Criterion
This value is the percentage of time that this task, function or mission must 
meet both its time requirement and its accuracy requirement 
simultaneously in order to be considered successful.
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D

Decision Node
A diamond-shaped object on a network diagram containing one of the 
following letters: P, M, or T—representing a Probabilistic, Multiple, or 
Tactical decision.

Decision Type
The Decision Type determines which path(s) an entity may follow when 
exiting a node which branches out along multiple paths. Tasks with a 
decision type of Multiple will follow all paths every time; tasks with a 
decision type of Probabilistic are likely to follow the path(s) in proportion to 
the percentages you set for each path; tasks with a decision type of 
Tactical will follow only those paths whose conditions evaluate to True; 
tasks with a decision type of Single will only ever follow one path. 

Distribution
The range of all possible values which can be assigned to a task’s time 
value and the probability that those values will be chosen at random.

E

Effect
An expression that executes as a result of task activity during model 
execution. Tasks can have beginning, and ending effects. You can use 
these effects to change variable values and thus represent the system 
changes that occur as a result of the task activity.

Ending Effect
An expression used to change the values of variables in the model 
because of a task ending.

Entity
A conceptual object that travels through a task network and indicates by its 
location when each task is executing or waiting to execute. The entity may 
represent a physical object, such as a part being built on a production line. 
It may also represent a person performing the tasks. Or, the entity may 
simply trace the sequence of tasks and not correspond to anything 
physical. During model execution, entities can be represented by symbols 
or numbers that travel through the network diagram. Entities are identified 
by corresponding values of their entity attributes.
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Entity.Duration
An Entity attribute that records the time each entity spends in the current 
task.

Entity.Tag
An Entity attribute that records the identity of each entity when there are 
multiple entities traveling through a network. Once an entity has an 
Entity.Tag value, the value stays with the entity through the remainder of 
model execution.

Estimated Task Accuracy
Use Task Mean Accuracy and Accuracy Standard Deviation under this 
section of the TimeAcc tab to specify an average value for how accurately 
a particular task is likely to be performed. For example, you might say that 
on the average when performing this task the operators get 90 percent of 
the steps correct or for another tasks they are within 10 mils of the correct 
azimuth. Under the first option, you will also specify the standard deviation, 
which in some sense is a measure of the worst and best the task is likely to 
be performed. An easy rule of thumb for specifying the standard deviation 
is to compute the difference between the worst and best performance and 
divide it by 6. For example, if the worst performance is 40% steps correct 
and the best is 100%, then an estimate for the standard deviation would be 
10% (((100 - 40)/6) = 10). Under this option you will define what is 
acceptable performance by specifying an accuracy standard. For example, 
you may say that any error greater 5 mils causes firing inaccuracies that 
are unacceptable. With the information above, the model then computes 
the probability of the task performance being at or above the standard and 
compares a selected random number to determine if task was performed 
accurately.

Estimated Task Time
The Estimated Task Time is the amount of time a task will take to execute 
as calculated by IMPRINT Pro. This time will vary each time the task is 
executed. To calculate this time, IMPRINT Pro starts with an initial task 
time which can either be represented as a value (entered in the Value field 
in the format of HH:MM:SS.mm) or as a time expression (entered in the 
Expression field and evaluated to seconds). Next, IMPRINT Pro pairs this 
initial time with a statistical distribution type. This distribution determines 
the possible values your task time could take relative to your initial value. 
When IMPRINT Pro runs, a random number is generated and is used to 
pull a number from the distribution you have specified. This number 
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becomes the Estimated Task Time for that occurrence of the task. Note: of 
the available 20 distribution types, IMPRINT Pro uses, by default, the 
Normal distribution which uses Mean and Standard Deviation to predict a 
task performance time. Depending on the distribution type you choose to 
use, different and/or additional parameters such as Shape, Probability of 
Success, Maximum, Minimum and Scale, might also be required. 

Event
Something that is scheduled to happen during a simulation at a specific 
clock time. Some events are expressions that you schedule to occur at 
specific times—these are called scenario events. All other events are 
scheduled, such as the finish times for currently executing tasks, as the 
model is running. You can watch events being scheduled by displaying the 
Event Queue window.

Event Queue
Events that are scheduled to happen during model execution are placed in 
an Event Queue. As each event occurs, it is removed from the top of the 
queue. These events are displayed in the Event Queue window.

Expression
A calculation, formula, macro, or statement that supplies a value or 
performs an operation. Expressions can contain combinations of numerical 
values (constants or variables), macros, mathematical and logical 
operators, and logical statements.

F

Force Unit
A Force Unit is a group of individuals, defined by jobs, who perform a 
variety of activities according to schedules.

Function
A network that is inside another network. In a model, all networks are 
functions except for the top network (level 1). You can create a function by 
dragging a function object to the Network Diagram from the Palette. Select 
the function with the pointer to open its diagram. Function diagram are 
drawn in the same way as the main network diagram. Functions usually 
also contains tasks.
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Function Criterion
Function Criterion is a percentage that determines how often the function 
must meet its Function Time Requirement to be considered a success. 
Enter a value between 0 and 100, inclusive.

Function Time Requirement
The Time Requirement is the slowest performance time that can be 
tolerated and have the function still be considered a success. When 
IMPRINT Pro executes your mission model, the performance time that is 
predicted by the aggregation of all tasks in this function will be compared to 
this standard to ensure that your design can meet the function level time 
requirement. The format for this entry (as with all other time values) is 
HH:MM:SS.mm. To enter a time requirement of 30 minutes, 15 seconds 
enter 00:30:15.00. Notice that you can enter hundredths of a second after 
the decimal point.

G

H

I

J

Job
The occupation held by one or more members of the Force Unit. Each job 
is defined by a name, specialty, rank and role. Examples may include Tank 
Driver, Navigator and Analyst.

K

L

Length of run
The number of days of operations that the IMPRINT Pro maintenance 
model will simulate. If you define mission segments for more days than are 
entered here, the model will not execute any segments that go beyond this 
value. This value defaults to 1.00.
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M

Macro
One or more mathematical or logical expressions that are assigned a 
single name and return a single value. When a macro name is encountered 
in an expression in a model, the model executes the expressions included 
in the macro and returns a value. IMPRINT Pro contains model, 
mathematical, and distribution macros for your use, or you can define and 
save your own macros with the model.

Maximum Number of Systems
This value is the maximum number of systems that would be assigned to 
your segment if available.

Mean Accuracy
The Mean Accuracy is the estimate of the most likely, or average, accuracy 
value for a task.

Mean Time Expression
The Mean Time represents the average number of seconds required to 
execute a task. You can either enter a mean time value (00:00:30) or you 
can enter an expressionclock<=30 then 10 else 15). Each expression is 
delimited by semicolons. In building the expression you can use any of the 
algebraic or logical operators including the following: (&, |, >, <, :=,==, +, -
,*, and /), and you can use if-then-else statements. The assignment 
operator is :=. The equivalence operator is ==. 

Minimum Number of Systems
This value is the minimum number of systems that must be ready to begin 
the segment prior to the cancellation time in order to prevent all departure 
groups from being canceled.

Mission Accuracy Criterion
The Mission Accuracy Criterion is a percentage that determines how often 
the mission must complete without abort to be considered a success. 
Aborts are caused when a task fails and the consequence of failure is 
mission abort Values can range from 0 to 100.

Mission Criterion
The Mission Criterion is the percentage that represents how often the 
mission must meet both its time and accuracy standards at the same time. 
Values can range from 0 to 100.
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Mission Description
The Mission Description is a fairly long text field that you can use to 
describe the mission you intend to model. The description is limited to 255 
characters. All printable text characters are allowed.

Mission Name
The Mission Name is a brief text label that you will use to uniquely identify 
your system’s mission. The mission name is limited to 60 characters. All 
printable text characters are allowed, including spaces.

Mission Time Criterion
The Mission Time Criterion is a percentage that determines how often the 
mission must meet its Mission Time Requirement to be considered a 
success. Values can range from 0 to 100.

Mission Time Requirement
The Time Requirement is the slowest performance time that can be 
tolerated and have the mission still be considered a success. When 
IMPRINT Pro executes your mission model, the performance time that is 
predicted by aggregating your individual tasks will be compared to this 
standard to ensure that your design can meet the mission level time 
standard. The format for this entry (as with all other time values) is 
HH:MM:SS.mm. So, to enter a time requirement of 30 minutes, 15 seconds 
enter 00:30:15.00. Notice that you can enter hundredths of a second after 
the decimal point.

MMH/System
Annual MMHs/system (ORG, DS, & GS levels) are the total number of 
annual maintenance manhour (by maintenance level) required to maintain 
one new system in that unit.

N

New Systems
This is the number of new systems that will be fielded in the unit.

Network
A sequential relationship of jobs (tasks and functions) that simulate a 
system, activity, or process. You create the network by drawing a network 
diagram, and you use variables to simulate the effects of the tasks on other 
tasks and on the system.
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Network Diagram
A graphical depiction of a model network showing the sequence of tasks 
and functions, and the possible paths through the network. You draw the 
network diagram using the objects on the Palette.

Number of times to run the mission
If you would like to run a model more than once, you can enter that number 
in this field. If you have a relatively short scenario (in days), you may want 
to run the model several times in order to be confident that the data you get 
from all of the runs is representative. One short run may, by chance, 
produce data that are not very typical. Running a model for a long period of 
time (for example, 90 days) will also improve the probability that the results 
are typical. IMPRINT Pro will automatically begin each run with a new 
random number seed. This value defaults to 1.

Number Per Departure Group
This value controls the number of systems per group (sometimes referred 
to as a “flag”) that are sent out on this segment.

O

OP Tempo
Annual OP Tempo is the usage per year that the new system is expected 
to accrue in the type and size unit listed.

Overall Workload
The sum of all single task demand values and all conflict values (inter-
channel and intra-channel) of all ongoing tasks that an operator is currently 
performing at a given instant of time (see Operator Workload Summary 
and Detail reports.)

P

Path
A sequential connection between two nodes (tasks or functions), drawn by 
dragging the mouse cursor from one node (source) to another 
(destination). The conditions under which the path is taken is specified in 
the Paths tab of the source node.
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Planned Activity
A planned activity is an activity comprising part of a Force Unit schedule, 
which has a designated start time and will last until the next scheduled 
activity is set to occur. Examples may include “guard duty,”” hygiene,” 
“eating” and “sleeping.”

Primary Operator
The Primary Operator is the specialty and crew position that will be 
assigned to perform the task. 

Probability of Success
The Probability of Success is the likelihood that a task will succeed each 
time it is executed. This number can either be manually entered or can be 
calculated as a result of entering values for the remaining three fields upon 
which it is dependent, namely the Mean Accuracy, Accuracy Standard 
Deviation and the Accuracy Requirement.

Q

R

Random Number Seed
A number between approximately -2 billion and +2 billion used to generate 
random numbers for calculating task execution times and taking 
probabilistic paths through the network. You supply the random number 
seed when you define the Execution settings for a model.

Rank
An official position or standing in the armed forces. This information is used 
to help define the jobs in a force unit. Ranks include E1-E3 (Private and 
Private First Class), E4 (Specialist or Corporal), E5 (Sergeant), E6 (Staff 
Sergeant), E7 (Sergeant First Class), and E8-E9 (Master Sergeant, First 
Sergeant, Sergeant Major, Command Sergeant Major and Sergeant Major 
of the Army).

Release Condition
An expression that is evaluated to determine whether or not a task can 
execute. A task can execute only when the value of the release condition is 
nonzero or true. You supply the release condition when you define the 
task. The default release condition is always “true”.
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Repeating Segments
A Repeating Segment is one in which IMPRINT Pro’s maintenance model 
will attempt to send more systems out to perform this segment every so 
often. You can identify the frequency of the segment (for example, “repeats 
every four hours”).

Replacement Systems
The number of old systems that will be replaced in a unit.

Resource-Interface Channels
Resource-Interface Channels are formed by pairing the human resources 
with the interfaces (for example, visual/heads up display, motor/control 
stick). All workload is assigned to a task by setting individual single task 
demand values for each resource-interface channel used to perform that 
task.

Role
The level of participation that a job (an occupation held by one or more 
members of the Force Unit, such as a driver or gunner) will have in an 
unplanned activity if one requiring such a level occurs. Roles include 
Leader, Sub-Leader and Member. 

Run number
The current run number in cases where there are multiple runs. The run 
number can be accessed through the expression Model.RunNumber.

S

Scenario Description
The scenario description is a free text field that you can use to document 
your analysis. It is limited to 255 characters.

Scenario Name
This is the name of your maintenance scenario. You can have many 
maintenance scenarios for each system.

Seed 
A random number seed used to run a model. The random number seed 
generates a set of random numbers that are used to calculate task 
execution times and probabilistic paths taken through the network. The 
random number seed can be set in the Execution dialog box. For multiple 
runs of a model, the variable Model.RandomSeed contains the random 
seed used to generate the particular run.
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Segment Cancellation Time 
This is the number of hours that the simulation will wait for the minimum 
number of systems to be available before canceling the segment. For 
example, if the minimum number of systems for this segment is six and 
there are only four available at the scheduled start of the segment then the 
segment must wait. If there is a value of “01:00:00.00” in this field, then if 
the minimum number of systems do not become available within one hour 
of the scheduled start, the segment will be canceled. The default value for 
this item is 00:00:00.00. This means that the minimum number of systems 
must be available at the start time of this segment in order for the segment 
to begin. Be very careful that your cancellation is not after the segment 
would be attempting to repeat.

Segment Duration Time
This value indicates the number of operational hours for this segment. This 
value is used to schedule the return of the systems from operations and the 
beginning of the maintenance window. Additionally, this time is used to 
determine usage for the equipment on which failures are triggered by time. 

Segment Priority
When more than one segment has been defined to occur at the same time, 
the segments must compete for available systems. In this box, you can 
enter a priority number for each segment. Available systems will be 
allocated to higher priority segments first.

Segment Repeat Mean Time 
If you have checked the Repeating box for your segment, you will be able 
to enter a time in the Segment Repeat Time box. The value in this box 
controls the frequency (in hours) with which the simulation will attempt to 
repeat this segment. If you will enter the number 4 in this box, it will indicate 
that you want this segment to repeat every four hours. In other words, this 
segment will try to start again every four hours throughout the simulation. If 
you wanted this segment to repeat only twice, you could do this by defining 
two separate but identical segments with one starting four hours after the 
first.

Segment Start Day
The Segment Start Day and the Segment Start time work together to 
identify the start time of this segment. This value defaults to 1. If you were 
to leave the default values in both of these boxes, this mission would begin 
at time 0 on day 1.
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Segment Start Time
The time entered in the Segment Start Time box indicates the time the 
segment is to begin. This value defaults to 00:00:00.00.

Shift Data
Enter the maintenance shift length in clock hours and the number of shifts 
per day. The product of the two numbers must be less than or equal to 24. 
The number of shifts will determine the number of shift columns in the 
Maintenance Crew spreadsheet

Shift Length
The length of shift in hours. 

Shifts per day
The number of shifts per day. 

Snapshot
An option that records the values of specified variables at particular points 
during model execution—for example, when a task starts or ends, at the 
end of a run, or at specific clock times. When you run a model for which 
you have defined snapshots, the values are recorded, and results may be 
viewed in the Snapshots report.

Specialty
A specialty is a designation for a particular military job within the Armed 
Forces referenced by a 3-letter designation. For example, a Scout 
helicopter repairer is designated 67S. This option enables you to select 
people of appropriate specialties for task assignments.

Spinner Task
A task with a path that goes back to itself. Spinner tasks are used to 
generate multiple entities to travel through the network.

Subsystem Equipment Group Name
The subsystem type indicates the operational units (Armament, Mobility, 
and Other) that are used to describe the usage for that subsystem.
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Subsystem
A subsystem is one of several smaller elements comprising a system, for 
example, an engine is a subsystem that is part of a system called “Tank”. 
Each Subsystem is going to be one of three types (Armament, Mobility, 
and Other) and must be uniquely named. Subsystem type indicates the 
operational units that are used to accrue the usage for that subsystem 
Usage for an Armament subsystem is described as the number of rounds 
that have been fired from that subsystem. Usage for components in a 
Mobility system is described in terms of the distance that the system has 
traveled. Subsystems with a type of “Other” use operational time as the 
usage measure.

T

Task
Tasks are the basic building blocks of a model. A task is defined by timing 
information, execution constraints (or release conditions), effects of the 
task on the system, and routing information concerning following tasks and 
functions. Each time a task executes, the execution time is randomly 
calculated within the time distribution parameters you supply. You can 
create a task using the Palette and Network Diagram or through the 
Analysis Tree. To define a task simply double-click the task in the tree or in 
the network, and enter its information in the Task Properties window.

Task Accuracy Probability
As an alternative to specifying a task’s Accuracy Mean, Standard Deviation 
and Accuracy Standard data and relying upon IMPRINT Pro to calculate its 
Probability of Success, you can instead directly enter this value by (as a 
percentage) in the Probability of Success field. When the task runs, the 
value entered here is compared with a random number to determine if the 
task was performed accurately. 

Task Criterion
The percentage of time that the task must meet its time and accuracy 
standards in the same simulated occurrence in order to considered a 
success.

Task Mean Accuracy
The average value for how accurately a particular task is likely to be 
performed.
566



Glossary
Task Name
This text box displays the name of the task for which you are displaying or 
entering information.

Task Priority
On the Effects tab, task priorities are used to execute priority-based 
workload management strategies.The priorities range from 1 (very low) to 5 
(very high). New tasks are assigned a priority level of 3 (medium). To 
change a priority level for a task, double-click on a task to open the task 
parameter window, click in the Task priority field of the task and enter a 
priority value between 1 and 5, or click on the drop box in the task priority 
field and select a priority from the list.

Task Standard Deviation
A measure that tells you how closely all the various task times calculated 
by IMPRINT Pro are clustered around the mean task time. In general, one 
standard deviation away from the task mean time in either direction 
(greater than or less than the mean) accounts for somewhere around 68 
percent of all computed task times. Two standard deviations away from the 
mean account for roughly 95 percent of the computed task times. And 
three standard deviations account for about 99 percent of the computed 
task times. By specifying the Task Standard Deviation for your task, you 
are helping IMPRINT Pro to determine how widely varied (or unvaried) the 
distribution of all your different calculated task times will be.

Task Time Requirement
The Time Requirement is the slowest performance time that can be 
tolerated and have the task still be considered a success. When 
IMPRINT Pro executes your mission model, the Distribution along with 
parameters Mean and Standard Deviation are used to choose a specific 
task time for each occurrence of each task. These times are then 
accumulated throughout the model run and compared to the time standard 
in order to report the percentage of successes for each task. To enter the 
time requirement, use the mouse to position the cursor in the time 
requirement box. 

Time Between Departures 
The value in the Time Between Departures field denotes the amount of 
time that must lapse between any two consecutive group departures for a 
given segment. This value is in hours and can be entered in the 
HH:MM:SS.mm format to include hundredths of hours.
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Time Format
Time data entered in the IMPRINT Pro interfaces or viewed in the IMPRINT 
Pro reports can be displayed in one of several different formats, such as 
hours, minutes, seconds and HH:MM:SS.mm. Time formats may be 
changed in the Time tab through the Preferences option under the View 
menu.

Time Requirement
The Time Requirement is the maximum acceptable performance time for a 
task.

U

Unplanned Activity
A unplanned activity is an activity which can interrupt the normal planned 
activities comprising a Force Unit schedule, Unplanned activities are 
defined by a probable start time, duration and the number of people 
required to address them. Examples may include “fire” and “emergency”.

V

Variable
An identifier which is used to represent a quantity which can vary in value. 
When a variable name is encountered in an expression, IMPRINT Pro 
substitutes in the current value of the variable and evaluates the 
expression. Variables are useful for representing changeable aspects of 
the system you are simulating. You can change the value of a variable 
through any expression in your model, for example, in a task effect or in a 
scenario event. For each IMPRINT Pro model, five system variables are 
automatically created including Clock, Distributions, Entity, Model, and 
Task. For more information about system variables see the “Variables” 
section in this manual.

W

Warfighter
A warfighter is any person or automated device that operates, maintains, 
supplies or supports military equipment.
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